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Graphics

This section discusses techniques for plotting data and provides examples showing how to plot, 
annotate, and print graphs. 

Related Information
These other sections provide additional information about plotting.

MATLAB Plotting Tools Creating plots and setting graphic object properties

Data Exploration Tools Tools to extract information from graphs interactively

Annotating Graphs Adding annotations, axis labels, titles, and legends to graphs

Basic Plotting Commands Plotting vector and matrix data in 2-D representations

Creating Specialized Plots Creating bar graphs, histograms, contour plots, and other 
specialized plots

Displaying Bit-Mapped Images Displaying and modifying bit-mapped images with MATLAB®

Printing and Exporting Printing graphs on paper and exporting graphs to standard 
graphic file formats

Handle Graphics Objects MATLAB graphics objects and properties

Figure Properties How to use figure properties

Axes Properties How to use axes properties

3-D Visualization Using viewing and lighting techniques to achieve complex 
graphic effects

Creating Graphical User Interfaces How to include menus, push buttons, text boxes, and other 
user interface objects in MATLAB applications
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1
MATLAB Plotting Tools

If you are viewing this document in the Help browser, you can watch the Interactive Plot Creation 
with the Plot Tools video demo for an overview of the major functionality. It covers much of the 
material presented in the following sections:

Anatomy of a Graph (p. 1-2) Describes the basic components of a MATLAB graph

Plotting Tools — Interactive Plotting 
(p. 1-4)

Introduces the interactive tools you can use for creating 
graphs and setting properties

Example — Working with Plotting 
Tools (p. 1-19)

Shows how to work with the Plotting Tools

Example — Plotting Workspace 
Variables (p. 1-26)

Access workspace variables from the Plotting Tools

Example — Specifying a Data Source 
(p. 1-31)

Link graph data to workspace variables

Example — Generating M-Code to 
Reproduce a Graph (p. 1-35)

Save all the property settings and other steps used to 
create a graph

Editing Plots (p. 1-37) Overview of plot editing options.

Using Plot Edit Mode (p. 1-38) Modify graph appearance interactively

Saving Your Work (p. 1-46) Ways to save graphs
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Anatomy of a Graph
MATLAB® plotting functions and tools direct their output to a window that is 
separate from the Command Window. In MATLAB this window is referred to 
as a figure. For example, the following picture illustrates a graph of the Bessel 
function, highlighting the basic components of the graph.

By default, MATLAB uses line style and color to distinguish the data sets 
plotted in the graph. However, you can change the appearance of these graphic 
components or add annotations to the graph to help explain your data for 
presentation. 

Figure Toolbars
The figure’s default toolbar provides shortcuts to commonly used features. The 
following picture shows the features available from this toolbar.

MATLAB figure 
window 

Axes in which 
MATLAB plots data

Line plots 
representing data

One of the figure 
toolbars

Dock figure in 
MATLAB desktop
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Note that you can enable two other toolbars from the View menu:

• Camera Toolbar — Use for manipulating 3-D views. See “View Control with 
the Camera Toolbar” for more information.

• Plot Edit Toolbar — Use for annotation and setting object properties. See 
“Annotation Tools on the Plot Edit Toolbar” on page 3-2 for more 
information.

Enable plot edit 
mode

Zoom in

Zoom out

Pan Rotate 3-D Data cursor

Insert colorbar Insert legend

Hide/display 
plot tools
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Plotting Tools — Interactive Plotting
MATLAB provides a collection of plotting tools that form an interactive 
plotting environment. This environment enables you to

• Create various type of graphs

• Select variables to plot directly from a workspace browser

• Easily create and manipulate subplots in the figure

• Add annotations such as arrows, lines, and text

• Set properties on graphics objects

Starting the Plotting Tools
To create a figure with the plotting tools attached, use the plottools 
command. You can also start the plotting tools from the figure toolbar by 
clicking the Show Plot Tools icon . 

Remove the plotting tools from a figure using the Hide Plot Tools icon . 

You can display the three basic plotting tools from the View menu by selecting 
Figure Palette, Plot Browser, or Property Editor.

The next section describes the individual components making up the plotting 
tools.

Plotting Tools Interface Overview
The Plotting Tools interface includes three panels that are associated with a 
figure. 

• Figure Palette — Use to create and arrange subplot axes, view and plot 
workspace variables, and add annotations. Display the Figure Palette using 
the figurepalette command.

• Plot Browser — Use to select and control the visibility of the axes or graphic 
objects plotted in the figure. You can also add data to any selected axes by 
clicking the Add Data button. Display the Plot Browser using the 
plotbrowser command.

• Property Editor — Use to set common properties of the selected object. You 
can also click the More Properties button to display the Property Inspector, 
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which provides access to all object properties. Display the Property Editor 
using the propertyeditor command.

Plotting Tools
This picture shows the plotting tools attached to a figure that contains two 
subplots. 
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Plot BrowserFigure Palette Axes subplots Figure

Click to add data to axes Click to display Property Inspector

Lineseries selected

Property Editor displaying lineseries properties
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The Figure Palette
The Figure Palette contains three panels. Select the panel you want to view by 
clicking the respective button, which twists down the panel and exposes its 
contents. 

The Figure Palette enables you to perform the following tasks with these 
panels:

• New Subplots — Add 2-D or 3-D axes to the figure. 

• Variables — Browse and plot workspace variables.

• Annotations — Add annotations to graphs.

Adding Subplot Axes
The New Subplots panel enables you to create a grid of either 2-D or 3-D axes. 
To display the selector, click the grid icon next to the axes type. MATLAB 
displays the selector grid. 

As you move the cursor, squares darken to indicate the layout of axes that will 
be created if you release the mouse button. Click Cancel at the bottom of the 
grid to leave the figure unchanged.
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The picture above shows the New Subplots panel selected to display four 
equally sized axes in the figure. Existing axes resize as required to 
accommodate the new layout.

Plotting Workspace Variables
The Variables panel displays current workspace variables. Double-clicking a 
variable in this panel opens that variable in the Array Editor. If you select a 
variable and right-click to display the context menu, you can select a graphics 
function to plot the variable.

For example, the following picture illustrates how to plot the columns of 
variable Z. This is equivalent to passing a matrix to the plot function.

The context menu contains a list of possible plot types based on the variable 
you select and also enables you to perform certain operation on the variable, 
such as opening it in the Array Editor, saving, copying, and so on. 

Note that the context menu items may change when you select different 
variables because a particular variable might be incompatible some of the plot 
types.



Plotting Tools — Interactive Plotting

1-9

Drag and Drop Plotting
You can also drag the variable directly into an axes, in which case MATLAB 
selects the first appropriate plot type for that variable. If there are multiple 
axes, you must first select the one you want to plot in and then drag the 
variable to that axes. 

In the previous example, the variable Z would be plotted using the plot 
function if you were to drag it into an axes.

If the desired plotting function is not available from the context menu, you can 
select More Plots to display the Plot Catalog tool.

The Plot Catalog Tool
The Plot Catalog tool provides access to most of the MATLAB plotting 
functions. You can type any workspace variables in the Plotted Variables 
field, which are then passed to the selected plotting function as arguments. 
Separate variables with a comma. 

You can also enter a MATLAB expression using any workspace variables 
shown in the Figure Palette.

The following picture shows the Plot Catalog tool and describes its components.
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Comma-separated list of variables or expressions is passed to 
selected function.

Select a category of plotting 
functions.

Select a plotting function from the 
category. 

Plot in the current figure or a new 
figure.

Help provides information on function arguments 
and links to more information.
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Adding Annotations to Graphs
The Annotations panel enables you to insert annotation objects into a plot. To 
add an object, first select the object you want to add, and then click and drag 
the mouse to position and size the object. 

See “How to Annotate Graphs” on page 3-2 for more information about the 
various types of annotation objects.

The Plot Browser
The Plot Browser provides a legend of all the graphs in the figure. It lists each 
axes and the objects (lines, surfaces, etc.) used to create the graph. 

For example, suppose you plot an 11-by-11 matrix z. The plot function creates 
one line for each column in z. 

plot(z,'DisplayName','z')

When you set the DisplayName property, the Plot Browser indicates which line 
corresponds to which column.
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If you want to set the properties of an individual line, double-click on the line 
in the Plot Browser. Its properties are displayed in the Property Editor, which 
opens on the bottom of the figure. 

You can select a line in the graph, and the corresponding entry in the Plot 
Browser is highlighted, enabling you to see which column in the variable 
produced the line. 

Controlling Object Visibility
The check box next to each item in the Plot Browser controls the object’s 
visibility. For example, suppose you want to plot only certain columns of data 
in z, perhaps the positive values. You can uncheck the columns you do not want 
to display. The graph updates as you uncheck each box and rescales the axes 
as required.
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Deleting Objects
You can delete any selected item in the Plot Browser by selecting Delete from 
the right-click context menu.

Adding Data to Axes
The Plot Browser provides the mechanism by which you add data to axes. The 
procedure is as follows:

1 Select a 2-D or 3-D axes from the New Subplots subpanel.

2 After creating the axes, select it in the Plot Browser panel to enable the Add 
Data button at the bottom of the panel.

3 Click the Add Data button to display the Add Data to Axes dialog.
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The Add Data to Axes dialog enables you to select a plot type and specify the 
workspace variables to pass to the plotting function. You can also specify a 
MATLAB expression, which is evaluated to produce the data to plot.

Selecting Workspace Variables to Create a Graph. Suppose you want to create a 
surface graph from three workspace variables defining the XData, YData, and 
ZData (see the surf function for more information on this type of graph).

In the workspace you have defined three variables, x, y, and z. To create the 
graph, configure the Add Data to Axes dialog as shown in the following picture.

Using a MATLAB Expression to Create a Graph. The following picture shows the Add 
Data to Axes dialog specifying a workspace variable x for the plot’s x data and 
a MATLAB expression (x.^2 + 3*x + 5) for the y data.
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You can use the default X Data value of index if you do not want to specify x 
data. In this case, MATLAB plots the y data vs. the index of the y data value, 
which is equivalent to calling the plot command with only one argument.

The Property Editor
The Property Editor enables you to access a subset of the selected object’s 
properties. When no object is selected, the Property Editor displays the figure’s 
properties.

Ways to Display the Property Editor
There are a variety of ways to display the Property Editor: 

• Double-click an object when plot edit mode is enabled.

• Select an object and right-click to display its context menu, then select 
Properties.

• Select Property Editor from the View menu.

• Use the propertyeditor command.

Changing Plot Types 
You can use the property editor to change the type of plot used to display data. 
For example, you can change the following line graph to a stem, stairs, area, or 
bar graph by changing the Plot Type field.



1 MATLAB Plotting Tools

1-16

Accessing All Object Properties — Property 
Inspector
The Property Editor enables you to change the most commonly used object 
properties. If you want to access all object properties, use the Property 
Inspector. To display the Property Inspector, click the More Properties button 
on any Property Editor panel. The following picture shows the Property 
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Inspector displaying the properties of the same lineseries object as that in the 
previous picture.

For descriptions of the properties of graphics objects, use the Graphics 
Property Browser.

Accessing Objects You Cannot Click
If you want to access the properties of light or uicontextmenus objects, you need 
to get the handle using MATLAB commands, because you cannot click on these 
objects.

For example, to get the handles of all light objects in the current axes, use 
findobj.

h = findobj(gca,'Type','light');

Then use the inspect command to display the Property Inspector.
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inspect(h) % Inspect all light objects
inspect(h(1)) % Inspect the first light object in list
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Example — Working with Plotting Tools
This example illustrates how to use the plotting tools to graph a workspace 
variable vs. an expression typed into the Add Data to Axes dialog. 

Create a variable in the workspace,

x = -2*pi:pi/25:2*pi;

Use the plottools command to create a figure with the plotting tools attached.

plottools

Click 2D Axes in the New Subplot panel of the Figure Palette.

Once the axes appears, the Add Data button on the Plot Browser is activated. 
Click this button to display the Add Data to Axes dialog.

When the Add Data to Axes dialog is displayed, enter the following values:

• Select plot as the Plot Type.

• Set X Data Source to x.

• Set Y Data Source to sin(x).^2.

• Click OK to plot this data.
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MATLAB draws a plot of sin(x).^2 vs. x.

Now add another plot to the same axes. Click Add Data again and specify the 
data to plot:

• Set X Data Source to x.

• Set Y Data Source set to sin(x).^8.

• Click OK to plot this data.

Select the last plot (the green line) and set the Plot Type in the Property Editor 
to Stem. The plot should now look like the following picture.
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Adding a Subplot
Add a second axes below the current axes using the New Subplots panel. Click 
the right-facing arrowhead next to 2D Axes and move the mouse to darken two 
squares, one on top of the other. This creates a subplot axes below the existing 
axes. MATLAB resizes the existing axes so both fit in the figure.
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Once MATLAB inserts the new axes, select its entry in the Plot Browser and 
then click Add Data.

When the Add Data to Axes dialog is displayed, enter the following values:

• Set X Data Source to x.

• Set Y Data Source to sin(x).^3.

• Click OK to plot this data.

Now add another plot overlaid on the first by clicking Add Data again and 
specify the data to plot:

• Set X Data Source to x.

• Set Y Data Source to sin(x).^9.

• Click OK to plot this data.

Select the plot labeled sin(x).^9 under the second axes in the Plot Browser. 
Set the Plot Type in the Property Editor to Area. 

Setting Axis Limits
Adjust the x-axis in both axes using the Property Editor.

• Select the first axes in the Plot Browser.

• Change X Limits to -7 and 7.

Repeat these steps for the second axes.
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Adding Titles and Labels
Select the first axes in the Plot Browser and set the following properties in the 
Property Editor:

• Set Title to Even Powers.

• Set X Label to X. 

• Click the Y Axis tab and set Y Label to Sine of X.

Select the second axes in the Plot Browser and set the following properties in 
the properties panel:

• Set Title to Odd Powers.

• Set Axis label to Sine of X.

• On the Y Axis tab, set Axis label to Sine of X.

Note that the Plot Browser reflects the new axes names. 

The following picture shows the result of these steps.
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Select the text of the y-axis label on the first axes (now labeled Even Powers 
in the Plot Browser) and click the More Properties button on the Property 
Editor. Set the Rotation property to 0 and reposition the text by hand.

To make more space for the y-axis label, which is now in a horizontal position, 
select the axes and move it to the right with the mouse. 

Repeat this process for the second axes (labeled Odd Powers in the Plot 
Browser).
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The repositioned text label now looks like the following picture.

Note  You can always undo your last change to the graph by selecting Undo 
from the Edit menu.
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Example — Plotting Workspace Variables
This example shows how to use the Figure Palette to select variables to plot. 
Suppose you have three variables in your workspace (x, y, z) created by the 
following statements: 

[x,y] = meshgrid([-2:.2:2]);
z = x.*exp(-x.^2-y.^2);

You decide to visualize this data as a surface/contour plot (as produced by the 
surfc function).

The first step is to display a figure with the Figure Palette tool attached. You 
can do this with the figurepalette command.

figurepalette

Expand the Variables panel and shift-click (for multiple selection) on the 
three variables you want to pass the plotting function. Since surfc is not in the 
list, select More Plots.

From the Plot Catalog tool, select the 3D Surfaces in the Categories column 
and surfc as the Plot Type, as shown in the following picture. To create the 
plot, click the Plot button.
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MATLAB creates the following graph.
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Plotting Expressions
You can enter MATLAB expressions in the Plot Catalog tool, as well as 
variables. For example, suppose you have created the following variables in the 
workspace.

t = 0:.01:20;
alpha =.055;

and you want to plot t vs. this expression:

exp(-alpha*t).*sin(.5*t)

The first step is to display a figure with the Figure Palette tool attached. You 
can do this with the figurepalette command.

figurepalette

First select the variable t and right-click to display the context menu. Select 
More Plots.
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When the Plot Catalog tool is displayed, add the expression to the Plotted 
Variables text field. Note that you can reference the variable alpha because 
you created it in the base workspace. See MATLAB Workspace for information 
about variables in the MATLAB workspace.
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Click the Plot button to create the graph. Note that the previous step is the 
equivalent of issuing the following command: 

plot(t,exp(-alpha*t).*sin(.5*t))
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Example — Specifying a Data Source
Plot objects have properties that enable you to specify the source of the data 
that defines the object. For example, you can specify a workspace variable 
name or a MATLAB expression as the value of the XDataSource, YDataSource, 
or ZDataSource property for a line in a plot (i.e., a lineseries object). You can 
then use the Property Editor to change the variable name or alter the 
expression, and the plot is updated to reflect the change.

Creating the Graph
First define two variables by issuing these statements in the command 
window. 

t = 0:.01:20;
alpha =.055;

Next plot t vs. the expression exp(-alpha*t).*sin(.5*t) using the plot 
function or the plot tools.

plot(t,exp(-alpha*t).*sin(.5*t))

Varying the Data Source
After creating the graph, you can use the Property Editor to couple the plotted 
line to the MATLAB expression. 

1 Double-click on the plotted line to display its property panel. 

2 Enter the MATLAB expression exp(-alpha*t).*cos(.5*t) in the Y Data 
Source text field.
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You can now modify the expression in the Y Data Source text field and observe 
how the graph changes. After changing the text, click the Refresh Data button 
to update the data.

Enter the expression in the Y Data Source text field.
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In the following picture, alpha is no longer negated, so the function grows 
instead of decays. Also the period has been shortened by changing sin(.5*t) 
to sin(1.5*t).

Data Sources for Multiobject Graphs
Suppose you create a line graph from matrix data. For example,
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z = peaks;
h = plot(z,'YDataSource','z');

Because MATLAB creates one lineseries object for each column of z, the 
following is true.

The data source for h(1) is z(:,1). 

The data source for h(2) is z(:,2). 

...

The data source for h(n) is z(:,n).
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Example — Generating M-Code to Reproduce a Graph
Suppose you have created the following graph.

t = 0:.2:20;
alpha =.055;
stem(t,exp(-alpha*t).*sin(5*t))

You then use the Property Editor to modify the graph to look like the following 
picture.

You can generate code to reproduce this graph by selecting Generate M-File 
from the Figure menu. MATLAB creates a function that recreates the graph 
and opens the generated M-File in the editor.

This feature is particularly useful for capturing property settings and other 
modifications made using the plot tools GUI. 
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Data Arguments
You must supply the data arguments t and exp(-alpha*t).*sin(5*t) to the 
function. Generated functions do not store the data necessary to recreate the 
graph.

Limitations
Attempting to generate code for graphs containing a large number of graphics 
objects (e.g., greater than 20 plotted lines) might be impractical.
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Editing Plots
MATLAB formats a graph to provide readability, setting the scale of axes, 
including tick marks on the axes, and using color and line style to distinguish 
the plots in the graph. However, if you are creating presentation graphics, you 
might want to change this default formatting or add descriptive labels, titles, 
legends, and other annotations to help explain your data.

MATLAB supports two ways to edit the plots you create:

• Using the mouse to select and edit objects interactively

• Using MATLAB functions at the command line or in an M-file

Interactive Plot Editing
If you enable plot editing mode in the MATLAB figure window, you can perform 
point-and-click editing of your graph. In this mode, you can modify the 
appearance of a graphics object by double-clicking on the object and changing 
the values of its properties. You access the properties through a graphical user 
interface called the Property Editor. 

For more information about interactive editing, see “Using Plot Edit Mode” on 
page 1-38. 

For information about editing object properties in plot editing mode, see “The 
Property Editor” on page 1-15. 

Using Functions to Edit Graphs
If you prefer to work from the MATLAB command line or if you are creating an 
M-file, you can use MATLAB commands to edit the graphs you create. Taking 
advantage of the MATLAB Handle Graphics® system, you can use the set and 
get commands to change the properties of the objects in a graph. 

Note  Plot editing mode provides an alternative way to access the properties 
of MATLAB graphic objects. However, you can only access a subset of object 
properties through this mechanism. You might need to use a combination of 
interactive editing and command-line editing to achieve the effect you desire.
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Using Plot Edit Mode

The MATLAB figure window supports a point-and-click editing mode that you 
can use to customize the appearance of your graph. This section describes how 
to start plot edit mode and perform basic editing tasks, including

• “Selecting Objects in a Graph” on page 1-39

• “Cutting, Copying, and Pasting Plot Objects” on page 1-40

• “Moving and Resizing Objects” on page 1-44

• “Setting Object Properties” on page 1-44

• “Saving Your Work” on page 1-46 

To start plot edit mode, click this button.

Use these toolbar buttons to add a legend, text, and 
arrows.

Use the Edit, Insert, and Tools menus to add 
objects or edit existing objects in a graph.

Access object-specific plot edit functions 
through context-sensitive pop-up menus. 

Position labels, legends, and other objects by 
clicking and dragging.

Double-click on an object to select it. 
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Starting Plot Edit Mode
Before you can select objects in a figure by clicking on them, you must activate 
plot editing mode. There are several ways to activate plot edit mode:

• Choose the Edit Plot option on the figure window Tools menu.

• Click the selection button in the figure window toolbar. 

• Choose an option from the Edit or Insert menu. For example, if you choose 
the Axes Properties option on the Edit menu, MATLAB activates plot edit 
mode and the axes appear selected.

• Run the plotedit command in the MATLAB Command Window.

• Start the plotting tools with the plottools command.

When a figure window is in plot edit mode, the Edit Plot option on the Tools 
menu is checked and the selection button in the toolbar is depressed. 

Exiting Plot Edit Mode
To exit plot edit mode, click the selection button or click the Edit Plot option 
on the Tools menu. When plot edit mode is turned off, the selection button is 
no longer depressed.

Selecting Objects in a Graph
To select an object in a graph,

1 Start plot edit mode.

2 Move the cursor over the object and click it. 

Selection handles appear on the selected object. 

Selecting Multiple Objects
To select multiple objects at the same time,

Click this button to start plot edit mode.
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1 Start plot edit mode.

2 Move the cursor over an object and shift+click to select it. Repeat for each 
object you want to select. 

You can perform actions on all the selected objects. For example, to remove a 
textbox annotation and an arrow annotation from a graph, select the objects 
and then select Delete or Cut from the Edit menu (Cut keeps a copy on the 
clipboard, Delete does not). 

Deselecting Objects
To deselect an object, move the cursor off the object onto the figure window 
background and click the left mouse button (this deselects all selected objects 
and selects the one you clicked). You can also shift+click on a selected object 
to deselect it (doing this will not deselect any other object).

Cutting, Copying, and Pasting Plot Objects
To cut an object from a graph, or copy and paste an object in a graph, perform 
these steps:

1 Start plot edit mode.

2 Select the object.

3 Select the Cut, Copy, or Paste option from the Edit menu or use standard 
shortcut keys for your platform.

Alternatively, with plot edit mode enabled, you can right-click on an object and 
then select an editing command from the context menu associated with the 
object. 

Copying and Pasting Multiple Objects
When you cut or copy axes and plot objects such as lineseries or barseries from 
a figure and paste them there or elsewhere, the results depend on what you 
select and the type of container into which you paste the objects. 
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Copy and Paste Axes. The following semantics apply to copying and pasting axes 
into the same or different figure:

Note  When an axis is pasted into an existing axes, the pasted axes becomes a 
peer of the existing axes and is offset slightly to visually indicate that the 
paste operation was successful.

Select, Copy, and Paste Axes Result of Pasting Axes

Select axes Ax1 from figure Fig1, 
copy and paste it into Fig2, which 
has no axes

New axes Ax2 is created in Fig2. Ax2 
inherits all properties of Ax1, 
including all children. Ax1 will be 
selected in Fig1; Ax2 will be selected 
in Fig2

Select axes Ax1 from figure Fig1, 
copy and paste (from Edit Menu) 
into Fig2, that contains axis Ax2 
which is not selected

New axes Ax3 is created in Fig2. All 
children of Ax1 are copied to Ax3. All 
the selected objects in Fig2 are 
deselected, and the pasted axes Ax3 
is selected. The selections in Fig1 are 
unchanged.

Select axes Ax1 from figure Fig1, 
copy and paste into Ax2 in the 
same or different figure

New axis Ax3 is created having the 
same properties (including position) 
and children as Ax1; any selected 
objects in Ax2 are deselected, and 
axes Ax3 is selected. When pasting 
to a new figure, selections in Fig1 
will be unchanged

Select axes Ax1 from figure Fig1, 
copy and paste into same or 
different axes in Fig1

New axes Ax2 is added to Fig1, 
offset from Ax1, and is the only 
selected object
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Copy and Paste Plot Objects. The following semantics apply to copying and pasting 
plot objects (lines are used as examples) from one axes into the same or 
different figure:

Copy and Paste Plot Objects from Multiple Axes. The following semantics apply to 
copying and pasting plot objects (lines are used as examples) from one or more 
axes into the same or different figure:

Select, Copy, and Paste Objects Result of Pasting Objects

Select and copy one or more lines 
from axes Ax1 and paste into 
selected axes Ax2 in the same or 
different figure

The lines are added to Ax2; the 
pasted lines are the only selected 
objects in the destination figure

Select and copy lines from axes Ax1 
in Fig1 and paste into figure Fig2, 
which contains no axes or has no 
axes selected

New axes Ax2 is created in Fig2 
containing the lines, which are 
selected in it; Ax2 has default axes 
properties

Select and copy lines from axes 
Ax1 and paste into selected axes 
Ax2 and Ax3

Lines are pasted into both Ax2 and 
Ax3; all the pasted lines are selected

Select and copy lines from axes 
Ax1 and paste into selected axes 
Ax1

Nothing is pasted, as the extra 
content would be redundant

Select, Copy, and Paste Objects Result of Pasting Objects

Select and copy Line1 from axes 
Ax1 and Line2 from axes Ax2 and 
paste into axes Ax3

Two lines are pasted into axes Ax3 
and are the only selected objects 
there
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Copy and Paste Multiple Axes and Plot Objects. The following semantics apply to 
copying and pasting several axes and selected plot objects (lines are used as 
examples) from one or more axes into the same or different figure:

Select and copy lines from axes Ax1 
and axes Ax2 and paste into figure 
Fig2, which contains no axes or has 
no axes selected

New axes Ax3 is created in Fig2, into 
which all the lines are pasted; Ax3 
has default axes properties

Select and copy multiple lines from 
Axes Ax1 and axes Ax2 and paste 
into Ax1, Ax2, or some other axes

Only those lines that did not 
originate in an axes are pasted into 
it, and the pasted lines are the only 
selected objects

Select, Copy, and Paste Objects Result of Pasting Objects

Select Line1 from axes Ax1, select 
axes Ax2, and paste into into figure 
Fig2, which contains no axes or has 
no axes selected

Ax2 and its contents is pasted as new 
axes Ax3; another new axis Ax4 is 
created into which the line is pasted

Select Line1 from axes Ax1, select 
axes Ax2, and paste into into axes 
Ax3

Line1 is into axes Ax3 and axes Ax2 
is pasted as new axis Ax4

Select axes Ax1 and Line1 from 
Ax1, and paste into Ax1

New axes Ax2 is created having all 
the properties of Ax1 but containing 
Line1 as its only child

Select axes Ax1 and Line1 from 
Ax1 in Fig1 and paste into figure 
Fig2, which contains no axes or has 
no axes selected

Line1 is pasted in new axes Ax2, 
and Ax1 and its children (including 
Line1) is pasted as new axis Ax3

Select axes Ax1 and Line1 from 
Ax1, and paste into axes Ax2

Line1 is pasted into Ax2, and Ax1 
and its child Line1 only is pasted as 
new axes Ax3

Select, Copy, and Paste Objects Result of Pasting Objects
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Copying and Pasting Annotation Objects
In plot edit mode you can copy and paste annotations such as textboxes, 
textarrows, rectangles, and ellipses, in various combinations. If any such 
objects happen to be pinned to their axes (see “Pinning — Attaching to a Point 
in the Graph” on page 3-19), their copies are pasted unpinned. As annotation 
objects are children of figures, they never create new axes when you paste 
them.

Moving and Resizing Objects
To move or resize an object in a graph, perform these steps:

1 Start plot edit mode.

2 For axes objects only: unlock the axes by right-clicking on an empty region 
and choosing Unlock Axes Position from the context menu.

3 Select the object. Selection handles appear on the object.

To move the object, drag it to the new location.

To resize the object, drag a selection handle.

Note  You can move text objects, but you cannot resize them. 

Setting Object Properties
In MATLAB, every object in a graph supports a set of properties that control 
the graph’s appearance and behavior. For example, line objects have properties 
that control thickness, color, and line style. 

Double-clicking on an object displays the Property Editor. To edit the 
properties of the axes or figure, double-click on a region that does not contain 
other objects.

See “The Property Editor” on page 1-15 for more information.
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Undo/Redo — Eliminating Mistakes
The figure Edit menu contains two items that enable you to undo recent 
operation.

Undo — Remove the effect of the last operation.

Redo — Perform again the last operation that you removed by selecting Undo.

For example, if you create a plot, zoom in, pan the view, and then undo the pan 
operation, the menu looks as follows:

You could now undo the previous zoom operation or redo the pan operation you 
just undid.
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Saving Your Work
After editing a graph, you can

• Save your work in a format that can be opened during another MATLAB 
session

• Save your work in a format that can be used by other applications

Saving a Graph in MAT-File Format

Note  To save a figure in a format that is compatible with MATLAB versions 
before MATLAB 7, refer to “Plot Objects and Backward Compatibility” on 
page 8-20 for more information.

MATLAB supports a binary format in which you can save figures so that they 
can be opened in subsequent MATLAB sessions. MATLAB assigns these files 
the .fig filename extension. 

To save a graph in a figure file,

1 Select Save from the figure window File menu or click the Save button on 
the toolbar. If this is the first time you are saving the file, the Save As dialog 
box appears. 

2 Make sure that the Save as type is Fig-File.

3 Specify the name you want assigned to the figure file.

4 Click OK.

The graph is saved as a figure file (.fig), which is a binary file format used to 
store figures.

You can also use the saveas command.

Use the hgsave command to create backward compatible Fig-Files.

If you want to save the figure in a format that can be used by another 
application, see “Saving to a Different Format — Exporting Figures” on 
page 1-47.
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Opening a Figure File
To open a figure file, perform these steps: 

1 Select Open from the File menu or click the Open button on the toolbar.

2 Select the figure file you want to open and click OK.

The figure file appears in a new figure window.

You can also use the open command.

Saving to a Different Format — Exporting Figures
To save a figure in a format that can be used by another application, such as 
the standard graphics file formats TIFF or EPS, perform these steps:

1 Select Export Setup from the File menu. This dialog provides options you 
can specify for the output file, such as the figure size, fonts, line size and 
style, and output format. 

2 Select Export from the Export Setup dialog. A standard Save As dialog 
appears.

3 Select the format from the list of formats in the Save as type drop-down 
menu. This selects the format of the exported file and adds the standard 
filename extension given to files of that type.

4 Enter the name you want to give the file, less the extension.

5 Click Save.

Copying a Figure to the Clipboard
On Windows systems, you can also copy a figure to the clipboard and then paste 
it into another application:

1 Select Copy Options from the Edit menu. The Copying Options page of the 
Preferences dialog box appears.

2 Complete the fields on the Copying Options page and click OK.
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3 Select Copy Figure from the Edit menu.

The figure is copied to the Windows clipboard. You can then paste the figure 
from the Windows clipboard into a file in another application.

Printing Figures
Before printing a figure,

1 Select Page Setup from the File menu to set printing options.

The Page Setup dialog box opens.

2 Make changes in the dialog box. If you want the printed output to match the 
annotated plot you see on the screen exactly,

a On the Size and Position tab, click Use screen size, centered on page.

b On the Axes and Figure tab, click Keep screen limits and ticks.

For information about other options for page setup, click the Help button in 
the dialog box.

To print a figure, select Print from the figure window File menu and complete 
the Print dialog box that appears. 

You can also use the print command.

Generating an M-File to Recreate a Graph 
You can generate an M-file from a graph, which you can then use to regenerate 
the graph. This approach is a useful way to generate M-code for work you have 
performed with the plotting tools. To use this option,

1 Select Generate M-file from the File menu.

MATLAB displays the generated code in the MATLAB Editor.

2 Save the M-file using Save As from the Editor File menu.

Running the Saved M-File
Most of the generated M-files require you to pass in data as arguments. The 
M-file assumes you are using the same data originally used to create the graph. 
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Comments at the beginning of the M-file state the type of data expected. For 
example, the following statements illustrate a case where three input vectors 
are required. 

function createplot(X1, Y1, Y2)
%CREATEPLOT(X1,Y1,Y2)
%  X1:  vector of x data
%  Y1:  vector of y data
%  Y2:  vector of y data

See “Example — Generating M-Code to Reproduce a Graph” on page 1-35 for 
another example.
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Data Exploration Tools

Ways to Explore Graphical Data 
(p. 2-2)

Overview of tools for exploring graph data

Data Cursor — Displaying Data Values 
Interactively (p. 2-3)

Data cursors enable you to read data directly off a graph, 
save it in the workspace, and label data points

Zooming in 2-D and 3-D (p. 2-11) Behavior of zoom tools in 2- and 3-D

Panning — Moving Your View of the 
Graph (p. 2-14)

Tool that grabs the graph with the mouse and moves it 
within the axes

Rotate 3D — Interactive Rotation of 
3-D Views (p. 2-15)

Move the viewpoint around 3-D objects
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Ways to Explore Graphical Data
After determining what type of graph best represents your data, you can 
further enhance the visual display of information using the tools discussed in 
this section. These tools enable you to explore data interactively, eliminating 
the need to set the plethora of graphics properties required to achieve the same 
results using MATLAB commands.

Once you have achieved the desired results, you can then generate the 
MATLAB code necessary to reproduce the graph you created interactively. See 
“Example — Generating M-Code to Reproduce a Graph” on page 1-35 for more 
information.

Types of Tools
See the following sections for information on specific tools.

• “Data Cursor — Displaying Data Values Interactively” on page 2-3 

• “Zooming in 2-D and 3-D” on page 2-11

• “Panning — Moving Your View of the Graph” on page 2-14

• “Rotate 3D — Interactive Rotation of 3-D Views” on page 2-15

• Camera Toolbar — Interacting with 3-D Views

You can perform data analysis directly on graphs with curve fitting and time 
series tools; see

• Data Fitting Using Linear Regression

• The Basic Fitting Tool

• The Time Series Tools

These and other topics are covered in the Data Analysis section of the MATLAB 
documentation. You can also use cftool if you have the Curve Fitting Toolbox.
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Data Cursor — Displaying Data Values Interactively
Topics in this section:

• “Enabling Data Cursor Mode” on page 2-3

• “Selection Style — Select Data Points or Interpolate Points on Graph” on 
page 2-8

• “Display Style — Datatip or Cursor Window” on page 2-7

• “Exporting Data Value to Workspace Variable” on page 2-9

Data cursors enable you to read data directly from a graph by displaying the 
values of points you select on plotted lines, surfaces, images, and so on. 

When data cursor mode is enabled, you can

• Click on any graphics object defined by data values and display the x, y, and 
z (if 3-D) values of the nearest data point.

• Interpolate the values of points between data points.

• Display multiple data tips on graphs.

• Display the data values in a cursor window that you can locate anywhere in 
the figure window or as a data tip (small text box) located next to the data 
point.

• Export data values as workspace variables.

• Print or export the graph with data tip or cursor window displayed for 
annotation purposes.

Enabling Data Cursor Mode
Select the data cursor icon in the figure toolbar  or select the Data Cursor 
item in the Tools menu.

Once data cursor mode is enabled, clicking the mouse on a line or other graph 
object returns the data value of the point clicked. For example, in the following 
picture, the black square is the point selected and the values are displayed in 
the data tip next to the point.
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Moving the Marker
You can move the marker using the arrow keys and the mouse. The up and 
right arrows move the marker to data points having greater index values in the 
data arrays. The down and left arrow keys move the marker to data points 
having lesser index values. 

Positioning the Datatip Text Box
You can position the data tip text box in any one of four positions with respect 
to the data point: upper right (the default), upper left, lower left, and lower 
right.

To position the datatip, press, but do not release the mouse button while over 
the datatip text box and drag it to one of the four positions. 

You can move a datatip using the arrow keys as well as the mouse. 
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Dragging the Datatip to Different Locations
You can drag the datatip to different locations on the graph object by clicking 
down on the datatip and dragging the mouse. You can also use the arrow keys 
to move the datatip. 

Datatips on Image Objects 
Datatips on images display the x- and y-coordinates as well as the RGB values. 

Datatips on 3-D Objects
You can use datatips to read data points on 3-D graphs as well. In 3-D views, 
data tips display the x-, y- and z-coordinates. 

Click on the square and drag the data tip along 
the blue line.
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Creating Multiple Data Tips 
Normally, there is only one datatip displayed at one time. However, you can 
display multiple datatips simultaneously on a graph. This is a simple way to 
annotate a number of points on a graph. 

Use the following procedure to create multiple datatips. 

1 Enable data cursor mode from the figure toolbar. The cursor changes to a 
cross. 

2 Click on the graph to insert a datatip. 

3 Right-click to display the context menu. Select Create New Datatip. 
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4 Click on the graph to place the second datatip. 

Customizing Data Cursor Text 
You can customize the text displayed by the data cursor using the 
datacursormode function. See the Examples section of the datacursormode 
reference page for more information.

Deleting Datatips 
You can remove the most recently added datatip or all datatips. When in data 
cursor mode, right-click to display the context menu.

• Select Delete Current Datatip to delete the last datatip that you added.

• Select Delete All Datatips to delete all datatips. 

Display Style — Datatip or Cursor Window 
By default, the data cursor displays values as a datatip (small text box located 
next to the data point). You can also display the data values in a cursor window. 
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You can place multiple datatips on a graph, which makes this display style 
useful for annotations.

To use the cursor window, change the display style as follows:

1 While in data cursor mode, right-click to display the context menu. 

2 Mouse over the Display Style item.

3 Select Window Inside Figure.

Selection Style — Select Data Points or Interpolate 
Points on Graph
By default, the data cursor displays the values of the data point nearest to the 
point you click with the mouse, and the data marker snaps to this point. The 
data cursor can also determine the values of points that lie in between the data 
defining the graph, by linearly interpolating between the two data points 
closest to the location you click the mouse.

Enabling Interpolation Mode
If you want to be able to select any point along a graph and display its value, 
use the following procedure:

1 While in data cursor mode, right-click to display the context menu.

2 Mouse over the Selection Style item.
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3 Select Mouse Position.

Note that interpolation mode does not work when you are using the arrow keys.

Exporting Data Value to Workspace Variable
You can export the values displayed with the data cursor to MATLAB 
workspace variables. To do this, display the right-click context menu while in 
data cursor mode and select Export Cursor Data to Workspace.

MATLAB then displays a dialog that enables you to name the workspace 
variable.
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When you click OK, MATLAB creates a structure with the specified name in 
your base workspace, containing the following fields:

• Target — Handle of the graphics object containing the data point

• Position — x- and y- (and z-) coordinates of the data cursor location in axes 
data units

Line and lineseries objects have an additional field:

• DataIndex — A scalar index into the data arrays that correspond to the 
nearest data point. The value is the same for each array.

For example, if you saved the workspace variable as cursor_info, then you 
would access the position data by referencing the Position field.

cursor_info.Position
ans =
    0.4189 0.1746 0
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Zooming in 2-D and 3-D
Zooming changes your view of a graph. Zooming is useful to see greater detail 
in a smaller area. Zoom behaves differently depending on whether it is applied 
to a 2-D or 3-D view. 

Enable zooming by clicking one of the zoom icons . Select + to zoom in 
and – to zoom out. 

Note, when in zoom in mode, you can use Alt-Click to zoom out (i.e., press and 
hold down the Alt key while clicking the mouse).

Zooming in 2-D Views
In 2-D views, click the area of the axes where you want to zoom in, or drag the 
cursor to draw a box around the area you want to zoom in on. MATLAB 
redraws the axes, changing the limits to display the specified area. 

For example, selecting the region of the following plot,

results in a rescaling of the axes to display only that region.

Select area to 
zoom in on
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Undoing Zoom Actions
If you want to reset the graph to its original view, right-click to display the 
context menu and select Reset to Original View. You can also use the Undo 
item on the Edit menu to undo each operation you performed on your graph.

Zoom Constrained to Horizontal or Vertical
In 2-D views, you can constrain zoom to operate in either the horizontal or 
vertical direction. To do this, right-click to display the context menu while in 
zoom mode and select the desired zoom option. 
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Zooming in 3-D Views
In 3-D views, moving the cursor up or to the right zooms in, while moving the 
cursor down or to the left zooms out. Both toolbar icons enable the same 
behavior. 3-D zooming does not change the axes limits, as in 2-D zooming. 
Instead it changes the view (specifically, the axes CameraViewAngle property) 
as if you were looking through a camera with a zoom lens. 
‘
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Panning — Moving Your View of the Graph
You can move your view of a graph up and down as well as left and right with 
the pan tool. Panning is useful when you have zoomed in on a graph and want 
to translate the plot to view different portions.

Click this icon on the figure toolbar to enable panning .

2-D vs. 3-D Panning
2-D panning has the effect of changing the axis limits that you are viewing, but 
it does not change the actual limits of the plot. For example, suppose you have 
a time-series waveform that you want to zoom in on to view detail, but you also 
want to be able to scan the entire plot. 

3-D panning moves the axes with the object, because the 3-D view is not aligned 
to the x-, y-, or z-axis. The axes limits do not change as in 2-D panning. 
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Rotate 3D — Interactive Rotation of 3-D Views
MATLAB enables you to rotate graphs to any orientation with the mouse. 
Rotation involves the reorientation of the axes and all the graphics objects it 
contains. Therefore none of the data defining the graphics objects is affected by 
rotation; instead the orientation of the x-, y-, and z-axes changes with respect 
to the viewer.

Enabling Rotate 3D
There are three ways to enable Rotate 3D mode:

• Select Rotate 3D from the Tools menu.

• Click the Rotate 3D icon in the figure toolbar .

• Execute the rotate3d command.

Once the mode is enabled, you press and hold the mouse button while moving 
the cursor to rotate the graph.

Selecting Predefined Views
When Rotate 3D mode is enabled, you can control various rotation options from 
the right-click context menu.

You can rotate to predefined views on the right-click context menu:

• Reset to Original View — Reset to the default MATLAB view (azimuth 
-37.5°, elevation 30°).

• Go to X-Y View — View graph along the z-axis (azimuth 0°, elevation 90°).

• Go to X-Z View — View graph along the y-axis (azimuth 0°, elevation 0°).

• Go to Y-Z View — View graph along the x-axis (azimuth 90°, elevation 0°).

Rotation Style for Complex Graphs
You can select from two rotation styles on the right-click context menu’s 
Rotation Options submenu:

• Plot Box Rotate — Display only the axes bounding box for faster rotation of 
complex objects. Use this option if the default Continuous Rotate style is 
unacceptably slow.
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• Continuous Rotate — Display all graphics during rotation.

Axes Behavior During Rotation
You can select two types of behavior with respect to the aspect ratio of axes 
during rotation:

• Stretch-to-Fill Axes – Default axes behavior is optimized for 2-D plots. 
Graphs fit the rectangular shape of the figure.

• Fixed Aspect Ratio Axes – Maintains a fixed shape of objects in the axes as 
they are rotated. Use this setting when rotating 3-D plots.

The following pictures illustrate a sphere as it is rotated with Stretch-to-Fill 
Axes selected. Note that the sphere is not round.

The next picture shows how the Fixed Aspect Ratio Axes option results in a 
sphere that maintains its proper shape as it is rotated.
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Undo/Redo — Eliminating Mistakes
The figure Edit menu contains two items that enable you to undo any zoom, 
pan, or rotate operation.

Undo — Remove the effect of the last operation.

Redo — Perform again the last operation that you removed by selecting Undo.

For example, if you create a plot, zoom in, pan the view, and then undo the pan 
operation, the menu looks as follows:

You could now undo the previous zoom operation or redo the pan operation you 
just undid.
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Annotating Graphs
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Adding Titles to Graphs (p. 3-29) Illustrates the procedure for adding a title to a graph

Adding Axis Labels to Graphs (p. 3-32) Illustrates the procedure for adding axis labels to a 
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legends from graphs

Adding Text Annotations to Graphs 
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Techniques for using text with graphs, including 
alignment, symbols and Greek letters, using variables in 
text strings, multiline text, and text background color
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Illustrates the procedure for adding callout arrows and 
lines to graphs
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How to Annotate Graphs
Annotating graphs with text and other explanatory material can improve the 
graph’s ability to convey information. This section describes techniques 
available in MATLAB for creating annotations.

Graph Annotation Features
MATLAB provides a variety of features for annotating graphs, including those 
that

• Add text, lines and arrows, rectangles, ellipses, and other annotation objects 
anywhere on the figure

• Anchor annotations to locations in data space

• Add a legend and colorbar

• Add axis labels and titles

• Edit the properties of graphics objects

The following sections provide more information.

• “Enclosing Regions of a Graph in a Rectangle or an Ellipse” on page 3-5

• “Textbox Annotations” on page 3-7

• “Annotation Lines and Arrows” on page 3-10

• “Adding a Colorbar to a Graph” on page 3-13

• “Adding a Legend to a Graph” on page 3-17

• “Pinning — Attaching to a Point in the Graph” on page 3-19

Annotation Tools on the Plot Edit Toolbar
Select Plot Edit Toolbar from the View menu to display the toolbar.



How to Annotate Graphs

3-3

Annotation Tools on the Figure Palette
Basic annotation tools are available from the figure palette. Select Figure 
Palette from the View menu to display the figure palette.

Insert lines 
and arrows

Insert textarrow, text, 
rectangle, and ellipse

Pin object to 
data point

Align textText color, font, bold, 
or italics

Display the object 
Alignment tool

Fill color and 
line/edge color

Click this button to enable property 
editing of graphic objects.
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Adding Annotations from the Insert Menu
Annotation features are available from the Insert menu.

Command Interface
You can add annotations using MATLAB commands. The following table lists 
the functions used to create annotations.

MATLAB Functions for Creating Annotations

Function Purpose

annotation Create annotations including lines, arrows, text 
arrows, double arrows, text boxes, rectangles, and 
ellipses

xlabel, ylabel, 
zlabel

Add a text label to the respective axis

title Add a title to a graph
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Removing Annotations
You can delete any annotation manually, and (if it has an explicit handle) 
programmatically. See “Deleting Annotations” in the MATLAB function 
reference documentation for details.

Enclosing Regions of a Graph in a Rectangle or an 
Ellipse
You can add a rectangle or an ellipse to draw attention to a specific region of a 
graph. While either object is selected, you can move and resize it as well as 
display a right-click context menu that enables you to modify behavior and 
appearance. 

Insert the rectangle or ellipse by clicking the corresponding button in the plot 
edit toolbar 

or by selecting Rectangle or Ellipse from the Insert menu. MATLAB changes 
the cursor to a cross indicating you can click down, drag, and release the left 
mouse button to define the size and shape of the object.

Pinning Rectangles and Ellipses
You can attach the rectangle to a particular point in the figure by pinning it to 
that point. There are three ways to pin the rectangle:

• Right-click the rectangle to display its context menu. Select Pin to axes to 
set a pin in the default location.

• Select the pin button in the figure toolbar (see “Pinning — Attaching to a 
Point in the Graph” on page 3-19).

• Select Pin to axes from the Tools menu. The cursor changes to a pin; click 
anywhere within the object to set a pin at that location.

colorbar Add a colorbar to a graph

legend Add a legend to a graph

MATLAB Functions for Creating Annotations

Function Purpose
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By default (using the first of the options described above), pinning attaches the 
lower left corner of the rectangle or ellipse to its current location in the axes 
data units. You can move the point of attachment by clicking the corner and 
dragging the anchor to another point. The cursor changes to a pin while you are 
dragging.

Note that you cannot drag or resize a rectangle or an ellipse when it is pinned.

Modifying the Rectangle or Ellipse from the Context Menu
Right-click the rectangle or ellipse to display its context menu.

The menu contains the following options:

• Cut, Copy, Delete — Cut to clipboard, copy to clipboard, or delete the 
selected object.

• Pin to axes — Pin the lower left corner to the current location (you can move 
the point of attachment by clicking and dragging the point while in plot edit 
mode).

• Unpin — Detach the rectangle from the attachment point.
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• Face Color — Fill color for the rectangle or ellipse

• Edge Color — Color of the line used to draw the rectangle or ellipse

• Line Width — Width of the line used to draw the rectangle or ellipse

• Line Style — Type of line used to draw the rectangle or ellipse

• Properties — Display the Property Editor with textbox properties.

• Show M-code — Create M-code that recreates the graph.

Setting Rectangle and Ellipse Properties
You can use the Property Editor to set rectangle and ellipse properties by 
selecting Properties from the context menu. The Property Editor displays the 
same properties that are described above in the context menu section.

You can click the More Properties button on the Property Editor to display the 
Property Inspector. The Property Inspector displays all properties for the 
selected annotation object. However, you should not change some of these 
properties because doing so can affect the proper functioning of the annotation 
object. See the following sections for descriptions of the properties you can 
change on the respective objects. 

• Annotation Rectangle Properties

• Annotation Ellipse Properties

Textbox Annotations
A textbox is a rectangle that can contain multiline text. You can attach the 
textbox to any point in the figure.

Insert a textbox by clicking the textbox button in the figure toolbar , then 
click where you want to place the text string. You can resize the textbox after 
typing the text or click and drag the box when you create it.

You can also select TextBox from the Insert menu.

Selecting Textbox Objects
The selection behavior of the textbox object differs from other annotation 
objects. 

• To move a textbox, click once on the text to select it. 

• To edit the a textbox, double click within the box. 
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• To display the Property Editor with textbox properties, right-click to display 
the context menu and select Properties.

Pinning the Textbox
You can attach the textbox to a particular point in the figure by pinning it to 
that point. There are three ways to pin the textbox:

• Right-click within the textbox to display its context menu.

• Select the pin button in the figure toolbar (See “Pinning — Attaching to a 
Point in the Graph” on page 3-19).

• Select Pin Object from the Edit menu.

By default, pinning attaches the lower left corner of the textbox to its location 
in the axes data space. You can move the point of attachment by clicking on the 
corner and dragging the anchor to another point. The cursor changes to the pin 
while dragging.

Note that you cannot drag the textbox when it is pinned.

Modifying the Textbox from the Context Menu
Right-clicking in a textbox displays its context menu, which enables you to 
perform a number of operations on the textbox. In the following picture, the 
textbox Background Color has been set to yellow using the context menu.
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The menu contains the following options:

• Cut, Copy, Delete — Cut to clipboard, copy to clipboard, or delete the 
textbox.

• Pin to axes — Pin the textbox to the current location (you can move the point 
of attachment by clicking and dragging the point while in plot edit mode).

• Unpin — Detach the textbox from the attachment point.

• Edit — Enable edit mode to change the text. You can also double-click the 
textbox with the left mouse button to enable edit mode.

• Text Color — Color of the text characters

• Background Color — Fill color of the rectangle enclosing the text

• Edge Color — Color of the textbox edge line (you must set Line Style to a 
value other than none to display edges)

• Font — Type of font used for the text

• Interpreter — Interpret characters as TEX (latex or tex) or as literal 
characters (none).

• Line Width — Width of the textbox edge line

• Line Style — Style of line used for the textbox edge

• Properties — Display the Property Editor with textbox properties.
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• Show M-code — Create M-code that recreates the graph.

Setting Textbox Properties
You can use the Property Editor to set textbox properties by selecting 
Properties from the textbox context menu. It displays the same properties that 
are described above in the context menu section.

You can click the More Properties button on the Property Editor to display the 
Property Inspector. The Property Inspector displays all textbox properties. 
However, you should not change some of these properties because doing so can 
affect the proper functioning of the textbox. 

See “Textbox Properties” in the reference documentation for a description of 
the properties you can change. 

Annotation Lines and Arrows
You can add lines and three types of arrows to a graph and attach them to any 
point in the figure. The three types of arrows include

• Single-headed arrow

• Arrow with attached text box

• Double-headed arrow

Insert a line or arrow by clicking the appropriate button in the figure toolbar, 

then click down, drag the line or arrow to the desired point, and release the 
mouse. The arrowhead appears at the terminal end.

With the line or arrow selected, right-click to display the context menu, which 
provides access to a number of options.

Inserting a Text Arrow
A text arrow combines a textbox with an arrow. It is useful for labeling points 
on a graph. Add a text arrow to a graph by selecting the arrow button that has 
a T above the arrow. Insert the text arrow and type text in the box. 
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Pinning the Arrowhead End
You can attach the arrowhead end to the point of interest on the graph while 
letting the text box automatically reposition itself as you zoom or pan the 
graph. 

There are three ways to pin annotations:

• Right-click the object to display its context menu and select Pin.

• Select the pin button in the plot edit toolbar (See “Pinning — Attaching to a 
Point in the Graph” on page 3-19).

• Select Pin Object from the Edit menu.

Modifying the Text Arrow from the Context Menu
Right-clicking on a text arrow displays its context menu, which enables you to 
perform a number of operations on the text arrow. The context menus for lines, 
arrows, and double arrows contain similar items:

• Cut, Copy, Delete — Cut to clipboard, copy to clipboard, or delete the 
textbox.

• Pin to axes — Pin the textbox to the current location (you can move the point 
of attachment by clicking and dragging the point while in plot edit mode).

• Unpin — Detach the textbox from the attachment point.

You can pin the arrowhead 
and then pan the graph to 
get the desired view.
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• Reverse Direction — Swap the arrow head and the textbox or move the 
arrowhead to the other end of a plain arrow.

• Edit Text — Enable edit mode to change the text characters.

• Color — Color of the text characters, textbox edge, and arrow

• Text Background Color — Color of the rectangle enclosing the text

• Font — Type of font used for the text

• Line Width — Width of the textbox edge line

• Line Style — Style of line used for the textbox edge

• Head Style — Type of arrowhead to use

• Head Size — Size of the arrowhead in points

• Properties — Display the Property Editor with textbox properties.

• Show M-code — Create M-code that recreates the graph.

For example, the following illustration shows the text border enabled and the 
text background color set to yellow. 
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Setting Line and Arrow Properties
You can use the Property Editor to set line and arrow properties by selecting 
Properties from the context menu. The Property Editor displays the same 
properties that are described above in the context menu section.

You can click the More Properties button on the Property Editor to display the 
Property Inspector. The Property Inspector displays all properties for the 
selected annotation object. However, you should not change some of these 
properties, because doing so can affect the proper functioning of the 
annotation. See the following sections in the reference documentation for 
descriptions of the properties you can change on the respective objects. 

• Annotation Line Properties

• Annotation Arrow Properties

• Annotation Textarrow Properties

• Annotation Doublearrow Properties

Adding a Colorbar to a Graph
Colorbars display the current colormap and indicate the mapping from data 
values to colors. The following picture shows a surface plot with 2-D contour 
lines below. Note how the colorbar at the right indicates how the z-axis data 
values correspond to colors in both the surface and contour graphs.

Add a colorbar by clicking the colorbar button in the toolbar  or by selecting 
Colorbar from the Insert menu. When plot editing is enabled, you can select 
and then move and resize the colorbar. The following commands will also 
create this plot:

surfc(peaks(30))
colorbar
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You can also use the colorbar command to add a colorbar to a 2-D graph.

Positioning Options for Colorbars
There are a variety of ways to reposition a colorbar in the figure.

• Enable plot edit mode, then select and drag the colorbar to the desired 
location.

• Right-click over the colorbar to display its context menu. Mouse over 
Locations and select one of the predefined locations for the colorbar.

• Right-click over the colorbar to display its context menu and select 
Properties. This displays the Property Editor, which provides a graphical 
positioning device for the colorbar.

Labeling Colorbar Ticks
The default colorbar labels ticks with numeric values, which are placed at 
intervals specified by the colorbar’s YTick parameter (for vertical colorbars) or 
its XTick parameter (for horizontal colorbars), within upper and lower limits 
specified by CData. You can override these limits by using the caxis command.
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You can specify strings in place of the numeric labels on colorbars. This is 
useful for display of data on nominal or ordinal scales and for when you want 
to interpret the meaning of entries in the colormap for the viewer. To substitute 
strings for numbers along a colorbar, you define a label for each tick location. 
You do this by specifying a cell array of strings for YTicklabel (vertical 
colorbars) or XTickLabel (horizontal colorbars), as the examples below show. 

Example 1: Default Vertical Colorbar with YTickLabels

contourf(peaks(60));
colormap(jet(8));
hcb = colorbar('YTickLabel',...
{'Freezing','Cold','Cool','Neutral',...
'Warm','Hot','Burning','Nuclear'});
set(hcb,'YTickMode','manual')

Example 2: Horizontal Colorbar with XTickLabels

figure
contourf(peaks(60));
colormap(jet(8));
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hcb = colorbar('Location','SouthOutside','XTickLabel',...
{'Freezing','Cold','Cool','Neutral',...
'Warm','Hot','Burning','Nuclear'});
set(hcb,'XTickMode','manual')

In these examples, the number of colors and the number of labels were set to 
be the same (8). This is typical for nominal (categorical) data, but not necessary 
if you do not object to having a range of colors associated with each label.

Note that if ticks change, for instance if YTick (XTick) values change or the plot 
is rescaled while YTickMode (XTickMode) or YTickLabelMode (XTickLabelMode) 
is auto, too few or too many colorbar labels may be displayed, and can sit next 
to colors they do not represent. When there are fewer labels than ticks, the 
labels will cycle, with the lowest one following the highest one, etc., to give each 
tick a label. This is probably not what you want, so you need to reset YTick 
(XTick) values in such cases. Finding the correct values can take some 
experimentation. The set commands in the above examples prevent MATLAB 
from changing the number of ticks when you resize figures.
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Selecting a Different Colormap
If you change the figure colormap, the colorbar updates automatically. Use one 
of the following methods to change the colormap.

• Right-click over the colorbar to display its context menu. Mouse over 
Standard Colormaps and select from the displayed list.

• Right-click over the colorbar to display its context menu and select 
Properties. Click the figure background to load the figure properties into the 
Property Editor. Select the colormap from the pull-down list.

• Use the colormap command.

Modifying the Colormap
You can use a colorbar to modify the current colormap. To do this, select 
Interactive Colormap Shift from the right-click context menu. In this mode, 
you can left-click down on any color in the colorbar and, by dragging the mouse, 
shift the color-to-data mapping.

To perform more sophisticated operations on the colormap, launch the 
colormap editor by selecting Launch Colormap Editor from the colorbar’s 
context menu. See the colormapeditor reference page for more information.

Adding a Legend to a Graph
Legends provide a key to the various data plotted on a graph. The following 
picture shows the legend for a graph of four functions of a variable plotted with 
lines of different colors. A graph can have only one legend, which applies to and 
will symbolize all data series contained by an axes, according to their form (e.g., 
lines, bars, pies, etc.). Note how you can assign an appropriate string to each 
line in the legend.
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Add a legend by clicking the legend button in the toolbar  or by selecting 
Legend from the Insert menu. When plot editing is enabled, you can select and 
then move and resize the legend.

You can also use the legend command to add a legend to a graph, which gives 
additional controls over appearance.

Specifying the Text 
By default, the legend labels each plotted object (line, surface, etc.) with the 
strings data1, data2, etc. You can change this text by double-clicking on the 
text to enable edit mode. In edit mode, you can retype the text string.

You can use TEX characters in the text strings to produce symbols. You can 
disable interpretation of characters as TEX sequences by selecting none from 
the Interpreter submenu of the legend’s right-click context menu.

See the Table of TEX symbols in the Text Properties reference documentation 
for more information. 

Positioning the Legend
There are a number of ways to position the legend.

• Enable plot edit mode, select the legend, and drag it to the desired location.
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• Right-click the legend to display its context menu, mouse over Location, and 
select one of the predefined locations from the submenu.

• Right-click the legend to display its context menu and select Properties to 
display the Property Editor, which provides a graphical device for 
positioning the legend.

You can also select a vertical or horizontal orientation for the legend. Use the 
Orientation item in the context menu to make this selection.

Changing the Appearance of the Legend
You can specify the following legend characteristics from the context menu:

• Color — Set the background color of the legend. In addition, you can specify 
the Color property as 'none' to make the legend background be transparent.

• EdgeColor — Set the color of the line enclosing the legend box.

• TextColor — Set the color of the legend text.

You can use a colorspec or an RGB color triplet to set the above three 
properties. 

• LineWidth — Set the width of the edge line.

• Font — Set the font, font style, and font size of the text used in the legend.

• Interpreter — Set the text Interpreter property to use TEX or plain text.

• Orientation — Orient the legend entries side by side (horizontal) or on top 
of each other.

• Properties — Display the Property Editor with legend properties.

• Show M-code — Generates M-code for recreating the legend.

Pinning — Attaching to a Point in the Graph
Pinning is the attachment of an object to a particular point in the figure. 
Pinning enables you to pan or resize the figure while keeping annotations 
associated with the same point. For example, the following picture shows 
regions in two different graphs associated by pinning both ends of a double 
arrow.
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If you perform a horizontal zoom on the top axes (select Horizontal Zoom from 
the Options submenu of the Tools menu) and then pan the graph to show the 
first 120 seconds of the data, the double arrow continues to point to the same 
locations on the graph.
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Pinning Objects
To pin an object, first enable pinning mode by clicking the pin object button 

 in the plot edit toolbar or selecting Pin Object from the Edit menu. Then 
click the point you want to pin. 

To unpin an object, right-click to display the context menu and select Unpin.

You can pin annotation lines, arrows, rectangles, ellipses, and text boxes.

When this mode is enabled, axes, rectangle, arrows, and lines automatically 
align their upper left corners to the grid. As you move or resize one of these 
objects, the size or position snaps to the next grid location.
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Alignment Tool — Aligning and Distributing Objects
The Alignment Tool enables you to position objects with respect to each other 
and to adjust the spacing between selected objects. The specified 
align/distribute operations apply to all components that are selected when you 
click the Apply or OK buttons.

Display the Alignment Tool by clicking the Align/Distribute button  or by 
selecting Align Distribute Tool from the Tools menu.

Alignment Tool Functionality

The Alignment Tool provides two types of positioning operations: 

• Align — Align all selected objects to a single reference line. 

• Distribute — Space all selected objects uniformly with respect to each other. 

You can align and distribute objects in the vertical and horizontal directions. 
The following sections provide more information.

• “Example — Vertical Distribute, Horizontal Align” on page 3-23

• “Align/Distribute Menu Options” on page 3-25
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• “Snap to Grid — Aligning Objects on a Grid” on page 3-27

Example — Vertical Distribute, Horizontal Align
This example illustrates how to align three textboxes with three corresponding 
axes. In this example, the text boxes were just plunked down close to the 
desired position and then right aligned and distributed to have 40 pixels 
between them.

The following picture shows the initial layout.

Use Shift+click to select all three textboxes and then configure the Alignment 
Tool as shown in the following picture.

• Set vertical distribution to 40 pixels.

• Set horizontal alignment to right-aligned.

• Click Apply.
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The following picture shows the result.
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Align/Distribute Menu Options
The Tools menu contains the alignment and distribution options that are 
available via the Alignment Tool. 

The Smart Align and Distribute option aligns objects into rows and columns 
with equal spacing between each object. It is useful when you have a number 
of objects to align that can be positioned in an m-by-n grid. 

For example, the following figure contains six axes that have been placed 
approximately into two columns in the figure.
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To align all axes in a grid, select each axes (Shift+click each one), then select 
Smart Align and Distribute from the Tools menu. The resulting alignment 
and distribution of the axes are shown below.
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Snap to Grid — Aligning Objects on a Grid
Figures have a layout grid that can aid the hand layout of objects displayed in 
the figure. You can also enable a snap-to-grid feature that forces objects to 
align with the grid increments when moved.

To display the grid on the figure background, select View Layout Grid from 
the Tools menu. 

To force objects to align with the grid, select Snap To Layout Grid from the 
Tools menu.

To move objects in the figure, enable Plot Edit mode by selecting Edit Plot from 
the Tools menu. Click to select an object and then drag it to the desired 
location. 

The following picture illustrates a figure with four subplots. You can select any 
of the four axes and move them. Note that all axis labels and the title move 
with the axes. Annotation objects move independently of the plot axes.
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Adding Titles to Graphs
In MATLAB, a title is a text string at the top of an axes. Titles typically define 
the subject of the graph.

There are several ways to add a title to a graph:

• “Using the Title Option on the Insert Menu” on page 3-30 

• “Using the Property Editor to Add a Title” on page 3-30

• “Using the title Function” on page 3-31
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Note  While you can use text annotations to create a title for your graph, it is 
not recommended. Titles are anchored to the top of the axes they describe; text 
annotations are not. If you move or resize your axes, the title remains at the 
top. Additionally, if you cut a title and then paste it back into a figure, the title 
is no longer anchored to the axes.

Using the Title Option on the Insert Menu
To add a title to a graph using the Insert menu,

1 Click the Insert menu in the figure menu bar and choose Title. MATLAB 
opens a text entry box at the top of the axes.

Note  When you select the Title option, MATLAB enables plot editing mode 
automatically.

2 Enter the text of the label. 

3 When you are finished entering text, click anywhere in the figure 
background to close the text entry box around the title. If you click on 
another object in the figure, such as an axes or line, you close the title text 
entry box and also automatically select the object you clicked.

To change the font used in the title to bold, you must edit the title. You can edit 
the title as you would any other text object in a graph. 

Using the Property Editor to Add a Title
To add a title to a graph using the Property Editor,

1 Start plot editing mode by selecting Edit Plot from the figure Tools menu.

2 Double-click an empty region of the axes in the graph. This starts the 
Property Editor. You can also start the Property Editor by right-clicking on 
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the axes and selecting Show Property Editor from the context menu or by 
selecting Property Editor from the View menu. 

The Property Editor displays a property panel specific to axes objects. Titles 
are a property of axes objects.

3 Type the text of your title in the Title text entry box.

You can change the font, font style, position, and many other aspects of the title 
format. 

• To move the title, select the text and drag it to the desired position.

• To edit the text, double-click the title and type new characters.

• To change the font and other text properties, select the title and right-click 
to display the context menu. 

Using the title Function
To add a title to a graph at the MATLAB command prompt or from an M-file, 
use the title function. 

For example, the following code adds a title to the current axes and sets the 
value of the FontWeight property to bold. 

title('Lotka-Volterra Predator-Prey Population Model',... 
'FontWeight','bold')

To edit a title from the MATLAB command prompt or from an M-file, use the 
set function. 
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Adding Axis Labels to Graphs
In MATLAB, an axis label is a text string aligned with the x-, y-, or z-axis in a 
graph. Axis labels can help explain the meaning of the units that each axis 
represents. 

Note  While you can use freeform text annotations to create axes labels, it is 
not recommended. Axis labels are anchored to the axes they describe; text 
annotations are not. If you move or resize your axes, the labels automatically 
move with the axes. Additionally, if you cut a label and then paste it back into 
a figure, the label is no longer anchored to the axes. 

To add axis labels to a graph, you can use any of these mechanisms:

• “Using the Label Options on the Insert Menu” on page 3-33 
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• “Using the Property Editor to Add Axis Labels” on page 3-33

• “Using Axis-Label Commands” on page 3-35 

Using the Label Options on the Insert Menu

1 Click the Insert menu and choose the label option that corresponds to the 
axis you want to label: X Label, Y Label, or Z Label. MATLAB opens a text 
entry box along the axis or around an existing axis label.

Note  MATLAB opens up a horizontal text editing box for the y- and z-axis 
labels and automatically rotates the label into alignment with the axis when 
you finish entering text.

2 Enter the text of the label, or edit the text of an existing label. 

3 Click anywhere else in the figure background to close the text entry box 
around the label. If you click on another object in the figure, such as an axes 
or line, you close the label text entry box but also automatically select the 
object you clicked.

Note  After you use the Insert menu to add an axis label, plot edit mode is 
enabled in the figure, if it was not already enabled. 

Using the Property Editor to Add Axis Labels
To add labels to a graph using the Property Editor,

1 Start plot editing mode by selecting Edit Plot from the figure Tools menu.

2 Start the Property Editor by double-clicking on the axes in the graph. You 
can also start the Property Editor by right-clicking on the axes and selecting 
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Properties from the context menu or by selecting Property Editor from the 
View menu. 

The Property Editor displays the set of property panels specific to axes 
objects. 

3 Select the X Axis, Y Axis, or Z Axis panel, depending on which axis label you 
want to add. Enter the label text in the text entry box. 

Rotating Axis Labels
You can rotate axis labels using the Property Editor:

1 Start plot editing mode by selecting Edit Plot from the figure Tools menu.

2 Display the Property Editor by selecting (left-clicking) the axis label you 
want to rotate. Right-click over the selected text, then choose Properties 
from the context menu. 

3 Click the More Properties button to display the Property Inspector.
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4 Select the Rotation property text field. A value of 0 degrees orients the label 
in the horizontal position.

5 With the left mouse button down on the selected label, drag the text to the 
desired location and release.

Using Axis-Label Commands
You can add x-, y-, and z-axis labels using the xlabel, ylabel, and zlabel 
commands. For example, these statements label the axes and add a title.

xlabel('t = 0 to 2\pi','FontSize',16)
ylabel('sin(t)','FontSize',16)
title('\it{Value of the Sine from Zero to Two Pi}','FontSize',16)
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The labeling commands automatically position the text string appropriately. 
MATLAB interprets the characters immediately following the backslash (\) as 
TeX commands. These commands draw symbols such as Greek letters and 
arrows. 

See the text String property for a list of TeX character sequences. See also the 
texlabel function for converting MATLAB expressions to TeX symbols.

Rotating Axis Labels Using Commands
Axis labels are text objects that you can rotate by specifying a value for the 
object’s Rotation property. The handles of the x-, y-, and z-axis labels are 
stored in the axes XLabel, YLabel, and ZLabel properties respectively.

Therefore, to rotate the y-axis label so that the text is horizontal:

1 Get the handle of the text object using the axes YLabel property.

2 Set the Rotation property to 0.0 degrees.
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For example, this statement rotates the text of the y-axis label on the current 
axes:

set(get(gca,'YLabel'),'Rotation',0.0)

Repositioning Axis Labels
You can reposition an axis label by dragging the text.

1 Start plot editing mode by selecting Edit Plot from the figure Tools menu.

2 Select the text of the label you want to reposition (handles appear around 
the text object).

3 With the left mouse button down on the selected label, drag the text to the 
desired location and release.
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Adding Text Annotations to Graphs
You can add freeform text annotations anywhere in a MATLAB figure to help 
explain your data or bring attention to specific points in your data sets.

If you enable plot editing mode, you can create text annotations by clicking in 
an area of the graph or the figure background and entering text. You can also 
add text annotations from the command line, using the text or gtext 
command. 

Using plot editing mode or gtext makes it easy to place a text annotation 
anywhere in a graph. Use the text command when you want to position a text 
annotation at a specific point in a data set. 
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Note  Text annotations created using the text or gtext command are 
anchored to the axes. Text annotations created in plot edit mode are not. If 
you move or resize your axes, you will have to reposition your text 
annotations. 

Creating Text Annotations with the text or gtext 
Command 
To create a text annotation using the text function, you must specify the text 
and its location in the graph, using x- and y-coordinates. You specify the 
coordinates in the units of the graph. 

Use the gtext command when you want to position a text annotation at a 
specific point in the data space with the mouse. 

For example, the following code creates text annotations at specific points in 
the Lotka-Volterra Predator-Prey Population Model graph. 

str1(1) = {'Many Predators;'};
str1(2) = {'Prey Population'};
str1(3) = {'Will Decline'};
text(7,220,str1)

str2(1) = {'Few Predators;'};
str2(2) = {'Prey Population'};
str2(3) = {'Will Increase'};
text(5.5,125,str2)

This example also illustrates how to create multiline text annotations with cell 
arrays. 

Calculating the Positions of Text Annotations
You can also calculate the positions of text annotations in a graph. The 
following code adds annotations at three data points on a graph.

text(3*pi/4,sin(3*pi/4),...
'\leftarrowsin(t) = .707',...
'FontSize',16)
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text(pi,sin(pi),'\leftarrowsin(t) = 0',...
'FontSize',16)

text(5*pi/4,sin(5*pi/4),'sin(t) = −.707\rightarrow',...
'HorizontalAlignment','right',...
'FontSize',16)

The HorizontalAlignment of the text string 'sin(t) = −.707 \rightarrow' 
is set to right to place it on the left side of the point [5*pi/4,sin(5*pi/4)] on 
the graph. For more information about aligning text annotations, see “Text 
Alignment” on page 3-42.

Defining Symbols. For information on using symbols in text strings, see 
“Mathematical Symbols, Greek Letters, and TEX Characters” on page 3-45.

You can use text objects to annotate axes at arbitrary locations. MATLAB 
locates text in the data units of the axes. For example, suppose you plot the 
function  with A = 0.25, α = 0.005, and t = 0 to 900.
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t = 0:900;
plot(t,0.25*exp(−0.005*t))

To annotate the point where the value of t = 300, calculate the text coordinates 
using the function you are plotting.

text(300,.25*exp(−0.005*300),...
'\bullet\leftarrow\fontname{times}0.25{\ite}^{-0.005{\itt}} at {\itt} = 

300',...

'FontSize',14)

This statement defines the text Position property as

x = 300, 

The default text alignment places this point to the left of the string and 
centered vertically with the rectangle defined by the text Extent property. The 
following section provides more information about changing the default text 
alignment.
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Text Alignment
The HorizontalAlignment and the VerticalAlignment properties control the 
placement of the text characters with respect to the specified x-, y-, and 
z-coordinates. The following diagram illustrates the options for each property 
and the corresponding placement of the text. 

The default alignment is

• HorizontalAlignment = left 
• VerticalAlignment = middle

MATLAB does not place the text String exactly on the specified Position. For 
example, the previous section showed a plot with a point annotated with text. 
Zooming in on the plot enables you to see the actual positioning of the text.

Middle Top Cap

Baseline Bottom

Left Center Right

Text HorizontalAlignment property viewed with the VerticalAlignment
property set to middle (the default).

Text VerticalAlignment property viewed with the HorizontalAlignment
property set to left (the default).
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The small dot is the point specified by the text Position property. The larger 
dot is the bullet defined as the first character in the text String property.

Example — Aligning Text
Suppose you want to label the minimum and maximum values in a plot with 
text that is anchored to these points and that displays the actual values. This 
example uses the plotted data to determine the location of the text and the 
values to display on the graph. One column from the peaks matrix generates 
the data to plot.

Z = peaks;
h = plot(Z(:,33));

The first step is to find the indices of the minimum and maximum values to 
determine the coordinates needed to position the text at these points (get, 
find). Then create the string by concatenating the values with a description of 
what the values are.

x = get(h,'XData'); % Get the plotted data
y = get(h,'YData');
imin = find(min(y) == y);% Find the index of the min and max
imax = find(max(y) == y);
text(x(imin),y(imin),[' Minimum = ',num2str(y(imin))],...

'VerticalAlignment','middle',...
'HorizontalAlignment','left',...
'FontSize',14)

text(x(imax),y(imax),['Maximum =  ',num2str(y(imax))],...
'VerticalAlignment','bottom',...
'HorizontalAlignment','right',...

•←0.25e−0.005t   at t = 300Point defined by
text Position
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'FontSize',14)

The text function positions the string relative to the point specified by the 
coordinates, in accordance with the settings of the alignment properties. For 
the minimum value, the string appears to the right of the text position point; 
for the maximum value the string appears above and to the left of the text 
position point. The text always remains in the plane of the computer screen, 
regardless of the view.

Editing Text Objects
You can edit any of the text labels or annotations in a graph:

1 Start plot edit mode.

2 Double-click the string, or right-click the string and select Edit from the 
context menu.

An editing bar (|) appears next to the text.
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3 Make any changes to the text.

4 Click anywhere outside the text edit box to end text editing.

Note  To create special characters in text, such as Greek letters or 
mathematical symbols, use TEX sequences. See the text string property for a 
table of characters you can use. If you create special characters by using the 
Edit Font Properties dialog box and selecting the Symbol font family, you 
cannot edit that text object using MATLAB commands.

Mathematical Symbols, Greek Letters, and TEX 
Characters
You can include mathematical symbols and Greek letters in text using 
TEX-style character sequences. This section describes how to construct a TEX 
character sequence. 

Two Levels of TEX Support
MATLAB provides two levels of TEX support, controlled by the text 
Interpreter property:

• tex — Support for a subset of TEX markup

• latex — Support TEX and LaTEX markup

If you do not want the characters interpreted as TEX markup, then set the 
interpreter property to none.

Available Symbols and Greek Letters
For a list of symbols and the character sequences used to define them, see the 
table of available TEX characters in the Text Properties reference page. 

In general, you can define text that includes symbols and Greek letters using 
the text function, assigning the character sequence to the String property of 
text objects. You can also include these character sequences in the string 
arguments of the title, xlabel, ylabel, and zlabel commands.
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Example — Using a Mathematical Expression to Title a Graph
This example uses TEX character sequences to create graph labels. The 
following statements add a title and x- and y-axis labels to an existing graph.

title('{\itAe}^{−\alpha\itt}sin\beta{\itt} \alpha<<\beta')
xlabel('Time \musec.')
ylabel('Amplitude')

The backslash character (\) precedes all TEX character sequences. Looking at 
the string defining the title illustrates how to use these characters.
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Controlling the Interpretation of TEX Characters
The text Interpreter property controls the interpretation of TEX characters. 
If you set this property to none, MATLAB interprets the special characters 
literally.

Using Character and Numeric Variables in Text
Any string variable is a valid specification for the text String property. This 
section illustrates how to use matrix, cell array, and numeric variables as 
arguments to the text function.

Character Variables
For example, each row of the matrix PersonalData contains specific 
information about a person (note that all but the longest row are padded with 
a space so that each has the same number of columns). 

PersonalData = ['Jack Straw ';'489 Main St.';'Wichita KN '];

To display the data, index into the desired row.

text(x1,y1,['Name: ',PersonalData(1,:)])
text(x2,y2,['Address: ',PersonalData(2,:)])
text(x3,y3,['City and State: ',PersonalData(3,:)])

Cell Arrays
Using a cell array enables you to create multiline text with a single text object. 
Each cell does not need to be the same number of characters. For example, the 
following statements,

key(1)={'{\itAe}^{-\alpha\itt}sin\beta{\itt}'};
key(2)={'Time in \musec'};
key(3)={'Amplitude in volts'};
text(x,y,key)

produce this output.
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Numeric Variables
You can specify numeric variables in text strings using the num2str (number 
to string) function. For example, if you type on the command line

x = 21;
['Today is the ',num2str(x),'st day.']

MATLAB concatenates the three separate strings into one.

Today is the 21st day.

Since the result is a valid string, you can specify it as a value for the text String 
property.

text(xcoord,ycoord,['Today is the ',num2str(x),'st day.'])

Example — Multiline Text
MATLAB supports multiline text strings using cell arrays. Simply define a 
string variable as a cell array with one line per cell. This example defines two 
cell arrays, one used for a uicontrol and the other as text.

str1(1) = {'Center each line in the Uicontrol'};
str1(2) = {'Also check out the textwrap function'};

str2(1) = {'Each cell is a quoted string'};
str2(2) = {'You can specify how the string is aligned'};
str2(3) = {'You can use LaTeX symbols like \pi \chi \Xi'};
str2(4) = {'\bfOr use bold \rm\itor italic font\rm'};
str2(5) = {'\fontname{courier}Or even change fonts'};
plot(0:6,sin(0:6))
uicontrol('Style','text','Position',[80 80 200 30],...

'String',str1);
text(5.75,sin(2.5),str2,'HorizontalAlignment','right')
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Drawing Text in a Box
When you use the text command to display a character string, the string’s 
position is defined by a rectangle called the Extent of the text. You can display 
this rectangle either as a box or a filled area. For example, you can highlight 
contour labels to make the text easier to read.

[x,y] = meshgrid(-1:.01:1);
z = x.*exp(-x.^2-y.^2);;
[c,h]=contour(x,y,z);
h = clabel(c,h);
set(h,'BackgroundColor',[1 1 .6])
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For additional features, see the following text properties:

• BackgroundColor — Color of the rectangle’s interior (none by default)

• EdgeColor — Color of the rectangle’s edge (none by default)

• LineStyle — Style of the rectangle’s edge line (first set EdgeColor)

• LineWidth — Width of the rectangle’s edge line (first set EdgeColor)

• Margin — Increase the size of the rectangle by adding a margin to the text 
extent.
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Adding Arrows and Lines to Graphs
With plot editing mode enabled, you can add arrows and lines anywhere in a 
figure window. 

You can also use arrow characters (TeX characters) to create arrows using the 
text command. However, arrows created this way can only point to the left or 
right, horizontally. See “Calculating the Positions of Text Annotations” on 
page 3-39 for an example. 

Creating Arrows and Lines in Plot Editing Mode
To add an arrow or line annotation to a graph,

1 Click the Insert menu and choose the Arrow or Line option, or click the 
Arrow or Line button in the Plot Edit toolbar.
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MATLAB changes the cursor to a cross-hair. 

2 Position the cursor in the figure where you want to start the line or arrow 
and press either mouse button. Hold the button down and move the mouse 
to define the length and direction of the line or arrow.

3 Release the mouse button. 

Note  After you add an arrow or line, plot edit mode is enabled in the figure, if 
it was not already enabled. 

Editing Arrows and Line Annotations
You can edit the appearance of arrow and line annotations using the context 
menu. 

With plot editing mode enabled, right-click the arrow or line annotation to 
display its context menu. 

For more options, select Properties to display the Property Editor.



 

4

Creating Specialized Plots

Bar and Area Graphs (p. 4-2) View results over time, comparing results, and displaying 
individual contribution to a total amount

Pie Charts (p. 4-21) Individual contribution to a total amount

Histograms (p. 4-24) Distribution of data values

Discrete Data Graphs (p. 4-29) Stem and stairstep plots of discrete data

Direction and Velocity Vector Graphs 
(p. 4-38)

Compass, feather, and quiver plots show direction and 
magnitude.

Contour Plots (p. 4-44) Indicate locations of equal data values.

Interactive Plotting (p. 4-60) User-selectable data point (using mouse) for plotting

Animation (p. 4-62) Show an additional data dimension by sequencing plots.
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Bar and Area Graphs
Bar and area graphs display vector or matrix data. These types of graphs are 
useful for viewing results over a period of time, comparing results from 
different data sets, and showing how individual elements contribute to an 
aggregate amount. Bar graphs are suitable for displaying discrete data, 
whereas area graphs are more suitable for displaying continuous data. 

Types of Bar Graphs
MATLAB has four specialized functions that display bar graphs. These 
functions display 2- and 3-D bar graphs, and vertical and horizontal bar 
graphs. 

Grouped Bar Graph
By default, a bar graph represents each element in a matrix as one bar. Bars 
in a 2-D bar graph, created by the bar function, are distributed along the x-axis 
with each element in a column drawn at a different location. All elements in a 
row are clustered around the same location on the x-axis.

Function Description

bar Displays columns of m-by-n matrix as m groups of n vertical 
bars

barh Displays columns of m-by-n matrix as m groups of n 
horizontal bars

bar3 Displays columns of m-by-n matrix as m groups of n vertical 
3-D bars

bar3h Displays columns of m-by-n matrix as m groups of n 
horizontal 3-D bars

area Displays vector data as stacked area plots

Two-Dimensional Three-Dimensional

Vertical bar bar3

Horizontal barh bar3h
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For example, define Y as a simple matrix and issue the bar statement in its 
simplest form.

Y = [5 2 1
8 7 3
9 8 6
5 5 5
4 3 2];

bar(Y)

The bars are clustered together by rows and evenly distributed along the 
x-axis.

Detached 3-D Bars
The bar3 function, in its simplest form, draws each element as a separate 3-D 
block, with the elements of each column distributed along the y-axis. Bars that 
represent elements in the first column of the matrix are centered at 1 along the 
x-axis. Bars that represent elements in the last column of the matrix are 
centered at size(Y,2) along the x-axis. For example,

bar3(Y)

displays five groups of three bars along the y-axis. Notice that larger bars 
obscure Y(1,2) and Y(1,3).
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By default, bar3 draws detached bars. The statement bar3(Y,'detach') has 
the same effect.

Labeling the Graph. To add axes labels and x tick marks to this bar graph, use the 
statements

xlabel('X Axis')
ylabel('Y Axis')
zlabel('Z Axis')
set(gca,'XTick',[1 2 3])

Grouped 3-D Bars
Cluster the bars from each row beside each other by specifying the argument 
'group'. For example,

bar3(Y,'group')

groups the bars according to row and distributes the clusters evenly along the 
y-axis.
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Coloring 2-D Bars According to Height
The bar and barh functions make all bars in a series the same color. With a 
little effort, however, you can assign a desired color to each bar. The typical 
approach is to associate bar colors with bar heights (Y-values). The following 
steps describe one way to do this, first using faceted shading and then using 
smooth (interpolated) shading:

1 Make up some numbers, plot a default bar plot, and assign a bichromatic 
colormap: 

n = 13;
Z = rand(n,1);
h = bar(Z);
colormap(summer(n));
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Notice that only the first color is used to color the faces.

2 Assign a new color to each bar. bar (and barh) creates a barseries object, 
which encapsulates a set of patch objects for the bars. The patches have 
face-vertex syntax. You must first get a handle for the children, and then 
obtain the vertices for the bars and the vertex color data: 

ch = get(h,'Children');
fvd = get(ch,'Faces');
fvcd = get(ch,'FaceVertexCData');

3 Sort the data to obtain an index for traversing the Faces array from the 
lowest to highest bar:

[zs, izs] = sortrows(Z,1);

4 Traverse the Faces and assign colors to the face-vertex color data as you go:

for i = 1:n
row = izs(i);
fvcd(fvd(row,:)) = i;
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end
set(ch,'FaceVertexCData',fvcd)

Note that the code assigns colors to bars based on their YData ranks, rather 
than by their YData values. This helps to distinguish bars by color, but also 
can assign to bars that are nearly the same height a wider range of colors 
than if the colors were directly mapped to YData values.

5 To make the graph more readable, you can set different colors for vertices on 
the baseline and on the top, then apply interpolated shading to change hue 
going up the bars. The following code colors the two vertices at the base of 
each bar using the first color in the colormap, and assigns a color to the two 
vertices at the top proportionally to bar height. A longer color ramp than was 
used above is needed to obtain smooth gradiations of shading:

k = 128; % Number of colors in color table
colormap(summer(k)); % Expand the previous colormap
shading interp % Needed to graduate colors
for i = 1:n

color = floor(k*i/n); % Interpolate a color index
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row = izs(i); % Look up actual row # in data
fvcd(fvd(row,1)) = 1; % Color base vertices 1st index
fvcd(fvd(row,4)) = 1;    
fvcd(fvd(row,2)) = color; % Assign top vertices color
fvcd(fvd(row,3)) = color;

end
set(ch,'FaceVertexCData', fvcd); % Apply the vertex coloring
set(ch,'EdgeColor','k') % Give bars black borders

Coloring 3-D Bars According to Height
By default, all bars in a series (column) have the same color. You can modify a 
3-D bar plot to color each bar according to how tall it is, but the technique is 
slightly different than the one used for coloring 2-D bars, described above. 
Applying a monochromatic or bichromatic colormap to such plots helps viewers 
see height distinctions more readily. Adding a colorbar can also help.

The graph will read better if you override the default behavior of bar3 to shade 
the sides of the bars with contrasting hues. You can color bars by height and 
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make the sides match the color of the top of each bar by executing the following 
code:

Z = magic(5);
h = bar3(Z);
for i = 1:length(h)

zdata = ones(6*length(h),4);
k = 1;
for j = 0:6:(6*length(h)-6)

zdata(j+1:j+6,:) = Z(k,i);
k = k+1;

end
set(h(i),'Cdata',zdata)

end
colormap cool
colorbar

You can then make the plot even more readable by interpolating colors along 
the bars and giving their EdgeColor a contrasting color. The following code 
accomplishes this:
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shading interp
for i = 1:length(h)

zdata = get(h(i),'Zdata');
set(h(i),'Cdata',zdata)
set(h,'EdgeColor','k')

end

Stacked Bar Graphs to Show Contributing Amounts
Bar graphs can show how elements in the same row of a matrix contribute to 
the sum of all elements in the row. These types of bar graphs are referred to as 
stacked bar graphs.

Stacked bar graphs display one bar per row of a matrix. The bars are divided 
into n segments, where n is the number of columns in the matrix. For vertical 
bar graphs, the height of each bar equals the sum of the elements in the row. 
Each segment is equal to the value of its respective element. 

Redefining Y
Y = [5 1 2
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8 3 7
9 6 8
5 5 5
4 2 3];

Create stacked bar graphs using the optional 'stack' argument. For example,

bar(Y,'stack')
grid on
set(gca,'Layer','top') % display gridlines on top of graph

creates a 2-D stacked bar graph, where all elements in a row correspond to the 
same x location.
 

Horizontal Bar Graphs
For horizontal bar graphs, the length of each bar equals the sum of the 
elements in the row. The length of each segment is equal to the value of its 
respective element.

barh(Y,'stack')
grid on
set(gca,'Layer','top') % Display gridlines on top of graph
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Specifying X-Axis Data
Bar graphs automatically generate x-axis values and label the x-axis tick lines. 
You can specify a vector of x values (or y values in the case of horizontal bar 
graphs) to label the axes.

For example, given temperature data, 

temp = [29 23 27 25 20 23 23 27];

obtained from samples taken every five days during a thirty-five day period,

days = 0:5:35;

you can display a bar graph showing temperature measured along the y-axis 
and days along the x-axis using

bar(days,temp)

These statements add labels to the x- and y-axis.

xlabel('Day')
ylabel('Temperature (^{o}C)') 
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Setting Y-Axis Limits
By default, the y-axis range is from 0 to 30. To focus on the temperature range 
from 15 to 30, change the y-axis limits.

set(gca,'YLim',[15 30],'Layer','top') 
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Overlaying Bar Graphs
In addition to grouping and stacking barseries, you can overlay several bars 
that share the same baseline and y-range by making each series of bars a 
different width and plotting the widest ones first. The following example shows 
how to accomplish this within an axes:

1 Define x and y data; it probably helps to make spacing of x-values constant:

x=[1 3 5 7 9]; 
y1=[10 25 90 35 16]; 
K=0.5; 

2 Plot Series 1 in red, and set bar width to one-half an x-unit:

bar1=bar(x, y1, 'FaceColor', 'b', 'EdgeColor', 'b'); 
set(bar1,'BarWidth',K); 

3 Define Series 2, and plot it in blue over the first one:

hold on;
y2=[7 38 31 50 41];
bar2=bar(x, y2, 'FaceColor', 'r', 'EdgeColor', 'r');
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4 Set the width of the second series to half that of the first one:

set(bar2,'BarWidth',K/2); 
hold off; 
legend('series1','series2')

Overlaying Other Plots on Bar Graphs
You can overlay data on a bar graph by creating another axes in the same 
position. This enables you to have an independent y-axis for the overlaid 
dataset (in contrast to the hold on statement, which uses the same axes).

For example, consider a bioremediation experiment that breaks down 
hazardous waste components into nontoxic materials. The trichloroethylene 
(TCE) concentration and temperature data from this experiment are

TCE = [515 420 370 250 135 120 60 20];
temp = [29 23 27 25 20 23 23 27];

This data was obtained from samples taken every five days during a thirty-five 
day period.



4 Creating Specialized Plots

4-16

days = 0:5:35;

Display a bar graph and label the x- and y-axis using the statements

bar(days,temp)
xlabel('Day')
ylabel('Temperature (^{o}C)')

Overlaying a Line Plot on the Bar Graph
To overlay the concentration data on the bar graph, position a second axes at 
the same location as the first axes, but first save the handle of the first axes.

h1 = gca;

Create the second axes at the same location before plotting the second dataset.

h2 = axes('Position',get(h1,'Position'));
plot(days,TCE,'LineWidth',3)

To ensure that the second axes does not interfere with the first, locate the 
y-axis on the right side of the axes, make the background transparent, and set 
the second axes’ x-tick marks to the empty matrix.

set(h2,'YAxisLocation','right','Color','none','XTickLabel',[])

Align the x-axis of both axes and display the grid lines on top of the bars.

set(h2,'XLim',get(h1,'XLim'),'Layer','top')
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Annotating the Graph. These statements annotate the graph.

text(11,380,'Concentration','Rotation',–55,'FontSize',16)
ylabel('TCE Concentration (PPM)')
title('Bioremediation','FontSize',16)

To print the graph, set the current figure’s PaperPositionMode to auto, which 
ensures the printed output matches the display.

set(gcf,'PaperPositionMode','auto')

Area Graphs
The area function displays curves generated from a vector or from separate 
columns in a matrix. area plots the values in each column of a matrix as a 
separate curve and fills the area between the curve and the x-axis.

Area Graphs Showing Contributing Amounts
Area graphs are useful for showing how elements in a vector or matrix 
contribute to the sum of all elements at a particular x location. By default, area 
accumulates all values from each row in a matrix and creates a curve from 
those values. 
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Using this matrix,

Y = [5 1 2
8 3 7
9 6 8
5 5 5
4 2 3];

the statement

area(Y)

displays a graph containing three area graphs, one per column.

The height of the area graph is the sum of the elements in each row. Each 
successive curve uses the preceding curve as its base.

Displaying the Grid on Top. To display the grid lines in the foreground of the area 
graph and display only five grid lines along the x-axis, use the statements

set(gca,'Layer','top')
set(gca,'XTick',1:5)
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Comparing Data Sets with Area Graphs
Area graphs are useful for comparing different datasets. For example, given a 
vector containing sales figures, 

sales = [51.6 82.4 90.8 59.1 47.0];

for the five-year period

x = 90:94;

and a vector containing profits figures for the same five-year period,

profits = [19.3 34.2 61.4 50.5 29.4];

display both as two separate area graphs within the same axes. Set the color of 
the area interior (FaceColor), its edges (EdgeColor), and the width of the edge 
lines (LineWidth). See patch for a complete list of properties.

area(x,sales,'FaceColor',[.5 .9 .6],...
'EdgeColor','b',...
'LineWidth',2)

hold on
area(x,profits,'FaceColor',[.9 .85 .7],...

'EdgeColor','y',...
'LineWidth',2)

hold off

To annotate the graph, use the statements

set(gca,'XTick',[90:94])
set(gca,'Layer','top')
gtext('\leftarrow Sales')
gtext('Profits')
gtext('Expenses')
xlabel('Years','FontSize',14)
ylabel('Expenses + Profits = Sales in 1,000''s','FontSize',14)
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Pie Charts
Pie charts display the percentage that each element in a vector or matrix 
contributes to the sum of all elements. pie and pie3 create 2-D and 3-D pie 
charts.

Example — Pie Chart
Here is an example using the pie function to visualize the contribution that 
three products make to total sales. Given a matrix X where each column of X 
contains yearly sales figures for a specific product over a five-year period,

X = [19.3 22.1 51.6;
34.2 70.3 82.4;
61.4 82.9 90.8;
50.5 54.9 59.1;
29.4 36.3 47.0];

sum each row in X to calculate total sales for each product over the five-year 
period.

x = sum(X);

You can offset the slice of the pie that makes the greatest contribution using 
the explode input argument. This argument is a vector of zero and nonzero 
values. Nonzero values offset the respective slice from the chart. 

First, create a vector containing zeros.

explode = zeros(size(x));

Then find the slice that contributes the most and set the corresponding 
explode element to 1.

[c,offset] = max(x);
explode(offset) = 1;

The explode vector contains the elements [0 0 1]. To create the exploded pie 
chart, use the statement

h = pie(x,explode); colormap summer
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Labeling the Graph
The pie chart’s labels are text graphics objects. To modify the text strings and 
their positions, first get the objects’ strings and extents. Braces around a 
property name ensure that get outputs a cell array, which is important when 
working with multiple objects.

textObjs = findobj(h,'Type','text');
oldStr = get(textObjs,{'String'});
val = get(textObjs,{'Extent'});
oldExt = cat(1,val{:});

Create the new strings, then set the text objects’ String properties to the new 
strings.

Names = {'Product X: ';'Product Y: ';'Product Z: '};
newStr = strcat(Names,oldStr);
set(textObjs,{'String'},newStr)

Find the difference between the widths of the new and old text strings and 
change the values of the Position properties.

val1 = get(textObjs, {'Extent'});
newExt = cat(1, val1{:});
offset = sign(oldExt(:,1)).*(newExt(:,3) oldExt(:,3))/2;

Product X: 25%

Product Y: 34%

Product Z: 42%
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pos = get(textObjs, {'Position'});
textPos =  cat(1, pos{:});
textPos(:,1) = textPos(:,1)+offset;
set(textObjs,{'Position'},num2cell(textPos,[3,2]))

Removing a Piece from a Pie Chart
When the sum of the elements in the first input argument is equal to or greater 
than 1, pie and pie3 normalize the values. So, given a vector of elements x, 
each slice has an area of xi/sum(xi), where xi is an element of x. The normalized 
value specifies the fractional part of each pie slice.

When the sum of the elements in the first input argument is less than 1, pie 
and pie3 do not normalize the elements of vector x. They draw a partial pie. 
For example,

x = [.19 .22 .41];
pie(x)

19%

22%

41%
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Histograms
MATLAB histogram functions show the distribution of data values. The 
functions that create histograms are hist and rose.

The histogram functions count the number of elements within a range and 
display each range as a rectangular bin. The height (or length when using 
rose) of the bins represents the number of values that fall within each range.

Histograms in Cartesian Coordinate Systems
The hist function shows the distribution of the elements in Y as a histogram 
with equally spaced bins between the minimum and maximum values in Y. If 
Y is a vector and is the only argument, hist creates up to 10 bins. For example,

yn = randn(10000,1);
hist(yn)

generates 10,000 random numbers and creates a histogram with 10 bins 
distributed along the x-axis between the minimum and maximum values of yn.

Function Description

hist Displays data in a Cartesian coordinate system

rose Displays data in a polar coordinate system
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Matrix Input Argument
When Y is a matrix, hist creates a set of bins for each column, displaying each 
set in a separate color. The statements

Y = randn(10000,3);
hist(Y)

create a histogram showing 10 bins for each column in Y.
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Histograms in Polar Coordinates
A rose plot is a histogram created in a polar coordinate system. For example, 
consider samples of the wind direction taken over a 12-hour period.

wdir = [45 90 90 45 360 335 360 270 335 270 335 335];

To display this data using the rose function, convert the data to radians, then 
use the data as an argument to the rose function. Increase the LineWidth 
property of the line to improve the visibility of the plot (findobj).

wdir = wdir * pi/180;
rose(wdir)
hline = findobj(gca,'Type','line');
set(hline,'LineWidth',1.5)

The plot shows that the wind direction was primarily 335° during the 12-hour 
period.
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Specifying Number of Bins
hist and rose interpret their second argument in one of two ways — as the 
locations on the axis or the number of bins. When the second argument is a 
vector x, it specifies the locations on the axis and distributes the elements in 
length(x) bins. When the second argument is a scalar x, hist and rose 
distribute the elements in x bins.

For example, compare the distribution of data created by two MATLAB 
functions that generate random numbers. The randn function generates 
normally distributed random numbers, whereas the rand function generates 
uniformly distributed random numbers. 

yn = randn(10000,1);
yu = rand(10000,1);

The first histogram displays the data distribution resulting from the randn 
function. The locations on the x-axis and number of bins depend on the vector x. 

x = min(yn):.2:max(yn);
subplot(1,2,1)
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hist(yn,x)
title('Normally Distributed Random Numbers','FontSize',16)

The second histogram displays the data distribution resulting from the rand 
function and explicitly creates 25 bins along the x-axis.

subplot(1,2,2)
hist(yu,25)
title('Uniformly Distributed Random Numbers','FontSize',16)

Note  You can change the aspect ratio of the histogram plots using the mouse 
to resize the figure window. However, before creating hardcopy output, set the 
figure’s PaperPositionMode to auto to produce printed output that matches 
the display.

set(gcf,'PaperPositionMode','auto')
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Discrete Data Graphs
MATLAB has a number of specialized functions that are appropriate for 
displaying discrete data. This section describes how to use stem plots and 
stairstep plots to display this type of data. (Bar charts, discussed earlier in this 
section, are also suitable for displaying discrete data.)

• “Two-Dimensional Stem Plots” on page 4-29 — Compares 2-D stem and line 
plots and shows techniques for customizing the stems

• “Combining Stem Plots with Line Plots” on page 4-32 — Combination line 
and stem plot with legend

• “Three-Dimensional Stem Plots” on page 4-33 — 3-D stem plot of an FFT and 
a combination 3-D stem and line plot

• “Stairstep Plots” on page 4-36 — Plotting a mathematical function with a 
stairstep plot

The following table lists the commands described in this section.

Two-Dimensional Stem Plots
A stem plot displays data as lines (stems) terminated with a marker symbol at 
each data value. In a 2-D graph, stems extend from the x-axis.

The stem function displays two-dimensional discrete sequence data. For 
example, evaluating the function  with the values

alpha = .02; beta = .5; t = 0:4:200;
y = exp(-alpha*t).*cos(beta*t);

yields a vector of discrete values for y at given values of t. A line plot shows the 
data points connected with a straight line.

plot(t,y)

Function Description

stem Displays a discrete sequence of y-data as stems from x-axis

stem3 Displays a discrete sequence of z-data as stems from 
xy-plane

stairs Displays a discrete sequence of y-data as steps from x-axis

y e αt– βtcos=
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A stem plot of the same function plots only discrete points on the curve.

stem(t,y)
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Add axes labels to the x- and y-axis.

xlabel('Time in \musecs')
ylabel('Magnitude')

If you specify only one argument, the number of samples is equal to the length 
of that argument. In this example, the number of samples is a function of t, 
which contains 51 elements and determines the length of y.

Customizing the Graph
You can specify the line style, the type of marker, and the color used in the stem 
plot. For example, adding the string ':sr' specifies a dotted line (:), a square 
marker (s), and a red color (r). The 'fill' argument colors the face of the 
marker.

stem(t,y,'−−sr','fill')

Setting the aspect ratio of the x- and y-axis to 2:1 improves the utility of the 
graph. You can do this by setting the aspect ratio of the plot box using 
pbaspect.

pbaspect([2,1,1])

This is equivalent to setting the PlotBoxApectRatio property directly.
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set(gca,'PlotBoxAspectRatio',[2,1,1])

See LineSpec for a list of line styles and marker types.

Combining Stem Plots with Line Plots
Sometimes it is useful to display more than one plot simultaneously with a 
stem plot to show how you arrived at a result. For example, create a linearly 
spaced vector with 60 elements and define two functions, a and b.

x = linspace(0,2*pi,60);
a = sin(x);
b = cos(x);

Create a stem plot showing the linear combination of the two functions.

stem_handles = stem(x,a+b);

Overlaying a and b as line plots helps visualize the functions. Before plotting 
the two curves, set hold to on so MATLAB does not clear the stem plot.

hold on
plot_handles = plot(x,a,'−−r',x,b,'−−g');
hold off

Use legend to annotate the graph. The stem and plot handles passed to legend 
identify the lines to label. Stem plots are composed of two lines; one draws the 
markers and the other draws the vertical stems. To create the legend, use the 
first handle returned by stem, which identifies the marker line.

legend_handles = [stem_handles(1);plot_handles];
legend(legend_handles,'a + b','a = sin(x)','b = cos(x)')

Labeling the axes and creating a title finishes the graph.

xlabel('Time in \musecs')
ylabel('Magnitude')
title('Linear Combination of Two Functions')
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Three-Dimensional Stem Plots
stem3 displays 3-D stem plots extending from the xy-plane. With only one 
vector argument, MATLAB plots the stems in one row at x = 1 or y = 1, 
depending on whether the argument is a column or row vector. stem3 is 
intended to display data that you cannot visualize in a 2-D view.

Example – 3-D Stem Plot of an FFT
Fast Fourier transforms are calculated at points around the unit circle on the 
complex plane. So, it is interesting to visualize the plot around the unit circle. 
Calculating the unit circle

th = (0:127)/128*2*pi;
x = cos(th);
y = sin(th);

and the magnitude frequency response of a step function

f = abs(fft(ones(10,1),128));
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displays the data using a 3-D stem plot, terminating the stems with filled 
diamond markers.

stem3(x,y,f','d','fill')
view([−65 30])

 

Label the Graph
Label the graph with the statements

xlabel('Real')
ylabel('Imaginary')
zlabel('Amplitude')
title('Magnitude Frequency Response')

To change the orientation of the view, turn on mouse-based 3-D rotation.

rotate3d on

Example — Combining Stem and Line Plots
Three-dimensional stem plots work well for visualizing discrete functions that 
do not output a large number of data points. For example, you can use stem3 to 
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visualize the Laplace transform basis function, , for a particular 
constant value of s.

t = 0:.1:10;% Time limits
s = 0.1+i;% Spiral rate
y = exp(-s*t);% Compute decaying exponential 

Using t as magnitudes that increase with time, create a spiral with increasing 
height and draw a curve through the tops of the stems to improve definition.

stem3(real(y),imag(y),t)
hold on
plot3(real(y),imag(y),t,'r')
hold off
view(-39.5,62)

 

Label the Graph
Add axes labels, with the statements

xlabel('Real')
ylabel('Imaginary')
zlabel('Magnitude')
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Stairstep Plots
Stairstep plots display data as the leading edges of a constant interval (i.e., 
zero-order hold state). This type of plot holds the data at a constant y-value for 
all values between x(i) and x(i+1), where i is the index into the x data. This type 
of plot is useful for drawing time-history plots of digitally sampled data 
systems. 

Example — Stairstep Plot of a Function
Define a function f that varies over time,

alpha = 0.01;
beta = 0.5;
t = 0:10;
f = exp(−alpha*t).*sin(beta*t);

Use stairs to display the function as a stairstep plot and a linearly 
interpolated function.

stairs(t,f)
hold on
plot(t,f,'--*')
hold off 
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Annotate the graph and set the axes limits.

label = 'Stairstep plot of e^{–(\alpha*t)} sin\beta*t';
text(0.5,–0.2,label,'FontSize',14)
xlabel('t = 0:10','FontSize',14)
axis([0 10 –1.2 1.2])
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Direction and Velocity Vector Graphs
Several MATLAB functions display data consisting of direction vectors and 
velocity vectors. This section describes these functions.

You can define the vectors using one or two arguments. The arguments specify 
the x and y components of the vectors relative to the origin.

If you specify two arguments, the first specifies the x components of the vectors 
and the second the y components of the vectors. If you specify one argument, 
the functions treat the elements as complex numbers. The real parts are the x 
components and the imaginary parts are the y components.

Compass Plots
The compass function shows vectors emanating from the origin of a graph. The 
function takes Cartesian coordinates and plots them on a circular grid. 

Example — Compass Plot of Wind Direction and Speed
This example shows a compass plot indicating the wind direction and strength 
during a 12-hour period. Two vectors define the wind direction and strength.

wdir = [45 90 90 45 360 335 360 270 335 270 335 335];
knots = [6 6 8 6 3 9 6 8 9 10 14 12];

Convert the wind direction, given as angles, into radians before converting the 
wind direction into Cartesian coordinates.

rdir = wdir * pi/180;
[x,y] = pol2cart(rdir,knots);
compass(x,y) 

Function Description

compass Displays vectors emanating from the origin of a polar plot

feather Displays vectors extending from equally spaced points along 
a horizontal line

quiver Displays 2-D vectors specified by (u,v) components

quiver3 Displays 3-D vectors specified by (u,v,w) components
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Create text to annotate the graph.

desc = {'Wind Direction and Strength at',
'Logan Airport for ',
'Nov. 3 at 1800 through',
'Nov. 4 at 0600'};

text(–28,15,desc)

Feather Plots
The feather function shows vectors emanating from a straight line parallel to 
the x-axis. For example, create a vector of angles from 90° to 0° and a vector the 
same size, with each element equal to 1.

theta = 90:–10:0;
r = ones(size(theta));

Before creating a feather plot, transform the data into Cartesian coordinates 
and increase the magnitude of r to make the arrows more distinctive.

[u,v] = pol2cart(theta*pi/180,r*10);
feather(u,v)
axis equal 
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Plotting Complex Numbers
If the input argument Z is a matrix of complex numbers, feather interprets the 
real parts of Z as the x components of the vectors and the imaginary parts as 
the y components of the vectors.

t = 0:0.5:10; % Time limits
s = 0.05+i;  % Spiral rate
Z = exp(–s*t);  % Compute decaying exponential
feather(Z)
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Printing the Graph
This particular graph looks better if you change the figure’s aspect ratio by 
stretching the figure lengthwise using the mouse. However, to maintain this 
shape in the printed output, set the figure’s PaperPositionMode to auto.

set(gcf,'PaperPositionMode','auto')

In this mode, MATLAB prints the figure as it appears on screen.

Two-Dimensional Quiver Plots
The quiver function shows vectors at given points in two-dimensional space. 
The vectors are defined by x and y components.

A quiver plot is useful when displayed with another plot. For example, create 
10 contours of the peaks function (see “Contour Plots” on page 4-44 for more 
information).

n = –2.0:.2:2.0;
[X,Y,Z] = peaks(n);
contour(X,Y,Z,10)
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Now use gradient to create the vector components to use as inputs to quiver. 

[U,V] = gradient(Z,.2);

Set hold to on and add the contour plot.

hold on
quiver(X,Y,U,V)
hold off 

Three-Dimensional Quiver Plots
Three-dimensional quiver plots (quiver3) display vectors consisting of (u,v,w) 
components at (x,y,z) locations. For example, you can show the path of a 
projectile as a function of time,

First, assign values to the constants vz and a.

vz = 10; % Velocity
a = 32; % Acceleration
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Then, calculate the height z, as time varies from 0 to 1 in increments of 0.1.

t = 0:.1:1;
z = vz*t + 1/2*a*t.^2;

Calculate the position in the x and y directions.

vx = 2;
x = vx*t;
vy = 3;
y = vy*t;

Compute the components of the velocity vectors and display the vectors using 
the 3-D quiver plot.

u = gradient(x);
v = gradient(y);
w = gradient(z);
scale = 0;
quiver3(x,y,z,u,v,w,scale)
view([70 18])
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Contour Plots
The contour functions create, display, and label isolines determined by one or 
more matrices.

Creating Simple Contour Plots
contour and contour3 display 2- and 3-D contours, respectively. They can be 
called with separate x, y, and z matrices, but need only one input argument — 
a z matrix interpreted as heights with respect to a plane. In this case, the 
contour functions determine the number of contours to display based on the 
minimum and maximum data values.

To explicitly set the number of contour levels displayed by the functions, you 
specify a second optional argument. 

Contour Plot of the Peaks Function
The statements

[X,Y,Z] = peaks;
contour(X,Y,Z,20)

Function Description

clabel Generates labels using the contour matrix and displays the 
labels in the current figure

contour Displays 2-D isolines generated from values given by a 
matrix Z

contour3 Displays 3-D isolines generated from values given by a 
matrix Z

contourf Displays a 2-D contour plot and fills the area between the 
isolines with a solid color

contourc Low-level function to calculate the contour matrix used by 
the other contour functions

meshc Creates a mesh plot with a corresponding 2-D contour plot

surfc Creates a surface plot with a corresponding 2-D contour plot
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display 20 contours of the peaks function in a 2-D view.

The statements

[X,Y,Z] = peaks;
contour3(X,Y,Z,20)
h = findobj('Type','patch');
set(h,'LineWidth',2)
title('Twenty Contours of the peaks Function')

display 20 contours of the peaks function in a 3-D view and increase the line 
width to 2 points. 
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Labeling Contours
Each contour level has a value associated with it. clabel uses these values to 
display labels for 2-D contour lines. The contour matrix contains the values 
clabel uses for the labels. This matrix is returned by contour, contour3, and 
contourf and is described in “The Contouring Algorithm” on page 4-51.

clabel optionally returns the handles of the text objects used as labels. You 
can then use these handles to set the properties of the label string.

For example, display 10 contour levels of the peaks function,

Z = peaks;
[C,h] = contour(Z,10);

then label the contours and display a title.

clabel(C,h)
title({'Contour Labeled Using','clabel(C,h)'})

Note that clabel labels only those contour lines that are large enough to have 
an inline label inserted.
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The 'manual' option enables you to add labels by selecting the contour you 
want to label with the mouse.

You can also use this option to label only those contours you select 
interactively.

For example,

clabel(C,h,'manual')

displays a crosshair cursor when your cursor is inside the figure. Pressing any 
mouse button labels the contour line closest to the center of the crosshair. 

Filled Contours
contourf displays a two-dimensional contour plot and fills the areas between 
contour lines. Use caxis to control the mapping of contour to color. For 
example, this filled contour plot of the peaks data uses caxis to map the fill 
colors into the center of the colormap. 

Z = peaks;
[C,h] = contourf(Z,10);
caxis([−20 20])
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title({'Filled Contour Plot Using','contourf(Z,10)'}) 

Drawing a Single Contour Line at a Desired Level
The contouring functions permit you to specify the number of contour levels or 
the particular contour levels to draw. In the case of contour, the two forms of 
the function are contour(Z,n) and contour(Z,v). Z is the data matrix, n is the 
number of contour lines, and v is a vector of specific contour levels.

MATLAB does not differentiate between a scalar and a one-element vector. So, 
if v is a one-element vector specifying a single contour at that level, contour 
interprets it as the number of contour lines, not the contour level. 
Consequently, contour(Z,v) behaves in the same manner as contour(Z,n).

To display a single contour line, define v as a two-element vector with both 
elements equal to the desired contour level. For example, create a 3-D contour 
of the peaks function.

xrange = 3:.125:3;
yrange = xrange;
[X,Y] = meshgrid(xrange,yrange);
Z = peaks(X,Y);
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contour3(X,Y,Z)

To display only one contour level at Z = 1, define v as [1 1].

v = [1 1]
contour3(X,Y,Z,v)

Index Contours
You can index contours to visually emphasize certain contour levels. This 
technique, commonly used on topographic maps to highlight contours at set 
altitudes such as 25, 50, 75 ... meters above sea level, provides visual cues 
analogous to major ticks on a graph's axis. It is much easier to read a contour 
display that shows index contours because the heavier lines lessen the chance 
that one’s eye will jump between adjacent contours in scanning across the plot.

Example — Specifying Index Contours
The following code example highlights contours at elevations of -6, -5, -4, ... 7 
for the output of the peaks function.

1 Generate a data matrix to contour:

z = peaks(100);

2 Compute 40 contour levels. Select contour levels so as to be round numbers; 
zlevs is the vector of contour levels to be plotted:

zmin = floor(min(z(:))); zmax = ceil(max(z(:)));
zinc = (zmax - zmin) / 40;
zlevs = zmin:zinc:zmax;

3 Specify the vertical distance between index contours; here it is unity, but it 
can be any modulus of values in zlevs.

zindex = 1;

4 Plot 2-D level lines with the CONTOUR function:

[c2,hc2] = contour(z,zlevs);

5 Create Index Contours by thickening level lines every zindex units

nc = get(hc2,'Children');
for i = 1:length(nc)
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   ud = get(nc(i),'UserData');
   if (mod(ud,zindex) == 0)
       set(nc(i),'LineWidth',2);
   end
end

A contour line will thicken with each call to set.

6 Annotate to identify the contouring parameters used

s = sprintf('%s %g %s %g %s', 'Peaks Function Contoured at', ...
    zinc, 'Units, Indexed every', zindex, 'Units');
title(s)

The loop of code in step 5 above works for contour but not contour3, because 
contour3 does not create contourgroup objects containing Children. To 
accomplish the same result with contour3 you must dereference the handle to 
the contours returned by contour3 (hc3, below) differently, as follows:
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figure;
[c3,hc3] = contour3(z,zlevs);
for i = 1:length(hc3)
   ud = get(hc3(i),'UserData');
   if (mod(ud,zindex) == 0)
       set(hc3(i),'LineWidth',2);
   end
end
s = sprintf('%s %g %s %g %s',...

'Peaks Function Contoured in 3-D at', ...
    zinc, 'Units, Indexed every', zindex, 'Units');
title(s)

The Contouring Algorithm
The contourc function calculates the contour matrix for the other contour 
functions. It is a low-level function that is not called from the command line. 
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The contouring algorithm first determines which contour levels to draw. If you 
specified the input vector v, the elements of v are the contour level values, and 
length(v) determines the number of contour levels generated. If you do not 
specify v, the algorithm chooses no more than 20 contour levels that are 
divisible by 2 or 5.

The contouring algorithm treats the input matrix Z as a regularly spaced grid, 
with each element connected to its nearest neighbors. The algorithm scans this 
matrix comparing the values of each block of four neighboring elements (i.e., a 
cell) in the matrix to the contour level values. If a contour level falls within a 
cell, the algorithm performs a linear interpolation to locate the point at which 
the contour crosses the edges of the cell. The algorithm connects these points 
to produce a segment of a contour line. 

contour, contour3, and contourf return a two-row matrix specifying all the 
contour lines. The format of the matrix is

C = [ value1 xdata(1) xdata(2)...
numv ydata(1) ydata(2)...]

The first row of the column that begins each definition of a contour line 
contains the value of the contour, as specified by v and used by clabel. Beneath 
that value is the number of (x,y) vertices in the contour line. Remaining 
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columns contain the data for the (x,y) pairs. For example, the contour matrix 
calculated by C = contour(peaks(3)) is

The circled values begin each definition of a contour line.

Changing the Offset of a Contour
The surfc and meshc functions display contours beneath a surface or a mesh 
plot. These functions draw the contour plot at the axes’ minimum z-axis limit. 
To specify your own offset, you must change the ZData values of the contour 
lines. First, save the handles of the graphics objects created by meshc or surfc.

h = meshc(peaks(20));

The first handle belongs to the mesh or surface. The remaining handles belong 
to the contours you want to change. To raise the contour plane, increment the 
z coordinate of each contour line by some amount by resetting its Zdata value:

for i = 2:length(h);

Columns 1 through 7 
−0.2000 1.8165    2.0000    2.1835         0    1.0003    2.0000
3.0000 1.0000    1.0367    1.0000    3.0000    1.0000    1.1998

Columns 8 through 14 
3.0000         0    1.0000    1.0359    1.0000    0.2000    1.6669
1.0002    3.0000    2.9991    2.0000    1.0018    5.0000    3.0000

Columns 15 through 21 
1.2324    2.0000    2.8240    2.3331    0.4000    2.0000    2.6130
2.0000    1.3629    2.0000    3.0000    5.0000    2.8530    2.0000

Columns 22 through 28 
2.0000    1.4290    2.0000    0.6000    2.0000    2.4020    2.0000
1.5261    2.0000    2.8530    5.0000    2.5594    2.0000    1.6892

Columns 29 through 35 
1.6255    2.0000    0.8000    2.0000    2.1910    2.0000    1.8221
2.0000    2.5594    5.0000    2.2657    2.0000    1.8524    2.0000

Column 36 
2.0000
2.2657

Three vertices at
v = 0

Three vertices at
v = 0.2

Five vertices at
v = 0.8
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newz = get(h(i),'Zdata') + 5;
set(h(i),'Zdata',newz)

end

Displaying Contours in Polar Coordinates 
You can contour data defined in the polar coordinate system. As an example, 
set up a grid in polar coordinates and convert the coordinates to Cartesian 
coordinates.

[th,r] = meshgrid((0:5:360)*pi/180,0:.05:1);
[X,Y] = pol2cart(th,r);

Then generate the complex matrix Z on the interior of the unit circle.

Z = X+i*Y;

X, Y, and Z are points inside the circle.

Create and display a surface of the function .

f = (Z.^4 1).^(1/4);
surf(X,Y,abs(f))

Display the unit circle beneath the surface using the statements

hold on
surf(X,Y,zeros(size(X)))
hold off

Z4 1–4
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Labeling the Graph
These statements add labels.

xlabel('Real','FontSize',14);
ylabel('Imaginary','FontSize',14);
zlabel('abs(f)','FontSize',14);

Contours in Cartesian Coordinates
These statements display a contour of the surface in Cartesian coordinates and 
label the x- and y-axis.

contour(X,Y,abs(f),30)
axis equal
xlabel('Real','FontSize',14);
ylabel('Imaginary','FontSize',14);
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Contours on a Polar Axis
You can also display the contour within a polar axes. Create a polar axes using 
the polar function, and then delete the line specified with polar.

h = polar([0 2*pi], [0 1]);
delete(h)

With hold on, display the contour on the polar grid.

hold on
contour(X,Y,abs(f),30)

Real
−1 −0.5 0 0.5 1
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Preparing Data for Contouring
The various contour plotting functions, as well as the mesh and surface families 
of functions, accept 2-D matrices as inputs. For most applications, these input 
grids will represent continuous functions of two variables or relatively 
continuous fields of data. In many applications, source data might consist of 
z-values sampled over a two-dimensional domain in an irregular fashion, such 
as discrete spot elevations from GPS measurements (in the form of x, y, and z 
data vectors). To prepare such data for contour or mesh display, you need to 
interpolate it in some fashion.

MATLAB provides methods for interpolating data into vectors, grids and 
triangulated (Delaunay) tessellations. Input observations can be one-, two-, 
three- or higher-dimensional. By choosing and using these functions carefully 
you can control parameters and constraints for interpolation to model your 
assumptions about the underlying nature of the raw data. Typically, you would 
use the interp2, meshgrid, and griddata functions to interpolate z-values for 
scattered x-y data points into a 2-D grid. See “Interpolation” in the MATLAB 
Mathematics documention for discussion and examples of data interpolation 
using these and other functions.

If the surface you are contouring is “noisy,” contours depicting it will exhibit 
jaggedness. When you analyze and explore such data, you can filter it to 
attentuate high-frequency variations. One way to do this is with a convolution 
(with conv2 or filter2) filter, as the following example demonstrates:
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Example — Smoothing a Matrix for Plotting Contours
The conv2 and filter functions can remove high-frequency components from 
a matrix representing a continuous surface or field to make the underlying 
data easier to visualize. This requires few assumptions

1 Create a function of two variables and plot contour lines at a specified, fixed 
interval.

Z = peaks(100);
figure; 
set (gcf,'position',[400,100,600,600], 'color','w')
subplot(2,2,1); 
cl = [-7:1:10]; % Define contour levels for all plots
contour(Z, cl)
axis([0 100 0 100]); colormap autumn;
set(gca,'Xtick',[0 100],'Ytick',[0 100]);
title('Peaks Surface (underlying data)')

2 Add uniform random noise with mean of 0 to the surface and plot resulting 
contours. Irregularities in the contours tend to obscure the trend of the data:

ZN = Z + rand(100) - .5;
subplot (2,2,2)
contour(ZN, cl)
axis([0 100 0 100]);
set(gca,'Xtick',[0 100],'Ytick',[0 100]);
title('Peaks Surface (noise added)')

3 Specify a 3x3 convolution kernal, F, for smoothing the matrix and use the 
conv2 function to attenuate high spatial frequencies in the surface data:

F = [.05 .1 .05; .1 .4 .1; .05 .1 .05];
ZC = conv2(ZN,F,'same');

4 Visually compare the smoothed surface to the original and the noisy ones:

subplot (2,2,3)
contour(ZC, cl)
axis([0 100 0 100]);
set(gca,'Xtick',[0 100],'Ytick',[0 100]);
title('Noisy Surface (smoothed once)')
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5 Smooth the surface one more time using the same operator and compare (a 
larger or more uniform kernal could have achieved this in one pass):

ZC2 = conv2(ZC,F,'same');
subplot (2,2,4)
contour(ZC2, cl)
axis([0 100 0 100]);
set(gca,'Xtick',[0 100],'Ytick',[0 100]);
title('Noisy Surface (smoothed twice)')
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Interactive Plotting
The ginput function enables you to use the mouse or the arrow keys to select 
points to plot. ginput returns the coordinates of the pointer’s position, either 
the current position or the position when a mouse button or key is pressed. See 
the ginput function for more information.

Example — Selecting Plotting Points from the Screen
This example illustrates the use of ginput with the spline function to create a 
curve by interpolating in two dimensions.

First, select a sequence of points, [x,y], in the plane with ginput. Then pass 
two one-dimensional splines through the points, evaluating them with a 
spacing one-tenth of the original spacing.

axis([0 10 0 10])
hold on
% Initially, the list of points is empty.
xy = [];
n = 0;
% Loop, picking up the points.
disp('Left mouse button picks points.')
disp('Right mouse button picks last point.')
but = 1;
while but == 1

[xi,yi,but] = ginput(1);
plot(xi,yi,'ro')
n = n+1;
xy(:,n) = [xi;yi];

end
% Interpolate with a spline curve and finer spacing.
t = 1:n;
ts = 1: 0.1: n;
xys = spline(t,xy,ts);

% Plot the interpolated curve.
plot(xys(1,:),xys(2,:),'b-');
hold off

This plot shows some typical output.
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Animation 
You can create animated sequences with MATLAB in two different ways:

• Save a number of different pictures and then play them back as a movie.

• Continually erase and then redraw the objects on the screen, making 
incremental changes with each redraw.

Movies are better suited to situations where each frame is fairly complex and 
cannot be redrawn rapidly. You create each movie frame in advance so the 
original drawing time is not important during playback, which is just a matter 
of blitting the frame to the screen. A movie is not rendered in real time; it is 
simply a playback of previously rendered frames.

The second technique, drawing, erasing, and then redrawing, makes use of 
different drawing modes supported by MATLAB. These modes allow faster 
redrawing at the expense of some rendering accuracy, so you must consider 
which mode to select.

This section provides an example of each technique. To see more sophisticated 
demonstrations of these features, type demo at the MATLAB prompt and 
explore the animation demonstrations.

Movies
You can save any sequence of graphs and then play the sequence back in a 
short movie. There are two steps to this process:

• Use getframe to generate each movie frame. 

• Use movie to run the movie a specified number of times at the specified rate.

Typically, you use getframe in a for loop to assemble the array of movie 
frames. getframe returns a structure having the following fields:

• cdata — Image data in a uint8 matrix. The matrix has dimensions of 
height-by-width on indexed-color systems and height-by-width-by-3 on 
truecolor systems. 

• colormap — The colormap in an n-by-3 matrix, where n is the number of 
colors. On truecolor systems, the colormap field is empty.

See image for more information on images. 
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Example — Visualizing an FFT as a Movie
This example illustrates the use of movies to visualize the quantity 
fft(eye(n)), which is a complex n-by-n matrix whose elements are various 
powers of the nth root of unity, exp(i*2*pi/n). 

Creating the Movie
Create the movie in a for loop calling getframe to capture the graph. Since the 
plot command resets the axes properties, call axis equal within the loop 
before getframe.

for k = 1:16
plot(fft(eye(k+16)))
axis equal
M(k) = getframe;

end

Running the Movie
After generating the movie, you can play it back any number of times. To play 
it back 30 times, type

movie(M,30)

You can readily generate and smoothly play back movies with a few dozen 
frames on most computers. Longer movies require large amounts of primary 
memory or a very effective virtual memory system.

Movies that Include the Entire Figure
If you want to capture the contents of the entire figure window (for example, to 
include GUI components in the movie), specify the figure’s handle as an 
argument to the getframe command. For example, suppose you want to add a 
slider to indicate the value of k in the previous example.

h = uicontrol('style','slider','position',...
[10 50 20 300],'Min',1,'Max',16,'Value',1)

for k = 1:16
plot(fft(eye(k+16)))
axis equal
set(h,'Value',k)
M(k) = getframe(gcf);

end
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In this example, the movie frame contains the entire figure. To play so that it 
looks like the original figure, make the playback axes fill the figure window.

clf
axes('Position',[0 0 1 1])
movie(M,30)

Erase Modes
You can select the method MATLAB uses to redraw graphics objects. One event 
that causes MATLAB to redraw an object is changing the properties of that 
object. You can take advantage of this behavior to create animated sequences. 
A typical scenario is to draw a graphics object, then change its position by 
respecifying the x-, y,- and z-coordinate data by a small amount with each pass 
through a loop.

You can create different effects by selecting different erase modes. This section 
illustrates how to use the three modes that are useful for dynamic redrawing:

• none—MATLAB does not erase the objects when it is moved.

• background—MATLAB erases the object by redrawing it in the background 
color. This mode erases the object and anything below it (such as grid lines).

• xor—This mode erases only the object and is usually used for animation.

All three modes are faster (albeit less accurate) than the normal mode used by 
MATLAB.

Example — Animating with Erase Modes
It is often interesting and informative to see 3-D trajectories develop in time. 
This example involves chaotic motion described by a nonlinear differential 
equation known as the Lorenz strange attractor. It can be written 

in the form  

with a vector-valued function y(t) and a matrix A that depends upon y. 

yd
td
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The solution orbits about two different attractive points without settling into a 
steady orbit about either. This example approximates the solution with the 
simplest possible numerical method — Euler’s method with fixed step size. The 
result is not very accurate, but it has the same qualitative behavior as other 
methods.

A = [ −8/3 0 0; 0 −10 10; 0 28 −1 ];
y = [35 −10 −7]';
h = 0.01;
p = plot3(y(1),y(2),y(3),'.', ...

'EraseMode','none','MarkerSize',5); % Set EraseMode to none
axis([0 50 -25 25 -25 25])
hold on
for i=1:4000

A(1,3) = y(2);
A(3,1) = −y(2);
ydot = A*y;
y = y + h*ydot;
% Change coordinates
set(p,'XData',y(1),'YData',y(2),'ZData',y(3)) 
drawnow

end

The plot3 statement sets EraseMode to none, indicating that the points already 
plotted should not be erased when the plot is redrawn. In addition, the handle 
of the plot object is saved. Within the for loop, a set statement references the 
plot object and changes its internally stored coordinates for the new location. 
While this manual cannot show the dynamically evolving output, this picture 
shows a snapshot.
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Note that, as far as MATLAB is concerned, the graph created by this example 
contains only one dot. What you see on the screen are remnants of previous 
plots that MATLAB has been instructed not to erase. The only way to print this 
graph from MATLAB is with a screen capture. 

Background Erase Mode. To see the effect of EraseMode background, add these 
statements to the previous program.

p = plot3(y(1),y(2),y(3),'square', ...
'EraseMode','background','MarkerSize',10,...
'MarkerEdgeColor',[1 .7 .7],'MarkerFaceColor',[1 .7 .7]);

for i=1:4000
A(1,3) = y(2);
A(3,1) = -y(2);
ydot = A*y;
y = y + h*ydot;
set(p,'XData',y(1),'YData',y(2),'ZData',y(3))
drawnow 

end
hold off
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Since hold is still on, this code erases the previously created graph by setting 
the EraseMode property to background and changing the marker to a “pink 
eraser” (a square marker colored pink). 

Xor Erase Mode. If you change the EraseMode of the first plot3 statement from 
none to xor, you will see a moving dot (Marker '.') only. Xor mode is used to 
create animations where you do not want to leave remnants of previous 
graphics on the screen. 

Additional Examples
The MATLAB demo lorenz provides a more accurate numerical approximation 
and a more elaborate display of the Lorenz strange attractor example. Other 
MATLAB demos illustrate animation techniques. 
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Basic Plotting Commands

Basic Plotting Commands (p. 5-2) Basic commands for creating line plots, specifying line 
styles, colors, and markers, and setting defaults

Line Plots of Matrix Data (p. 5-14) Line plots of the rows or column of matrices

Plotting Imaginary and Complex Data 
(p. 5-16)

How the plot command handles complex data as a special 
case

Plotting with Two Y-Axes (p. 5-17) Creating line plots that have left and right y-axes

Setting Axis Parameters (p. 5-20) Specifying axis ticks location, tick labels, and axes aspect 
ratio

Figure Windows (p. 5-27) Displaying multiple plots per figure, targeting a specific 
axes, figure color schemes
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Basic Plotting Commands
MATLAB provides a variety of functions for displaying vector data as line 
plots, as well as functions for annotating and printing these graphs. The 
following table summarizes the functions that produce basic line plots. These 
functions differ in the way they scale the plot’s axes. Each accepts input in the 
form of vectors or matrices and automatically scales the axes to accommodate 
the data.

Plotting Steps
The process of constructing a basic graph to meet your presentation graphics 
requirements is outlined in the following table. The table shows seven typical 
steps and some example code for each.

If you are performing analysis only, you may want to view various graphs just 
to explore your data. In this case, steps 1 and 3 may be all you need. If you are 
creating presentation graphics, you may want to fine-tune your graph by 

Function Description

plot Graph 2-D data with linear scales for both axes

plot3 Graph 3-D data with linear scales for both axes

loglog Graph with logarithmic scales for both axes

semilogx Graph with a logarithmic scale for the x-axis and a 
linear scale for the y-axis

semilogy Graph with a logarithmic scale for the y-axis and a 
linear scale for the x-axis

plotyy Graph with y-tick labels on the left and right side
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positioning it on the page, setting line styles and colors, adding annotations, 
and making other such improvements.

Creating Line Plots
The plot function has different forms depending on the input arguments. For 
example, if y is a vector, plot(y) produces a linear graph of the elements of y 
versus the index of the elements of y. If you specify two vectors as arguments, 
plot(x,y) produces a graph of y versus x. 

For example, the following statements create a vector of values in the range [0, 
2π] in increments of π/100 and then use this vector to evaluate the sine function 

Step Typical Code

1 Prepare your data x = 0:0.2:12;
y1 = bessel(1,x);
y2 = bessel(2,x);
y3 = bessel(3,x);

2 Select a window and position a 
plot region within the window

figure(1)
subplot(2,2,1)

3 Call elementary plotting 
function

h = plot(x,y1,x,y2,x,y3);

4 Select line and marker 
characteristics

set(h,'LineWidth',2,{'LineStyle'},{'--';':';'-.'})
set(h,{'Color'},{'r';'g';'b'})

5 Set axis limits, tick marks, and 
grid lines

axis([0 12 −0.5 1])
grid on

6 Annotate the graph with axis 
labels, legend, and text

xlabel('Time')
ylabel('Amplitude')
legend(h,'First','Second','Third')
title('Bessel Functions')
[y,ix] = min(y1);
text(x(ix),y,'First Min \rightarrow',...

'HorizontalAlignment','right')

7 Export graph print −depsc -tiff -r200 myplot
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over that range. MATLAB plots the vector on the x-axis and the value of the 
sine function on the y-axis.

t = 0:pi/100:2*pi;
y = sin(t);
plot(t,y)
grid on % Turn on grid lines for this plot

MATLAB automatically selects appropriate axis ranges and tick mark 
locations.

You can plot multiple graphs in one call to plot using x-y pairs. MATLAB 
automatically cycles through a predefined list of colors (determined by the axes 
ColorOrder property) to allow discrimination between sets of data. Plotting 
three curves as a function of t produces

y = sin(t);
y2 = sin(t-0.25); 
y3 = sin(t-0.5);
plot(t,y,t,y2,t,y3)
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Specifying Line Style
You can assign different line styles to each data set by passing line style 
identifier strings to plot. For example, 

t = 0:pi/100:2*pi;
y = sin(t);
y2 = sin(t-0.25); 
y3 = sin(t-0.5);
plot(t,y,'−',t,y2,'--',t,y3,':')
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Colors, Line Styles, and Markers
The basic plotting functions accepts character-string arguments that specify 
various line styles, marker symbols, and colors for each vector plotted. In the 
general form,

plot(x,y,'linestyle_marker_color')

linestyle_marker_color is a character string (delineated by single quotation 
marks) constructed from

• A line style (e.g., dashed, dotted, etc.)

• A marker type (e.g., x, *, o, etc.)

• A predefined color specifier (c, m, y, k, r, g, b, w)

For example,

plot(x,y,':squarey')

plots a yellow dotted line and places square markers at each data point. If you 
specify a marker type, but not a line style, MATLAB draws only the marker. 
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The specification can consist of one or none of each specifier in any order. For 
example, the string

'go--'

defines a dashed line with circular markers, both colored green.

You can also specify the size of the marker and, for markers that are closed 
shapes, you can specify separately the colors of the edges and the face.

See the LineSpec discussion for more information.

Specifying the Color and Size of Lines
You can control a number of line style characteristics by specifying values for 
line properties:

• LineWidth — Width of the line in units of points

• MarkerEdgeColor — Color of the marker or the edge color for filled markers 
(circle, square, diamond, pentagram, hexagram, and the four triangles)

• MarkerFaceColor — Color of the face of filled markers 

• MarkerSize — Size of the marker in units of points

For example, these statements,

x = −pi:pi/10:pi;
y = tan(sin(x)) − sin(tan(x));
plot(x,y,'−−rs','LineWidth',2,...
                'MarkerEdgeColor','k',...
                'MarkerFaceColor','g',...
                'MarkerSize',10)

produce a graph with

• A red dashed line with square markers

• A line width of two points

• The edge of the marker colored black

• The face of the marker colored green

• The size of the marker set to 10 points
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Adding Plots to an Existing Graph 
You can add plots to an existing graph using the hold command. When you set 
hold to on, MATLAB does not remove the existing graph; it adds the new data 
to the current graph, rescaling if the new data falls outside the range of the 
previous axis limits. 

For example, these statements first create a semilogarithmic plot, then add a 
linear plot.

semilogx(1:100,'+')
hold all % hold plot and cycle line colors
plot(1:3:300,1:100,'--')
hold off
grid on % Turn on grid lines for this plot

While MATLAB resets the x-axis limits to accommodate the new data, it does 
not change the scaling from logarithmic to linear. 
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Plotting Only the Data Points
To plot a marker at each data point without connecting the markers with lines, 
use a specification that does not contain a line style. For example, given two 
vectors,

x = 0:pi/15:4*pi;
y = exp(2*cos(x));

calling plot with only a color and marker specifier

plot(x,y,'r+') 

plots a red plus sign at each data point.
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See LineSpec for a list of available line styles, markers, and colors.

Plotting Markers and Lines
To plot both markers and the lines that connect them, specify a line style and 
a marker type. For example, the following command plots the data as a red, 
solid line and then adds circular markers with black edges at each data point.

x = 0:pi/15:4*pi;
y = exp(2*cos(x));
plot(x,y,'−r',x,y,'ok') 
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Line Styles for Black and White Output
Line styles and markers enable you to discriminate different plots on the same 
graph when color is not available. For example, the following statements create 
a graph using a solid ('−*k') line with asterisk markers colored black and a 
dash-dot ('−.ok') line with circular markers colored black.

x = 0:pi/15:4*pi;
y1 = exp(2*cos(x));
y2 = exp(2*sin(x));
plot(x,y1,'−*k',x,y2,'−.ok')
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Setting Default Line Styles
You can configure MATLAB to use line styles instead of colors for multiline 
plots by setting a default value for the axes LineStyleOrder property. For 
example, the command 

set(0,'DefaultAxesLineStyleOrder',{'-o',':s','--+'})

defines three line styles and makes them the default for all plots.

To set the default line color to dark gray, use the statement

set(0,'DefaultAxesColorOrder',[0.4,0.4,0.4])

See ColorSpec for information on how to specify color as a three-element vector 
of RGB values.

Now the plot command uses the line styles and colors you have defined as 
defaults. For example, these statements create a multiline plot.

x = 0:pi/10:2*pi;
y1 = sin(x);
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y2 = sin(x-pi/2);
y3 = sin(x-pi);
plot(x,y1,x,y2,x,y3)

The default values persist until you quit MATLAB. To remove default values 
during your MATLAB session, use the reserved word remove.

set(0,'DefaultAxesLineStyleOrder','remove')
set(0,'DefaultAxesColorOrder','remove')

See “Setting Default Property Values” on page 8-43 for more information.
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Line Plots of Matrix Data 
When you call the plot function with a single matrix argument

plot(Y)

MATLAB draws one line for each column of the matrix. The x-axis is labeled 
with the row index vector 1:m, where m is the number of rows in Y. For example, 

Z = peaks;

returns a 49-by-49 matrix obtained by evaluating a function of two variables. 
Plotting this matrix

plot(Z)

 produces a graph with 49 lines.

In general, if plot is used with two arguments and if either X or Y has more 
than one row or column, then

• If Y is a matrix, and x is a vector, plot(x,Y) successively plots the rows or 
columns of Y versus vector x, using different colors or line types for each. The 

0 5 10 15 20 25 30 35 40 45 50
−8

−6

−4

−2

0

2

4

6

8

10



Line Plots of Matrix Data

5-15

row or column orientation varies depending on whether the number of 
elements in x matches the number of rows in Y or the number of columns. If 
Y is square, its columns are used.

• If X is a matrix and y is a vector, plot(X,y) plots each row or column of X 
versus vector y. For example, plotting the peaks matrix versus the vector 
1:length(peaks) rotates the previous plot. 

y = 1:length(peaks);
plot(peaks,y)

• If X and Y are both matrices of the same size, plot(X,Y) plots the columns of 
X versus the columns of Y.

You can also use the plot function with multiple pairs of matrix arguments.

plot(X1,Y1,X2,Y2,...)

This statement graphs each X-Y pair, generating multiple lines. The different 
pairs can be of different dimensions.
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Plotting Imaginary and Complex Data
When the arguments to plot are complex (i.e., the imaginary part is nonzero), 
MATLAB ignores the imaginary part except when plot is given a single 
complex data argument. For this special case, the command is a shortcut for a 
plot of the real part versus the imaginary part. Therefore,

plot(Z)

where Z is a complex vector or matrix, is equivalent to

plot(real(Z),imag(Z))

For example, this statement plots the distribution of the eigenvalues of a 
random matrix using circular markers to indicate the data points.

plot(eig(randn(20,20)),'o','MarkerSize',6)

To plot more than one complex matrix, there is no shortcut; the real and 
imaginary parts must be taken explicitly.
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Plotting with Two Y-Axes
The plotyy command enables you to create plots of two data sets and use both 
left and right side y-axes. You can also apply different plotting functions to 
each data set. For example, you can combine a line plot with a stem plot of the 
same data.

t = 0:pi/20:2*pi;
y = exp(sin(t));
plotyy(t,y,t,y,'plot','stem')

Combining Linear and Logarithmic Axes
You can use plotyy to apply linear and logarithmic scaling to compare two data 
sets having different ranges of values.

t = 0:900; A = 1000; a = 0.005; b = 0.005;
z1 = A*exp(-a*t);
z2 = sin(b*t);
[haxes,hline1,hline2] = plotyy(t,z1,t,z2,'semilogy','plot');
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This example saves the handles of the lines and axes created to adjust and label 
the graph. First, label the axes whose y value ranges from 10 to 1000. This is 
the first handle in haxes because it was specified first in the call to plotyy. Use 
the axes command to make haxes(1) the current axes, which is then the target 
for the ylabel command.

axes(haxes(1))
ylabel('Semilog Plot')

Now make the second axes current and call ylabel again.

axes(haxes(2))
ylabel('Linear Plot')

You can modify the characteristics of the plotted lines in a similar way. For 
example, to change the line style of the second line plotted to a dashed line, use 
the statement

set(hline2,'LineStyle','--')
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See “Using Multiple X- and Y-Axes” on page 10-22 for an example that employs 
double x- and y-axes. 

See LineSpec for additional line properties.
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Setting Axis Parameters
When you create a graph, MATLAB automatically selects the axis limits and 
tick-mark spacing based on the data plotted. However, you can also specify 
your own values for axis limits and tick marks with the following commands:

• axis — Sets values that affect the current axes object (the most recently 
created or the last clicked on).

• axes — (Not axis) creates a new axes object with the specified 
characteristics.

• get and set — Enable you to query and set a wide variety of properties of 
existing axes.

• gca — Returns the handle (identifier) of the current axes. If there are 
multiple axes in the figure window, the current axes is the last graph created 
or the last graph you clicked on with the mouse. The following two sections 
provide more information and examples:

“Axis Limits and Ticks” on page 5-20

“Example — Specifying Ticks and Tick Labels” on page 5-23

Related Information
See Defining the View for more extensive information on manipulating 3-D 
views.

Axis Limits and Ticks
MATLAB selects axis limits based on the range of the plotted data. You can 
specify the limits manually using the axis command. Call axis with the new 
limits defined as a four-element vector.

axis([xmin,xmax,ymin,ymax])

Note that the minimum values must be less than the maximum values. 

Semiautomatic Limits
If you want MATLAB to autoscale only one of a min/max set of axis limits, but 
you want to specify the other, use the MATLAB variable Inf or −Inf for the 
autoscaled limit. For example, this graph uses default scaling.
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Compare the default limits to the following graph, which sets the maximum 
limit of the x-axis, but autoscales the minimum limit.

axis([−Inf 5 2 2.5])
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Axis Tick Marks
MATLAB selects the tick-mark locations based on the range of data so as to 
produce equally spaced ticks (for linear graphs). You can specify different tick 
marks by setting the axes XTick and YTick properties. Define tick marks as a 
vector of increasing values. The values do not need to be equally spaced.

For example, setting the y-axis tick marks for the graph from the preceding 
example,

set(gca,'ytick',[2 2.1 2.2 2.3 2.4 2.5])

produces a graph with only the specified ticks on the y-axis. 
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Note that if you specify tick-mark values that are outside the axis limits, 
MATLAB does not display them (that is, specifying tick marks cannot cause 
axis limits to change).

Example — Specifying Ticks and Tick Labels
You can adjust the axis tick-mark locations and the labels appearing at each 
tick mark. For example, this plot of the sine function relabels the x-axis with 
more meaningful values.

x = −pi:.1:pi;
y = sin(x);
plot(x,y)
set(gca,'XTick',−pi:pi/2:pi)
set(gca,'XTickLabel',{'−pi','−pi/2','0','pi/2','pi'})

These commands (xlabel, ylabel, title, text) add axis labels and draw an 
arrow that points to the location on the graph where y = sin(−pi/4).

xlabel('−\pi \leq \Theta \leq \pi')
ylabel('sin(\Theta)')
title('Plot of sin(\Theta)')
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text(−pi/4,sin(−pi/4),'\leftarrow sin(−\pi\div4)',...
'HorizontalAlignment','left')

Setting Line Properties on an Existing Plot
Change the line color to purple by first finding the handle of the line object 
created by plot and then setting its Color property. Use findobj and the fact 
that MATLAB creates a blue line (RGB value [0 0 1]) by default. In the same 
statement, set the LineWidth property to 2 points.

set(findobj(gca,'Type','line','Color',[0 0 1]),...
'Color',[0.5,0,0.5],'LineWidth',2)

The Greek symbols are created using TeX character sequences.

Setting Aspect Ratio
By default, MATLAB displays graphs in a rectangular axes that has the same 
aspect ratio as the figure window. This makes optimum use of space available 
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for plotting. MATLAB provides control over the aspect ratio with the axis 
command. 

For example,

t = 0:pi/20:2*pi;
plot(sin(t),2*cos(t))
grid on

produces a graph with the default aspect ratio. The command

axis square

makes the x- and y-axes equal in length.

The square axes has one data unit in x to equal two data units in y. If you want 
the x- and y-data units to be equal, use the command

axis equal

This produces an axes that is rectangular in shape, but has equal scaling along 
each axis.
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If you want the axes shape to conform to the plotted data, use the tight option 
in conjunction with equal.

axis equal tight
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Figure Windows
MATLAB directs graphics output to a window that is separate from the 
Command Window. In MATLAB this window is referred to as a figure. The 
characteristics of this window are controlled by your computer’s windowing 
system and MATLAB figure properties (see a description of each property). See 
“Figure Properties” on page 9-1 for some examples illustrating how to use 
figure properties.

Graphics functions automatically create new figure windows if none currently 
exist. If a figure already exists, MATLAB uses that window. If multiple figures 
exist, one is designated as the current figure and is used by MATLAB (this is 
generally the last figure used or the last figure you clicked the mouse in). 

The figure function creates figure windows. For example,

figure

creates a new window and makes it the current figure. You can make an 
existing figure current by clicking it with the mouse or by passing its handle 
(the number indicated in the window title bar), as an argument to figure.

figure(h)

Displaying Multiple Plots per Figure
You can display multiple plots in the same figure window and print them on 
the same piece of paper with the subplot function. 

subplot(m,n,i) breaks the figure window into an m-by-n matrix of small 
subplots and selects the ith subplot for the current plot. The plots are 
numbered along the top row of the figure window, then the second row, and so 
forth. 

For example, the following statements plot data in four different subregions of 
the figure window.

t = 0:pi/20:2*pi;
[x,y] = meshgrid(t);

subplot(2,2,1)
plot(sin(t),cos(t)) 
axis equal
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subplot(2,2,2)
z = sin(x)+cos(y);
plot(t,z)
axis([0 2*pi −2 2])

subplot(2,2,3)
z = sin(x).*cos(y);
plot(t,z)
axis([0 2*pi −1 1])

subplot(2,2,4)
z = (sin(x).^2)−(cos(y).^2);
plot(t,z)
axis([0 2*pi −1 1])



Figure Windows

5-29

Each subregion contains its own axes with characteristics you can control 
independently of the other subregions. This example uses the axis command 
to set limits and change the shape of the subplots.

See the axes, axis, and subplot functions for more information.

Specifying the Target Axes
The current axes is the last one defined by subplot. If you want to access a 
previously defined subplot, for example to add a title, you must first make that 
axes current. 

You can make an axes current in three ways:

• Click on the subplot with the mouse.

• Call subplot the m, n, i specifiers.

• Call subplot with the handle (identifier) of the axes.

For example,

subplot(2,2,2)
title('Top Right Plot')

adds a title to the plot in the upper right side of the figure.

You can obtain the handles of all the subplot axes with the statement

h = get(gcf,'Children');

MATLAB returns the handles of all the axes, with the most recently created 
one first. That is, h(1) is subplot 224, h(2) is subplot 223, h(3) is subplot 222, 
and h(4) is subplot 221. For example, to replace subplot 222 with a new plot, 
first make it the current axes with

subplot(h(3))

Default Color Scheme
The default figure color scheme produces good contrast and visibility for the 
various graphics functions. This scheme defines colors for the window 
background, the axis background, the axis lines and labels, the colors of the 
lines used for plotting and surface edges, and other properties that affect 
appearance. 
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The colordef function enables you to select from predefined color schemes and 
to modify colors individually. colordef predefines three color schemes:

• colordef white — Sets the axis background color to white, the window 
background color to gray, the colormap to jet, surface edge colors to black, 
and defines appropriate values for the plotting color order and other 
properties.

• colordef black — Sets the axis background color to black, the window 
background color to dark gray, the colormap to jet, surface edge colors to 
black, and defines appropriate values for the plotting color order and other 
properties.

• colordef none — Set the colors to match that of MATLAB 4. This is 
basically a black background with white axis lines and no grid. MATLAB 
programs that are based on the MATLAB 4 color scheme may need to call 
colordef with the none option to produce the expected results.

You can examine the colordef.m M-file to determine what properties it sets 
(enter type colordef at the MATLAB prompt). 
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Overview
MATLAB provides commands for reading, writing, and displaying several 
types of graphics file formats for images. As with MATLAB-generated images, 
once a graphics file format image is displayed, it becomes a Handle Graphics 
image object. MATLAB supports the following graphics file formats:

• BMP (Microsoft Windows Bitmap)

• HDF (Hierarchical Data Format)

• JPEG (Joint Photographic Experts Group)

• PCX (Paintbrush)

• PNG (Portable Network Graphics)

• TIFF (Tagged Image File Format)

• XWD (X Window Dump)

For information concerning the bit depths and image types supported for these 
formats, see imread and imwrite.

MATLAB supports three different numeric classes for image display: 
double-precision floating-point (double), 16-bit unsigned integer (uint16), and 
8-bit unsigned integer (uint8). The image display commands interpret data 
values differently depending on the numeric class the data is stored in.

This chapter discusses the different data and image types you can use, and 
includes details on how to read, write, work with, and display graphics images; 
how to alter the display properties and aspect ratio of an image during display; 
how to print an image; and how to convert the data type or graphics format of 
an image.

This table lists the functions discussed in this chapter.

Function Purpose Function Group

axis Plot axis scaling and appearance Display

image Display image (create image object) Display

imagesc Scale data and display as image Display

imread Read image from graphics file File I/O
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imwrite Write image to graphics file File I/O

imfinfo Get image information from graphics file Utility

ind2rgb Convert indexed image to RGB image Utility

Function Purpose Function Group
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Images in MATLAB
The basic data structure in MATLAB is the array, an ordered set of real or 
complex elements. This object is naturally suited to the representation of 
images, real-valued, ordered sets of color or intensity data. (MATLAB does not 
support complex-valued images.)

MATLAB stores most images as two-dimensional arrays (i.e., matrices), in 
which each element of the matrix corresponds to a single pixel in the displayed 
image. For example, an image composed of 200 rows and 300 columns of 
different colored dots would be stored in MATLAB as a 200-by-300 matrix. 
Some images, such as RGB, require a three-dimensional array, where the first 
plane in the third dimension represents the red pixel intensities, the second 
plane represents the green pixel intensities, and the third plane represents the 
blue pixel intensities.

This convention makes working with graphics file format images in MATLAB 
similar to working with any other type of matrix data. For example, you can 
select a single pixel from an image matrix using normal matrix subscripting.

I(2,15)

This command returns the value of the pixel at row 2, column 15 of the image I. 

Bit Depth Support
MATLAB supports reading the most commonly used bit depths (bits per pixel) 
of any of the supported graphics file formats. When the data is in memory, it 
can be stored as uint8, uint16, or double. For details on which bit depths are 
appropriate for each supported format, see imread and imwrite.

Data Types
This section introduces you to the different data types that MATLAB uses to 
store images. Details on the inner workings of the storage for 8- and 16-bit 
images are included in “Working with 8-Bit and 16-Bit Images” on page 6-11.

By default, MATLAB stores most data in arrays of class double. The data in 
these arrays is stored as double-precision (64-bit) floating-point numbers. All 
MATLAB functions and capabilities work with these arrays.

For images stored in one of the graphics file formats supported by MATLAB, 
however, this data representation is not always ideal. The number of pixels in 
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such an image can be very large; for example, a 1000-by-1000 image has a 
million pixels. Since each pixel is represented by at least one array element, 
this image would require about 8 megabytes of memory if it were stored as 
class double.

To reduce memory requirements, MATLAB supports storing image data in 
arrays of class uint8 and uint16. The data in these arrays is stored as 8-bit or 
16-bit unsigned integers. These arrays require one-eighth or one-fourth as 
much memory as data in double arrays.
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Image Types
In MATLAB, an image consists of a data matrix and possibly a colormap 
matrix. Three basic image types are used in MATLAB, each differing in the 
way that the data matrix elements are interpreted:

• Indexed images

• Intensity (or grayscale) images

• RGB (or truecolor) images

This section discusses how MATLAB represents each of these image types.

Indexed Images
An indexed image consists of a data matrix, X, and a colormap matrix, map. map 
is an m-by-3 array of class double containing floating-point values in the range 
[0, 1]. Each row of map specifies the red, green, and blue components of a single 
color. An indexed image uses “direct mapping” of pixel values to colormap 
values. The color of each image pixel is determined by using the corresponding 
value of X as an index into map. The value 1 points to the first row in map, the 
value 2 points to the second row, and so on. You can display an indexed image 
with the statements

image(X); colormap(map)

A colormap is often stored with an indexed image and is automatically loaded 
with the image when you use the imread function. However, you are not limited 
to using the default colormap—you can use any colormap that you choose. The 
description for the property CDataMapping describes how to alter the type of 
mapping used.

The next figure illustrates the structure of an indexed image. The pixels in the 
image are represented by integers, which are pointers (indices) to color values 
stored in the colormap.
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The relationship between the values in the image matrix and the colormap 
depends on the class of the image matrix. If the image matrix is of class double, 
the value 1 points to the first row in the colormap, the value 2 points to the 
second row, and so on. If the image matrix is of class uint8 or uint16, there is 
an offset— the value 0 points to the first row in the colormap, the value 1 points 
to the second row, and so on. The offset is also used in graphics file formats, to 
maximize the number of colors that can be supported. In the image above, the 
image matrix is of class double. Because there is no offset, the value 5 points 
to the fifth row of the colormap.

Intensity Images
An intensity image is a data matrix, I, whose values represent intensities 
within some range. MATLAB stores an intensity image as a single matrix, with 
each element of the matrix corresponding to one image pixel. The matrix can 
be of class double, uint8, or uint16. While intensity images are rarely saved 
with a colormap, MATLAB uses a colormap to display them. In essence, 
MATLAB handles intensity images as indexed images. 

This figure depicts an intensity image of class double.
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To display an intensity image, use the imagesc (“image scale”) function, which 
enables you to set the range of intensity values. imagesc scales the image data 
to use the full colormap. Use the two-input form of imagesc to display an 
intensity image. For example,

imagesc(I,[0 1]); colormap(gray);

The second input argument to imagesc specifies the desired intensity range. 
The function imagesc displays I by mapping the first value in the range 
(usually 0) to the first colormap entry, and the second value (usually 1) to the 
last colormap entry. Values in between are linearly distributed throughout the 
remaining colormap colors. 

Although it is conventional to display intensity images using a grayscale 
colormap, it is possible to use other colormaps. For example, the following 
statements display the intensity image I in shades of blue and green.

imagesc(I,[0 1]); colormap(winter);

To display a matrix A with an arbitrary range of values as an intensity image, 
use the single-argument form of imagesc. With one input argument, imagesc 
maps the minimum value of the data matrix to the first colormap entry, and 

 0.5342  0.2051  0.2157  0.2826  0.3822  0.4391  0.4391
 0.5342  0.2251  0.2563  0.2826  0.2826  0.4391  0.4391
 0.5342  0.1789  0.1307  0.1789  0.2051  0.3256  0.2483
 0.4308  0.2483  0.2624  0.3344  0.3344  0.2624  0.2549
 0.4510  0.3344  0.2624  0.3344  0.3344  0.3344  0.3344
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maps the maximum value to the last colormap entry. For example, these two 
lines are equivalent.

imagesc(A); colormap(gray)
imagesc(A,[min(A(:)) max(A(:))]); colormap(gray)

RGB (Truecolor) Images
An RGB image, sometimes referred to as a “truecolor” image, is stored in 
MATLAB as an m-by-n-by-3 data array that defines red, green, and blue color 
components for each individual pixel. RGB images do not use a palette. The 
color of each pixel is determined by the combination of the red, green, and blue 
intensities stored in each color plane at the pixel’s location. Graphics file 
formats store RGB images as 24-bit images, where the red, green, and blue 
components are 8 bits each. This yields a potential of 16 million colors. The 
precision with which a real-life image can be replicated has led to the nickname 
“truecolor image.”

An RGB MATLAB array can be of class double, uint8, or uint16. In an RGB 
array of class double, each color component is a value between 0 and 1. A pixel 
whose color components are (0,0,0) is displayed as black, and a pixel whose 
color components are (1,1,1) is displayed as white. The three color components 
for each pixel are stored along the third dimension of the data array. For 
example, the red, green, and blue color components of the pixel (10,5) are stored 
in RGB(10,5,1), RGB(10,5,2), and RGB(10,5,3), respectively.

To display the truecolor image RGB, use the image function. For example,

image(RGB)

The next figure shows an RGB image of class double.
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To determine the color of the pixel at (2,3), you would look at the RGB triplet 
stored in (2,3,1:3). Suppose (2,3,1) contains the value 0.5176, (2,3,2) contains 
0.1608, and (2,3,3) contains 0.0627. The color for the pixel at (2,3) is

0.5176 0.1608 0.0627

  0.5804  0.2235  0.1294  0.2902  0.4196  0.4824  0.4824
  0.5804  0.2902  0.0627  0.2902  0.2902  0.4824  0.4824
  0.5804  0.0627  0.0627  0.0627  0.2235  0.2588  0.2588
  0.5176  0.2588  0.0627  0.0941  0.0941  0.0627  0.0627
  0.4510  0.0941  0.0627  0.0941  0.0941  0.0941  0.0941

  0.5176  0.1922  0.0627  0.1294  0.1922  0.2588  0.2588
  0.5176  0.1294  0.1608  0.1294  0.1294  0.2588  0.2588
  0.5176  0.1608  0.0627  0.1608  0.1922  0.2588  0.2588
  0.4196  0.2588  0.3529  0.4196  0.4196  0.3529  0.2902
  0.4510  0.4196  0.3529  0.4196  0.4196  0.4196  0.4196

 0.5490  0.2235  0.5490  0.5804  0.7412  0.7765  0.7765
 0.5490  0.3882  0.5176  0.5804  0.5804  0.7765  0.7765
 0.5490  0.2588  0.2902  0.2588  0.2235  0.4824  0.2235
 0.4196  0.2235  0.1608  0.2588  0.2588  0.1608  0.2588
 0.4510  0.2588  0.1608  0.2588  0.2588  0.2588  0.2588

Red

Green

Blue
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Working with 8-Bit and 16-Bit Images
MATLAB usually works with double-precision (64-bit) floating-point numbers. 
However, to reduce memory requirements for working with images, MATLAB 
provides support for storing images as 8-bit or 16-bit unsigned integers by 
using the numeric classes uint8 or uint16, respectively. An image whose data 
matrix has class uint8 is called an 8-bit image; an image whose data matrix 
has class uint16 is called a 16-bit image.

The image function can display 8- or 16-bit images directly without converting 
them to double precision. However, image interprets matrix values slightly 
differently when the image matrix is uint8 or uint16. The specific 
interpretation depends on the image type. 

8-Bit and 16-Bit Indexed Images
If the class of X is uint8 or uint16, its values are offset by 1 before being used 
as colormap indices. The value 0 points to the first row of the colormap, the 
value 1 points to the second row, and so on. The image command automatically 
supplies the proper offset, so the display method is the same whether X is 
double, uint8, or uint16.

image(X); colormap(map);

The colormap index offset for uint8 and uint16 data is intended to support 
standard graphics file formats, which typically store image data in indexed 
form with a 256-entry colormap. The offset allows you to manipulate and 
display images of this form in MATLAB using the more memory-efficient uint8 
and uint16 arrays.

Because of the offset, you must add 1 to convert a uint8 or uint16 indexed 
image to double. For example,

X64 = double(X8) + 1;
or

X64 = double(X16) + 1;

Conversely, subtract 1 to convert a double indexed image to uint8 or uint16.

X8 = uint8(X64 - 1);
or

X16 = uint16(X64 - 1);
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8-Bit and 16-Bit Intensity Images
Whereas the range of double image arrays is usually [0, 1], the range of 8-bit 
intensity images is usually [0, 255] and the range of 16-bit intensity images is 
usually [0, 65535]. Use the following command to display an 8-bit intensity 
image with a grayscale colormap.

imagesc(I,[0 255]); colormap(gray);

To convert an intensity image from double to uint16, first multiply by 65535.

I16 = uint16(round(I64*65535));

Conversely, divide by 65535 after converting a uint16 intensity image to 
double.

I64 = double(I16)/65535;

8-Bit and 16-Bit RGB Images
The color components of an 8-bit RGB image are integers in the range [0, 255] 
rather than floating-point values in the range [0, 1]. A pixel whose color 
components are (255,255,255) is displayed as white. The image command 
displays an RGB image correctly whether its class is double, uint8, or uint16.

image(RGB);

To convert an RGB image from double to uint8, first multiply by 255.

RGB8 = uint8(round(RGB64*255));

Conversely, divide by 255 after converting a uint8 RGB image to double.

RGB64 = double(RGB8)/255

To convert an RGB image from double to uint16, first multiply by 65535.

RGB16 = uint16(round(RGB64*65535));

Conversely, divide by 65535 after converting a uint16 RGB image to double.

RGB64 = double(RGB16)/65535;
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Mathematical Operations Support for uint8 and 
uint16
To use the following MATLAB functions with uint8 and uint16 data, first 
convert the data to type double: conv2, convn, fft2, fftn. For example, if X is 
a uint8 image, cast the data to type double:

fft(double(X))

In these cases, the output is always double.

The sum function returns results in the same type as its input, but provides an 
option to use double precision for calculations. 

Integer Mathematics in MATLAB
See Arithmetic Operations on Integer Data Types for more information on how 
mathematical functions work with data types that are not doubles. 

Most of the functions in the Image Processing Toolbox accept uint8 and uint16 
input. If you plan to do sophisticated image processing on uint8 or uint16 data, 
you should consider adding the Image Processing Toolbox to your MATLAB 
computing environment.

Other 8-Bit and 16-Bit Array Support
MATLAB supports several other operations on uint8 and uint16 arrays, 
including

• Reshaping, reordering, and concatenating arrays using the functions 
reshape, cat, permute, and the [] and ' operators

• Saving and loading uint8 and uint16 arrays in MAT-files using save and 
load. (Remember that if you are loading or saving a graphics file format 
image, you must use the commands imread and imwrite instead.)

• Locating the indices of nonzero elements in uint8 and uint16 arrays using 
find. However, the returned array is always of class double.

• Relational operators
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Converting an 8-Bit RGB Image to Grayscale
MATLAB can perform arithmetic operations on integer data, which enables 
you to convert image types without first converting the numeric class of the 
image data.

This example reads an 8-bit RGB image into MATLAB and converts it to a 
grayscale image. 

rgb_img = imread('ngc6543a.jpg'); % Load the image
image(rgb_img) % Display the RGB image

Now calculate the monochrome luminance by combining the RGB values 
according to the NTSC standard, which applies coefficients related to the eye’s 
sensitivity to RGB colors.

I = .2989*rgb_img(:,:,1)...
+.5870*rgb_img(:,:,2)...
+.1140*rgb_img(:,:,3);

I is an intensity image with integer values ranging from a minimum of zero,

min(I(:))
ans =

0
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to a maximum of 255,

max(I(:))
ans = 

255

To display the image, use a grayscale colormap with 256 values. This avoids the 
need to scale the data-to-color mapping, which would be required if you used a 
colormap of a different size. You can use the imagesc function in cases where 
the colormap does not contain one entry for each data value.

Now display the image in a new figure using the gray colormap. 

figure; colormap(gray(256)); image(I)

Related Information
Other colormaps with a range of colors that vary continuously from dark to 
light can produce usable images. For example, try colormap(summer(256)) for 
a classic oscilloscope look. See colormap for more choices.

The brighten function enables you to increase or decrease the color intensities 
in a colormap to compensate for computer display differences or to enhance the 
visibility of faint or bright regions of the image (at the expense of the opposite 
end of the range). 
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Summary of Image Types and Numeric Classes
This table summarizes the way MATLAB interprets data matrix elements as 
pixel colors, depending on the image type and data class.

Image Type double Data uint8 or uint16 Data

Indexed Image is an m-by-n array of 
integers in the range [1, p]. 

Colormap is a p-by-3 array 
of floating-point values in 
the range [0, 1].

Image is an m-by-n array of 
integers in the range
 [0, p  – 1]. 

Colormap is a p-by-3 array 
of floating-point values in 
the range [0, 1]. 

Intensity Image is an m-by-n array of 
floating-point values that 
are linearly scaled by 
MATLAB to produce 
colormap indices. Typical 
range of values is [0, 1].

Colormap is a p-by-3 array 
of floating-point values in 
the range [0, 1] and is 
typically grayscale.

Image is an m-by-n array of 
integers that are linearly 
scaled by MATLAB to 
produce colormap indices. 
The typical range of values 
is [0, 255] or [0, 65535]. 

Colormap is a p-by-3 array 
of floating-point values in 
the range [0, 1] and is 
typically grayscale.

RGB 
(Truecolor)

Image is an m-by-n-by-3 
array of floating-point 
values in the range [0, 1]. 

Image is an m-by-n-by-3 
array of integers in the 
range [0, 255] or [0, 65535]. 
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Reading, Writing, and Querying Graphics Image Files
In its native form, a graphics file format image is not stored as a MATLAB 
matrix, or even necessarily as a matrix. Most graphics files begin with a header 
containing format-specific information tags, and continue with bitmap data 
that can be read as a continuous stream. For this reason, you cannot use the 
standard MATLAB I/O commands load and save to read and write a graphics 
file format image.

MATLAB provides special functions for reading and writing image data from 
graphics file formats. To read a graphics file format image use imread; to write 
a graphics file format image, use imwrite; to obtain information about the 
nature of a graphics file format image, use imfinfo.

This table gives a clearer picture of which MATLAB commands should be used 
with which image types.

Reading a Graphics Image
The function imread reads an image from any supported graphics image file in 
any of the supported bit depths. Most of the images that you will read are 8-bit. 
When these are read into memory, MATLAB stores them as class uint8. The 
main exception to this rule is that MATLAB supports 16-bit data for PNG and 
TIFF images. If you read a 16-bit PNG or TIFF image, it is stored as class 
uint16.

Procedure Functions to Use

Load or save a matrix as a MAT-file load

save

Load or save graphics file format image, e.g. 
BMP, TIFF

imread

imwrite

Display any image loaded into MATLAB image

imagesc

Utilities imfinfo

ind2rgb
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Note  For indexed images, imread always reads the colormap into an array of 
class double, even though the image array itself can be of class uint8 or 
uint16.

The following statement reads the image ngc6543a.jpg into the workspace 
variable RGB and then displays the image using the image function.

RGB = imread('ngc6543a.jpg');
image(RGB)

You can write (save) image data using the imwrite function. The statements

load clown % An image that is included with MATLAB
imwrite(X,map,'clown.bmp')

create a BMP file containing the clown image.

Writing a Graphics Image
When you save an image using imwrite, the default behavior is to 
automatically reduce the bit depth to uint8. Many of the images used in 
MATLAB are 8-bit, and most graphics file format images do not require 
double-precision data. One exception to the MATLAB rule for saving the image 
data as uint8 is that PNG and TIFF images can be saved as uint16. Because 
these two formats support 16-bit data, you can override the MATLAB default 
behavior by specifying uint16 as the data type for imwrite. The following 
example shows writing a 16-bit PNG file using imwrite.

imwrite(I,'clown.png','BitDepth',16);

Subsetting a Graphics Image (Cropping)
Sometimes you want to work with only a portion of an image file or would like 
to break it up into subsections. You can specify the pixel coordinates of the 
rectangular subsection you want to work with and save it to a file from the 
command line. If you do not know the coordinates of the corner points of the 
subsection, you can choose them interactively, as the following example shows:

% Read demo RGB image from graphics file. 
im = imread('street2.jpg'); 
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% Display image with true aspect ratio
image(im); axis image

% Use ginput to select corner points of a rectangular
% region by pointing and clicking the mouse twice
p = ginput(2); 

% Get the x and y corner coordinates as integers
sp(1) = min(floor(p(1)), floor(p(2))); %xmin
sp(2) = min(floor(p(3)), floor(p(4))); %ymin
sp(3) = max(ceil(p(1)), ceil(p(2))); %xmax
sp(4) = max(ceil(p(3)), ceil(p(4))); %ymax

% Index into the original image to create the new image
MM = im(sp(2):sp(4), sp(1): sp(3),:);

% Display the subsetted image with appropriate axis ratio
figure; image(MM); axis image

% Write image to graphics file. 
imwrite(MM,'street2_cropped.tif') 

If you knew what the image corner coordinates should be, you could manually 
define sp in the above example rather than using ginput.

You can also make MATLAB display a “rubber band box” as you interact with 
the image to subset it. See the code example for rbbox for details. For further 
information, see the documentation for the MATLAB functions ginput and 
image.

Obtaining Information About Graphics Files 
The imfinfo function enables you to obtain information about graphics files in 
any of the standard formats listed above. The information you obtain depends 
on the type of file, but it always includes at least the following:

• Name of the file, including the directory path if the file is not in the current 
directory

• File format
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• Version number of the file format

• File modification date

• File size in bytes

• Image width in pixels

• Image height in pixels

• Number of bits per pixel

• Image type: RGB (truecolor), intensity (grayscale), or indexed
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Displaying Graphics Images
To display a graphics file image, use either image or imagesc. For example, 
assuming RGB is an image, 

figure('Position',[100 100 size(RGB,2) size(RGB,1)]);
image(RGB); set(gca,'Position',[0 0 1 1])

(This image was created with the support of the Space Telescope Science 
Institute, operated by the Association of Universities for Research in 
Astronomy, Inc., from NASA contract NAs5-26555, and is reproduced with 
permission from AURA/STScI. Digital renditions of images produced by 
AURA/STScI are obtainable royalty-free. Credits: J.P. Harrington and K.J. 
Orkowski (University of Maryland), and NASA.)
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Summary of Image Types and Display Methods
This table summarizes display methods for the three types of images. 

Controlling Aspect Ratio and Display Size
The image function displays the image in a default-sized figure and axes. 
MATLAB stretches or shrinks the image to fit the display area. Sometimes you 
want the aspect ratio of the display to match the aspect ratio of the image data 
matrix. The easiest way to do this is with the command axis image.

For example, these commands display the earth image in the demos directory 
using the default figure and axes positions.

load earth
image(X); colormap(map)

Image Type Display Commands Uses Colormap 
Colors

Indexed image(X); colormap(map) Yes

Intensity imagesc(I,[0 1]); colormap(gray) Yes

RGB 
(truecolor)

image(RGB) No
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The elongated globe results from stretching the image display to fit the axes 
position. Use the axis image command to force the aspect ratio to be one-to-one.

axis image
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The command axis image works by setting the DataAspectRatio property of 
the axes object to [1 1 1]. See axis and axes for more information on how to 
control the appearance of axes objects.

Sometimes you might want to display an image so that each element in the 
data matrix corresponds to a single screen pixel. To display an image with this 
one-to-one matrix-element-to-screen-pixel mapping, you need to resize the 
figure and axes. For example, these commands display the earth image so that 
one data element corresponds to one screen pixel.

[m,n] = size(X);
figure('Units','pixels','Position',[100 100 n m])
image(X); colormap(map)
set(gca,'Position',[0 0 1 1])
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The figure’s Position property is a four-element vector that specifies the 
figure's location on the screen as well as its size. The second statement above 
positions the figure so that its lower left corner is at position (100,100) on the 
screen and so that its width and height match the image width and height. 
Setting the axes position to [0 0 1 1] in normalized units creates an axes that 
fills the figure. The resulting picture is shown.

0
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0

0
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The Image Object and Its Properties
The commands image and imagesc create image objects. Image objects are 
children of axes objects, as are line, patch, surface, and text objects. Like all 
Handle Graphics objects, the image object has a number of properties you can 
set to fine-tune its appearance on the screen. The most important properties of 
the image object with respect to appearance are CData, CDataMapping, XData, 
YData, and EraseMode. For detailed information about these and all the 
properties of the image object, see image.

Image CData
The CData property of an image object contains the data array. In the 
commands below, h is the handle of the image object created by image, and the 
matrices X and Y are the same.

h = image(X); colormap(map)
Y = get(h,'CData');

The dimensionality of the CData array controls whether MATLAB displays the 
image using colormap colors or as an RGB image. If the CData array is 
two-dimensional, then the image is either an indexed image or an intensity 
image, and in either case the image is displayed using colormap colors. If, on 
the other hand, the CData array is m-by-n-by-3, then MATLAB displays it as a 
truecolor image, ignoring the colormap colors.

Image CDataMapping
The CDataMapping property controls whether an image is indexed or intensity. 
An indexed image is displayed by setting the CDataMapping property to 
'direct', in which case the values of the CData array are used directly as 
indices into the figure’s colormap. When the image command is used with a 
single input argument, it sets the value of CDataMapping to 'direct'.

h = image(X); colormap(map)
get(h,'CDataMapping')
ans =

direct

Intensity images are displayed by setting the CDataMapping property to 
'scaled'. In this case the CData values are linearly scaled to form colormap 
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indices. The scale factors are controlled by the axes CLim property. The imagesc 
function creates an image object whose CDataMapping property is set to 
'scaled', and it also adjusts the CLim property of the parent axes. For 
example,

h = imagesc(I,[0 1]); colormap(map)
get(h,'CDataMapping')
ans =

scaled

get(gca,'CLim')
ans =

[0 1]

XData and YData
The XData and YData properties control the coordinate system of the image. For 
an m-by-n image, the default XData is [1 n] and the default YData is [1 m]. 
These settings imply the following:

• The left column of the image has an x-coordinate of 1.

• The right column of the image has an x-coordinate of n.

• The top row of the image has a y-coordinate of 1.

• The bottom row of the image has a y-coordinate of m.

For example, the statements

X = [1 2 3 4; 5 6 7 8; 9 10 11 12];
h = image(X); colormap(colorcube(12))
xlabel x; ylabel y

produce the following picture.
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The XData and YData properties of the resulting image object have the default 
values shown below.

get(h,'XData')
ans =

     1     4

get(h,'YData')
ans =

     1     3

However, you can override the default settings to specify your own coordinate 
system. For example, the statements

X = [1 2 3 4; 5 6 7 8; 9 10 11 12];
image(X,'XData',[−1 2],'YData',[2 4]); colormap(colorcube(12))
xlabel x; ylabel y
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produce the following picture.

EraseMode
The EraseMode property controls how MATLAB updates the image on the 
screen if the image object’s CData property changes. The default setting of 
EraseMode is 'normal'. With this setting, if you change the CData of the image 
object using the set command, MATLAB erases the image on the screen before 
redrawing the image using the new CData array. The erase step is a problem if 
you want to display a series of images quickly and smoothly.

You can achieve fast and visually smooth updates of displayed images as you 
change the image CData by setting the image object EraseMode property to 
'none'. With this setting, MATLAB does not take the time to erase the 
displayed image — it immediately draws the updated image when the CData 
changes.
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Suppose, for example, that you have an m-by-n-by-3-by-x array A, containing x 
different truecolor images of the same size. You can display them dynamically 
with

h = image(A(:,:,:,1),'EraseMode','none');
for i = 2:x
    set(h,'CData',A(:,:,:,i))
    drawnow
end

Rather than creating a new image object each time through the loop, this code 
simply changes the CData of the image object (which was created on the first 
line using the image command). The drawnow command causes MATLAB to 
update the display with each pass though the loop. Because the image 
EraseMode is set to 'none', changes to the CData do not cause the image on the 
screen to be erased each time through the loop.

Adding Text to Images
You can use basic array indexing to rasterize text strings into an existing 
image, as follows: 

Draw the text strings using text, and then capture a bitmapped version of 
them using getframe. Then find the black pixels and convert their subscripts 
to indexes using sub2ind. Use these subscripts to “paint” the text into the 
image into which you want to add the text string, then save that image. Here 
is an example using the image in the demo MAT-file mandrill.mat:

% Create the text in an axis:
t = text(.05,.1,'Mandrill Face', ...

'FontSize',12, 'FontWeight','demi');

% Capture the text from the screen:
F = getframe(gca,[10 10 200 200]);

% Close the figure:
close

% Select any plane of the resulting RGB image:
c = F.cdata(:,:,1);

% Note: If you have the Image Processing Toolbox installed,
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% you can convert the RGB data from the frame to black or white:
% c = rgb2ind(F.cdata,2);

% Determine where the text was (black is 0):
[i,j] = find(c == 0);

% Read in or load the image that is to contain the text:
load mandrill

% Use the size of that image, plus the row/column locations
% of the text, to determine locations in the new image:
ind = sub2ind(size(X),i,j);

% Index into new image, replacing pixels with white:
X(ind) = uint8(255);

% Display and color the new image:
imagesc(X)
axis image
colormap(bone)
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Additional Techniques for Fast Image Updating
To increase the rate at which MATLAB can update the CData property of an 
image object you can optimize CData and set some related figure and axes 
properties:

• Use the smallest datatype possible. Using a uint8 datatype for your image 
will be faster than using a double datatype. 

Part of the process of setting the image's CData property includes copying the 
matrix for the image's use. The overall size of the matrix is dependent on the 
size of its individual elements. Using smaller individual elements (i.e., a 
smaller datatype) decreases matrix size,and reduces the amount of time 
needed to copy the matrix.

• Use the smallest acceptable matrix. 

If the speed at which the image is displayed is your highest priority, you may 
need to compromise on the size and quality of the image. Again, decreasing 
the size will reduce the time needed to copy the matrix. 

• Make the axes exactly the same size (in pixels) as the CData matrix.

Maintaining a one-to-one correspondence between the data and the onscreen 
pixels will eliminate the need for interpolation. For example:
set(gca,'Units','pixels')
pos = get(gca,'Position')
width = pos(3);
height = pos(4);

When the size of your CData exactly equals [width height], each element of 
the array corresponds directly to a pixel. Otherwise, MATLAB must 
interpolate the values in the "CData" array, so it will fit the axes at their 
current size.

• Set the limit mode properties (XLimMode and YLimMode) of your axes to 
manual. 

If they are set to auto, then every time an object (such as an image, line, 
patch, etc.) changes some aspect of its data, the axes must recalculate its 
related properties. For example, if you specify
image(firstimage);
set(gca, 'xlimmode','manual',...
'ylimmode','manual',...
'zlimmode','manual',...
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'climmode','manual',...
'alimmode','manual');

the axes will not recalculate any of the limit values before redrawing the 
image.

• Set the figure's DoubleBuffer property to off.
set(gcf,'doublebuffer','off');

Set the DoubleBuffer property on for to obtain flicker-free animation. 
However, to maximize rendering speed, set DoubleBuffer to off.

• Alternately, you might consider using a movie object if the main point of your 
task is to simply display a series of images onscreen. 

The MATLAB movie object utilizes underlying system graphics resources 
directly, instead of gexecuting MATLAB object code. This is faster than 
repeatedly setting an image's CData property, as outlined above.
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Printing Images
When you set the axes Position to [0 0 1 1] so that it fills the entire figure, 
the aspect ratio is not preserved when you print because MATLAB adjusts the 
figure size when printing according to the figure’s PaperPosition property. To 
preserve the image aspect ratio when printing, set the figure’s 
PaperPositionMode to 'auto' from the command line.

set(gcf,'PaperPositionMode','auto')
print

When PaperPositionMode is set to 'auto', the width and height of the printed 
figure are determined by the figure’s dimensions on the screen, and the figure 
position is adjusted to center the figure on the page. If you want the default 
value of PaperPositionMode to be 'auto', enter this line in your startup.m 
file.

set(0,'DefaultFigurePaperPositionMode','auto')

Printed images may not always be the same size as they are on your monitor. 
The size depends on accurately specifying the numbers of pixels per inch that 
you monitor is displaying. 

To specify the pixels-per-inch on your display, you need to do the following (in 
Windows):

1 Go into your Display Properties by right-clicking on an empty space on your 
desktop and choose Properties.

2 Click the Settings pane

3 Click the Advanced pushbutton and choose the General pane

4 Switch DPI setting to Custom setting and hold a real ruler up to the picture 
of the ruler on the screen and drag until they match.

Until you do this, neither MATLAB nor any other software can determine how 
big images on the screen are, and printed images cannot match the size. 

Note that on the Macintosh platform, pixels per inch is hard-coded to 72.



Converting the Data or Graphic Type of Images

6-35

Converting the Data or Graphic Type of Images
Converting between data types changes the way MATLAB interprets the 
image data. If you want the resulting array to be interpreted properly as image 
data, you need to rescale or offset the data when you convert it. (See the earlier 
sections “Image Types” on page 6-6 and “8-Bit and 16-Bit Indexed Images” on 
page 6-11 for more information about offsets.)

For certain operations, it is helpful to convert an image to a different image 
type. For example, if you want to filter a color image that is stored as an 
indexed image, you should first convert it to RGB format. To do this efficiently, 
use the ind2rgb function, which originated in the Image Processing Toolbox. 
When you apply the filter to the RGB image, MATLAB filters the intensity 
values in the image, as is appropriate. If you attempt to filter the indexed 
image, MATLAB simply applies the filter to the indices in the indexed image 
matrix, and the results may not be meaningful.

You can also perform certain conversions just using MATLAB syntax. For 
example, if you want to convert a grayscale image to RGB, you can concatenate 
three copies of the original matrix along the third dimension.

RGB = cat(3,I,I,I);

The resulting RGB image has identical matrices for the red, green, and blue 
planes, so the image is displayed as shades of gray.

Sometimes you will want to change the graphics format of an image, perhaps 
for compatibility with another software product. This process is very 
straightforward. For example, to convert an image from a BMP to a PNG, load 
the BMP using imread, set the data type to uint8, uint16, or double, and then 
save the image using imwrite, with 'PNG' specified as your target format. See 
imread and imwrite for the specifics of which bit depths are supported for the 
different graphics formats, and for how to specify the format type when writing 
an image to file.
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Overview of Printing and Exporting
This section is an introduction to the graphics printing capabilities provided 
with MATLAB and how to make use of them. It covers

• “Print and Export Operations”

• “Graphical User Interfaces”

• “Command Line Interface” on page 7-3

• “Specifying Parameters and Options” on page 7-5

• “Default Settings and How to Change Them” on page 7-6

Print and Export Operations
There are four basic operations that you can perform in printing or transferring 
figures you’ve created in MATLAB. 

Graphical User Interfaces
You interact with the MATLAB print and export tools using either Microsoft 
Windows or UNIX graphical user interfaces or with MATLAB commands. The 
table below lists the dialog boxes you need to print and export and summarizes 
how to open them from the figure window.

Operation Description

Print Send a figure from the screen directly to the printer.

Print to File Write a figure to a PostScript file to be printed later.

Export to 
File

Export a figure in graphics format to a file, so that you can 
import it into an application.

Export to 
Clipboard

Copy a figure to the Windows clipboard, so that you can 
paste it into an application.
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You can open the Print, Page Setup, and Print Preview dialog boxes from a 
program or from the command line with the printdlg, pagesetupdlg, and 
printpreview functions.

Command Line Interface
You can print a MATLAB figure from the command line or from a program. Use 
the set function to set the properties that control how the printed figure looks. 
Use the print function to start the print or export operation.

Dialog Box How to Open Description

Print
(Windows and 
UNIX)

File->Print or
printdlg function

Send figure to the printer, select 
the printer, print to file, and 
several other options

Printing 
Options

Click Options on 
UNIX Print dialog

Set some of the most commonly 
used print settings (UNIX only)

Page Setup File->Page Setup
or pagesetupdlg 
function

Set properties to be associated 
with the figure when printed or 
exported

Print Preview File->Print Preview
or printpreview 
function

View and adjust the final output

Export File->Export Export the figure in graphics 
format to a file

Copy Options Edit->Copy Options Set format, figure size, and 
background color for Copy to 
Clipboard

Figure Copy 
Template

File->Preferences Change text, line, axes, and UI 
control properties
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Modifying Properties with set
The set function changes the values of properties that control the look of a 
figure. These properties are stored with the figure. When you change one of the 
properties, the new value is saved with the figure and affects the look of the 
figure each time you print it until you change the setting again.

To change the print properties of the current figure, the set command has the 
form

set(gcf, 'Property1', value1, 'Property2', value2, ...)

where gcf is a call that returns the handle of the current figure, and each 
property-value pair consists of a named property followed by the value to which 
the property is set.

For example,

set(gcf, 'PaperUnits', 'centimeters', 'PaperType', 'A4', ...)

sets the units of measure and the paper size. “Changing a Figure’s Settings” on 
page 7-38 describes commonly used print properties. The Figure Properties 
reference page contains a complete list of the properties.

Examining Properties with get
You can also use the get function to retrieve the value of a specific property.

a = get(gcf, 'Property')

Printing and Exporting with print
The print function performs any of the four actions shown in the table below. 
You control what action is taken, depending on the presence or absence of 
certain arguments. 

Action Print Command

Print a figure to a printer print

Print a figure to a file for later printing print filename
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You can also include optional arguments with the print command. For 
example, to export Figure No. 2 to file spline2d.eps, with 600 dpi resolution, 
and using the EPS color graphics format, use

print -f2 -r600 -depsc spline2d

The functional form of this command is

print('-f2', '-r600', '-depsc', 'spline2d');

Specifying Parameters and Options
The table below lists parameters you can modify for the figure to be printed or 
exported. To change one of these parameters, use the Page Setup or Printing 
Options (UNIX only) dialog boxes, or use the set or print function.

See “Changing a Figure’s Settings” on page 7-38 for more detailed instructions. 

Copy a figure in graphics format to the 
clipboard

print -dfileformat

Export a figure to a graphics format file 
that you can later import into an 
application

print -dfileformat filename

Parameter Description

Figure size Set the size of the figure on the printed page

Figure position Set the position of the figure on the printed page

Paper size Select printer paper, specified by dimension or type

Paper orientation Specify the way the figure is oriented on the page

Position mode Specify the figure position yourself or have MATLAB 
determine position automatically

Graphics format Select the format for exported data (e.g., EPS, JPEG)

Resolution Specify how finely your figure is to be sampled

Action Print Command
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Default Settings and How to Change Them
If you have not changed the default print and export settings, MATLAB prints 
or exports the figure

• 8-by-6 inches with no window frame

• Centered on portrait format 8.5-by-11 inch paper if available

• Using white for the figure and axes background color

• With the ticks and limits of the axes scaled to accommodate the printed size

Renderer Select the software that processes your graphics data

Renderer mode Specify the renderer yourself or have MATLAB 
determine which renderer to use automatically

Axes tick marks Keep axes tick marks and limits as shown or have 
MATLAB adjust depending on figure size

Background color Keep background color as shown on the screen or 
force it to white

Line and text 
color

Keep line and text objects as shown on screen or print 
them in black and white

UI controls Show or hide all user interface controls in the figure

Bounding box Leave space between outermost objects in the plot 
and the edges of its background area

CMYK Automatically convert RGB values to CMYK values

Character set 
encoding

Select character set for PostScript printers

Parameter Description
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Setting Defaults for a Figure
In general, to change the property settings for a specific figure, follow the 
instructions given in the section “Changing a Figure’s Settings” on page 7-38.

Any settings you change with the Page Setup, Print, and Printing Options 
dialog boxes or with the set function are saved with the figure and affect each 
printing of the figure until you change the settings again.

The settings you change with the Figure Copy Template Preferences and 
Copy Options Preferences panels alter the figure as it is displayed on the 
screen.

Setting Defaults for the Session
MATLAB enables you to set the session defaults for figure properties. Set the 
session default for a property using the syntax

set(0, 'DefaultFigurepropertyname', 'value')

where propertyname is one of the named figure properties. This example sets 
the paper orientation for all subsequent print operations in the current 
MATLAB session.

set(0, 'DefaultFigurePaperOrientation', 'landscape')

The Figure Properties reference page contains a complete list of the properties.

Setting Defaults Across Sessions
MATLAB enables you to set the session-to-session defaults for figure 
properties, the print driver, and the print function.

Print Device and Print Command. Set the default print driver and the default print 
command in your printopt.m file. This file contains instructions for changing 
these settings and for displaying the current defaults. Open printopt.m in 
your editor by typing the command

edit printopt

Scroll down about 40 lines until you come to this comment line and make your 
changes after this line.

%---> Put your own changes to the defaults here (if needed)
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For example, to change the default driver, first find the line that sets dev, and 
then replace the text string with an appropriate value. So, to set the default 
driver to HP LaserJet III, modify the line to read

dev = '-dljet3';

For the full list of values for dev, see the “Drivers” section of the print 
reference page.

Note  If you set dev to be a graphics format, such as -djpeg, MATLAB 
exports the figure rather than printing it.

Figure Properties. Set the session-to-session default for a property by including 
this command in your startup.m file:

set(0, 'DefaultFigurepropertyname', 'value')

where propertyname is one of the named figure properties. For example,

set(0, 'DefaultFigureInvertHardcopy', 'off')

keeps the figure background in the screen color.

This is the same command you use to change a session default, except that it 
executes automatically every time MATLAB is invoked.

Note  Arguments specified with the print command override properties set 
using MATLAB commands or the Page Setup dialog box, which in turn 
override any MATLAB default settings specified in printopt.m or startup.m.
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How to Print or Export
This section covers the following topics to show you the steps you need to take 
to produce a printed or exported figure:

• “Using Print Preview” on page 7-9

• “Printing a Figure” on page 7-11

• “Printing to a File” on page 7-15

• “Exporting to a File” on page 7-17

• “Exporting to the Windows Clipboard” on page 7-27

Using Print Preview
Before you print or export a figure, preview the image by selecting Print 
Preview from the figure window’s File menu. If necessary, you can then click 
Page Setup or use the set function to adjust the look of the printed or exported 
figure. See “Changing a Figure’s Settings” on page 7-38 for details. 
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Adding a Header to the Printed Page
You can add a header to the page you are about to print by clicking the Header 
button at the top of the Print Preview dialog box. This opens the Figure Page 
Header dialog box, as shown here. 

The print header includes any text you want to appear at the top of the printed 
page. It can also include the current date. Under Header String, enter the text 
of the header. Under Date Format, select from a number of possible formats 
with which to display the current date and/or time. Click Header Font to 
change the font, font style, font size, or script type for the header text and date 
format. 
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Click OK to close the dialog box and apply these settings to your figure. 

Printing a Figure
This section tells you how to print your figure to a printer:

• “Using the Graphical User Interface on Windows” on page 7-12

• “Using the Graphical User Interface on UNIX” on page 7-13

• “Using MATLAB Commands” on page 7-15
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Using the Graphical User Interface on Windows
MATLAB for Windows uses the standard Windows Print dialog box, which 
normally comes with Windows software products. To open the Windows Print 
dialog box, select Print from the figure window’s File menu.   

• To print a figure, first select a printer from the list box, then click OK.

• To save it to a file, click the Print to file check box, click OK, and when the 
Print to File window appears, enter the filename you want to save the figure 
to. MATLAB creates the file in your current working directory.

Settings you can change in the Windows Print dialog box are as follows:

Properties. To make changes to settings specific to a printer, click the 
Properties button. This opens the Windows Document Properties window.

Print range. You can only select All in this panel. The selection does not affect 
your printed output.

Copies. Enter the number of copies you want to print.
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Using the Graphical User Interface on UNIX
MATLAB for UNIX has a Print dialog box and an associated Printing Options 
dialog box. To open the Print dialog box, select Print from the figure window’s 
File menu.   

• To print a figure, click the Printer button and select a printer from the list 
box. You can select a driver from the Driver list box if you don’t want the 
default driver.

• To save it to a file, click the File button, enter a filename, and browse for the 
directory you want the file saved in.

Settings you can change in the UNIX Print dialog box are as follows:

Figure Size on Printed Page. If you want the printed plot to have the same size as 
it does on your screen, select Same size as screen. If you want the printed 
output to have the default size of 8-by-6 inches, select 8 by 6 inches.

See “Setting the Figure Size and Position” on page 7-41 for more information.

Axes Limits and Ticks. To force MATLAB to print the same number of ticks and 
the same limit values for the axes as are used on the screen, select Same as on 
screen. To let MATLAB scale the limits and ticks of the axes based on the size 
of the printed figure, select Allow MATLAB to select.

See “Setting the Axes Ticks and Limits” on page 7-54 for more information.
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UNIX Printing Options Dialog Box
To open the UNIX Printing Options dialog box, click the Options button on 
the UNIX Print dialog box (see figure shown above).   

Settings you can change in the Printing Options dialog box are as follows:

Use loose bounding box for PS and Ghostscript drivers. Select this box to leave a little 
space between the outermost objects in the plot and the edges of the plot’s 
background.

Use CMYK colors in PS and Ghostscript drivers instead of RGB. Select this box to 
produce output in CMYK (cyan, magenta, yellow, black) color space instead of 
RGB (red, green blue). This is for PostScript printers and drivers only.

Use Adobe PS default character set encoding. Select this box to have MATLAB use 
the default character set that is supported by all PostScript printers. This 
option is provided because some early PostScript printers do not support the 
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PostScript operator ISOLatin1Encoding, which MATLAB uses when it 
generates PostScript files. If your printer does not support this operator, you 
may notice problems in the text of MATLAB printouts.

Suppress printing of user interface controls. Select this box to prevent any user 
interface controls that you added to the plot from appearing in the printed plot.

Handle Graphics Renderer. Select one of the radio buttons to have MATLAB select 
the renderer, or to select a specific renderer from those that MATLAB supports. 
See “The Default Renderer for MATLAB” on page 7-50 for information on how 
MATLAB selects a renderer.

Printing Resolution. Select one of the radio buttons to either have MATLAB select 
the resolution for your printout, to set the resolution to that used for the screen 
display, or to enter a specific resolution value. See “Default Resolution and 
When You Can Change It” on page 7-52 for information on how MATLAB 
selects a resolution setting.

Using MATLAB Commands
Use the print function to print from the MATLAB command line or from a 
program. See “Printing and Exporting with print” on page 7-4 for more 
information.

To send the current or most recently active figure to a printer, simply type

print

The Printing Options table on the print reference page shows a full list of 
options that you can use with the print function. For example, the following 
command prints Figure No. 2 with 600 dpi resolution, using the Canon 
BubbleJet BJ200 printer driver:

print -f2 -r600 -dbj200

Printing to a File
Instead of sending your figure to the printer right now, you have the option of 
“printing” it to a file, and then sending the file to the printer later on. You can 
also append additional figures to the same file using the print command.
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This section tells you how to save your figure to a file

• “Using the Graphical User Interface on Windows”

• “Using the Graphical User Interface on UNIX”

• “Using MATLAB Commands”

Using the Graphical User Interface on Windows

1 To open the Print dialog box, select Print from the figure window’s File 
menu.

2 Select the check box labeled Print to file, and click the OK button.

3 The Print to File dialog box appears, allowing you to specify the output 
directory and filename.

Using the Graphical User Interface on UNIX

1 To open the Print dialog box, select Print from the figure window’s File 
menu.

2 Select the radio button labeled File, and either fill in or browse for the 
directory and filename.

Using MATLAB Commands
To print the figure to a PostScript file, type

print filename

If you don’t specify the filename extension, MATLAB uses an extension that is 
appropriate for the print driver being used.

You can also include an -options argument when printing to a file. For 
example, to append the current figure to an existing file, type

print -append filename

The only way to append to a file is by using the print function. There is no 
dialog box that enables you to do this.
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Note  If you print a figure to a file, the file can only be printed and cannot be 
imported into another application. If you want to create a figure file that you 
can import into an application, see the next section, “Exporting to a File.” 

Appending Additional Figures to a File. Once you have printed one figure to a 
PostScript file, you can append other figures to that same file using the 
-append option of the print function. You can only append using the print 
function.

This example prints Figure No. 2 to PostScript file myfile.ps, and then 
appends Figure No. 3 to the end of the same file.

print -f2 myfile
print -f3 -append myfile

Exporting to a File
Export a figure in a graphics format to a file if you want to import it into 
another application, such as a word processor. You can export to a file from the 
Windows or UNIX Export Setup dialog box or from the command line.

This section tells you how to export your figure to a file:

• “Exporting Using the Graphical User Interface” on page 7-18

• “Exporting Using MATLAB Commands” on page 7-23

It also covers

• “Exporting with getframe” on page 7-24

• “Saving Multiple Figures to an AVI File” on page 7-25

• “Importing MATLAB Graphics into Other Applications” on page 7-25

For further information, see “Choosing a Graphics Format” on page 7-64.
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Exporting Using the Graphical User Interface
Select Export Setup from the File menu of the figure window. This displays 
the first of four dialog boxes that enable you to adjust the size, rendering, font, 
and line appearance of your figure prior to exporting it. You select each of these 
dialog boxes by clicking the Size, Rendering, Fonts, or Lines keyword shown 
to the left under Properties. For a description of each dialog box, see

• “Adjusting the Figure Size” on page 7-18

• “Changing the Rendering” on page 7-19

• “Changing Font Characteristics” on page 7-20

• “Changing Line Characteristics” on page 7-21

Adjusting the Figure Size
Click Size in the Export Setup dialog box to display this dialog box. 

The Size dialog box, shown above, modifies the size of the figure as it will 
appear when imported from the export file into your application. If you leave 
the Width and Height settings on auto, the figure remains the same size as it 
appears on your screen. You can change the size of the figure by entering new 
values in the Width and Height text boxes and then clicking Apply to Figure. 
To go back to the original settings, click Restore Figure.

To save any settings that you change, or to load settings that you used earlier, 
see “Saving and Loading Settings” on page 7-22.
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Changing the Rendering
Click Rendering in the Export Setup dialog box to display this dialog box. 

You can change the settings in this dialog box as follows:

Colorspace. Use the drop-down list to select a colorspace. Your choices are

• Black and white

• Grayscale

• RGB color

• CMYK color

Custom Color. Click the check box and enter a color to be used for the figure 
background. Valid entries are

• white, yellow, magenta, red, cyan, green, blue, or black

• Abbreviated name for the same colors — w, y, m, r, c, g, b, k

• Three-element RGB value — See the help for colorspec for valid values. 
Examples: [1 0 1] is magenta. [0 .5 .4] is a dark shade of green.
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Custom Renderer. Click the check box and select a renderer from the drop-down 
list:

• Painter’s — Vector format

• OpenGL — Bitmap format

• Z-buffer — Bitmap format

Resolution. You can select one of the following from the drop-down list:

• Screen — The same resolution as used on your screen display

• A specific numeric setting — 150, 300, or 600 dpi

• Auto — MATLAB selects a suitable setting

Keep axis limits. Click the check box to keep axis tick marks and limits as shown. 
If unchecked, have MATLAB adjust depending on figure size.

Show uicontrols. Click the check box to show all user interface controls in the 
figure. If unchecked, hide user interface controls.

Changing Font Characteristics
Click Fonts in the Export Setup dialog box to display this dialog box. 
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You can change the settings in this dialog box as follows:

Custom Size. Click the check box and use the radio buttons to select a relative or 
absolute font size for text in the figure.

• Scale font by N % — Increases or decreases the size of all fonts by a relative 
amount, N percent. Enter the word auto to have MATLAB select the 
appropriate font size.

• With minimum of N points — You can specify a minimum font size when 
scaling the font by a percentage.

• Use fixed font size N points — Sets the size of all fonts to an absolute value, 
N points.

Custom Name. Click the check box and use the drop-down list to select a font 
name from those offered in the drop-down list.

Custom Weight. Click the check box and use the drop-down list to select the 
weight or thickness to be applied to text in the figure. Choose from normal, 
light, demi, or bold.

Custom Angle. Click the check box and use the drop-down list to select the angle 
to be applied to text in the figure. Choose from normal, italic, or oblique.

Changing Line Characteristics
Click Lines in the Export Setup dialog box to display this dialog box. 
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You can change the settings in this dialog box as follows:

Custom width. Click the check box and use the radio buttons to select a relative 
or absolute line size for the figure.

• Scale line width by N % — Increases or decreases the width of all lines by a 
relative amount, N percent. Enter the word auto to have MATLAB select the 
appropriate line width.

• With minimum of N points — You can specify a minimum line width when 
scaling the font by a percentage.

• Use fixed line width N points — Sets the width of all lines to an absolute 
value, N points.

Convert solid lines to cycle through line styles. When colored graphics are imported 
into an application that does not support color, lines that could formerly be 
distinguished by unique color are likely to appear the same. For example, a red 
line that shows an input level and a blue line showing output both appear as 
black when imported into an application that does not support colored 
graphics.

Clicking this check box causes MATLAB to export lines using different line 
styles, such as solid, dotted, or dashed lines rather than differentiating 
between lines based on color.

Saving and Loading Settings
If you think you might use these export settings again at another time, you can 
save them now and then reload them later. At the bottom of each Export Setup 
dialog box, there is a panel labeled Export Styles. To save your current export 
styles, type a name into the Save as style named text box, and then click Save.

If you then click the Load settings from drop-down list, you will see the name 
of the style you just saved among the choices of export styles you can load. To 
load a style, select one of the choices from this list and then click Load.

To delete any style you no longer have use for, select that style name from the 
Delete a style drop-down list and click Delete.
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Exporting the Figure
When you finish setting the export style for your figure, you can export the 
figure to a file by clicking the Export button on the right side of any of the four 
Export Setup dialog boxes. As new window labeled Save As opens.

Select a directory to save the file in from the Save in list at the top. Select a file 
type for your file from the Save as type drop-down list at the bottom, and then 
enter a file name in the File name text box. Click the Save button to export the 
file.   

For information on the graphics file formats supported by MATLAB, see 
“Choosing a Graphics Format” on page 7-64.

Exporting Using MATLAB Commands
Use the print function to print from the MATLAB command line or from a 
program. See “Printing and Exporting with print” on page 7-4 for basic 
information on printing from the command line.

To export the current or most recently active figure, type

print -dfileformat filename

where fileformat is a graphics format supported by MATLAB and filename 
is the name you want to give to the export file. MATLAB selects the filename 
extension, if you don’t specify it.
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You can also specify a number of options with the print function. These are 
shown in the Printing Options table on the print reference page.

For example, to export Figure No. 2 to file spline2d.eps, with 600 dpi 
resolution, and using the EPS color graphics format, type

print -f2 -r600 -depsc spline2d

Graphics file formats are explained in more detail in the sections “Choosing a 
Graphics Format” on page 7-64 and “Description of Selected Graphics 
Formats” on page 7-70.

Exporting with getframe
You can use the getframe function with imwrite to export a graphic. getframe 
is often used in a loop to get a series of frames (figures) with the intention of 
creating a movie. Note that no matter what the intrinsic resolution of the 
graphics might be, getframe will only capture them at screen resolution.

Some of the benefits of using this export method over using print are

• You can use getframe to capture a portion of the figure, rather than the 
whole figure. 

• imwrite offers greater flexibility for setting format-specific options, such as 
the bit depth and compression.

The drawbacks of using this method are that imwrite uses built-in MATLAB 
formats only. Therefore, you do not have access to the Ghostscript formats 
available to you when exporting with the print function or Export menu. Also, 
as mentioned above, this technique is limited to screen resolution.

How to Use getframe and imwrite. Use getframe to capture a figure and imwrite to 
save it to a file. getframe returns a structure containing the fields cdata and 
colormap. The colormap field is empty on true color displays. The following 
example captures the current figure and exports it to a PNG file.

I = getframe(gcf);
imwrite(I.cdata, 'myplot.png');

You should use the proper syntax of imwrite for the type of image captured. In 
the example above, the image is captured from a true color display. Because the 
colormap field is empty, it is not passed to imwrite.



How to Print or Export

7-25

Example — Exporting a Figure Using getframe and imwrite. This example offers device 
independence — it will work for either RGB-mode or indexed-mode monitors. 

X=getframe(gcf);
if isempty(X.colormap)
   imwrite(X.cdata, 'myplot.bmp')
else
   imwrite(X.cdata, X.colormap, 'myplot.tif')
end

For information about available file formats and format-specific options, see 
the imwrite reference page. For information about creating a movie from a 
series of frames, see the reference pages for getframe and movie, or see 
“Movies” in Chapter 4, “Creating Specialized Plots”.

Saving Multiple Figures to an AVI File
You can also save multiple figures to an AVI file using the MATLAB avifile 
and addframe functions. AVI files can be used for animated sequences and do 
not need MATLAB to run, but do require an AVI viewer. For more information, 
see “Exporting Audio/Video Data” in the MATLAB Programming 
documentation.

Importing MATLAB Graphics into Other Applications
You can include MATLAB graphics in a wide variety of applications for word 
processing, slide preparation, modification by a graphics program, 
presentation on the Internet, and so on. In general, the process is the same for 
all applications:

1 Use MATLAB to create the figure you want to import into another 
application.

2 Export the MATLAB figure to one of the supported graphics file formats, 
selecting a format that is both appropriate for the type of figure and 
supported by the target application. See “Choosing a Graphics Format” on 
page 7-64 for help.

3 Use the import features of the target application to import the graphics file. 
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Edit Before You Export. Vector graphics may be fully editable in a few high-end 
applications, but most applications do not support editing beyond simple 
resizing. Bitmaps cannot be edited with quality results unless you use a 
software package devoted to image processing. In general, you should try to 
make all the necessary settings while your figure is still in MATLAB.

Importing into Microsoft Applications. To import your exported figure into a 
Microsoft application, select Picture from the Insert menu. Then select From 
File and navigate to your exported file. If you use the clipboard to perform your 
export operations, you can take advantage of the recommended MATLAB 
settings for Word and PowerPoint.

Example — Importing an EPS Graphic into LaTeX. This example shows how to import 
an EPS file named peaks.eps into LaTeX. 

\documentclass{article}

\usepackage{graphicx}

\begin{document}

\begin{figure}[h]
\centerline{\includegraphics[height=10cm]{peaks.eps}}
\caption{Surface Plot of Peaks}
\end{figure}

\end{document}

EPS graphics can be edited after being imported to LaTeX. For example, you 
can specify the height in any LaTeX-compatible dimension. To set the height to 
3.5 inches, use the command

height=3.5in

You can use the angle function to rotate the graph. For example, to rotate the 
graph 90 degrees, add

angle=90

to the same line of code that sets the height, i.e., [height=10cm,angle=90].
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Exporting to the Windows Clipboard
You can export a figure to the Windows clipboard using one of two graphics 
formats: EMF color vector or BMP 8-bit color bitmap.

By default, MATLAB chooses the graphics format for you, based on the 
rendering method used to display the figure. For figures rendered with 
OpenGL or Z-buffer, MATLAB uses the BMP format. For figures rendered with 
Painter’s, the EMF format is used. For information about how MATLAB selects 
a rendering method, see “The Default Renderer for MATLAB” on page 7-50.

To override the selection by MATLAB, specify the format of your choice using 
either the Windows Copy Options Preferences dialog box, or the -d switch in 
the print command.

You can export to the clipboard:

• “Using the Graphical User Interface on Windows” on page 7-27

• “Using MATLAB Commands” on page 7-29

Using the Graphical User Interface on Windows
Before you export the figure to the clipboard, you can use the Copy Options 
Preferences dialog box to select a nondefault graphics format, or to adjust 
certain figure settings. These settings become the new defaults for all figures 
exported to the clipboard.

Note  When exporting to the clipboard in Windows metafile format (-dmeta), 
the settings from the figure Copy Options Preferences template are ignored.

To open the Copy Options Preferences dialog box, select Copy Options from 
the figure window’s Edit menu. Any changes you make with this dialog box 
affect only the clipboard copy of the figure; they do not affect the way the figure 
looks on the screen.
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Settings you can change in the Copy Options Preferences dialog box are as 
follows:

Clipboard format. To copy the figure in EMF color vector format, select Metafile. 
To use BMP 8-bit color bitmap format, select Bitmap. Or, to have MATLAB 
select the format for you, select Preserve information. MATLAB uses the 
metafile format whenever possible.

Figure background color. To keep the background color the same as it appears on 
the screen, select Use figure color. To make the background white, select 
Force white background. For a background that is transparent, for example, 
a slide background to frame the axes part of a figure, select Transparent 
background.
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Size. Select Match figure screen size to copy the figure as it appears on the 
screen, or leave it unselected to use the Page Setup settings to determine its 
size.

1 Open the Copy Options Preferences dialog box if you need to make any 
changes to those preferences used in copying to the clipboard.

2 Click OK to se the new preferences. These will be used for all future figures 
exported to the clipboard.

3 Select Copy Figure from the figure window’s Edit menu to copy the figure 
to the clipboard.

Using MATLAB Commands
Export to the clipboard using the print function with a graphics format, but no 
filename. You must use one of the following clipboard formats: -dbitmap or 
-dmeta. These switches create a Windows bitmap (BMP) or an enhanced 
metafile (EMF), respectively. 

For example, to export the current figure to the clipboard in enhanced metafile 
format, type

print -dmeta

Note  When printing, the print -d option specifies a printer driver. When 
exporting, the print -d option specifies a graphics format.
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Examples of Basic Operations
This section provides step-by-step instructions for common printing and 
exporting tasks. Each printing example tells you how to perform the task from 
the print menus and from the command line. You can perform some tasks from 
the command line and others only from the menus.

The examples presented here are

• “Printing a Figure at Screen Size”

• “Printing with a Specific Paper Size” on page 7-31

• “Printing a Centered Figure” on page 7-32

• “Exporting in a Specific Graphics Format” on page 7-33

• “Exporting in EPS Format with a TIFF Preview” on page 7-34

• “Exporting a Figure to the Clipboard” on page 7-35

Printing a Figure at Screen Size
By default, MATLAB prints your figure at 8-by-6 inches. This size includes the 
area delimited by the background. This example shows how to print or export 
your figure the same size it is displayed on your screen.

Using the Graphical User Interface

1 Resize your figure window to the size you want it to be when printed. 

2 Select Page Setup from the figure window’s File menu, and select the Size 
and Position tab.

3 In the Mode panel, select Use screen size, centered on page.

4 Click OK.

5 Open the Print dialog box and print the figure. 
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Using MATLAB Commands
Set the PaperPositionMode property to auto before printing the figure.

set(gcf, 'PaperPositionMode', 'auto');
print

If later you want to print the figure at its original size, set PaperPositionMode 
back to 'manual'.

Printing with a Specific Paper Size
By default, MATLAB uses 8.5-by-11 inch paper. This example shows how to 
change the paper size to 8.5-by-14 inches by selecting a paper type (Legal).

Using the Graphical User Interface

1 Select Page Setup from the figure window’s File menu, and select the 
Paper tab.

2 Select the Legal paper type from the list under Paper size. The width and 
height fields update to 8.5 and 14, respectively.

3 Make sure that Units is set to inches.

4 Click OK.

5 Open the Print dialog box and print the figure.

Using MATLAB Commands
Set the PaperUnits property to inches, and the PaperType property to Legal.

set(gcf, 'PaperUnits', 'inches');
set(gcf, 'PaperType', 'Legal');

Alternatively, you can set the PaperSize property to the size of the paper, in 
the specified units.

set(gcf, 'PaperUnits', 'inches');
set(gcf, 'PaperSize', [8.5 14]);
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Printing a Centered Figure
This example sets the size of a figure to 5.5-by-3 inches and centers it on the 
paper.

Using the Graphical User Interface

1 Select Page Setup from the figure window’s File menu, and select the Size 
and Position tab. 

2 Make sure Use manual size and position is selected.

3 Enter 5.5 in the Width field and 3 in the Height field.

4 Make sure that Units field is set to inches.

5 Click Center.

6 Click OK.

7 Open the Print dialog box and print the figure.

Using MATLAB Commands

1 Start by setting PaperUnits to inches.

set(gcf, 'PaperUnits', 'inches')

2 Use PaperSize to return the size of the current paper.

papersize = get(gcf, 'PaperSize')

papersize =
              8.5000   11.0000

3 Initialize variables to the desired width and height of the figure.

width = 5.5;         % Initialize a variable for width.
height = 3;          % Initialize a variable for height.
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4 Calculate a left margin that centers the figure horizontally on the paper. Use 
the first element of papersize (width of paper) for the calculation.

left = (papersize(1)- width)/2

left =
          1.5000

5 Calculate a bottom margin that centers the figure vertically on the paper. 
Use the second element of papersize (height of paper) for the calculation.

bottom = (papersize(2)- height)/2

bottom =
          4

6 Set the figure size and print. 

myfiguresize = [left, bottom, width, height];
set(gcf, 'PaperPosition', myfiguresize);
print

Exporting in a Specific Graphics Format
Export a figure to a graphics-format file when you want to import it at a later 
time into another application such as a word processor.

Using the Graphical User Interface

1 Select Export from the figure window’s File menu.

2 Use the Save in field to navigate to the directory in which you want to save 
your file.

3 Select a graphics format from the Save as type list.

4 Enter a filename in the File name field. An appropriate file extension, based 
on the format you chose, is displayed.

5 Click Save to export the figure.
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Using MATLAB Commands
From the command line, you must specify the graphics format as an option. See 
the print reference page for a complete list of graphics formats and their 
corresponding option strings.

This example exports a figure to an EPS color file, myfigure.eps, in your 
current directory. 

print -depsc myfigure

This example exports Figure No. 2 at a resolution of 300dpi to a 24-bit JPEG 
file, myfigure.jpg.

print -djpeg -f2 -r300 myfigure

This example exports a figure at screen size to a 24-bit TIFF file, 
myfigure.tif.

set(gcf, 'PaperPositionMode', 'auto') % Use screen size
print -dtiff myfigure

Exporting in EPS Format with a TIFF Preview
Use the print function to export a figure in EPS format with a TIFF preview. 
When you import the figure, the application can display the TIFF preview in 
the source document. The preview is color if the exported figure is color, and 
black and white if the exported figure is black and white.

This example exports a figure to an EPS color format file, myfigure.eps, and 
includes a color TIFF preview.

print -depsc -tiff myfigure

This example exports a figure to an EPS black-and-white format file, 
myfigure.eps, and includes a black-and-white TIFF preview.

print -deps -tiff myfigure



Examples of Basic Operations

7-35

Exporting a Figure to the Clipboard
Export a figure to the clipboard in graphics format when you want to paste it 
into another Windows application such as a word processor.

Using the Graphical User Interface on Windows
This example exports a figure to the clipboard in enhanced metafile (EMF) 
format. Figure settings are chosen that would make the exported figure 
suitable for use in a PowerPoint slide. Note that changing the settings modifies 
the figure displayed on the screen.

1 Create a figure containing text. You can use the following code.

x = -pi:0.01:pi; 
h = plot(x, sin(x));
title('Sine Plot');

2 Select Preferences from the File menu. Then select Figure Copy Template 
from the Preferences dialog box.

3 In the Figure Copy Template Preferences panel, click the PowerPoint 
button. The MATLAB suggested settings for PowerPoint are added to the 
template. 

4 In the Lines panel, change the Custom width to 4 points.

5 In the Uicontrols and axes panel, select Keep axes limits and tick spacing 
to prevent MATLAB from possibly rescaling tick marks and limits when you 
export.

The PowerPoint 
settings increase the 
font size by a 
percentage and make 
all text bold. 

The Text panel after the PowerPoint button is clicked
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6 Click Apply to Figure. The changes appear in the figure window. 

If you don’t like the way your figure looks with the new settings, you can 
restore it to its original settings by clicking the Restore Figure button.

7 In the left pane of the Preferences dialog box, expand the Figure Copy 
Template topic. Select Copy Options.

8 In the Copy Options panel, select Metafile to tell MATLAB to export the 
figure in EMF format.

9 Check that Transparent background is selected. This choice makes the 
figure background transparent and allows the slide background to frame the 
axes part of the figure.

10 Clear the Match figure screen size check box so that you can use your own 
figure size settings.

11 Click OK.

12 Select Page Setup from the figure window’s File menu.

13 In the Size and Position tab, set Width to 10 and Height to 7.5. Make sure 
that Units are set to inches.

14 Click OK.

15 Select Copy Figure from the Edit menu. Your figure is now exported to the 
clipboard and can be pasted into another Windows application such as a 
PowerPoint slide. 
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Using MATLAB Commands
Use the print function and one of two clipboard formats (-dmeta, -dbitmap) to 
export a figure to the clipboard. Do not specify a filename.

This example exports a figure to the clipboard in enhanced metafile (EMF) 
format. 

print -dmeta

This example exports a figure to the clipboard in bitmap (BMP) 8-bit color 
format. 

print -dbitmap
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Changing a Figure’s Settings
The table below shows parameters that you can set before submitting your 
figure to the printer.

Column 1 of the table lists all parameters that you can change.

Column 2 shows the default setting that MATLAB uses.

Column 3 shows which dialog box to use to set that parameter. If you can make 
this setting on only one platform, this is noted in parentheses: (W) for 
Windows, and (U) for UNIX.

Some dialog boxes have tabs at the top to enable you to select a certain 
category. These categories are denoted in the table below using the format 
<dialogbox>/<tabname>. For example, “Page Setup/Size ...” in this column 
means to use the Page Setup dialog box, selecting the Size and Position tab.

Column 4 shows how to set the parameter using the MATLAB print or set 
function. When using print, the table shows the appropriate command option 
(for example, print -loose). When using set, it shows the property name to 
set along with the type of object (for example, (Line) for line objects). 

Parameter Default Dialog Box PRINT Command
or SET Property

Select figure Last active window None print -fhandle

Select printer System default Print print -pprinter

Figure size 8-by-6 inches Page Setup/Size ... PaperSize (Figure)
PaperUnits (Figure)

Position on page 0.25 in. from left,
2.5 in. from bottom

Page Setup/Size ... PaperPosition (Figure)
PaperUnits (Figure)

Position mode Manual Page Setup/Size ... PaperPositionMode 
(Figure)

Paper type Letter Page Setup/Paper PaperType (Figure)
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Paper orientation Portrait Page Setup/Paper PaperOrientation 
(Figure)

Renderer Selected by MATLAB Page Setup/Axes ... print -zbuffer | 
-painters | -opengl

Renderer mode Auto Page Setup/Axes ... RendererMode (Figure)

Resolution Depends on driver or 
graphics format

Print Properties (W)
Printing Options (U)

print -rresolution

Axes tick marks Recompute Page Setup/Axes ... XTickMode, etc. (Axes)

Background color Force to white Page Setup/Axes ... Color (Figure)
InvertHardCopy (Figure)

Font size As in the figure Fig. Copy Template FontSize (Text)

Bold font Regular font Fig. Copy Template FontWeight (Text)

Line width As in the figure Fig. Copy Template LineWidth (Line)

Line style Black or white Fig. Copy Template LineStyle (Line)

Line and text color Black and white Page Setup/Lines ... Color (Line, Text)

CMYK color RGB color Printing Options (U) print -cmyk

UI controls Printed Page Setup/Axes ... print -noui

Bounding box Tight Printing Options (U) print -loose

Copy background Transparent Copy Options (W) See “Background color”

Copy size Same as screen size Copy Options (W) See “Figure Size”

Parameter Default Dialog Box PRINT Command
or SET Property



7 Printing and Exporting

7-40

Selecting the Figure
By default, MATLAB prints the current figure. If you have more than one 
figure open, the current figure is the last one that was active. To make a 
different figure active, click on it to bring it to the foreground.

Using MATLAB Commands
Specify a figure handle using the command

print -fhandle

This example sends Figure No. 2 to the printer. A figure’s number is usually its 
handle.

print -f2

Selecting the Printer
You can select the printer you want to use with the Print dialog box or with the 
print function.

Using the Graphical User Interface

1 Select Print from the figure window’s File menu.

2 Select the printer from the list box near the top of the Print dialog box.

3 Click OK.

Using MATLAB Commands
You can select the printer using the -P switch of the print function.

This example prints Figure No. 3 to a printer called Calliope.

print -f3 -PCalliope

If the printer name has spaces in it, put quotation marks around the -P option, 
as shown here.

print "-Pmy local printer"
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Using a Network Print Server. On Windows systems, you can print to a network 
print server using the form shown here for a printer named trinity.

print -P\\PRINTERS\trinity

Setting the Figure Size and Position
The default output figure size is 8 inches wide by 6 inches high, which 
maintains the aspect ratio (width to height) of the MATLAB figure window. 
The figure’s default position is centered both horizontally and vertically when 
printed to a paper size of 8.5-by-11 inches.

You can change the size and position of the figure:

• “Using the Graphical User Interface”

• “Using MATLAB Commands” on page 7-44

Using the Graphical User Interface
Select Page Setup from the figure window’s File menu to open the Page Setup 
dialog box. Click the Size and Position tab to make changes to the size and 
position of your figure on the printed page.

Use the text edit boxes on the left to enter new dimensions for your figure. Or 
use the graphical user interface at the right to drag the borders and location of 
the “sample” figure with your mouse.
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Settings you can change in the Size and Position window are as follows:

Mode. Choose whether you want the figure to be the same size as it is displayed 
on your screen, or you want to manually change its size using the options in the 
Size and Position window.

The next two panels are enabled only when you select the Use manual size and 
position mode.

Manual size and position. Enter the measurements and units for the size and 
position of the figure.

Graphical User Interface. Use the “Sample” figure at the right of the dialog box to 
move and resize your MATLAB figure interactively.
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To set the width and height interactively, use the mouse to drag the edges of 
the “Sample” figure to the desired size. 

To set the margins of the figure (offsets from the left and top edges of the 
paper), drag the entire “Sample” figure to a new position with the mouse. 

If you want the figure resized to fill the paper, click Fill page. Note that Fill 
page might alter the aspect ratio of your image. To get the maximum figure 
size without altering the aspect ratio, select Fix aspect ratio.

Note  Changes you make using Page Setup affect the printed output only. 
They do not alter the figure displayed on your screen.

Width and Height update as you 
resize the preview image.

Preview image

Left and Top update as you move 
the sample figure around.
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Using MATLAB Commands
To print your figure with a specific size or position, make sure that the 
PaperPositionMode property is set to manual (the default). Then set the 
PaperPosition property to the desired size and position.

The PaperPosition property references a four-element row vector that 
specifies the position and dimensions of the printed output. The form of the 
vector is

[left bottom width height]

where

• left specifies the distance from the left edge of the paper to the left edge of 
the figure.

• bottom specifies the distance from the bottom of the paper to the bottom of 
the figure.

• width and height specify the figure’s width and height.

The MATLAB default values for PaperPosition are

[0.25 2.5 8.0 6.0]

This example sets the figure size to a width of 4 inches and height of 2 inches, 
with the origin of the figure positioned 2 inches from the left edge of the paper 
and 1 inch from the bottom edge.

set(gcf, 'PaperPositionMode', 'manual');
set(gcf, 'PaperUnits', 'inches');
set(gcf, 'PaperPosition', [2 1 4 2]);

Note  PaperPosition specifies a bottom margin, rather than a top margin as 
Page Setup does. When you set the top margin using Page Setup, MATLAB 
uses this setting to calculate the bottom margin, and updates the 
PaperPosition property appropriately.
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Setting the Paper Size or Type
Set the paper size by specifying the dimensions or by choosing from a list of 
predefined paper types. If you do not set a paper size or type, MATLAB uses 
the default paper size of 8.5-by-11 inches. 

Paper-size and paper-type settings are interrelated — if you set a paper type, 
MATLAB updates the paper size. For example, if you set the paper type to US 
Legal, MATLAB updates the width of the paper to 8.5 inches and the height to 
14 inches.

You can change the paper size and orientation:

• “Using the Graphical User Interface”

• “Using MATLAB Commands” on page 7-46

Using the Graphical User Interface
Select Page Setup from the figure window’s File menu to open the Page Setup 
dialog box. Click the Paper tab to make changes to the paper type and 
orientation of the figure on the printed page.   
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Settings you can change in the Paper window are as follows:

Paper size. Select a paper type from the list under Paper size. If there is no 
paper type with suitable dimensions, enter your own dimensions in the Width 
and Height fields. Make sure Units is set appropriately to inches, 
centimeters, points, or normalized.

Orientation. Select how you want the figure to be oriented on the printed page. 
The illustration under “Setting the Paper Orientation” on page 7-46 shows the 
three types of orientation you can choose from.

Note  Changes you make using Page Setup affect the printed output only. 
They do not alter the figure displayed on your screen.

Using MATLAB Commands
Set the PaperType property to one of the built-in MATLAB paper types, or set 
the PaperSize property to the dimensions of the paper.

When you select a paper type, the unit of measure is not automatically 
updated. We recommend that you set the PaperUnits property first.

For example, these commands set the units to centimeters and the paper type 
to A4.

set(gcf, 'PaperUnits', 'centimeters');
set(gcf, 'PaperType', 'A4');

This example sets the units to inches and sets the paper size of 5-by-7 inches.

set(gcf, 'PaperUnits', 'inches');
set(gcf, 'PaperSize', [5 7]);

If you set a paper size for which there is no matching paper type, the PaperType 
property is automatically set to '<custom>'.

Setting the Paper Orientation
Paper orientation refers to how the paper is oriented with respect to the figure. 
The choices are Portrait (the default), Landscape, and Rotated.
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You can change the orientation of the figure:

• “Using the Graphical User Interface”

• “Using MATLAB Commands” on page 7-48

The figure below shows the same figure printed using the three different 
orientations. 

Note  The rotated orientation is not supported by all printers. When the 
printer does not support it, landscape is used.

Using the Graphical User Interface

1 Select Page Setup from the figure window’s File menu and select the Paper 
tab. (See “Using the Graphical User Interface” on page 7-45).

2 Select the appropriate option button under Orientation.

3 Click OK.

Portrait Landscape Rotated (by 180 degrees)
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Using MATLAB Commands 
Use the PaperOrientation figure property or the orient function. Use the 
orient function if you always want your figure centered on the paper.

The following example sets the orientation to landscape:

set(gcf, 'PaperOrientation', 'landscape');

Centering the Figure. If you set the PaperOrientation property from portrait to 
either of the other two orientation schemes, you might find that what was 
previously a centered image is now positioned near the paper’s edge. You can 
either adjust the position (use the PaperPosition property), or you can use the 
orient function, which always centers the figure on the paper.

The orient function takes the same argument names as PaperOrientation. 
For example,

orient rotated; 

Selecting a Renderer
A renderer is software and/or hardware that processes graphics data (such as 
vertex coordinates) to display, print, or export a figure. You can change the 
renderer that MATLAB uses when printing a figure:

• “Using the Graphical User Interface” on page 7-51

• “Using MATLAB Commands” on page 7-51

Orientation set to 'landscape' using 
'PaperOrientation' property.

Orientation set to 'landscape' using orient 
function.
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Renderers Supported by MATLAB
MATLAB supports three rendering methods with the following characteristics:

Painter’s 

• Draws figures using vector graphics

• Generally produces higher resolution results

• The fastest renderer when the figure contains only simple or small graphics 
objects

• The only renderer possible when printing with the HPGL print driver or 
exporting to an Adobe Illustrator file

• The best renderer for creating PostScript or EPS files

• Cannot render figures that use RGB color for patch or surface objects

• Does not show lighting or transparency

Z-buffer 

• Draws figures using bitmap (raster) graphics

• Faster and more accurate than Painter’s

• Can consume a lot of system memory if MATLAB is displaying a complex 
scene

• Shows lighting, but not transparency

OpenGL 

• Draws figures using bitmap (raster) graphics

• Generally faster than Painter’s or Z-buffer

• In some cases, enables MATLAB to access graphics hardware that is 
available on some systems

• Shows both lighting and transparency

For more detailed information about the rendering methods, see Renderer on 
the Figure Properties reference page.
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The Default Renderer for MATLAB
By default, MATLAB automatically selects the best rendering method, based 
on the attributes of the figure (its complexity and the settings of various 
Handle Graphics properties) and in some cases, the printer driver or file format 
used.

In general, MATLAB uses

• Painter’s for line plots, area plots (bar graphs, histograms, etc.), and simple 
surface plots

• Z-buffer when the computer screen is not truecolor or when the opengl 
function was called with selection_mode set to neverselect

• OpenGL for complex surface plots using interpolated shading and any figure 
using lighting

The RendererMode property tells MATLAB whether to automatically select the 
renderer based on the contents of the figure (when set to auto), or to use the 
Renderer property that you have indicated (when set to manual).

Reasons for Manually Setting the Renderer
Two reasons to set the renderer yourself are

• To make your printed or exported figure look the same as it did on the screen. 
The rendering method used for printing and exporting the figure is not 
always the same method used to display the figure.

• To avoid unintentionally exporting your figure as a bitmap within a vector 
format. For example, MATLAB typically renders high-complexity plots using 
OpenGL or Z-buffer. If you export a high-complexity figure to the EPS or 
EMF vector formats without specifying a rendering method, MATLAB might 
use OpenGL or Z-buffer, each of which creates bitmap graphics.

Storing a bitmap in a vector file can generate a very large file that takes a 
long time to print. If you use one of these formats and want to make sure that 
your figure is saved as a vector file, be sure to set the rendering method to 
Painter’s.
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Using the Graphical User Interface

1 Open the Page Setup dialog box by selecting Page Setup from the figure 
window’s File menu. Select the Axes and Figure tab.

2 Under Figure renderer, select the desired rendering method from the list 
box.

3 Click OK.

Using MATLAB Commands
You can use the Renderer property or a switch with the print function to set 
the renderer for printing or exporting. These two lines each set the renderer for 
the current figure to Z-buffer.

set(gcf, 'Renderer', 'zbuffer');

or

print -zbuffer

The first example saves the new value of Renderer with the figure; the second 
example only affects the current print or export operation.

Note that when you set the Renderer property, the RendererMode property is 
automatically reset from auto (the factory default) to manual.

Setting the Resolution
Resolution refers to how accurately your figure is rendered when printed or 
exported. Higher resolutions produce higher quality output. The specific 
definition of resolution depends on whether your figure is output as a bitmap 
or as a vector graphic.

You can change the resolution that MATLAB uses to print a figure:

• “Using the Graphical User Interface on Windows” on page 7-53

• “Using the Graphical User Interface on UNIX” on page 7-54

• “Using MATLAB Commands” on page 7-54



7 Printing and Exporting

7-52

Default Resolution and When You Can Change It
The default resolution depends on the renderer used and the graphics format 
or printer driver specified. The following two tables summarize the default 
resolutions and whether you can change them.    

Resolutions Used with Graphics Formats

Graphics Format Default Resolution Can Be 
Changed?

Built-in MATLAB export 
formats, (except for EMF, 
EPS, and ILL)

150 dpi (always use OpenGL or 
Z-buffer)

Yes

EMF export format 
(Enhanced Metafile)

150 dpi Yes

EPS (Encapsulated 
PostScript)

150 dpi, if OpenGL or Z-buffer;
864 dpi if Painter’s

Yes

ILL export format (Adobe 
Illustrator)

72 dpi (always uses Painter’s) No

Ghostscript export 
formats

72 dpi (always uses OpenGL or 
Z-buffer)

No

Resolutions Used with Printer Drivers

Printer Driver Default Resolution Can Be 
Changed?

Windows and PostScript 
drivers

150 dpi, if OpenGL or Z-buffer; 
864 dpi if Painter’s

Yes

Ghostscript driver 150 dpi, if OpenGL or Z-buffer; 
864 dpi if Painter’s

Yes

HPGL driver 1116 dpi (always uses 
Painter’s)

Yes
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Choosing a Setting
You might need to determine your resolution requirements through 
experimentation, but you can also use the following guidelines.

For Printing. The default resolution of 150 dpi is normally adequate for typical 
laser-printer output. However, if you are preparing figures for high-quality 
printing, such as a textbook or color brochures, you might want to use 200 or 
300 dpi. The resolution you can use can be limited by the printer’s capabilities.

For Exporting. If you are exporting your figure, base your decision on the 
resolution supported by the final output device. For example, if you will import 
your figure into a word processing document and print it on a printer that 
supports a maximum resolution setting of 300 dpi, you could export your figure 
using 300 dpi to get a precise one-to-one correspondence between pixels in the 
file and dots on the paper.

Note  The only way to set resolution when exporting is with the print 
function.

Impact of Resolution on Size and Memory Needed
Resolution affects file size and memory requirements. For both printing and 
exporting, the higher the resolution setting, the longer it takes for MATLAB or 
your printer to render your figure.

Using the Graphical User Interface on Windows
To set the resolution for built-in MATLAB printer drivers on Windows systems,

1 From the Print dialog box, click Properties. This opens a new dialog box. 
(This box can differ from one printer to another.)

2 You may be able to set the resolution from this dialog. If not, then click 
Advanced to get to a dialog box that enables you to do this.

3 Set the resolution, and then click OK. (The resolution setting might be 
labeled by another name, such as “Print Quality.”)
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Using the Graphical User Interface on UNIX
To set the resolution for built-in MATLAB printer drivers on UNIX systems,

1 From the UNIX Print dialog box, click Options. This opens the Printing 
Options dialog box. 

2 Under the Printing Resolution panel, select either Use same resolution as 
the screen or Specify resolution in dots per inch.

3 If you select Specify resolution in dots per inch, enter a value in the 
Specify resolution in dots per inch text box.

4 Click OK.

Using MATLAB Commands 
If you use a Windows printer driver, you can only set the resolution using the 
Windows Document Properties dialog box.

Otherwise, to set the resolution for printing or exporting, the syntax is

print -rnumber

where number is the number of dots per inch. To print or export a figure using 
screen resolution, set number to 0 (zero).

This example prints the current figure with a resolution of 100 dpi:

print -r100

This example exports the current figure to a TIFF file using screen resolution:

print -r0 -dtiff myfile.tif

Setting the Axes Ticks and Limits
The MATLAB default output size, 8-by-6 inches, is normally larger than the 
screen size. If the size of your printed or exported figure is different from its 
size on the screen, MATLAB scales the number and placement of axes tick 
marks to suit the output size. This section shows you how to lock them so that 
they are the same as they were when displayed.
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You can change the resolution that MATLAB uses to print a figure:

• “Using the Graphical User Interface”

• “Using MATLAB Commands” on page 7-56

Using the Graphical User Interface
Select Page Setup from the figure window’s File menu to open the Page Setup 
dialog box. Select the Axes and Figure tab to make changes to the axes, UI 
controls, background color, or renderer selection.   

Settings you can change in the Axes and Figure window are as follows:

Axes limits and ticks. If the size of your printed or exported figure is different 
from its size on the screen, MATLAB scales the number and placement of axes 
tick marks to suit the output size. Select Keep screen limits and ticks to lock 
them so that they are the same as they were when displayed. 

Figure controls. By default, user interface controls are included in your printed 
or exported figure. Clear the Print UIControls check box to exclude them. (See 
“Excluding User Interface Controls” on page 7-62).
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Background color. You can keep the background the same as is shown on the 
screen when printed, or change the background to be white. (See “Setting the 
Background Color” on page 7-56).

Figure renderer. Set the renderer to Painter’s, Z-buffer, or OpenGL, or let 
MATLAB decide which one to use, depending on the characteristics of the 
figure. (See “Selecting a Renderer” on page 7-48).

Note  Changes you make using Page Setup affect the printed output only. 
They do not alter the figure displayed on your screen.

Using MATLAB Commands
To set the XTickMode, YTickMode, and ZTickMode properties to manual, type

set(gca, 'XTickMode', 'manual');
set(gca, 'YTickMode', 'manual');
set(gca, 'ZTickMode', 'manual');

Setting the Background Color
There are two types of background color settings in a figure: the axes 
background and the figure background. The default displayed color of both 
backgrounds is gray, but you can set them to any of several colors.

Regardless of the background colors in your displayed figure, by default, 
MATLAB always changes them to white when you print or export. This section 
shows you how to retain the displayed background colors in your output.

Using the Graphical User Interface
To retain the background color on a per figure basis,

1 Open the Page Setup dialog box by selecting Page Setup from the figure 
window’s File menu. Select the Axes and Figure tab.

2 Select Keep screen background color.

3 Click OK.
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If you are exporting your figure using the clipboard, use the Copy Options 
panel of the Preferences dialog box.

Using MATLAB Commands
To retain your background colors, use

set(gcf, 'InvertHardCopy', 'off');

The following example sets the figure background color to blue, the axes 
background color to yellow, and then sets InvertHardCopy to off so that these 
colors will appear in your printed or exported figure.

set(gcf, 'color', 'blue');
set(gca, 'color', 'yellow');
set(gcf, 'InvertHardCopy', 'off');

Setting Line and Text Characteristics
If you transfer your figures to Word or PowerPoint applications, you can set 
line and text characteristics to values recommended for those applications. The 
Figure Copy Template Preferences dialog box provides Word and 
PowerPoint options to make these settings, or you can set certain line and text 
characteristics individually.

You can change line and text characteristics:

• “Using the Graphical User Interface”

• “Using MATLAB Commands” on page 7-59

Using the Graphical User Interface
To open Figure Copy Template Preferences, select Preferences from the  
File menu, and then click Figure Copy Template in the left pane.
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Settings you can change in the Figure Copy Template Preferences dialog box 
are as follows:

Word or PowerPoint. Click Word or PowerPoint to apply settings recommended 
for MATLAB.

Text. Use options in the Text panel to modify the appearance of all text in the 
figure. You can change the font size, change color text to black and white, and 
change the font style to bold.

Note the difference between Apply to Figure and Apply.  Use Apply to Figure
to modify the figure in the figure window.  Use Apply or OK to save your preferences.
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Lines. Use the Lines panel to modify the appearance of all lines in the figure. 
Options include

• Custom width — Change the line width.

• Change style (Black or white) — Change colored lines to black or white.

• Change style (B&W styles) — Change solid lines to different line styles (e.g., 
solid, dashed, etc.), and black or white color.

UIControls and axes. If your figure includes user interface controls, you can 
choose to show or hide them by clicking Show uicontrols. Also, to keep axes 
limits and tick marks as they appear on the screen, click Keep axes limits and 
tick spacing. To allow MATLAB to scale axes limits and tick marks based on 
the size of the printed figure, clear this box.

Note  Changes you make using Page Setup affect the printed output only. 
They do not alter the figure displayed on your screen.

Using MATLAB Commands
You can use the set function on selected graphics objects in your figure to 
change individual line and text characteristics.

For example, to change line width to 1.8 and line style to a dashed line, use

lineobj = findobj('type', 'line');
set(lineobj, 'linewidth', 1.8);
set(lineobj, 'linestyle', '--');

To change the font size to 15 points and font weight to bold, use

textobj = findobj('type', 'text');
set(textobj, 'fontunits', 'points');
set(textobj, 'fontsize', 15);
set(textobj, 'fontweight', 'bold');

Setting the Line and Text Color
When colored lines and text are dithered to gray by a black-and-white printer, 
it does not produce good results for thin lines and the thin lines that make up 
text characters. You can, however, force all line and text objects in the figure to 
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print in black and white, thus improving their appearance in the printed copy. 
When you select this setting, the lines and text are printed all black or all 
white, depending on the background color.

The default is to leave lines and text in the color that appears on the screen.

Note  Your background color might not be the same as what you see on the 
screen. See the Axes and Figure tab for an option that preserves the 
background color when printing.

You can change the resolution that MATLAB uses to print a figure:

• “Using the Graphical User Interface” on page 7-60

• “Using MATLAB Commands” on page 7-61

Using the Graphical User Interface
Select Page Setup from the figure window’s File menu to open the Page Setup 
dialog box. Select the Lines and Text tab to make changes to the color of all 
lines and text on the printed page.   
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Settings you can change in the Lines and Text window are as follows:

Lines and text. To have colored lines and text printed as black and white, select 
Black and white. To print them in color, select Color (don’t convert).

Note  Changes you make using Page Setup affect the printed output only. 
They do not alter the figure displayed on your screen.

Using MATLAB Commands
There is no equivalent MATLAB command that sets line and text color 
depending on background color. Set the color of lines and text using the set 
function on either line or text objects in your figure.

This example sets all lines and text to black:

set(findobj('type', 'line'), 'color', 'black');
set(findobj('type', 'text'), 'color', 'black');

Setting CMYK Color
By default, MATLAB produces color output in the RGB color space (red, green, 
blue). If you plan to publish and print MATLAB figures using printing industry 
standard four-color separation, you might want to use the CMYK color space 
(cyan, magenta, yellow, black).

Using the Graphical User Interface on UNIX

1 Select Print from the figure window’s File menu.

2 Click Options. This opens the Printing Options dialog box.

3 Select Use CMYK colors in PS and Ghostscript drivers instead of RGB.

4 Click OK.
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Using MATLAB Commands
Use the -cmyk option with the print function. This example prints the current 
figure in CMYK using a PostScript Level II color printer driver.

print -dpsc2 -cmyk

Excluding User Interface Controls
User interface controls are objects that you create and add to a figure. For 
example, you can add a button to a figure that, when clicked, conveniently runs 
another M-file. By default, user interface controls are included in your printed 
or exported figure. This section shows how to exclude them.

Using the Graphical User Interface

1 Open the Page Setup dialog box by selecting Page Setup from the figure 
window’s File menu. Select the Axes and Figure tab.

2 Under Figure controls, clear the Print UIControls check box.

3 Click OK.

Using MATLAB Commands
Use the -noui switch. This example specifies a color PostScript driver and 
excludes UI controls.

print -dpsc -noui

This example exports the current figure to a color EPS file and excludes UI 
controls.

print -depsc -noui myfile.eps

Producing Uncropped Figures
In most cases, MATLAB crops the background tightly around the objects in the 
figure. Depending on the printer driver or file format you use, you might be 
able to produce uncropped output. An uncropped figure has increased 
background area and is often desirable for figures that contain UI controls.

The setting you make in MATLAB changes the PostScript BoundingBox 
property saved with the figure.
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Using the Graphical User Interface on UNIX
You can only make the uncropped setting on a per figure basis:

1 Select Print from the figure window’s File menu.

2 From the UNIX Print dialog box, click Options. This opens the Printing 
Options dialog box. 

3 Select Use loose bounding box for PS and Ghostscript drivers.

4 Click OK.

Using MATLAB Commands
Use the -loose option with the print function. For Windows, the uncropped 
option is only available if you print to a file.

This example exports the current figure, uncropped, to an EPS file.

print -deps -loose myfile.eps
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Choosing a Graphics Format
A graphics file format is a specification for storing and organizing data in a file. 
MATLAB supports many different graphics file formats. Some are built into 
MATLAB and others are Ghostscript formats. File formats also differ in color 
support, graphics style (bitmap or vector), and bit depth.

This section provides information to help you decide which graphics format to 
use when exporting your figure to a file or to the Windows clipboard. It covers

• “Frequently Used Graphics Formats” on page 7-65

• “Factors to Consider in Choosing a Format” on page 7-66

• “Properties Affected by Choice of Format” on page 7-68

• “Impact of Rendering Method on the Output” on page 7-70

• “Description of Selected Graphics Formats” on page 7-70

• “How to Specify a Format for Exporting” on page 7-74

Before deciding on a graphics format, check what formats are supported by 
your target application and platform. See the print reference page for a 
complete list of graphics formats supported in MATLAB. Once you decide on 
which format to use in exporting your figure, follow the instructions in 
“Exporting to a File” on page 7-17 or “Exporting to the Windows Clipboard” on 
page 7-27.
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Frequently Used Graphics Formats
Here are some of the more frequently used graphics formats. For a complete 
list, see the Graphics Format table on the print reference page. For a more 
complete description of these formats, see “Description of Selected Graphics 
Formats” on page 7-70.  

Format Description Command Line -device 
Parameter

EPS color, and 
black and white

Export line plots or simple graphs to a file.

Note. An EPS file does not display within 
some applications unless you add a TIFF 
preview image to it. See the example 
“Exporting in EPS Format with a TIFF 
Preview” on page 7-34.

-deps (black and white)

-depsc (color)

-depsc -tiff 
(TIFF preview)

JPEG 24-bit Export plots with surface lighting or 
transparency to a file. This format can be 
displayed by most Web browsers.

-djpeg

-djpegnumber,
where number is the 
compression. 

TIFF 24-bit bitmap 
color

Export plots with surface lighting or 
transparency to a file. Widely available. A 
good format to choose if you are not sure what 
formats your application supports.

-dtiff

BMP 8-bit color 
bitmap

Export a figure to the clipboard (Windows 
only).

-dbitmap

EMF color vector 
format 

Export a figure to the clipboard (Windows 
only).

-dmeta
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Factors to Consider in Choosing a Format
There are at least five main factors to consider when choosing a graphics 
format to use in exporting a figure:

• Implementation — Is it a built-in MATLAB or Ghostscript format?

• Graphics Format — Is it bitmap or vector graphics format?

• Bit Depth — What bit depth does the format offer?

• Color Support — What color support does it have?

• Model/Publication — Is it a Simulink® model or specific publication type?

The Graphics Format table shown on the print reference page provides 
information on the first four of these items for each format that MATLAB 
supports.

Built-In MATLAB or Ghostscript Formats
Some graphics formats are built-in MATLAB formats and others are provided 
by Ghostscript. In some cases (such as the Windows Bitmap format), the 
format is available both as a built-in format and a Ghostscript format. In 
general, when this is the case, we recommend that you choose the MATLAB 
format, especially if you plan to read the image back into MATLAB later.

The choice of MATLAB versus Ghostscript is important when any of these 
properties affects your output:

• Font support

• Resolution

• Importing back into MATLAB

Bitmap or Vector Graphics
MATLAB file formats are created using either bitmap or vector graphics. 
Bitmap formats store graphics as matrices of pixels. Vector formats use 
drawing commands to store graphics as geometric objects. Whether to use a 
bitmap or vector format depends mostly on the type of objects in your figure.

The choice of bitmap versus vector graphics is important when any of these 
properties or capabilities affects your output:

• Degree of complexity

• Lighting and transparency
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• Line and text quality

• File size

• Resizing after import

Bit Depth
Bit depth is the number of bits a format uses to store each pixel. This 
determines the number of colors the exported figure can contain.

Bit depth applies mostly to bitmap graphics. An 8-bit image uses 8 bits per 
pixel (bpp), enabling it to define 28, or 256, unique colors. The other supported 
bit depths are 1-bit (2 colors), 4-bit (16 colors), and 24-bit (16 million colors).

In vector files that don’t normally have a bit depth, the color of objects is 
specified by drawing commands stored in the file. However, vector files can 
contain bitmaps under the following conditions:

• Image objects saved in vector formats are always saved as bitmaps, 
regardless of the rendering method used.

• For vector files created using the OpenGL or Z-buffer renderer, everything 
in the figure is saved as a bitmap.

The Graphics Format table on the print reference page indicates the bit depth 
of each format. If file size is not critical, make sure you choose a format with a 
bit depth that supports the number of colors or shades of gray in your displayed 
figure.

Color Support
Each graphics format can produce color, grayscale, or monochrome output. 
Check the Graphics Format table to see the level of color support for each 
format type. To preserve the color in your exported file, you must select a color 
graphics format. Color is also affected by bit depth.

Simulink Models
Simulink models can only be exported to EPS or a Ghostscript format. Note 
that you can only use the print function to export a model, not the Export 
dialog box.
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High Resolution or Web Publications
If you want to use a figure in a journal or other publication, use a format that 
enables you to set a high resolution. We recommend using either TIFF or EPS.

If you want to use a figure in a Web publication, you should use either the PNG 
or the JPEG format. Note that if you need to save an image as a GIF file, you 
can use the imwrite function. You can also export your figure as a TIFF file and 
convert it to a GIF using another software application.

Properties Affected by Choice of Format
The figure properties listed in this section are affected when you select a 
graphics format when exporting to a file or the Windows clipboard.

Font Support
Ghostscript formats support a limited number of fonts. If you use an 
unsupported font, MATLAB substitutes Courier. See “PostScript and 
Ghostscript Supported Fonts” on page 7-78 for more information.

Resolution
Generally, higher resolution means higher quality. Your choice of resolution 
should be based in part on the device to which you will ultimately print it. 
Experimentation with different resolution settings can be helpful.

You cannot change the resolution of a Ghostscript format. The resolution is low 
(72 dpi) and might not be appropriate for publications.

Importing into MATLAB
If you want to read an exported figure back into MATLAB, it is best to use one 
of the built-in MATLAB formats.

Degree of Complexity
Bitmaps are preferable for high-complexity plots, where complexity is 
determined by the number of polygons, the number of polygons with 
interpolated shading, the number of markers, the presence of truecolor images, 
and other factors. An example of a high-complexity plot is a surface plot that 
uses interpolated shading.

Vector formats are preferable for most 2-D plots and for some low-complexity 
surface plots.
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Lighting and Transparency
Surface lighting and transparency are only supported by bitmap graphics 
formats. If you use a vector format, the lighting and transparency disappear. 
Note that of the two renderers intended for bitmaps (OpenGL and Z-buffer) 
only OpenGL supports transparency.

Note  If you export to an EPS (vector) file using the Painter’s renderer and 
include a TIFF preview, the preview image is a bitmap and will show lighting 
or transparency when displayed on your screen. Remember that the 
underlying format vector file, which is what normally gets printed, does not 
support these features.

Lines and Text
Generally, vector formats create better lines and text than bitmap formats.

File Size
In general, bitmap formats produce smaller files for complex plots than vector 
formats, and vector formats produce smaller files for simple plots than bitmap 
formats.

You can calculate the size of a figure exported to an uncompressed bitmap by 
multiplying the figure size by its resolution and the bit depth of the chosen 
format. For example, if a figure is 2 inches by 3 inches and has a resolution of 
100 dpi (dots per inch), it will consist of , or 60,000 pixels. 
If exported to an 8-bit file, it uses 480,000 bits, or 60 KB. If exported to a 24-bit 
file, it uses three times the number of bytes, or 180 KB.

Vector format file size is affected by the complexity and number of objects in 
your figure. As the complexity and number of objects increase, the number of 
drawing commands increases.

Resizing After Import
You can resize a vector graphics figure after importing it into another software 
application without losing quality. (Not all applications that support vector 
formats enable you to resize them.)

2 100×( ) 3 100×( )×
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This is not true of bitmap formats. Resizing a bitmap causes round-off errors 
that result in jagged edges and degradation of picture quality. This 
degradation is particularly obvious in lines and text and is highly discouraged.

Color
The Graphics Format table on the print reference page indicates the color 
support and bit depth of each format. If file size is not critical, make sure you 
choose a format with a bit depth that supports the number of colors or shades 
of gray in your displayed figure.

Impact of Rendering Method on the Output
If you specify a bitmap format when exporting, the exported file will always 
contain a bitmap regardless of your current renderer setting. If you have the 
renderer set to Painter’s, which normally produces a vector format, that setting 
is ignored under these circumstances.

Vector format files, however, can store your figure as a vector or bitmap graphic 
depending on the renderer used to export it. If you do not specify a rendering 
method and MATLAB chooses the OpenGL or Z-buffer renderer, your exported 
vector file will contain a bitmap. If you want your figure exported as a vector 
graphic, be sure to set the rendering method to Painter’s.

Description of Selected Graphics Formats
This section contains details about some of the export file formats MATLAB 
supports. For information about formats not listed here, consult a graphics file 
format reference.

Formats covered in this section are

• “Adobe Illustrator 88 Files” on page 7-71

• “EMF Files” on page 7-71

• “EPS Files” on page 7-71

• “TIFF Files” on page 7-73

• “JPEG Files” on page 7-73
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Adobe Illustrator 88 Files
Adobe Illustrator (ILL) is a vector format that is fully compatible with Adobe 
Illustrator software. An Illustrator file created in MATLAB can be further 
processed with Adobe Illustrator running on any platform. (Note that when you 
view it in Illustrator, it will have no template.)

By default, Illustrator files are color and saved in portrait orientation. The 
Illustrator group command is used to give the illustrations a hierarchy similar 
to that of the Handle Graphics or Simulink graphic. 

Some limitations of the Illustrator format are

• Interpolated patches and surfaces cannot be created. The color of each 
polygon is determined by the average of the CData values for all of the 
polygon’s vertices.

• Images cannot be exported in this format.

• The resolution setting of 72 dpi cannot be changed.

• No fonts are downloaded to the Illustrator file. Any unavailable fonts are 
replaced with fonts that are available.

EMF Files
Enhanced Metafiles (EMF) are vector files similar in nature to Encapsulated 
PostScript (EPS), capable of producing near publication-quality graphics. EMF 
is an excellent format to use if you plan to import your image into a Microsoft 
application and want the flexibility to edit and resize your image once it has 
been imported. It is the only MATLAB supported vector format you can edit 
from within a Microsoft application. (Note that your editing ability is limited. 
For the best results, do all your editing in MATLAB.)

A drawback of using EMF files is that they are generally only supported by 
Windows-based applications.

EPS Files
The Encapsulated PostScript (EPS) vector format is the most reliable and 
consistent file format MATLAB supports. It is widely recognized in desktop 
publishing and word processing packages on both UNIX and Windows 
platforms. EPS is the only MATLAB supported export format that can produce 
CMYK output. (PostScript printer drivers also support this feature.) 
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This format is your best choice for producing publication-quality graphics. It 
might not be appropriate for figures containing interpolated shading because 
it creates a very large file that is difficult to print. For such figures, use the 
TIFF format with a high-resolution setting. For more information about format 
choices, see “Bitmap or Vector Graphics” on page 7-66.

When imported into Microsoft applications, an EPS file will not display unless 
you add a TIFF preview image to it. 

The preview image is simple to add (see the next section, “Creating a Preview 
Image”). However, if you print your file to a non-PostScript printer, the TIFF 
preview is used as the printed image. The resolution of the preview image is 72 
dpi, resulting in much lower quality than the EPS image. If there is no preview 
image, your printout to a non-PostScript printer contains an error message in 
place of the graphic. Many high-end graphics packages, like Adobe Illustrator, 
can print an EPS file to a non-PostScript printer.

You cannot edit figures when using EPS files in Microsoft applications; they 
can only be annotated. 

Note  The best vector format to use with Microsoft applications is EMF. See 
“EMF Files” on page 7-71.

EPS format has limited font support. When MATLAB exports a graphic to the 
EPS file format, it does not try to determine whether the fonts you have used 
in your axes text objects are supported by the EPS format. Unsupported fonts 
are replaced with Courier.

Creating a Preview Image. You cannot create TIFF preview images using the 
graphical user interface. Use the print command with the -tiff switch. For 
example, to create an EPS Level 2 image with TIFF preview in file myfile.eps, 
type

print -depsc2 -tiff myfile.eps
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TIFF Files
The Tagged Image File Format (TIFF) is a very widely used bitmap format and 
can produce publication-quality graphics if you use a high-resolution setting 
(such as 200 or 300 dpi). 

TIFF is a good format to choose if you are not sure what formats your target 
application supports, or if you want to import the graphic into more than one 
application without having to export it to several different formats. It can also 
be imported into most image-processing applications and converted to other 
formats, if necessary. For example, the print command does not produce GIF 
files, but there are many applications that can convert TIFF files to GIF. You 
can also use getframe to create a snapshot of a figure and imwrite to save that 
image as a GIF file.

JPEG Files
The Joint Photographic Experts Group (JPEG) bitmap format is one of the 
dominant formats used in Web graphics. The 24-bit version MATLAB supports 
more colors than the popular GIF format. 

JPEG files always use JPEG compression. This is a lossy compression scheme, 
meaning that some data is thrown away during compression. When you export 
to a JPEG image, you can set the amount of compression to use. The more 
compression you use, the more data is thrown away. The compression amount 
is referred to as JPEG quality, where the highest setting results in the highest 
quality image, but the lowest amount of compression. 

Setting JPEG Quality. You cannot set the quality using the graphical user 
interface. Use the print command with the -djpeg format switch, including 
the desired quality value as a suffix. This example exports to a JPEG file using 
a quality setting of 100.

print -djpeg100 myfile.jpg

By default, MATLAB uses a quality setting of 75. Possible values are from 1 to 
100. Note that the highest setting of 100 still results in some data loss, 
although the result is usually visually indistinguishable from the original.
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How to Specify a Format for Exporting
To select a graphics format to use when exporting, choose a format from the 
Graphics Format table on the print reference page, and specify that format in 
either the Export dialog box or in the MATLAB print function.

Using the Graphical User Interface
When exporting your figure to a file,

1 Select Export from the figure window’s File menu.

2 Select a format from the Save as type list box.

3 Enter the filename you want to use and browse for the directory to save the 
file in.

4 Click Save.

Using MATLAB Commands
To specify a nondefault graphics format for the figure you are exporting, 
include the -d switch with the print command. For example, to export the 
current figure to file spline2d.eps, with 600 dpi resolution, and using the EPS 
color graphics format, type

print -r600 -depsc spline2d

Note  When printing, the print -d option specifies a printer driver. When 
exporting, the print -d option specifies a graphics format.
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Choosing a Printer Driver
A MATLAB printer driver formats your figure into instructions that your 
printer understands. See the Printer Driver table on the print reference page 
for a complete list of drivers. Specifying the printer driver does not change the 
selected printer.

This section provides information to help you decide which printer driver to use 
when printing your figure. It covers

• “Types of Printer Drivers”

• “Factors to Consider in Choosing a Driver” on page 7-76

• “Driver-Specific Information” on page 7-79

• “How to Specify the Printer Driver to Use” on page 7-83

Types of Printer Drivers
There are two main types of MATLAB printer drivers: built-in MATLAB, and 
Ghostscript.

Built-in MATLAB Drivers
Built-in MATLAB drivers are written specifically for MATLAB and include 
Windows, PostScript, and HPGL. 

MATLAB provides built-in Windows printer drivers so that your print requests 
can work with the Windows Print Manager. The Print Manager enables you to 
monitor printer queues and control various aspects of the printing process.

HPGL support is provided for the HP 7475A plotter and fully compatible 
plotters. HPGL files can also be imported into documents of other applications, 
such as Microsoft Word.

Ghostscript Drivers
Ghostscript drivers use Ghostscript, a free software conversion program, to 
convert your figure into printer-model-specific instructions. Examples of 
Ghostscript drivers are Epson and HP.
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Factors to Consider in Choosing a Driver
The choice of printer driver depends upon several considerations:

• What platform you are using

• What kind of printer you have

• What color model you want to use

• What font support you need

• Any driver-specific settings you need

The flow chart below gives an overview of how to choose a driver based on the 
platform you are using and the type of printer you have.

Deciding What Type of Printer Driver to Use

Using Windows ?
Want to use

the Windows Print
 Manager?

Use a Windows
printer driver

Is the
printer PostScript

compatible ?

Use a PostScript
printer driver

Use a GhostScript
printer driver

Yes

Yes

No

No

Yes

No
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Platform Considerations
On Windows, you can use any of the driver types shown in the figure above. If 
you use the Windows driver, you can use the Windows Print Manager.

On UNIX, you can use either PostScript or Ghostscript drivers. 

On either platform, if you have a PostScript-compatible printer, it is better to 
use a PostScript driver than a Ghostscript driver. PostScript is less prone to 
printing errors than Ghostscript.

Printer Type
Printer support is different among the Windows, PostScript, and Ghostscript 
drivers. Consult the manual for your printer to see what driver to use.

Windows drivers support most printer models, but sometimes the printer’s 
native driver is incompatible with the MATLAB Windows driver. If you are 
getting printing errors, see “Trouble with Native Drivers on Windows” on 
page 7-81. If lines and text in your figure are not printing with the desired color 
scheme, see “Correcting Color Results with Windows Drivers” on page 7-80.

Some Ghostscript drivers are specific to certain printer models. For example, 
MATLAB provides different drivers to support the HP DeskJet 500, 500C, and 
550C models, plus a generic driver for the series. When this is the case, try the 
model-specific driver first. If that doesn’t work, try the generic driver.

Color Model
By default, MATLAB uses a black-and-white driver. The built-in MATLAB and 
Ghostscript drivers print both color and black and white. The Printer Drivers 
table on the print reference page indicates which drivers are color.

Colored surfaces and images print in grayscale when you use a black-and-white 
driver. Colored lines and text can be printed in color, grayscale, or black and 
white, depending on the color support of the driver and color capability of your 
printer.

Font Support
In MATLAB, the fonts supported for printing depend upon the MATLAB 
printer driver you specify and sometimes upon which platform you are using.
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PostScript and Ghostscript Supported Fonts. The table below lists the fonts supported 
by the MATLAB PostScript and Ghostscript drivers. This same set of fonts is 
supported on both Windows and UNIX. If you use a font that is not on this list, 
it is replaced with Courier. 

If you set the font using the set function, use the names exactly as shown 
above. This example sets the font of the current text object to Helvetica-Narrow 
using MATLAB commands.

set(gca, 'FontName', 'Helvetica-Narrow');

If you use the Property Editor dialog box (available under Axes Properties or 
Current Object Properties on the Edit menu) to set the font, the list of 
available fonts shows those that are supported by your system. If you choose 
one that is not in the table above, your resulting file will use Courier.

Windows Drivers Supported Fonts. The MATLAB Windows drivers support any 
system-supported font. To see the list of fonts installed on your system, open 
the Font name list on the Text or Style tab of the Property Editor.

If you use the set function to set fonts, type in the name just as it appears in 
the Property Editor. For example, if you have the Script font installed on your 
system, set the title of your figure to Script using the following code.

h = get(gca, 'Title');
set(h, 'FontName', 'Script');

HPGL Driver Supported Fonts. HPGL drivers support only one font. However, you 
can set its size and color.

AvantGarde Helvetica-Narrow Times-Roman

Bookman NewCenturySchlbk ZapfChancery

Courier Palatino ZapfDingbats

Helvetica Symbol
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Settings That Are Driver Specific
Some print settings are only supported by specific drivers. This table 
summarizes the settings and which driver supports them.

Driver-Specific Information
This section provides additional information about the various types of printer 
drivers available to MATLAB users. It covers the following topics:

• “Setting the Windows Driver”

• “Correcting Color Results with Windows Drivers” on page 7-80

• “Trouble with Native Drivers on Windows” on page 7-81

• “Level 1 or Level 2 PostScript Drivers” on page 7-81

• “Early PostScript 1 Printers” on page 7-81

• “Background Fills in HPGL Drivers” on page 7-82

• “Color Selection in HPGL Drivers” on page 7-82

• “Limitations of HPGL Drivers” on page 7-83

Setting the Windows Driver
When you specify a Windows driver (-dwin or -dwinc), MATLAB interprets 
this to mean that the print request will use the Windows Print Manager. It also 
means that MATLAB will assign the default Windows driver based on your 
current printer’s color property setting. In other words, MATLAB does not 
differentiate between -dwin or -dwinc in printopt.m and you might not get the 
expected output color.

Setting Driver(s) 

Appending figures to a PostScript file PostScript

BoundingBox (setting figure to print 
uncropped)

PostScript, Ghostscript

CMYK PostScript

Resolution set with user interface PostScript, Windows

Resolution set with print function PostScript, Ghostscript
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There are two ways to ensure that MATLAB uses -dwin or -dwinc: specify the 
driver when you print, or use the Windows Document Properties dialog box 
to set the default driver.

You can use the printer’s Document Properties dialog box to set the default 
driver for all print requests. This dialog box sets the printer’s color property, 
which in turn sets the default Windows driver.

To access this dialog box, click the Options button on the Windows Print or 
Print Setup dialog box. See your Windows documentation if you need help 
with this dialog box. Document Properties dialog boxes vary from printer to 
printer. The figure below shows an example of one. 

Windows Document Properties Dialog Box for an HP LaserJet 5Si

Correcting Color Results with Windows Drivers
Sometimes, even when you use the Windows Document Properties dialog box, 
you can receive incorrect color results because some Windows printers return 
inaccurate information about their color property setting. 

Select this option, then set the 
printer’s color property below.
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If this happens, you can use the figure window’s Preferences dialog box to 
override the color property. This setting is used as the default setting for all 
future print operations:

1 Select Preferences from the figure window’s File menu or from the File 
menu on the MATLAB Command Window.

2 Select General Preferences.

3 Under the Figure Window Printing panel, select Always send as color.

4 Click OK.

Trouble with Native Drivers on Windows
Occasionally, printing problems are due to a bug in the native printer driver or 
an incompatibility between the native printer driver and the MATLAB driver.

If you are having trouble, try installing a different native printer driver. A 
newer version might be available from the manufacturer or from a different 
vendor. You may also be able to use the native driver from a different printer, 
such as an earlier model from the same manufacturer.

If this doesn’t help, try using a PostScript or Ghostscript driver. 

Level 1 or Level 2 PostScript Drivers
Choosing between the Level 1 and Level 2 MATLAB PostScript drivers does 
not affect the quality of your output. Make the choice based on what your 
printer supports and on any file size or speed concerns.

Level 1 PostScript produces good results on a Level 2 printer, but Level 2 
PostScript does not print properly on a Level 1 printer.

Level 2 PostScript files are generally smaller and render more quickly than 
Level 1 files. If your printer supports Level 2 PostScript, use one of the Level 2 
drivers. If your printer does not support Level 2, or if you’re not sure, use a 
Level 1 driver. 

Early PostScript 1 Printers
If you have an early PostScript 1 printer, such as some of the PostScript 
printers manufactured before 1990, you may notice problems in the text of 
MATLAB printouts. Your printer might not support the ISOLatin1Encoding 
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operator that MATLAB uses for PostScript files. If this is the case, use Adobe’s 
PostScript default character-set encoding:

• UNIX only: Open the Print dialog box and click Options. This opens the 
Printing Options dialog box. Select Use Adobe PS default character set 
encoding.

• Specify the -adobecset option with the print command.

Background Fills in HPGL Drivers
The HPGL driver cannot do background fills. Therefore, you should ensure 
that your figure is set to print with a white background (the default), and that 
any lines and text in your figure are drawn in a color dark enough to be seen 
on a white background. For more information about background color, see 
“Setting the Background Color” on page 7-56.

Color Selection in HPGL Drivers
The HP 7475A plotter supports six pens, none of which can be white. If 
MATLAB tries to draw in white while rendering in HPGL mode, the driver 
ignores all drawing commands until a different color is chosen. 

Pen 1, which is assumed to be black, is used for drawing axes. The remaining 
pens are used for the first five colors specified in the ColorOrder property of 
the current axes object. If ColorOrder specifies fewer than five colors, the 
unspecified pens are not used. 

For Simulink systems, which ordinarily use a maximum of eight colors, the six 
pens available on the plotter are assumed to be

• Pen 1: black

• Pen 2: red

• Pen 3: green

• Pen 4: blue

• Pen 5: cyan

• Pen 6: magenta
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If you attempt to draw a MATLAB object containing a color that is not a known 
pen color, the driver chooses the nearest approximation to the unlisted color. 

Limitations of HPGL Drivers
The HPGL driver has these limitations:

• Display colors and plotted colors sometimes differ.

• Areas (faces on mesh and surface plots, patches, blocks, and arrowheads) are 
not filled.

• There is no hidden line or surface removal.

• Text is printed in the plotter’s default font.

• Line width is determined by pen width.

• Images and UI controls cannot be plotted.

• Interpolated edge lines between two vertices are drawn with the pen whose 
color best matches the average color of the two vertices.

• Figures cannot be rendered using Z-buffer or OpenGL; this driver always 
uses the Painter’s algorithm.

How to Specify the Printer Driver to Use
If you need to use a driver other than the default driver for your system, choose 
a new driver from the Printer Driver table on the print reference page, and set 
it either as a new default or just for the current figure you are working on.

Setting the Default Driver for All Figures
If you do not indicate a specific printer driver, MATLAB uses the default driver 
specified by the variable dev in the printopt.m file. The factory default driver 
depends on the platform. 

To change the default driver for all figures, edit printopt.m and change the 
value for dev to match one of the driver codes listed in the Printer Drivers table 

Platform Factory Default Printer Driver Driver Code

Windows Black-and-white Windows -dwin

UNIX Black-and-white Level II PostScript -dps2
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on the print reference page. See “Setting Defaults Across Sessions” on 
page 7-7 for instructions.

Setting a Driver for the Current Figure Only
You can change the printer driver using a UNIX dialog box or from the 
MATLAB command line.

Using the Graphical User Interface on UNIX. To specify a printer driver for the 
current figure,

1 From the figure window’s File menu, select Print.

2 Select a printer driver from the Driver list.

3 Click OK to print your figure.

Using MATLAB Commands. To specify a nondefault printer driver for the figure 
you are printing, include the -d switch with the print command. For example, 
to print the current figure using the MATLAB built-in Windows color printer 
driver winc, type

print -dwinc

Note  When printing, the print -d option specifies a printer driver. When 
exporting, the print -d option specifies a graphics format.
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Troubleshooting
This section lists some common problems you might encounter when printing 
or exporting your figure. Refer to the appropriate section listed below:

• Printing Problems
- “Printer Drivers” on page 7-86

- “Default Settings” on page 7-87

- “Color vs. Black and White” on page 7-87

- “Printer Selection” on page 7-88

- “Rotated Text” on page 7-88

- “ResizeFcn Warning” on page 7-88

• Exporting Problems
- “Background Color” on page 7-89

- “Default Settings” on page 7-89

- “Microsoft Word” on page 7-89

- “File Format” on page 7-90

- “Size of Exported File” on page 7-91

- “Making Movies” on page 7-91

- “Extended Operations” on page 7-91
• General Problems

- “Background Color” on page 7-92

- “Default Settings” on page 7-92

- “Dimensions of Output” on page 7-93

- “Axis and Tick Labels” on page 7-93

- “UI Controls” on page 7-94

- “Cropping” on page 7-94

- “Text Object Font” on page 7-94

If you don’t find your problem listed here, try searching the Knowledge Base 
maintained by the MathWorks Technical Support Department. Go to 
http://www.mathworks.com/support and enter a topic in the search field.
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Printing Problems

Printer Drivers

I’m using a Windows printer driver and have been encountering problems such as 
segmentation violations, general protection faults, application errors, and unexpected 
output.

Try one of the following solutions:

• Check the table of drivers in the print reference page to see if there are other 
drivers you can try. 

- If your printer is PostScript compatible, try printing with one of the 
MATLAB built-in PostScript drivers.

- If your printer is not PostScript compatible, see if one of the MATLAB 
built-in Ghostscript devices is appropriate for your printer model. These 
devices use Ghostscript to convert PostScript files into other formats, such 
as HP LaserJet and Canon BubbleJet.

• Contact the printer vendor to obtain a different native printer driver. The 
behavior you are experiencing might occur only with certain versions of the 
native printer driver. If this doesn’t help and you are using Windows, try 
reinstalling the drivers that were shipped with your Windows installation 
disk.

• Export the figure to a graphics-format file, and then import it into another 
application before printing it. For information about exporting figures with 
MATLAB, see “Exporting to a File” on page 7-17.

When I use the print function with the -deps switch, I receive this error message.

Encapsulated PostScript files cannot be sent to the printer.
File saved to disk under name 'figure2.eps'

As the error message indicates, your figure was saved to a file. EPS is a 
graphics file format and cannot be sent to a printer using a printer driver. To 
send your figure directly to a printer, try using one of the PostScript driver 
switches. See the table of drivers in the print reference page. To print an EPS 
file, you must first import it into a word processor or other software program. 
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Default Settings

My printer uses a different default paper type than the MATLAB default type of “letter.” How 
can I change the default paper type so that I won’t have to set it for each new figure?

You can set the default value for any property by adding a line to startup.m. 
Adding the following line sets the default paper type to A4. 

set(0, 'DefaultFigurePaperType', 'A4'); 

In your call to set, combine the word Default with the name of the object 
Figure and the property name PaperType.

I set the paper orientation to landscape, but each time I go to print a new figure, the orientation 
setting is portrait again. How can I change the default orientation so that I won’t have to set 
it for each new figure?

See the explanation for the question above. Adding the following line to 
startup.m sets the default paper orientation to landscape.

set(0, 'DefaultFigurePaperOrient', 'landscape')

Color vs. Black and White

I want the lines in my figure to print in black, but they keep printing in color.

You must be using a color printer driver. You can specify a black-and-white 
driver using the print function or the Page Setup dialog box to force the lines 
for the current figure to print in black. See “Setting the Line and Text Color” 
on page 7-59 for instructions.

A white line in my figure keeps coming out black when I print it.

There are two things that can cause this to happen. Most likely, the line is 
positioned over a dark background. By default, MATLAB inverts your 
background to white when you print, and changes any white lines over the 
background to black. To avoid this, retain your background color when you 
print. See “Setting the Background Color” on page 7-56.

The other possibility is that you are using a Windows printer driver and the 
printer is sending inaccurate color information to MATLAB. See “Correcting 
Color Results with Windows Drivers” on page 7-80.
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I am using a color printer, but my figure keeps printing in black and white.

By default, MATLAB uses a black-and-white printer driver. You need to 
specify a color printer driver. For instructions, see “Choosing a Printer Driver” 
on page 7-75. If you are already using a Windows color driver, the printer 
might be returning inaccurate information about its color property. See 
“Correcting Color Results with Windows Drivers” on page 7-80.

Printer Selection

I have more than one printer connected to my system. How do I specify which one to print my 
figure with? 

You can use either the Print dialog box, or the MATLAB print function, 
specifying the printer with the -P switch. For instructions using either method, 
see “Selecting the Printer” on page 7-40.

Rotated Text

I have some rotated text in my figure. It looks fine on the screen, but when I print it, the 
resolution is poor.

You are probably using bitmapped fonts, which don’t rotate well. Try using 
TrueType fonts instead. 

ResizeFcn Warning

I get a warning about my ResizeFcn being used when I print my figure.

By default, MATLAB resizes your figure when converting it to printer 
coordinates. Therefore, MATLAB calls any ResizeFcn you have created for the 
figure and issues a warning. You can avoid this warning by setting the figure 
to print at screen size.
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Exporting Problems

Background Color

I generated a figure with a black background and selected “Use figure color” from the Copy 
Options panel of the Preferences dialog box. But when I exported my figure, its background 
was changed to white.

You must have exported your figure to a file. The settings in Copy Options 
only apply to figures copied to the clipboard. 

There are two ways to retain the displayed background color: use the Page 
Setup dialog box or set the InvertHardCopy property to off. See “Setting the 
Background Color” on page 7-56 for instructions on either method.

Default Settings

I want to export all of my figures using the same size. Is there some way to do this so that I 
don’t have to set the size for each individual figure?

You can set the default value for any property by adding a line to startup.m. 
Adding the following line sets the default figure size to 4-by-3 inches. 

set(0, 'DefaultFigurePaperPosition', [0 0 4 3]); 

In your call to set, combine the word Default with the name of the object 
Figure and the property name PaperPosition.

I use the clipboard to export my figures as metafiles. Is there some way to force all of my copy 
operations to use the metafile format?

Use the Copy Options panel of the Preferences dialog box. Any settings made 
here, including whether MATLAB copies your figure as a metafile or bitmap, 
apply to all copy operations. See “Exporting to the Windows Clipboard” on 
page 7-27 for instructions.

Microsoft Word

I exported my figure to an EPS file, and then tried to import it into my Word document. My 
printout has an empty frame with an error message saying that my EPS picture was not saved 
with a preview and will only print to a PostScript printer. How do I include a TIFF preview?
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Use the print command with the -tiff switch. For example,

print -deps -tiff filename

Note that if you print to a non-PostScript printer with Word, the preview image 
is used for printing. This is a low-resolution image that lacks the quality of an 
EPS graphic. For more information about preview images and other aspects of 
EPS files, see “EPS Files” on page 7-71.

When I try to resize my figure in Word, its quality suffers.

You must have used a bitmap format. Bitmap files generally do not resize well. 
If you are going to export using a bitmap format, try to set the figure’s size 
while it’s still in MATLAB. See “Setting the Figure Size and Position” on 
page 7-41 for instructions.

As an alternative, you can use one of the vector formats, EMF or EPS. Figures 
exported in these formats can be resized in Word without affecting quality.

I exported my figure as an EMF to the clipboard. When I paste it into Word, some of the labels 
are printed incorrectly.

This problem occurs with some versions of Word and Windows. Try editing the 
labels in Word.

File Format

I tried to import my exported figure into a word processing document, but I got an error saying 
the file format is unrecognized.

There are two likely causes: you used the print function and forgot to specify 
the export format, or your word processing program does not support the export 
format. Include a format switch when you use the print function; simply 
including the file extension is not sufficient. For instructions, see “Exporting to 
a File” on page 7-17.

If this does not solve your problem, check what formats the word processor 
supports.

I tried to append a figure to an EPS file, and received an error message.

You cannot append figures to an EPS file. The -append option is only valid for 
PostScript files, which should not be confused with EPS files. PostScript is a 
printer driver; EPS is a graphics file format.
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Of the supported export formats, only HDF supports storing multiple figures, 
but you must use the imwrite function to append them. For an example, see 
the reference page for imwrite.

Size of Exported File

I’ve always used the EPS format to export my figures, but recently it started to generate huge 
files. Some of my files are now several megabytes!

Your graphics have probably become complicated enough that MATLAB is 
using the OpenGL or Z-buffer renderer instead of the Painter’s renderer. It 
does this to improve display time or to handle attributes that Painter’s cannot, 
such as lighting. However, using OpenGL or Z-buffer causes a bitmap to be 
stored in your EPS file, which sometimes leads to a large file.

There are two ways to fix the problem. You can specify the Painter’s renderer 
when you export to EPS, or you can use a bitmap format, such as TIFF. The 
best renderer and type of format to use depend upon the figure. See “Bitmap or 
Vector Graphics” on page 7-66 if you need help deciding. For information about 
the rendering methods and how to set them, see “Selecting a Renderer” on 
page 7-48.

Making Movies

I am processing a large number of frames in MATLAB. I would like these frames to be saved 
as individual files for later conversion into a movie. How can I do this?

Use getframe to capture the frames, imwrite to write them to a file, and movie 
to create a movie from the files. For more information about using getframe 
and imwrite to capture and write the frames, see “Exporting with getframe” on 
page 7-24. For more information about creating a movie from the captured 
frames, see the reference page for movie.

You can also save multiple figures to an AVI file. AVI files can be used for 
animated sequences that do not need MATLAB to run. However, they do 
require an AVI viewer. For more information, see “Exporting Audio/Video 
Data” in the MATLAB Programming documentation.

Extended Operations

There are some export operations that cannot be performed using the Export dialog box.
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You need to use the print function to do any of the following operations:

• Export to a supported file format not listed in the Export dialog box. The 
formats not available from the Export dialog box include HDF, some 
variations of BMP and PCX, and the raw data versions of PBM, PGM, and 
PPM.

• Specify a resolution.

• Specify one of the following options: TIFF preview, loose bounding box for 
EPS files, compression quality for JPEG files, CMYK output on Windows.

• Perform batch exporting.

General Problems

Background Color

When I output my figure, its background is changed to white. How can I get it to have the 
displayed background color?

By default, when you print or export a figure, MATLAB inverts the background 
color to white. There are two ways to retain the displayed background color: use 
the Page Setup dialog box or set the InvertHardCopy property to off. See 
“Setting the Background Color” on page 7-56 for instructions on either method. 

If you are exporting your figure to the clipboard, you can also use the Copy 
Options panel of the Preferences dialog box. Setting the background here sets 
it for all figures copied to the clipboard.

Default Settings

I need to produce diagrams for publications. There is a list of requirements that I must meet 
for size of the figure, fonts types, etc. How can I do this easily and consistently?

You can set the default value for any property by adding a line to startup.m. 
As an example, the following line sets the default axes label font size to 12.

set(0, 'DefaultAxesFontSize', 12);

In your call to set, combine the word Default with the name of the object Axes 
and the property name FontSize.
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Dimensions of Output

The dimensions of my output are huge. How can I make it smaller?

Check your settings for figure size and resolution, both of which affect the 
output dimensions of your figure. 

The default figure size is 8-by-6 inches. You can use the Page Setup dialog box 
or the PaperPosition property to set the figure size. See “Setting the Figure 
Size and Position” on page 7-41. 

The default resolution depends on the export format or printer driver used. For 
example, built-in MATLAB bitmap formats, like TIFF, have a default 
resolution of 150 dpi. You can change the resolution by using the print 
function and the -r switch. For default resolution values and instructions on 
how to change them, see “Setting the Resolution” on page 7-51.

I selected “Match Screen Size” from the Page Setup menu, but my output looks a little bigger, 
and my font looks different.

You probably output your figure using a higher resolution than your screen 
uses. Set your resolution to be the same as the screen’s. 

As an alternative, if you are exporting your figure, see if your application 
enables you to select a resolution. If so, import the figure at the same resolution 
it was exported with. For more information about resolution and how to set it 
when exporting, see “Setting the Resolution” on page 7-51.

Axis and Tick Labels

When I resize my figure below a certain size, my x-axis label and the bottom half of the x-axis 
tick labels are missing from the output.

Your figure size might be too small to accommodate the labels. Labels are 
positioned a fixed distance from the x-axis. Since the x-axis itself is positioned 
a relative distance away from the window’s edge, the label text might not fit. 
Try using a larger figure size or smaller fonts. For instructions on setting the 
size of your figure, see “Setting the Figure Size and Position” on page 7-41. For 
information about setting font size, see the Text Properties reference page.

In my output, the x-axis has fewer ticks than it did on the screen.
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MATLAB has rescaled your ticks because the size of your output figure is 
different from its displayed size. There are two ways to prevent this: select 
Keep screen limits and ticks from the Axes and Figure tab of the Page Setup 
dialog box, or set the XTickMode, YTickMode, and ZTickMode properties to 
manual. See “Setting the Axes Ticks and Limits” on page 7-54 for details.

UI Controls

My figure contains UI controls. How do I prevent them from appearing in my output?

Use the print function with the -noui switch. For details, see “Excluding User 
Interface Controls” on page 7-62.

Cropping

I can’t output my figure using the uncropped setting (i.e., a loose BoundingBox).

Only PostScript printer drivers and the EPS export format support uncropped 
output. There is a workaround for Windows printer drivers, however. Using 
the print function, save your figure to a file that can be printed later. For an 
example see “Producing Uncropped Figures” on page 7-62.

Text Object Font

I have a problem with text objects when printing with a PostScript printer driver or exporting 
to EPS. The fonts are correct on the screen, but are changed in the output.

You have probably used a font that is not supported by EPS and PostScript. All 
unsupported fonts are converted to Courier. See “PostScript and Ghostscript 
Supported Fonts” on page 7-78 for the list of the supported fonts.
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Organization of Graphics Objects
Graphics objects are the basic drawing elements used by MATLAB to display 
data. Each instance of an object is associated with a unique identifier called a 
handle. Using this handle, you can manipulate the characteristics (called 
object properties) of an existing graphics object. You can also specify values for 
properties when you create a graphics object.

These objects are organized into a hierarchy, as shown by the following 
diagram.

The hierarchical nature of Handle Graphics is based on the interdependencies 
of the various graphics objects. For example, to draw a line object, MATLAB 
needs an axes object to orient and provide a frame of reference to the line. The 
axes, in turn, needs a figure window to display the axes and its child objects. 

Axes

Core Objects

Figure

Root

Annotation ObjectsPlot Objects

Annotation Axes

Group Objects

HiddenUI Objects
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Types of Graphics Objects
There are two basic types of graphics objects:

• Core graphics objects — Used by high-level plotting functions and by 
composite objects to create plot objects

• Composite objects — Composed of core graphics objects that have been 
grouped together to provide a more convenient interface

Composite objects form the basis for four subcategories of graphics objects.

• Plot objects — Composed of basic graphics objects, but enable properties to 
be set on plot object level

• Annotation objects — Exist on a layer separate from other graphics objects

• Group objects — Create groups of objects that can behave as one in certain 
respects. You can parent any axes child object (except light) to a group object, 
including other group object.

• UI objects — User interface objects are used to construct graphical user 
interfaces. 

Graphics objects are interdependent, so the graphics display typically contains 
a variety of objects that, in conjunction, produce a meaningful graph or picture. 

Information on Specific Graphics Objects
See the following sections for more information on the various types of graphics 
objects:

“Graphics Windows — the Figure” on page 8-5

“Core Graphics Objects” on page 8-8 

“Plot Objects” on page 8-17

“Annotation Objects” on page 8-22

“Group Objects” on page 8-25

“Object Properties” on page 8-35

For information on user interface objects and their application, see the 
“Creating Graphical User Interfaces” documentation.
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Graphics Windows — the Figure
Figures are the windows in which MATLAB displays graphics. Figures contain 
menus, toolbars, user-interface objects, context menus, axes and, as axes 
children, all other types of graphics objects.

MATLAB places no limits on the number of figures you can create (your 
computer systems might impose limitations, however). 

Figures play two distinct roles in MATLAB:

• Containing data graphs

• Containing graphical user interfaces

Figures can contain both graphs and GUIs components at the same time. For 
example, a GUI might be designed to plot data and therefore contain an axes 
as well as user interface objects. See “Example — Using Figure Panels” on 
page 8-77 for an example of such a GUI.

The following diagram illustrates the types of objects that figures can contain. 

Note that both figures and axes have children that act as containers. A uipanel 
can contain user interface objects and be parented to a figure and group objects 
(hggroup and hgtransform) can contain axes children (except light objects) and 
be parented to an axes. 

See “Objects That Can Contain Other Objects” on page 8-76 for more 
information.

Axes

Uipanel

Core and plot objects

User interface objects

Figure

Group objects



8 Handle Graphics Objects

8-6

Figures Used for Graphing Data
MATLAB functions that draw graphics (e.g., plot and surf) create figures 
automatically if none exist. If there are multiple figures open, one figure is 
always designated as the “current” figure, and is the target for graphics output.

The gcf command returns the handle of the current figure or creates a new 
figure if one does not exist. For example, you can enter the following command 
to see a list of figure properties.

get(gcf)

The root object CurrentFigure property returns the handle of the current 
figure, if one exists, or returns empty if there are no figures open. For example,

get(0,'CurrentFigure')
ans =
[]

See “Controlling Graphics Output” on page 8-60 for more information on how 
MATLAB determines where to display graphics.

Figure Children for Graphs
Figures that display graphs need to contain axes to provide the frame of 
reference for objects such as lines and surfaces, which are used to represent 
data. These data representing objects can be contained in group objects or 
contained directly in the axes. See “Example — Translating Grouped Objects” 
on page 8-82 for an example of how to use group objects. 

Figures can contain multiple axes arranged in various locations within the 
figure and can be of various sizes. See “Automatic Axes Resize” on page 10-7 
and “Multiple Axes per Figure” on page 10-13 for more information on axes.

Figures Used for GUIs
GUIs range from sophisticated applications to simple warning dialog boxes. 
You can modify many aspects of the figure to fit the intended use by setting 
figure properties. For example, the following figure properties are often useful 
when creating GUIs.

• Show or hide the figure menu, while displaying custom-designed menus 
(MenuBar)

• Change the figure title (Name)
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• Control user access to the figure handle (HandleVisibility)

• Create a callback that executes whenever the user resizes the figure 
(ResizeFcn)

• Control display of the figure toolbar (Toolbar)

• Assign a context menu (UIContextMenu)

• Define callbacks that execute when users click drag or release the mouse 
over the figure (WindowButtonDownFcn, WindowButtonMotionFcn, 
WindowButtonUpFcn). Also see the ButtonDownFcn property.

• Specify whether the figure is modal (WindowStyle)

See the figure properties for more information on figure characteristics you can 
specify. 

See the Creating Graphical User Interfaces documentation for more 
information about using figure to create GUIs.

Root Object — the Figure Parent 
The parent of a figure is the root object. You cannot instantiate the root object 
because its purpose is only to store information. It maintains information on 
the state of MATLAB, your computer system, and some MATLAB defaults. 

There is only one root object and all other objects are its descendants. You do 
not create the root object; it exists when you start MATLAB. You can, however, 
set the values of root properties and thereby affect the graphics display. 

For more information see root object properties. 

More Information on Figures
See the figure reference page for information on creating figures.

See “Callback Properties for Graphics Objects” on page 8-85 for information on 
figure events for which you can define callbacks.

See “Figure Properties” on page 9-1 for information on other figure properties.
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Core Graphics Objects
Core graphics objects include basic drawing primitives like line, text, and 
polygon shells (patch objects); specialized objects like surfaces, which are 
composed of a rectangular grid of vertices; images; and light objects, which are 
not visible but affect the way some objects are colored.

Axes contain objects that represent data, such as line, surfaces, contourgroups, 
etc.

The following table lists the core graphics objects and links to the reference 
pages of the functions used to create each object.
.

Core Graphics Objects

Function Purpose

axes Axes objects define the coordinate system for 
displaying graphs. Axes are always contained 
within a figure.

image 2-D representation of a matrix where numeric 
values are mapped to colors. Images can also be 
3-D arrays of RGB values. 

light Directional light source located within the axes. 
Lights affect patches and surfaces, but cannot 
themselves be seen.

line A line is drawn by connecting the data points that 
define it.

patch Filled polygons with separate edge properties. A 
single patch can contain multiple faces, each 
colored independently with solid or interpolated 
colors. 

rectangle 2-D object that has settable edge and face color, 
and variable curvature (can draw ellipses) 
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The following picture illustrates some typical core graphics objects.

surface 3-D grid of quadrilaterals created by plotting the 
value of each element in a matrix as a height above 
the x-y plane

text Character strings positioned in the coordinate 
system defined by the axes

Core Graphics Objects

Function Purpose
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Description of Core Graphics Objects
This section describes the core graphics objects. 

Axes
Axes objects define a frame of reference in a figure window for the display 
objects that are generally defined by data. For example, MATLAB creates a 
line by connecting each data point with a line segment. The axes determines 
the location of each data point in the figure by defining axis scales (x, y, and z 
or radius and angle, etc.)

Axes are children of figures and are parents of core, plot, and group objects. 

Note that, while annotation objects are also children of axes, they can be 
parented only to the hidden annotation axes (see the annotation function for 
more information).

All functions that draw graphics (e.g., plot, surf, mesh, and bar) create an axes 
object if one does not exist. If there are multiple axes within the figure, one axes 
is always designated as the “current” axes, and is the target for display of the 
above-mentioned graphics objects (uicontrols and uimenus are not children of 
axes).

Image
A MATLAB image consists of a data matrix and possibly a colormap. There are 
three basic image types that differ in the way that data matrix elements are 
interpreted as pixel colors — indexed, intensity, and truecolor. Since images 
are strictly 2-D, you can view them only at the default 2-D view.

Light
Light objects define light sources that affect all patch and surface objects 
within the axes. You cannot see lights, but you can set properties that control 
the style of light source, color, location, and other properties common to all 
graphics objects. 

Line
Line objects are the basic graphics primitives used to create most 2-D and some 
3-D plots. High-level functions plot, plot3, and loglog (and others) create line 
objects. The coordinate system of the axes positions and orients the line. 
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Patch
Patch objects are filled polygons with edges. A single patch can contain 
multiple faces, each colored independently with solid or interpolated colors. 
fill, fill3, and contour3 create patch objects. The coordinate system of the 
axes positions and orients the patch.

Rectangle
Rectangle objects are 2-D filled areas having a shape that can range from a 
rectangle to an ellipse. Rectangles are useful for creating flow-chart-type 
drawings.

Surface
Surface objects are 3-D representations of matrix data created by plotting the 
value of each matrix element as a height above the x-y plane. Surface plots are 
composed of quadrilaterals whose vertices are specified by the matrix data. 
MATLAB can draw surfaces with solid or interpolated colors or with only a 
mesh of lines connecting the points. The coordinate system of the axes positions 
and orients the surface.

The high-level function pcolor and the surf and mesh group of functions create 
surface objects.

Text
Text objects are character strings. The coordinate system of the parent axes 
positions the text. The high-level functions title, xlabel, ylabel, zlabel, and 
gtext create text objects. 

Example — Creating Core Graphics Objects
Object creation functions have a syntax of the form

handle = function('propertyname',propertyvalue,...)

You can specify a value for any object property (except those that are read only) 
by passing property name/value pairs as arguments. The function returns the 
handle of the object it creates, which you can use to query and modify 
properties after creating the object.
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This example evaluates a mathematical function and creates three graphics 
objects using the property values specified as arguments to the figure, axes, 
and surface commands. MATLAB uses default values for all other properties.

[x,y] = meshgrid([−2:.4:2]);
Z = x.*exp(−x.^2−y.^2);
fh = figure('Position',[350 275 400 300],'Color','w');
ah = axes('Color',[.8 .8 .8],'XTick',[−2 −1 0 1 2],...

'YTick',[−2 −1 0 1 2]);
sh = surface('XData',x,'YData',y,'ZData',Z,...

'FaceColor',get(ah,'Color')+.1,...
'EdgeColor','k','Marker','o',...
'MarkerFaceColor',[.5 1 .85]);

Note that the surface function does not use a 3-D view like the high-level surf 
functions. Object creation functions simply add new objects to the current axes 
without changing axes properties, except the Children property, which now 
includes the new object and the axis limits (XLim, YLim, and ZLim), if necessary. 

You can change the view using the camera commands or use the view 
command.

view(3)
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Parenting
By default, all statements that create graphics objects do so in the current 
figure and the current axes (if the object is an axes child). However, you can 
specify the parent of an object when you create it. For example, the statement

axes('Parent',figure_handle,...)

creates an axes in the figure identified by figure_handle. You can also move 
an object from one parent to another by redefining its Parent property.

set(gca,'Parent',figure_handle)

High-Level Versus Low-Level
Many MATLAB graphics functions call the object creation functions to draw 
graphics objects. However, high-level routines also clear the axes or create a 
new figure, depending on the settings of the axes and figure NextPlot 
properties. 
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In contrast, core object creation functions simply create their respective 
graphics objects and place them in the current parent object. They do not 
respect the settings of the figure or axes NextPlot property. 

For example, if you call the line function,

line('XData',x,'YData',y,'ZData',z,'Color','r')

MATLAB draws a red line in the current axes using the specified data values. 
If there is no axes, MATLAB creates one. If there is no figure window in which 
to create the axes, MATLAB creates it as well. 

If you call the line function a second time, MATLAB draws the second line in 
the current axes without erasing the first line. This behavior is different from 
high-level functions like plot that delete graphics objects and reset all axes 
properties (except Position and Units). You can change the behavior of 
high-level functions by using the hold command or by changing the setting of 
the axes NextPlot property. 

See “Controlling Graphics Output” on page 8-60 for more information on this 
behavior and on using the NextPlot property.

Simplified Calling Syntax
Object creation functions have convenience forms that allow you to use a 
simpler syntax. For example, 

text(.5,.5,.5,'Hello')

is equivalent to

text('Position',[.5 .5 .5],'String','Hello')

Note that using the convenience form of an object creation function can cause 
subtle differences in behavior when compared to formal property 
name/property value syntax.

A Note About Property Names
By convention, MATLAB documentation capitalizes the first letter of each 
word that makes up a property name, such as LineStyle or XTickLabelMode. 
While this makes property names easier to read, MATLAB does not check for 
uppercase letters. In addition, you need use only enough letters to identify the 
name uniquely, so you can abbreviate most property names. 
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In M-files, however, using the full property name can prevent problems with 
futures releases of MATLAB if a shortened name is no longer unique because 
of the addition of new properties. 



Plot Objects

8-17

Plot Objects
A number of high-level plotting functions create plot objects. The properties of 
plot objects provide easy access to the important properties of the core graphics 
objects that the plot objects contain. 

Plot object parents can be axes or group objects (hggroup or hgtransform). See 
“Objects That Can Contain Other Objects” on page 8-76 for examples.

This table lists the plot objects and the graphing functions that use them. Click 
object names to see a description of their properties.

Plot Objects

Object Purpose

areaseries Used to create area graphs 

barseries Used to create bar graphs

contourgroup Used to create contour graphs

errorbarseries Used to create errorbar graphs

lineseries Used by line plotting functions (plot, plot3, etc.)

quivergroup Used to create quiver and quiver3 graphs

scattergroup Used to create scatter and scatter3 graphs

stairseries Used to create stairstep graphs (stairs)

stemseries Used to create stem and stem3 graphs

surfaceplot Used by the surf and mesh group of functions

Axes

Group 
Object

Plot 
Object

Plot 
Object
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Creating a Plot Object
For example, the following statements create a contour graph of the peaks 
function and then set the line style and width of the contour lines.

[x,y,z] = peaks;
[c,h] = contour(x,y,z);
set(h,'LineWidth',3,'LineStyle',':')

The contour plot object enables you to set the line width and style of the contour 
graph by setting two properties. Looking at the core objects contained in the 
contour plot object reveals a number of patch objects whose edges are used to 
implement the contour line, which you would otherwise need to set 
individually.

child_handles = get(h,'Children');
get(child_handles,'Type')
ans = 
    'patch'
    'patch'
    'patch'
    'patch'
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    'patch'
    'patch'
    'patch'
    'patch'
    'patch'
    'patch'
    'patch'
    'patch'

Identifying Plot Objects Programmatically
Plot objects all return hggroup as the value of the Type property. If you want to 
be able to identify plot objects programmatically but do not have access to the 
object’s handle, set a value for the object’s Tag property. 

For example, the following statements create a bar graph with five barseries 
objects and assign a different value for the Tag property on each object.

h = bar(rand(5));
set(h,{'Tag'},{'bar1','bar2','bar3','bar4','bar5'}')

Note that the cell array of property values must be transposed (') to have the 
proper shape. See the set function for more information on setting properties.

No User Default Values
Note that you cannot define default values for plot objects. 

Linking Graphs to Variables — Data Source 
Properties
Plot objects enable you to link a MATLAB expression with properties that 
contain data. For example, the lineseries object has data source properties 
associated with the XData, YData, and ZData properties. These properties are 
called XDataSource, YDataSource, and ZDataSource. 

To use a data source property,

1 Assign the name of a variable to the data source property that you want 
linked to an expression.

2 Calculate a new value for the variable.
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3 Call the refreshdata function to update the plot object data. 

refreshdata enables you to specify whether to use a variable in the base 
workspace or the workspace of the function from which you call refreshdata.

Data Source Example
The following example illustrates how to use this technique.

function datasource_ex
t = 0:pi/20:2*pi;
y = exp(sin(t));
h = plot(t,y,'YDataSource','y');
for k = 1:.1:10

y = exp(sin(t.*k));
refreshdata(h,'caller') % Evaluate y in the function workspace
drawnow; pause(.1)

end

Changing the Size of Data Variables
If you change one data source property to a variable that contains data of a 
different dimension, you might cause the function to generate a warning and 
not render the graph until you have changed all data source properties to 
appropriate values. 

Plot Objects and Backward Compatibility
Plotting functions that create plot objects can introduce incompatibilities with 
code written before MATLAB Version 7. However, all plotting functions that 
return handles to plot objects support an optional argument ('v6') that forces 
the functions to use core objects, as was the case in MATLAB before Version 7. 

See “Plot Objects” on page 8-17 for a list of functions that create plot objects.

See “Core Graphics Objects” on page 8-8 for a list of core graphics objects.

Saving Figures That Are Compatible with Previous Version of MATLAB
Create backward-compatible FIG-files by following these two steps.

• Ensure that any plotting functions used to create the contents of the figure 
are called with the 'v6' argument, where applicable. 
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• Use the '-v6' option with the hgsave command. 

For example,

h = figure;
t = 0:pi/20:2*pi;
plot('v6',t,sin(t).*2)
hgsave(h,'myFigFile','-v6')

You can set a general MATLAB preference to ensure that figures saved by 
selecting the Save item under the figure File menu are backward compatible. 
To access MATLAB preferences, select Preferences from the Desktop File 
menu. Expand the General node and select MAT Files. Click Ensure 
backward compatibility (-v6). Note that this setting affects all FIG-files and 
MAT-files that you create.
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Annotation Objects
Users typically create annotation objects from the Plot Edit toolbar or the 
Insert menu (select Plot Edit in the View menu to display the Plot Edit 
toolbar). However, you can also create annotation objects using the annotation 
function. 

Annotation objects are created in a hidden axes that extends the full width and 
height of the figure. This enables you to specify the locations of annotation 
objects anywhere in the figure using normalized coordinates (the lower left 
corner is the point 0,0, the upper right corner is the point 1,1).

Annotation Object Properties

Note  You should not change any of the properties of the annotation axes or 
parent any graphics objects to this axes. Use the annotation function or the 
graphics tools to create annotation objects. 

The following links access descriptions of the properties you can set on the 
respective annotation objects.

• Annotation arrow properties

• Annotation doublearrow properties

• Annotation ellipse properties

• Annotation line properties

• Annotation rectangle properties

• Annotation textarrow properties

• Annotation textbox properties

To modify the appearance of annotation objects created with the plotting tools, 
use the Property Editor. 

Example — Enclosing Subplots with an Annotation 
Rectangle
The following example shows how to create a rectangle annotation object and 
use it to highlight two subplots in a figure. This example uses the axes 
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properties Position and TightInset to determine the location and size of the 
annotation rectangle.

1 First create an array of subplots.

x = -2*pi:pi/12:2*pi;
y = x.^2;
subplot(2,2,1:2)
plot(x,y)
h1=subplot(223);
y = x.^4;
plot(x,y)
h2=subplot(224);
y = x.^5;
plot(x,y)

2 Determine the location and size of the annotation rectangle required to 
enclose axes, tick mark labels, and title using the axes Position and 
TightInset properties.

p1 = get(h1,'Position'); 
t1 = get(h1,'TightInset');
p2 = get(h2,'Position');
t2 = get(h2,'TightInset');
x1 = p1(1)-t1(1); y1 = p1(2)-t1(2); 
x2 = p2(1)-t2(1); y2 = p2(2)-t2(2); 
w = x2-x1+t1(1)+p2(3)+t2(3); h = p2(4)+t2(2)+t2(4);

3 Create the annotation rectangle to enclose the lower two subplots. Make the 
rectangle a translucent red with a solid border.

annotation('rectangle',[x1,y1,w,h],...
 'FaceAlpha',.2,'FaceColor','red','EdgeColor','red');
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Group Objects
Group objects enable you to treat a number of axes child objects as one group. 
For example, you can make the entire group visible or invisible, select all 
objects when only one is clicked, or apply a transform matrix to reposition the 
objects by setting only one property on the group object.

There are two group objects:

• hggroup — Use when you want to create a group of objects and control the 
visibility or selectability of the group based on what happens to any 
individual object in the group. Create hggroup objects with the hggroup 
function.

• hgtransform — Use when you want to transform a group of objects. 
Transforms include rotation, translation, scaling, etc. See “Example — 
Transforming a Hierarchy of Objects” for an example. Create hgtransform 
objects with the hgtransform function.

Note that the difference between the hggroup and hgtransform objects is 
ability of the hgtransform object to apply a transform matrix (via its Matrix 
property) to all objects for which it is the parent.

Note  You cannot parent light objects to hggroup or hgtransform objects.

Creating a Group
You create a group by parenting axes children to an hggroup or hgtransform 
object. For example, 

hb = bar(rand(5)); % creates 5 barseries objects
hg = hggroup;
set(hb,'Parent',hg) % parent the barseries to the hggroup
set(hg,'Visible','off') % makes all barseries invisible

Group objects can be the parent of any number of axes children, including other 
group objects.
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Note  Many plotting functions clear the axes (i.e., remove axes children) 
before drawing the graph. Clearing the axes also deletes any hggroup or 
hgtransform objects in the axes.

Transforming Objects
The hgtransform object’s Matrix property enables you to apply a transform to 
all the hgtransform’s children in unison. Typical transforms include rotation, 
translation, and scaling. You define a transform with a four-by-four 
transformation matrix, which is described in the following sections.

Creating a Transform Matrix
The makehgtform function simplifies the construction of matrices to perform 
rotation, translation, and scaling. See the “Example — Transforming a 
Hierarchy of Objects” section for information on creating transform matrices 
using makehgtform.

Rotation
Rotation transforms rotate objects about the x-, y-, or z-axis, with positive 
angles rotating counterclockwise while sighting along the respective axis 
toward the origin. If the desired angle of rotation is θ, the following matrices 
define this rotation about the respective axis.

To create a transform matrix for rotation about an arbitrary axis, use the 
makehgtform function.
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Translation
Translation transforms move objects with respect to their current locations. 
Specify the translation as distances tx, ty, and tz in data space units. The 
following matrix shows the location of these elements in the transform matrix. 

Scaling
Scaling transforms change the sizes of objects. Specify scale factors sx, sy, and 
sz and construct the following matrix.

The Default Transform
The default transform is the identity matrix, which you can create with the eye 
function. Here is the identity matrix:

See “Undoing Transform Operations” for related information.
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Absolute vs. Relative Transforms
Transforms are specified in absolute terms, not relative to the current 
transform. For example, if you apply a transform that translates the 
hgtransform object 5 units in the x direction and then you apply another 
transform that translates it 4 units in the y direction, the resulting position of 
the object is 4 units in the y direction from its original position. 

If you want transforms to accumulate, you must concatenate the individual 
transforms into a single matrix. See “Combining Transforms into One Matrix” 
for more information.

Combining Transforms into One Matrix
It is usually more efficient to combine various transform operations into one 
matrix by concatenating (multiplying) the individual matrices and setting the 
Matrix property to the result. Note that matrix multiplication is not 
commutative, so the order in which you multiply the matrices affects the 
result. For example, suppose you want to perform an operation that scales, 
translates, and then rotates. You would multiply the matrices as follows:

C = R*T*S % operations are performed from right to left

where S is the scaling matrix, T is the translation matrix, R is the rotation 
matrix, and C is the composite of the three operations. You then set the 
hgtransform object’s Matrix property to C:

set(hgtransform_handle,'Matrix',C)

Note that the following sets of statements are not equivalent:

set(hgtransform_handle,'Matrix',C)% Transform as above
set(hgtransform_handle,'Matrix',eye(4) ) % Undo transform

versus

C = eye(4)*R*T*S % Multiply identity matrix as last step
set(hgtransform_handle,'Matrix',C)

Concatenating the identity matrix to other matrices has no effect on the 
composite matrix.
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Undoing Transform Operations
Since transform operations are specified in absolute terms (not relative to the 
current transform), you can undo a series of transforms by setting the current 
transform to the identity matrix. For example, the following statement

set(hgtransform_handle,'Matrix',eye(4))

returns the object hgtransform_handle to its untransformed orientation.

Rotations Away From the Origin
Since rotations are performed about the origin, it is often necessary to translate 
the hgtransform object so that the desired axis of rotation is temporarily at the 
origin. After applying the rotation transform matrix, you then translate the 
hgtransform object back to its original position. The following example 
illustrates how to do this.

Suppose you want to rotate a surface about the y-axis at the center of the 
surface (the y-axis that passes through the point x = 20 in this example).

Note  If you are using the MATLAB Help browser, you can run this example 
or open it in the MATLAB editor.

1 Create a surface and an hgtransform object. Parent the surface to the 
hgtransform object.
h = surf(peaks(40)); view(-20,30)
t = hgtransform;
set(h,'Parent',t)

The following picture shows the surface. 
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2 Create and set a y-axis rotation matrix to rotate the surface by -15 degrees.
ry_angle = -15*pi/180; % Convert to radians
Ry = makehgtform('yrotate',ry_angle);
set(t,'Matrix',Ry)

Axis of rotation
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Notice that the surface rotated -15 degrees about the y-axis that passes 
through the origin. However, to rotate about the y-axis that passes through the 
point x = 20, you must translate the surface in x by 20 units.

3 Create two translation matrices, one to translate the surface -20 units in x 
and another to translate 20 units back. Concatenate the two translation 
matrices with the rotation matrix in the correct order and set the transform.
Tx1 = makehgtform('translate',[-20 0 0]);
Tx2 = makehgtform('translate',[20 0 0]);
set(t,'Matrix',Tx2*Ry*Tx1)

Example — Transforming a Hierarchy of Objects
This example creates a hierarchy of hgtransform objects, which are then 
transformed in sequence to create a cube from six squares. The example 
illustrates how you can parent hgtransform objects to other hgtransform 
objects to create a hierarchy and how transforming members of a hierarchy 
affects subordinate members.

The following picture illustrates the hierarchy.

Effective axis of rotation
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hgtransform 1

Text ('Bottom')Patch (red)

hgtransform 2

Text ('Right')Patch (green)

hgtransform 3

Text ('Back')Patch (blue)

hgtransform 4

Text ('Top')Patch (yellow)

hgtransform 6

Text ('Front')Patch (magenta)

The diagram on the left represents the object hierarchy in the picture 
below. 

Through a series of simple rotations and translations, the six squares are 
folded into a cube.

hgtransform 5

Text ('Left')Patch (cyan)

Axes
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Note  If you are using the MATLAB Help browser, you can run this example 
or open it in the MATLAB editor.

1 Set up the figure and the view. Use double buffering to prevent flashing 
during the loop. Set the Renderer property to zbuffer.
set(gcf,'DoubleBuffer','on');
set(gcf,'Renderer','zbuffer');

% Set axis limits and view
set(gca,'XLim',[0 4], 'YLim',[0 4], 'ZLim', [0 3]);
view(3); axis equal; grid on

2 Define a hierarchy of hgtransform objects. 
t(1) = hgtransform;
t(2) = hgtransform('parent',t(1));
t(3) = hgtransform('parent',t(2));
t(4) = hgtransform('parent',t(3));
t(5) = hgtransform('parent',t(4));
t(6) = hgtransform('parent',t(5));

3 Create the patch and text objects and parent each pair to the respective 
hgtransform object. 

Note that the data defining each patch object and the locations of all text 
objects are the same and are assigned by a single call to set. The objects are 
then translated to the desired positions on screen. 
% Patch data
X = [0 0 1 1];
Y = [0 1 1 0];
Z = [0 0 0 0];

% Text data
Xtext = .5;
Ytext = .5;
Ztext = .15;

% Parent corresponding pairs of objects (patch and text)
% into the object hierarchy
p(1) = patch('FaceColor','red','Parent',t(1));
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txt(1) = text('String','Bottom','Parent',t(1));
p(2) = patch('FaceColor','green','Parent',t(2));
txt(2) = text('String','Right','Parent',t(2));
p(3) = patch('FaceColor','blue','Parent',t(3));
txt(3) = text('String','Back','Color','white','Parent',t(3));
p(4) = patch('FaceColor','yellow','Parent',t(4));
txt(4) = text('String','Top','Parent',t(4));
p(5) = patch('FaceColor','cyan','Parent',t(5));
txt(5) = text('String','Left','Parent',t(5));
p(6) = patch('FaceColor','magenta','Parent',t(6));
txt(6) = text('String','Front','Parent',t(6));

% Set the patch x, y, and z data
set(p,'XData',X,'YData',Y,'ZData',Z)

% Set the position and alignment of the text
set(txt,'Position',[Xtext Ytext Ztext],...
    'HorizontalAlignment','center',...
    'VerticalAlignment','middle')

4 Translate the squares (patch objects) to the desired locations. Note that as 
hgtransform object 2 is translated, all its children (including hgtransform 
objects 3 through 6) are also translated. Therefore, each translation requires 
moving the square by only one unit in either the x or y direction. 
Hgtransform object 1 is left at its original position.
% Set up initial translation transform matrices
% Translate 1 unit in x
Tx = makehgtform('translate',[1 0 0]);
% Translate 1 unit in y
Ty = makehgtform('translate',[0 1 0]);

% Set the Matrix property of each hgtransform object (2-6)
set(t(2),'Matrix',Tx);
drawnow
set(t(3),'Matrix',Ty);
drawnow
set(t(4),'Matrix',Tx);
drawnow
set(t(5),'Matrix',Ty);
drawnow
set(t(6),'Matrix',Tx);
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Object Properties
A graphics object’s properties control many aspects of its appearance and 
behavior. Properties include general information such as the object’s type, its 
parent and children, and whether it is visible, as well as information unique to 
the particular class of object. 

For example, from any given figure object you can obtain the identity of the last 
key pressed in the window, the location of the pointer, or the handle of the most 
recently selected menu. 

Note  The simplest way to access the documentation of all object properties is 
using the Handle Graphics Property Browser.

Storing Object Information
MATLAB organizes graphics information into a hierarchy and stores 
information about objects in properties. For example, root properties contain 
the handle of the current figure and the current location of the pointer (cursor), 
figure properties maintain lists of their descendants and keep track of certain 
events that occur within the window, and axes properties contain information 
about how each child object uses the figure colormap and the color order used 
by the plot function.

Changing Values
You can query the current value of any property and specify most property 
values (although some are set by MATLAB and are read only). Property values 
apply uniquely to a particular instance of an object; setting a value for one 
object does not change this value for other objects of the same type. 

Default Values
You can set default values that affect all subsequently created objects. 
Whenever you do not define a value for a property, either as a default or when 
you create the object, MATLAB uses “factory-defined” values.

Note that plot objects do not allow you to set default values.
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The reference entry for each object creation function provides a complete list of 
the properties associated with the graphics object.

Properties Common to All Objects
Some properties are common to all graphics objects, as illustrated in the 
following table.

Property Description

BeingDeleted Has a value of on when object’s DeleteFcn has 
been called

BusyAction Controls the way MATLAB handles callback 
routine interruption defined for the particular 
object

ButtonDownFcn Callback routine that executes when button press 
occurs

Children Handles of all this object’s child objects

Clipping Mode that enables or disables clipping (meaningful 
only for axes children)

CreateFcn Callback routine that executes when this type of 
object is created

DeleteFcn Callback routine that executes when you issue a 
command that destroys the object

HandleVisibility Allows you to control the availability of the object’s 
handle from the command line and from within 
callback routines

HitTest Determines if object can become the current object 
when selected by a mouse click

Interruptible Determines whether a callback routine can be 
interrupted by a subsequently invoked callback 
routine
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Parent The object’s parent

Selected Indicates whether object is selected

SelectionHighlight Specifies whether object visually indicates the 
selection state

Tag User-specified object label

Type The type of object (figure, line, text, etc.)

UserData Any data you want to associate with the object

Visible Determines whether or not the object is visible

Property Description
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Setting and Querying Property Values 
The set and get functions specify and retrieve the value of existing graphics 
object properties. They also enable you to list possible values for properties that 
have a fixed set of values. (You can also use the Property Editor to set many 
property values. 

The basic syntax for setting the value of a property on an existing object is

set(object_handle,'PropertyName','NewPropertyValue')

To query the current value of a specific object’s property, use a statement like

returned_value = get(object_handle,'PropertyName');

Property names are always quoted strings. Property values depend on the 
particular property. 

See “Accessing Object Handles” on page 8-50 and the findobj command for 
information on finding the handles of existing objects.

Setting Property Values
You can change the properties of an existing object using the set function and 
the handle returned by the creating function. For example, this statement 
moves the y-axis to the right side of the plot on the current axes.

set(gca,'YAxisLocation','right')

If the handle argument is a vector, MATLAB sets the specified value on all 
identified objects.

You can specify property names and property values using structure arrays or 
cell arrays. This can be useful if you want to set the same properties on a 
number of objects. For example, you can define a structure to set axes 
properties appropriately to display a particular graph.

view1.CameraViewAngleMode = 'manual';
view1.DataAspectRatio = [1 1 1];
view1.ProjectionType = 'Perspective';

To set these values on the current axes, type

set(gca,view1)
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Listing Possible Values
You can use set to display the possible values for many properties without 
actually assigning a new value. For example, this statement obtains the values 
you can specify for line object markers.

set(obj_handle,'Marker')

MATLAB returns a list of values for the Marker property for the type of object 
specified by obj_handle. Braces indicate the default value.

[ + | o | * | . | x | square | diamond | v | ^ | > | < | pentagram 
| hexagram | {none} ]

To see a list of all settable properties along with possible values of properties 
that accept string values, use set with just an object handle.

set(object_handle) 

For example, for a surface object, MATLAB returns

CData
CDataScaling: [ {on} | off]
EdgeColor: [ none | {flat} | interp ] ColorSpec.
EraseMode: [ {normal} | background | xor | none ]
FaceColor: [ none | {flat} | interp | texturemap ] ColorSpec.
LineStyle: [ {−} | −− | : | −. | none ]

.

.

.
Visible: [ {on} | off ]

If you assign the output of the set function to a variable, MATLAB returns the 
output as a structure array. For example, 

a = set(gca);

The field names in a are the object’s property names and the field values are 
the possible values for the associated property. For example,

a.GridLineStyle
ans = 

    '-'
    '--'
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    ':'
    '-.'
    'none'

returns the possible values for the axes grid line styles. Note that while 
property names are not case sensitive, MATLAB structure field names are. For 
example,

a.gridlinestyle
??? Reference to non-existent field 'gridlinestyle'.

returns an error.

Querying Property Values
Use get to query the current value of a property or of all the object’s properties. 
For example, check the value of the current axes PlotBoxAspectRatio 
property.

get(gca,'PlotBoxAspectRatio')

ans =
1     1     1

MATLAB lists the values of all properties, where practical. However, for 
properties containing data, MATLAB lists the dimensions only (for example, 
CurrentPoint and ColorOrder).

AmbientLightColor = [1 1 1]
Box = off
CameraPosition = [0.5 0.5 2.23205]
CameraPositionMode = auto
CameraTarget = [0.5 0.5 0.5]
CameraTargetMode = auto
CameraUpVector = [0 1 0]
CameraUpVectorMode = auto
CameraViewAngle = [32.2042]
CameraViewAngleMode = auto
CLim: [0 1]
CLimMode: auto
Color: [0 0 0]
CurrentPoint: [ 2x3  double]
ColorOrder: [ 7x3  double]
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.

.

.
Visible = on

Querying Individual Properties
You can obtain the data from the property by getting that property 
individually.

get(gca,'ColorOrder')
ans =

0         0    1.0000
         0    0.5000         0
    1.0000         0         0
         0    0.7500    0.7500
    0.7500         0    0.7500
    0.7500    0.7500         0
    0.2500    0.2500    0.2500

Returning a Structure
If you assign the output of get to a variable, MATLAB creates a structure array 
whose field names are the object property names and whose field values are the 
current values of the named property.

For example, if you plot some data, x and y,

h = plot(x,y);

and get the properties of the line object created by plot,

a = get(h);

you can access the values of the line properties using the field name. This call 
to the text command places the string 'x and y data' at the first data point 
and colors the text to match the line color.

text(x(1),y(1),'x and y data','Color',a.Color)

If x and y are matrices, plot draws one line per column. To label the plot of the 
second column of data, reference that line.

text(x(1,2),y(1,2),'Second set of data','Color',a(2).Color)
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Querying Groups of Properties
You can define a cell array of property names and conveniently use it to obtain 
the values for those properties. For example, suppose you want to query the 
values of the axes “camera mode” properties. First define the cell array.

camera_props(1) = {'CameraPositionMode'};
camera_props(2) = {'CameraTargetMode'};
camera_props(3) = {'CameraUpVectorMode'};
camera_props(4) = {'CameraViewAngleMode'};

Use this cell array as an argument to obtain the current values of these 
properties.

get(gca,camera_props)
ans = 

'auto' 'auto' 'auto' 'auto'

Factory-Defined Property Values
MATLAB defines values for all properties, which are used if you do not specify 
values as arguments or as defaults. You can obtain a list of all factory-defined 
values with the statement

a = get(0,'Factory');

get returns a structure array whose field names are the object type and 
property name concatenated, and field values are the factory value for the 
indicated object and property. For example, this field,

UimenuSelectionHighlight: 'on'

indicates that the factory value for the SelectionHighlight property on 
uimenu objects is on.

You can get the factory value of an individual property with

get(0,'FactoryObjectTypePropertyName')

For example,

get(0,'FactoryTextFontName')
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Setting Default Property Values
All object properties have values built into MATLAB (i.e., factory-defined 
values). You can also define your own default values at any point in the object 
hierarchy. 

Note that you cannot define default values for plot objects.

How MATLAB Searches for Default Values
MATLAB searches for a default value beginning with the current object and 
continuing through the object’s ancestors until it finds a user-defined default 
value or until it reaches the factory-defined value. Therefore, a search for 
property values is always satisfied.

The closer to the root of the hierarchy you define the default, the broader its 
scope. If you specify a default value for line objects on the root level, MATLAB 
uses that value for all lines (because the root is at the top of the hierarchy). If 
you specify a default value for line objects on the axes level, then MATLAB uses 
that value for line objects drawn only in that axes.

If you define default values on more than one level, the value defined on the 
closest ancestor takes precedence because MATLAB terminates the search as 
soon as it finds a value. 

Note that setting default values affects only those objects created after you set 
the default. Existing graphics objects are not affected.

This diagram shows the steps MATLAB follows in determining the value of a 
graphics object property.
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Defining Default Values
To specify default values, create a string beginning with the word Default 
followed by the object type and finally the object property. For example, to 
specify a default value of 1.5 points for the line property LineWidth at the level 
of the current figure, use the statement

set(gcf,'DefaultLineLineWidth',1.5)

The string DefaultLineLineWidth identifies the property as a line property. To 
specify the figure color, use DefaultFigureColor. Note that it is meaningful to 
specify a default figure color only on the root level.

set(0,'DefaultFigureColor','b')

Use get to determine what default values are currently set on any given object 
level; for example,

get(gcf,'default')

returns all default values set on the current figure.

Setting Properties to the Default
Specifying a property value of 'default' sets the property to the first 
encountered default value defined for that property. For example, these 
statements result in a green surface EdgeColor:

set(0,'DefaultSurfaceEdgeColor','k')
h = surface(peaks);
set(gcf,'DefaultSurfaceEdgeColor','g')
set(h,'EdgeColor','default')

Because a default value for surface EdgeColor exists on the figure level, 
MATLAB encounters this value first and uses it instead of the default 
EdgeColor defined on the root.

Removing Default Values
Specifying a property value of 'remove' gets rid of user-defined default values. 
The statement

set(0,'DefaultSurfaceEdgeColor','remove')

removes the definition of the default Surface EdgeColor from the root.
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Setting Properties to Factory-Defined Values
Specifying a property value of 'factory' sets the property to its 
factory-defined value. (The property descriptions provides access to the factory 
settings for properties having predefined sets of values.) 

For example, these statements set the EdgeColor of surface h to black (its 
factory setting) regardless of what default values you have defined.

set(gcf,'DefaultSurfaceEdgeColor','g')
h = surface(peaks);
set(h,'EdgeColor','factory')

Reserved Words
Setting a property value to default, remove, or factory produces the effects 
described in the previous sections. To set a property to one of these words (e.g., 
a text or uicontrol String property set to the word Default), you must precede 
the word with the backslash character. For example, 

h = uicontrol('Style','edit','String','\Default');

Examples — Setting Default Line Styles
The plot function cycles through the colors defined by the axes ColorOrder 
property when displaying multiline plots. If you define more than one value for 
the axes LineStyleOrder property, MATLAB increments the line style after 
each cycle through the colors.

You can set default property values that cause the plot function to produce 
graphs using varying linestyles, but not varying colors. This is useful when you 
are working on a monochrome display or printing on a black and white printer. 

First Example
This example creates a figure with a white plot (axes) background color, then 
sets default values for axes objects on the root level.

whitebg('w') %create a figure with a white color scheme
set(0,'DefaultAxesColorOrder',[0 0 0],...

'DefaultAxesLineStyleOrder','−|−−|:|−.')

Whenever you call plot,

Z = peaks; plot(1:49,Z(4:7,:))
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it uses one color for all data plotted because the axes ColorOrder contains only 
one color, but cycles through the linestyles defined for LineStyleOrder.

Second Example
This example sets default values on more than one level in the hierarchy. These 
statements create two axes in one figure window, setting default values on the 
figure level and the axes level.

t = 0:pi/20:2*pi;
s = sin(t);
c = cos(t);
% Set default value for axes Color property
figh = figure('Position',[30 100 800 350],...

'DefaultAxesColor',[.8 .8 .8]); 

axh1 = subplot(1,2,1); grid on
% Set default value for line LineStyle property in first axes
set(axh1,'DefaultLineLineStyle',' .')
line('XData',t,'YData',s) 
line('XData',t,'YData',c) 
text('Position',[3 .4],'String','Sine')
text('Position',[2 .3],'String','Cosine',...
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'HorizontalAlignment','right')

axh2 = subplot(1,2,2); grid on
% Set default value for text Rotation property in second axes
set(axh2,'DefaultTextRotation',90)
line('XData',t,'YData',s) 
line('XData',t,'YData',c) 
text('Position',[3 .4],'String','Sine')
text('Position',[2 .3],'String','Cosine',...

'HorizontalAlignment','right')

Issuing the same line and text statements to each subplot region results in a 
different display, reflecting different default settings.

Because the default axes Color property is set on the figure level of the 
hierarchy, MATLAB creates both axes with the specified gray background 
color.

The axes on the left (subplot region 121) defines a dash-dot line style (−.) as the 
default, so each call to the line function uses dash-dot lines. The axes on the 
right does not define a default line style, so MATLAB uses solid lines (the 
factory setting for lines). 

The axes on the right defines a default text Rotation of 90 degrees, which 
rotates all text by this amount. MATLAB obtains all other property values 
from their factory settings, which results in nonrotated text on the left.
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To install default values whenever you run MATLAB, specify them in your 
startup.m file. Note that MATLAB might install default values for some 
appearance properties when started by calling the colordef command. 
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Accessing Object Handles
MATLAB assigns a handle to every graphics object it creates. All object 
creation functions optionally return the handle of the created object. If you 
want to access the object’s properties (e.g., from an M-file) you should assign its 
handle to a variable at creation time to avoid searching for it later. 

You can always obtain the handle of an existing object with the findobj 
function or by listing its parent’s Children property. 

See “Searching for Objects by Property Values — findobj” on page 8-52 for 
examples.

See “Protecting Figures and Axes” on page 8-68 for more information on how 
object handles are hidden from normal access.

Special Object Handles
The root object’s handle is always zero. The handle of a figure is either

• An integer that, by default, is displayed in the window title bar 

• A floating point number requiring full MATLAB internal precision

The figure IntegerHandle property controls the type of handle the figure 
receives.

All other graphics object handles are floating-point numbers. You must 
maintain the full precision of these numbers when you reference handles. 
Rather than attempting to read handles off the screen and retype them, you 
must store the value in a variable and pass that variable whenever MATLAB 
requires a handle.

The Current Figure, Axes, and Object
An important concept in Handle Graphics is that of being current. The current 
figure is the window designated to receive graphics output. Likewise, the 
current axes is the target for commands that create axes children. The current 
object is the last graphics object created or clicked on by the mouse.

MATLAB stores the three handles corresponding to these objects in the 
ancestor’s property list.
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These properties enable you to obtain the handles of these key objects.

get(0,'CurrentFigure');
get(gcf,'CurrentAxes');
get(gcf,'CurrentObject');

The following commands are shorthand notation for the get statements.

• gcf — Returns the value of the root CurrentFigure property

• gca — Returns the value of the current figure’s CurrentAxes property

• gco — Returns the value of the current figure’s CurrentObject property

You can use these commands as input arguments to functions that require 
object handles. For example, you can click on a line object and then use gco to 
specify the handle to the set command,

set(gco,'Marker','square')

or list the values of all current axes properties with

get(gca)

You can get the handles of all the graphic objects in the current axes (except 
those with hidden handles),

h = get(gca,'Children');

and then determine the types of the objects.

get(h,'type')
ans = 

'text'
'patch'
'surface'
'line'

Root
CurrentFigure

Current Figure

CurrentObject
CurrentAxes

Current Axes

Current Object
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While gcf and gca provide a simple means of obtaining the current figure and 
axes handles, they are less useful in M-files. This is particularly true if your 
M-file is part of an application layered on MATLAB where you do not 
necessarily have knowledge of user actions that can change these values.

See “Controlling Graphics Output” on page 8-60 for information on how to 
prevent users from accessing the handles of graphics objects that you want to 
protect.

Searching for Objects by Property Values — findobj
The findobj function provides a means to traverse the object hierarchy quickly 
and obtain the handles of objects having specific property values. To serve as a 
means of identification, all graphics objects have a Tag property that you can 
set to any string. You can then search for the specific property/value pair. 

For example, suppose you create a checkbox that is sometimes inactivated in 
the GUI. By assigning a unique value for the Tag property, you can always find 
that particular instance and set its properties.

uicontrol('Style','checkbox','Tag','save option')

Use findobj to locate the object whose Tag property is set to 'save option' and 
disable it.

set(findobj('Tag','save option'),'Enable','off')

If you do not specify a starting object, findobj searches from the root object, 
finding all occurrences of the property name/property value combination that 
you specify. 

Example — Finding Objects
This plot of the sine function contains text objects labeling particular values of 
the function. 
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Suppose you want to move the text string labeling the value sin(t) = .707 from 
its current location at [pi/4,sin(pi/4)] to the point [3*pi/4,sin(3*pi/4)] 
where the function has the same value (shown grayed out in the picture). To do 
this, you need to determine the handle of the text object labeling that point and 
change its Position property. 

To use findobj, pick a property value that uniquely identifies the object. This 
example uses the text String property.

text_handle = findobj('String','\leftarrowsin(t) = .707');

Next move the object to the new position, defining the text Position in axes 
units.

set(text_handle,'Position',[3*pi/4,sin(3*pi/4),0])

findobj also lets you restrict the search by specifying a starting point in the 
hierarchy, instead of beginning with the root object. This results in faster 
searches if there are many objects in the hierarchy. In the previous example, 
you know the text object of interest is in the current axes, so you can type

text_handle = findobj(gca,'String','\leftarrowsin(t) = .707');
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Example — Using Logical Operators and Regular Expression
Suppose you create the following graph and want to modify certain properties 
of the objects created.

x = 0:30;
y = [1.5*cos(x);4*exp(-.1*x).*cos(x);exp(.05*x).*cos(x)]';
h = stem(x,y);
set(h(1),'Color','black',...
            'Marker','o',...
            'Tag','Decaying Exponential')
set(h(2),'Color','black',...
            'Marker','square',...
            'Tag','Growing Exponential')
set(h(3),'Color','black',...
            'Marker','*',...
            'Tag','Steady State')

The following instance diagram shows the graphics objects created in the 
graph. Each of the three sets of data produces a stemseries object, which in 
turn uses two lines to create the stem graph; one line for the stems and one for 
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the markers that terminate each stem. There is also a line used for the 
baseline.

Controlling the Depth of the Search. Now make the baseline into a dashed line. 
Because it is parented directly to the axes, you can use the following statement 
to access only this line:

set(findobj(gca,'-depth',1,'Type','line'),'LineStyle','--')

By setting -depth to 1, findobj searches only the axes and its immediate 
children. As you can see from the above instance diagram, the baseline is the 
only line object parented directly to the axes.

Limiting the Search with Regular Expressions. Increase the value of the MarkerSize 
property by 2 points on all stemseries objects that do not have their property 
Tag set to 'Steady State'.

h = findobj('-regexp','Tag','[^Steady State]');
set(h,{'MarkerSize'},num2cell(cell2mat(get(h,'MarkerSize'))+2))

See the regexp function for more information on using regular expressions in 
MATLAB.

Using Logical Operators. Change the color of the stem lines, but not the stem 
markers. To do this, you must access the line objects contained by the three 
stemseries objects. You cannot just set the stemseries Color property because 
it sets both the line and marker colors.

Line

Stemseries

Axes

Stemseries

Line
(stems) (markers)

Line Line
(stems) (markers)

Line
(baseline)Steady State Decaying Exponential

Stemseries

Line Line
(stems) (markers)

Growing Exponential
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Search for objects that are of Type line, have Marker set to none, and do not 
have LineStyle set to '--', which is the baseline.

h = findobj('type','line','Marker','none',...
'-and','-not','LineStyle','--');

set(h,'Color','red')

The following picture shows the graph after making the various changes 
described in this section.

Copying Objects
You can copy objects from one parent to another using the copyobj function. 
The new object differs from the original object only in the value of its Parent 
property and its handle; it is otherwise a clone of the original. You can copy a 
number of objects to a new parent, or one object to a number of new parents, as 
long as the result maintains the correct parent/child relationship. 

When you copy an object having child objects, MATLAB copies all children as 
well. 
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Example — Copying Objects
Suppose you are plotting a variety of data and want to label the point having 
the x- and y-coordinates determined by  in each plot. The 
text function allows you to specify the location of the label in the coordinates 
defined by the x- and y-axis limits, simplifying the process of locating the text.

text('String','\{5\pi\div4, sin(5\pi\div4)\}\rightarrow',...
'Position',[5*pi/4,sin(5*pi/4),0],...
'HorizontalAlignment','right')

In this statement, the text function

• Labels the data point with the string  using TeX 
commands to draw a right-facing arrow and mathematical symbols 

• Specifies the Position in terms of the data being plotted

• Places the data point to the right of the text string by changing the 
HorizontalAlignment to right (the default is left)

To label the same point with the same string in another plot, copy the text 
using copyobj. Because the last statement did not save the handle to the text 
object, you can find it using findobj and the 'String' property.

text_handle = findobj('String',...
'\{5\pi\div4,sin(5\pi\div4)\}\rightarrow');

5π 4÷ 5π 4÷〈 〉sin,

5π 4÷ 5π 4÷〈 〉sin,{ }
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After creating the next plot, add the label by copying it from the first plot.

copyobj(text_handle,gca).

This particular example takes advantage of the fact that text objects define 
their location in the axes data space. Therefore the text Position property did 
not need to change from one plot to another.

Deleting Objects
You can remove a graphics object with the delete command, using the object’s 
handle as an argument. For example, you can delete the current axes (and all 
of its descendants) with the statement

delete(gca)

You can use findobj to get the handle of a particular object you want to delete. 
For example, to find the handle of the dotted line in this multiline plot,
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use findobj to locate the object whose LineStyle property is ':'

line_handle = findobj('LineStyle',':');

then use this handle with the delete command.

delete(line_handle)

You can combine these two statements, substituting the findobj statement for 
the handle.

delete(findobj('LineStyle',':'))
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Controlling Graphics Output
MATLAB allows many figure windows to be open simultaneously during a 
session. A MATLAB application might create figures to display graphical user 
interfaces as well as plotted data. It is necessary then to protect some figures 
from becoming the target for graphics display and to prepare (e.g., reset 
properties and clear existing objects from) others before receiving new 
graphics. 

This section discusses how to control where and how MATLAB displays 
graphics output. Topics include

• “Specifying the Target for Graphics Output” on page 8-60

• “Preparing Figures and Axes for Graphics” on page 8-62

• “Targeting Graphics Output with newplot” on page 8-63

• “Example — Using newplot” on page 8-65

• “Testing for Hold State” on page 8-67

• “Protecting Figures and Axes” on page 8-68

Specifying the Target for Graphics Output
By default, MATLAB functions that create graphics objects display them in the 
current figure and current axes (if an axes child). You can direct the output to 
another parent by explicitly specifying the Parent property with the creating 
function. For example,

plot(1:10,'Parent',axes_handle)

where axes_handle is the handle of the target axes. The uicontrol and uimenu 
functions have a convenient syntax that enables you to specify the parent as 
the first argument,

uicontrol(figure_handle,...)
uimenu(parent_menu_handle,...)

or you can set the Parent property. Many plotting functions accept an axes 
handle as the first argument as well.
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Making a Figure and Axes Current
You can specify which figure and which axes within the figure are the target 
for graphics output. There are two ways to do this, each with different 
associated behavior. 

Making Current and Update. If figure_handle is the handle to an existing figure, 
then the following statement,

figure(figure_handle)

• Makes figure_handle the current figure

• Restacks figure_handle to be the front-most figure displayed

• Makes figure_handle visible if it was not

• Refreshes figure_handle and process all pending window events

The same behavior applies to axes. Therefore, the following statement,

axes(axes_handle)

• Makes axes_handle the current axes

• Restacks axes_handle to be the front-most axes displayed

• Makes axes_handle visible if it was not

• Refreshes the figure containing the axes and process all pending window 
events for that figure

Make Current Without Changing State. You can make a figure or axes current 
without causing MATLAB to change the object’s state by setting the figure’s 
root object CurrentFigure property or the figure object’s CurrentAxes property 
to the handle of the figure or axes you want to accept graphics output.

If figure_handle is the handle to an existing figure, then the following 
statement,

set(0,'CurrentFigure',figure_handle)

makes figure_handle the current figure without changes its state. Similarly, 
if axes_handle is the handle of an axes object, then the following statement

set(h,'CurrentAxes',axes_handle)

makes it the current axes assuming h is the handle of the figure that contains 
it.
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Preparing Figures and Axes for Graphics
By default, commands that generate graphics output display the graphics 
objects in the current figure without clearing or resetting figure properties. 
However, if the graphics objects are axes children, MATLAB clears the axes 
and resets most axes properties to their default values before displaying the 
objects. 

You can change this behavior by setting the figure and axes NextPlot 
properties.

Using NextPlot to Control Output Target
MATLAB high-level graphics functions check the values of the NextPlot 
properties to determine whether to add, clear, or clear and reset the figure and 
axes before drawing. Low-level object creation functions do not check the 
NextPlot properties. They simply add the new graphics objects to the current 
figure and axes. 

Low-level functions are designed primarily for use in M-files where you can 
implement whatever drawing behavior you want. However, when you develop 
a MATLAB-based application, controlling MATLAB drawing behavior is 
essential to creating a program that behaves predictably. 

This table summarizes the possible values for the NextPlot property.

NextPlot Figure Axes

new Create a new figure and use it as 
the current figure.

Not an option for axes.

add Add new graphics objects without 
clearing or resetting the current 
figure. (Default setting)

Add new graphics objects without 
clearing or resetting the current 
axes.
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Note that a reset returns all properties, except Position and Units, to their 
default values.

The hold command provides convenient access to the NextPlot properties. The 
statement

hold on

sets both figure and axes NextPlot properties to add.

The statement

hold off 

sets the axes NextPlot property to replace.

Targeting Graphics Output with newplot
MATLAB provides the newplot function to simplify the process of writing 
graphics M-files that conform to the settings of the NextPlot properties.

newplot checks the values of the NextPlot properties and takes the 
appropriate action based on these values. You should place newplot at the 
beginning of any M-file that calls object creation functions. 

When your M-file calls newplot, the following possible actions occur:

1 newplot checks the current figure’s NextPlot property:

- If there are no figures in existence, newplot creates one and makes it the 
current figure.

- If the value of NextPlot is add, newplot makes the figure the current 
figure.

replacechildren Remove all child objects, but do not 
reset figure properties. Equivalent 
to clf.

Remove all child objects, but do not 
reset axes properties. Equivalent to 
cla.

replace Remove all child objects and reset 
figure properties to their defaults. 
Equivalent to clf reset.

Remove all child objects and reset 
axes properties to their defaults. 
Equivalent to cla reset. (Default 
setting)

NextPlot Figure Axes



8 Handle Graphics Objects

8-64

- If the value of NextPlot is new, newplot creates a new figure and makes it 
the current figure

- If the value of NextPlot is replacechildren, newplot deletes the figure’s 
children (axes objects and their descendants) and makes this figure the 
current figure.

- If the value of NextPlot is replace, newplot deletes the figure’s children, 
resets the figure’s properties to the defaults, and makes this figure the 
current figure.

2 newplot checks the current axes’ NextPlot property:

- If there are no axes in existence, newplot creates one and makes it the 
current axes.

- If the value of NextPlot is add, newplot makes the axes the current axes.

- If the value of NextPlot is replacechildren, newplot deletes the axes’ 
children and makes this axes the current axes.

- If the value of NextPlot is replace, newplot deletes the axes’ children, 
resets the axes’ properties to the defaults, and makes this axes the current 
axes.

MATLAB Default Behavior
Consider the default situation where the figure NextPlot property is add and 
the axes NextPlot property is replace. When you call newplot, it

1 Checks the value of the current figure’s NextPlot property (which is add) 
and determines MATLAB can draw into the current figure with no further 
action. If there is no current figure, newplot creates one, but does not 
recheck its NextPlot property.

2 Checks the value of the current axes’ NextPlot property (which is replace), 
deletes all graphics objects from the axes, resets all axes properties (except 
Position and Units) to their defaults, and returns the handle of the current 
axes.
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Example — Using newplot
To illustrate the use of newplot, this example creates a function that is similar 
to the built-in plot function, except it automatically cycles through different 
line styles instead of using different colors for multiline plots.

function my_plot(x,y)
cax = newplot; % newplot returns handle of current axes
LSO = ['- ';'--';': ';'-.'];
set(cax,'FontName','Times','FontAngle','italic') 
set(get(cax,'Parent'),'MenuBar','none') % 
line_handles = line(x,y,'Color','b');
style = 1;
for i = 1:length(line_handles)
    if style > length(LSO), style = 1;end
    set(line_handles(i),'LineStyle',LSO(style,:))

style = style + 1;
end
grid on

The function my_plot uses the high-level line function syntax to plot the data. 
This provides the same flexibility in input argument dimension that the 
built-in plot function supports. The line function does not check the value of 
the figure or axes NextPlot property. However, because my_plot calls newplot, 
it behaves the same way the high-level plot function does — with default 
values in place, my_plot clears and resets the axes each time you call it. 

my_plot uses the handle returned by newplot to access the target figure and 
axes. This example sets axes font properties and disables the figure’s menu bar. 
Note how the figure handle is obtained via the axes Parent property.

This picture shows typical output for the my_plot function.

my_plot(1:10,peaks(10))
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Basic Plotting M-File Structure
This example illustrates the basic structure of graphics M-files:

• Call newplot early to conform to the NextPlot properties and to obtain the 
handle of the target axes.

• Reference the axes handle returned by newplot to set any axes properties or 
to obtain the figure’s handle.

• Call object creation functions to draw graphics objects with the desired 
characteristics.

The MATLAB default settings for the NextPlot properties facilitate writing 
M-files that adhere to the standard behavior: reuse the figure window, but 
clear and reset the axes with each new graph. Other values for these properties 
allow you to implement different behaviors. 
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Replacing Only the Child Objects — replacechildren
The replacechildren value for NextPlot causes newplot to remove child 
objects from the figure or axes, but does not reset any property values (except 
the list of handles contained in the Children property).

This can be useful after setting properties you want to use for subsequent 
graphs without having to reset properties. For example, if you type on the 
command line

set(gca,'ColorOrder',[0 0 1],'LineStyleOrder','-|--|:|-.',...
'NextPlot','replacechildren')

plot(x,y)

plot produces the same output as the M-file my_plot in the previous section, 
but only within the current axes. Calling plot still erases the existing graph 
(i.e., deletes the axes children), but it does not reset axes properties. The values 
specified for the ColorOrder and LineStyleOrder properties remain in effect.

Testing for Hold State
There are situations in which your M-file should change the visual appearance 
of the axes to accommodate new graphics objects. For example, if you want the 
M-file my_plot from the previous example to accept 3-D data, it makes sense to 
set the view to 3-D when the input data has z-coordinates. 

However, to be consistent with the behavior of the MATLAB high-level 
routines, it is good practice to test whether hold is on before changing parent 
axes or figure properties. When hold is on, the axes and figure NextPlot 
properties are both set to add. 

The M-file my_plot3 accepts 3-D data and also checks the hold state, using 
ishold, to determine whether it should change the view.

function my_plot3(x,y,z)
cax = newplot;
hold_state = ishold; % ishold tests the current hold state
LSO = ['- ';'--';': ';'-.'];
if nargin == 2

hlines = line(x,y,'Color','k');
if ~hold_state % Change view only if hold is off

view(2)
end
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elseif nargin == 3
hlines = line(x,y,z,'Color','k');
if ~hold_state % Change view only if hold is off

view(3)
end

end
ls = 1;
for hindex = 1:length(hlines)
    if ls > length(LSO),ls = 1;end
    set(hlines(hindex),'LineStyle',LSO(ls,:))
    ls = ls + 1;
end

If hold is on when you call my_plot3, it does not change the view. If hold is off, 
my_plot3 sets the view to 2-D or 3-D, depending on whether there are two or 
three input arguments. 

Protecting Figures and Axes
There are situations in which it is important to prevent particular figures or 
axes from becoming the target for graphics output (i.e., preventing them from 
becoming the gcf or gca). An example is a figure containing the uicontrols that 
implement a user interface.

You can prevent MATLAB from drawing into a particular figure or axes by 
removing its handle from the list of handles that are visible to the newplot 
function, as well as any other functions that either return or implicitly 
reference handles (i.e., gca, gcf, gco, cla, clf, close, and findobj). Two 
properties control handle hiding: HandleVisibility and ShowHiddenHandles.

HandleVisibility Property
HandleVisibility is a property of all objects. It controls the scope of handle 
visibility within three different ranges. Property values can be

• on — The object’s handle is available to any function executed on the 
MATLAB command line or from an M-file. This is the default setting.

• callback — The object’s handle is hidden from all functions executing on the 
command line, even if it is on the top of the screen stacking order. However, 
during callback routine execution (MATLAB statements or functions that 
execute in response to user action), the handle is visible to all functions, such 
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as gca, gcf, gco, findobj, and newplot. This setting enables callback 
routines to take advantage of the MATLAB handle access functions, while 
ensuring that users typing at the command line do not inadvertently disturb 
a protected object.

• off — The object’s handle is hidden from all functions executing on the 
command line and in callback routines. This setting is useful when you want 
to protect objects from possibly damaging user commands. 

For example, if a GUI accepts user input in the form of text strings, which are 
then evaluated (using the eval function) from within the callback routine, a 
string such as 'close all' could destroy the GUI. To protect against this 
situation, you can temporarily set HandleVisibility to off on key objects.

user_input = get(editbox_handle,'String');
set(gui_handles,'HandleVisibility','off')
eval(user_input)
set(gui_handles,'HandleVisibility','commandline')

Values Returned by gca and gcf. When a protected figure is topmost on the screen, 
but has unprotected figures stacked beneath it, gcf returns the topmost 
unprotected figure in the stack. The same is true for gca. If no unprotected 
figures or axes exist, calling gcf or gca causes MATLAB to create one in order 
to return its handle.

Accessing Protected Objects
The root ShowHiddenHandles property enables and disables handle visibility 
control. By default, ShowHiddenHandles is off, which means MATLAB obeys 
the setting of the HandleVisibility property. When ShowHiddenHandles is set 
to on, all handles are visible from the command line and within callback 
routines. This can be useful when you want access to all graphics objects that 
exist at a given time, including the handles of axes text labels, which are 
normally hidden.

The close function also allows access to nonvisible figures using the hidden 
option. For example, 

close('hidden') 

closes the topmost figure on the screen, even if it is protected. Combining all 
and hidden options,

close('all','hidden')
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closes all figures.

The Figure Close Request Function
MATLAB executes a callback routine defined by the figure’s CloseRequestFcn 
whenever you

• Issue a close command on a figure.

• Quit MATLAB while there are visible figures. (If a figure's Visible property 
is set to off, MATLAB does not execute its close request function when you 
quit MATLAB; the figure is just deleted).

• Close a figure from the windowing system using a close box or a close menu 
item.

The close request function enables you to prevent or delay the closing of a 
figure or the termination of a MATLAB session. This is useful to perform such 
actions as

• Displaying a dialog box requiring the user to confirm the action 

• Saving data before closing

• Preventing unintentional command-line deletion of a graphical user 
interface built with MATLAB

The default callback routine for the CloseRequestFcn is an M-file called 
closereq. It contains the statements

shh=get(0,'ShowHiddenHandles');
set(0,'ShowHiddenHandles','on');
delete(get(0,'CurrentFigure'));
set(0,'ShowHiddenHandles',shh);

This callback disables HandleVisibility control by setting the root 
ShowHiddenHandles property to on, which makes all figure handles visible.

Quitting MATLAB
When you quit MATLAB, the current figure’s CloseRequestFcn is called, and 
if the figure is deleted, the next figure in the root's list of children (i.e., the root's 
Children property) becomes the current figure, and its CloseRequestFcn is in 
turn executed, and so on. You can, therefore, use gcf to specify the figure 
handle from within the close request function. 
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If you change a figure's CloseRequestFcn so that it does not delete the figure 
(e.g., defining this property as an empty string), then issuing the close 
command on that figure does not cause it to be deleted. Furthermore, if you 
attempt to quit MATLAB, the quit is aborted because MATLAB does not delete 
the figure. 

Errors in the Close Request Function
If the CloseRequestFcn generates an error when executed, MATLAB aborts 
the close operation. However, errors in the CloseRequestFcn do not abort 
attempts to quit MATLAB. If an error occurs in a figure's CloseRequestFcn, 
MATLAB closes the figure unconditionally following a quit or exit command.

Overriding the Close Request Function
The delete command always deletes the specified figure, regardless of the 
value of its CloseRequestFcn. For example, the statement

delete(get(0,'Children'))

deletes all figures whose handles are not hidden (i.e., the HandleVisibility 
property is set to off). If you want to delete all figures regardless of whether 
their handles are hidden, you can set the root ShowHiddenHandles property to 
on. The root Children property then contains the handles of all figures. For 
example, the statements

set(0,'ShowHiddenHandles','yes')
delete(get(0,'Children'))

unconditionally delete all figures. 

Handle Validity Versus Handle Visibility
All handles remain valid regardless of whether they are visible or not. If you 
know an object’s handle, you can set and get its properties. By default, figure 
handles are integers that are displayed at the top of the window. 

You can provide further protection to figures by setting the IntegerHandle 
property to off. MATLAB then uses a floating-point number for figure handles. 
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Saving Handles in M-Files
Graphics M-files frequently use handles to access property values and to direct 
graphics output to a particular target. MATLAB provides utility routines that 
return the handles to key objects (such as the current figure and axes). In 
M-files, however, these utilities might not be the best way to obtain handles 
because

• Querying MATLAB for the handle of an object or other information is less 
efficient than storing the handle in a variable and referencing that variable.

• The current figure, axes, or object might change during M-file execution 
because of user interaction.

Save Information First
It is good practice to save relevant information about the MATLAB state in the 
beginning of your M-file. For example, you can begin an M-file with

cax = newplot;
cfig = get(cax,'Parent');
hold_state = ishold;

rather than querying this information each time you need it. Remember that 
utility commands like ishold obtain the values they return whenever called. 
(The ishold command issues a number of get commands and string compares 
(strcmp) to determine the hold state.)

If you are temporarily going to alter the hold state within the M-file, you should 
save the current values of the NextPlot properties so you can reset them later.

ax_nextplot = lower(get(cax,'NextPlot'));
fig_nextplot = lower(get(cfig,'NextPlot'));
.
.
.
set(cax,'NextPlot',ax_nextplot)
set(cfig,'NextPlot',fig_nextplot)
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Properties Changed by Built-In Functions
To achieve their intended effect, many built-in functions change axes 
properties, which can then affect the workings of your M-file. This table lists 
the MATLAB built-in graphics functions and the properties they change. Note 
that these properties change only if hold is off. 

Function Axes Property: Set To

fill Box: on

CameraPosition: 2-D view

CameraTarget: 2-D view

CameraUpVector: 2-D view

CameraViewAngle: 2-D view

fill3 CameraPosition: 3-D view

CameraTarget: 3-D view

CameraUpVector: 3-D view

CameraViewAngle: 3-D view

XScale: linear

YScale: linear

ZScale: linear
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image (high-level) Box: on

Layer: top

CameraPosition: 2-D view

CameraTarget: 2-D view

CameraUpVector: 2-D view

CameraViewAngle: 2-D view

XDir: normal

XLim: [0 size(CData,2)]+0.5

XLimMode: manual

YDir: reverse

YLim: [0 size(CData,1)]+0.5

YLimMode: manual

loglog Box: on

CameraPosition: 2-D view

CameraTarget: 2-D view

CameraUpVector: 2-D view

CameraViewAngle: 2-D view

XScale: log

YScale: log

plot Box: on

CameraPosition: 2-D view

CameraTarget: 2-D view

CameraUpVector: 2-D view

CameraViewAngle: 2-D view

Function Axes Property: Set To
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plot3 CameraPosition: 3-D view

CameraTarget: 3-D view

CameraUpVector: 3-D view

CameraViewAngle: 3-D view

XScale: linear

YScale: linear

ZScale: linear

semilogx Box: on

CameraPosition: 2-D view

CameraTarget: 2-D view

CameraUpVector: 2-D view

CameraViewAngle: 2-D view

XScale: log

YScale: linear

semilogy Box: on

CameraPosition: 2-D view

CameraTarget: 2-D view

CameraUpVector: 2-D view

CameraViewAngle: 2-D view

XScale: linear

YScale: log

Function Axes Property: Set To
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Objects That Can Contain Other Objects
Certain graphics objects can contain other objects. Consider a graph for 
example. In a graph, data is represented by an object like a line. Normally, the 
parent of the line is an axes (i.e., the handle of the line’s Parent property is set 
to the handle of the axes that contains it). A figure is normally the parent of an 
axes. A typical object diagram of a graph would look like this:

When graphs become more complicated and represent data with multiple 
objects, it can be useful to group these objects together so you can perform 
operations on the group as a whole.

These sections discuss how to use two container objects that group axes 
children within a graph and user interface components within a figure.

• “Using Panel Containers in Figures — Uipanels” on page 8-76

• “Grouping Objects Within Axes — hgtransform” on page 8-81

Using Panel Containers in Figures — Uipanels
Figures can contain axes and user interface objects directly, or you can parent 
these objects to uipanels, which you then parent to a figure. Uipanels are useful 
for the design of GUIs because they enable you to define subregions in a figure 
in which you can lay out components.

MATLAB interprets the Position property of all objects parented to a uipanel 
relative to the uipanel’s position. If you move the uipanel, the children 
automatically move with it.

Uipanels can also contain other uipanels, as well as axes, uicontrols, and 
uibuttongroups. See the uipanel reference page for more information on 
uipanels.

You can create multiple axes in a uipanel and direct plotting into any of them. 
However, some plotting functions do not allow you to specify the parent of the 

Axes

Figure

Lines
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graphics objects they create, so they create a new axes (and possibly a figure). 
To include such a graph in a uipanel, you can reparent the axes to the panel 
once the plot is made.

Figure Resize Functions
Containing various parts of a GUI in uipanels simplifies the process of 
programming figure resize behavior because you can write a separate resize 
function for each panel. The following example illustrates how to do this.

Example — Using Figure Panels
This example uses three uipanel objects as containers for the GUI’s 
components. All three uipanels are then parented to the figure, as shown in the 
following containment hierarchy. 

Here is a picture of the GUI with some data plotted in the axes.

Bottom uipanel

Figure

Axes

Right uipanelCenter uipanel

Push button Popup menuToggle button

Lineseries, etc.

Text label Text labelList box
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Complete Example Code

Note  If you are using the MATLAB Help browser, you can run this example 
or open it in the MATLAB editor.

This GUI enables you to select workspace variables from a list box and select a 
plot type from a pop-up menu. You can add plots to the existing graph by 
clicking the Hold toggle button and initiate the plot by clicking the Create Plot 
button.

Use the link above to run the example and open the GUI code in the MATLAB 
editor. 
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Creating the Uipanels
The following code shows the definition of the figure and the bottom panel. 
Setting Units to characters ensures that your GUI is properly sized on 
different computer systems. The Position property specifies the location and 
size of each component in units set by the Units property.

% Create the figure
f = figure('Units','characters',...

'Position',[30 30 120 35],...
'Color',panelColor,...
'HandleVisibility','callback',...
'IntegerHandle','off',...
'Renderer','painters',...
'ResizeFcn',@figResize);

% Create the bottom uipanel
botPanel = uipanel('BorderType','etchedin',...

'BackgroundColor',panelColor,...
'Units','characters',...
'Position',[1/20 1/20 119.9 8],...
'Parent',f,... 
'ResizeFcn',@botPanelResize);

Programming the Resize Functions
As you resize the figure, MATLAB calls the figure resize function (specified by 
the object’s ResizeFcn property), which, in this example, computes a new size 
for each uipanel. Because the figure resize function resizes the uipanels, 
MATLAB automatically calls the resize function of each uipanel once the figure 
resize function completes execution. The uipanel resize functions then adjust 
the sizes and locations of the components they contain. 

The following diagram illustrates the sequence of events that occurs when a 
user resizes the figure. 
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The following code shows the figure, bottom panel, and right panel resize 
functions. As each function is called, it sets the object’s size and position to 
values that are proportional to the original layout. 

See “Nested Functions” for more information.

% Figure resize function
function figResize(src,evt)

fpos = get(f,'Position');
set(botPanel,'Position',...

[1/20 1/20 fpos(3)-.1 fpos(4)*8/35])
set(rightPanel,'Position',...

Call figure resize function

User resizes figure

Call bottom panel resize function

Call center panel resize function

Call right panel resize function

Resize bottom panel
Resize right panel
Resize center panel

Resize and position components

Resize and position components

Resize and position components

MATLAB calls each
panel’s resize function

MATLAB calls figure
resize function

Figure resize function
resizes each panel
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[fpos(3)*85/120 fpos(4)*8/35 fpos(3)*35/120 fpos(4)*27/35])
set(centerPanel,'Position',...

[1/20 fpos(4)*8/35 fpos(3)*85/120 fpos(4)*27/35]);
end

% Bottom panel resize function
function botPanelResize(src,evt)

bpos = get(botPanel,'Position');
set(plotButton,'Position',...

[bpos(3)*10/120 bpos(4)*2/8 bpos(3)*24/120 2])
set(holdToggle,'Position',...

[bpos(3)*45/120 bpos(4)*2/8 bpos(3)*24/120 2])
set(popUp,'Position',...

[bpos(3)*80/120 bpos(4)*2/8 bpos(3)*24/120 2])
set(popUpLabel,'Position',...

[bpos(3)*80/120 bpos(4)*4/8 bpos(3)*24/120 2])
end

% Right panel resize function
function rightPanelResize(src,evt)

rpos = get(rightPanel,'Position');
set(listBox,'Position',...

[rpos(3)*4/32 rpos(4)*2/27 rpos(3)*24/32 rpos(4)*20/27]);
set(listBoxLabel,'Position',...

[rpos(3)*4/32 rpos(4)*24/27 rpos(3)*24/32 rpos(4)*2/27]);
end

Note that the center panel does not need a resize function because the axes 
automatically resize to fit the container (either a figure or uipanel). 

To see the complete code listing for this example, see “Complete Example Code” 
on page 8-78.

Grouping Objects Within Axes — hgtransform
MATLAB provides two objects that are designed to group any of the objects 
normally parented to axes. These two objects are

• Hggroup — Parent objects to an hggroup object when you want to reference 
the objects as a group. For example, to select or control visibility of all the 
group members. 
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• Hgtransform — This object also enables you to transform (rotate, translate, 
etc.) the objects as a group. 

See “Group Objects” on page 8-25 for more information about hggroup and 
hgtransform objects.

Example — Translating Grouped Objects
This example shows how using a hierarchy of hgtransform objects makes it 
possible to translate the contained graphics objects both independently and as 
a group. The example creates a cross-like cursor with a text readout in the 
center, which displays data values.

The cursor is constructed from two surfaces, each of which is contained in an 
hgtransform object so they can be translated independently to overlap, and a 
text object. These two hgtransform objects are then contained by a third 
hgtransform object, which also contains the text. This third hgtransform (with 
handle T in the diagram and code) enables the cursor to be transformed as a 
group.

The following diagram shows the containment hierarchy for this example. The 
axes contains a line, which is used to plot the data that the cursor moves along. 
The axes also contains the hierarchy of hgtransform objects that construct the 
cursor.

Hgtransform T

Hgtransform 

Axes

Figure

Text

Line

Hgtransform

Surface Surface

t2

(blue) (green)

t1



Objects That Can Contain Other Objects

8-83

Note  If you are using the MATLAB Help browser, you can run this example 
or open it in the MATLAB editor.

Set Up the Axes and Figure. The first step is to create an axes with fixed limits so 
MATLAB does not rescale the limits as the cursor moves along the line. 
Creating the axes automatically creates a figure to contain it. 

Set figure properties to use the OpenGL renderer and double buffering:

h_axes = axes('XLim',[-10 10],'YLim',[-5 5]);
set(get(h_axes,'Parent'),'Renderer','opengl',...

'DoubleBuffer','on')

Define the Transform Matrices and Hgtransform Objects. The cross part of the cursor is 
formed from two surface objects, which are translated to overlap. Each surface 
is contained in its own hgtransform object (handles t1 and t2) because they are 
translated in different directions. Both hgtransform objects are themselves 
contained in another hgtransform object (handle T).

See makehgtform, hgtransform.

% Create transform matrices
tmtx1 = makehgtform('translate',[-.5 0 0]);
tmtx2 = makehgtform('translate',[0 -.5 0]);

% Create hgtransform objects
T = hgtransform; % Contains the cursor
t1 = hgtransform('Parent',T,'Matrix',tmtx1);
t2 = hgtransform('Parent',T,'Matrix',tmtx2);

Create the Surface and Text Objects. The cursor is composed of two surface objects 
and a text object (to display data values). The two surfaces are parented to their 
respective hgtransform objects. The text is parented directly to the top-level 
hgtransform. The text object does not need coordinates because it is translated 
along with the surfaces in the top-level hgtransform object (T).

See cylinder, surface, text.

% Define surfaces and text
[sx,sy,sz] = cylinder([0 2 0]); % Use cylinder to generate data
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surface(sz,sy,sx,'FaceColor','green',...
                'EdgeColor','none','FaceAlpha',.2,'Parent',t1);
surface(sx,sz./1.5,sy,'FaceColor','blue',...
                'EdgeColor','none','FaceAlpha',.2,'Parent',t2);
h_text = text('FontSize',12,'FontWeight','bold',...
                'HorizontalAlignment','center',...
                'VerticalAlignment','Cap','Parent',T);

Generate Data and Plot a Line. This example uses a line plot of a mathematical 
function to create a path along which to move the cursor. 

% Plot the data x, y, and z
x = -10:.05:10;
y = [cos(x) + exp(-.01*x).*cos(x) + exp(.07*x).*sin(3*x)];
z = 1:length(x);
line(x,y)

Translate the Cursor Along the Plotted Line. To move the cursor along the line, a new 
transform matrix is calculated using each set of x, y, and z data points and used 
to set the Matrix property of the top-level hgtransfrom T. At the same time, the 
text object String property is updated to display the value of the current y data 
point.

The surfaces and the text translate together because all are contained in the 
top-level hgtransform object. 

% Loop through the line data to move the cursor
for ind = 1:length(x)
    set(T,'Matrix',...

makehgtform('translate',[x(ind) y(ind) z(ind)]))
    set(h_text,'String',num2str(y(ind)))
    drawnow,pause(.01)
end
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Callback Properties for Graphics Objects
A callback is a function that executes when a specific event occurs on a graphics 
object. You specify a callback by setting the appropriate property of the object. 
This section describes the events (specified via properties) for which you can 
define callbacks. See “Function Handle Callbacks” on page 8-87 for information 
on how to define callbacks.

Graphics Object Callbacks
All graphics objects have three properties for which you can define callback 
routines:

• ButtonDownFcn — Executes when users click the left mouse button while the 
cursor is over the object or within a 5-pixel border around the object 

• CreateFcn — Executes during object creation after all properties are set

• DeleteFcn — Executes just before deleting the object

User Interface Object Callbacks
User interface objects (e.g., uicontrol and uimenu) have a Callback property 
through which you define the function to execute when users activate these 
devices (e.g., click a push button or select a menu).

Figure Callbacks
Figures have additional properties that execute callback routines with the 
appropriate user action. Only the CloseRequestFcn property has a callback 
defined by default:

• CloseRequestFcn — Executes when a request is made to close the figure (by 
a close command, by the window manager menu, or by quitting MATLAB)

• KeyPressFcn — Executes when users press a key while the cursor is within 
the figure window

• ResizeFcn — Executes when users resize the figure window

• WindowButtonDownFcn — Executes when users click a mouse button while 
the cursor is over the figure background, a disabled uicontrol, or the axes 
background
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• WindowButtonMotionFcn — Executes when users move the mouse button 
within the figure window (but not over menus or title bar)

• WindowButtonUpFcn — Executes when users release the mouse button, after 
having pressed the mouse button within the figure
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Function Handle Callbacks
Handle Graphics objects have a number of properties for which you can define 
callback functions. When a specific event occurs (e.g., a user clicks a push 
button or deletes a figure), the corresponding callback function executes. You 
can specify the value of a callback property as a

• String that is a MATLAB command or the name of an M-file

• Cell array of strings

• Function handle or a cell array containing a function handle and additional 
arguments

The following sections illustrate how to define function handle callbacks for 
Handle Graphics objects. 

• “Function Handle Syntax” on page 8-87 describes how to define a function 
handle callback.

• “Why Use Function Handle Callbacks” on page 8-89 provides information on 
the advantages of using function handle callbacks.

• “Example — Using Function Handles in GUIs” on page 8-90 shows how to 
create a simple GUI that uses function handle callbacks.

For general information on function handles, see the function handle reference 
page. 

Function Handle Syntax
In Handle Graphics, functions that you want to use as function handle 
callbacks must define at least two input arguments in the function definition:

• The handle of the object generating the callback (the source of the event)

• The event data structure (can be empty for some callbacks)

MATLAB passes these two arguments implicitly whenever the callback 
executes. For example, consider the following statements, which are contained 
in a single M-file.

function myGui
% Create a figure and specify a callback
figure('WindowButtonDownFcn',@myCallback)

.
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.

.
% Callback subfunction defines two input arguments
function myCallback(src,eventdata)

.

.

.

The first statement creates a figure and assigns a function handle to its 
WindowButtondownFcn property (created by using the @ symbol before the 
function name). This function handle points to the subfunction myCallback. 
The definition of myCallback must specify the two required input arguments in 
its function definition line.

Passing Additional Input Arguments
You can define the callback function to accept additional input arguments by 
adding them to the function definition. For example, 

function myCallback(src,eventdata,arg1,arg2)

When using additional arguments for the callback function, you must set the 
value of the property to a cell array (i.e., enclose the function handle and 
arguments in curly braces). For example,

figure('WindowButtonDownFcn',{@myCallback,arg1,arg2})

Defining Callbacks as a Cell Array of Strings — Special Case
Defining a callback as a cell array of strings is a special case because MATLAB 
treats it differently from a simple string. Setting a callback property to a string 
causes MATLAB to evaluate that string in the base workspace when the 
callback is invoked. However, setting a callback to a cell array of strings 
requires the following:

• The cell array must contain the name of an M-file that is on the MATLAB 
path as the first string element.

• The M-file callback must define at least two arguments (the handle of the 
callback object and an empty matrix).

• Any additional strings in the cell array are passed to the M-file callback as 
arguments.
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For example, 

figure('WindowButtonDownFcn',{myCallback,arg1})

requires you to define a function M-file that uses three arguments,

function myCallback(src,eventdata,arg1)

Why Use Function Handle Callbacks
Using function handles to specify callbacks provides some advantages over the 
use of strings, which must be either MATLAB commands or the name of an 
M-file that will be on the MATLAB path at run-time. 

Single File for All Code
Function handles enable you to use a single M-file for all callbacks. This is 
particularly useful when you are creating graphical user interfaces, because 
you can include both the layout commands and callbacks in one file. 

For information on how to access subfunctions, see the “Calling a Function 
Through Its Handle” section of “Programming and Data Types” in the Using 
MATLAB documentation.

Keeping Variables in Scope
When MATLAB evaluates function handles, the same variables are in scope as 
when the function handle was created. (In contrast, callbacks specified as 
strings are evaluated in the base workspace.) This simplifies the process of 
managing global data, such as object handles in a GUI.

For example, suppose you create a GUI with a list box that displays workspace 
variables and a push button whose callback creates a plot using the variables 
selected in the list box. The push button callback needs the handle of the list 
box to query the names of the selected variables. Here’s what to do.

1 Create the list box and save the handle:

h_listbox = uicontrol('Style','listbox',... etc.);

2 Pass the list box handle to the push button’s callback, which is defined in the 
same M-file:

h_plot_button = uicontrol('Style','pushbutton',...
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'Callback',{@plot_button_callback,h_listbox},...,etc.);

The handle of the list box is now available in the plot button’s callback without 
relying on global variables or using findobj to search for the handle. See 
“Example — Using Function Handles in GUIs” on page 8-90 for an example 
that uses this technique.

Callback Object Handle and Event Data
MATLAB passes additional information to the callback when it is executed. 
This information includes the handle of the callback object (the source of the 
callback event) and event data that is specific to the particular callback 
property. 

For example, the event data returned for the figure KeyPressFcn property is a 
structure that contains information about which keys were pressed. 

Information about the event data associated with any given callback property 
is included with the property’s documentation. Use the Handle Graphics 
Property Browser to access property documentation.

Function Handles Stay in Scope
A function handle can point to a function that is not in scope at the time of 
execution. For example, the function can be a subfunction in another M-file.

For a general discussion of function handles, see the “Function Handles and 
Anonymous Functions in the MATLAB documentation.

Example — Using Function Handles in GUIs
This example creates a simple GUI that plots workspace variables. It is defined 
in a single M-file that contains both the layout commands and the callbacks. 
This example uses function handles to specify callback functions. Callbacks are 
implemented as nested functions to reduce the need to pass variables as 
arguments.

Complete Example Code
The documentation for this example does not list all the code used to lay out 
and program the GUI. To see a complete code listing, use the links in the note 
box below.
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Note  If you are using the MATLAB Help browser, you can run this example 
or open it in the MATLAB editor.

See “Function Handle Callbacks” on page 8-87 for more information on the use 
of function handle callbacks.

The GUI Layout
The following picture shows the GUI after running the example code. The 
program creates two variables (testvarX and testVarY) in the base workspace 
for testing purposes.
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The GUI layout is split among three uipanel containers. One contains the axes, 
the right side panel contains a list box to display workspace variables, and the 
bottom panel contains the plot and hold buttons and the plot type pop-up menu. 

Initialize the GUI
The list box and the hold toggle button need to be initialized before the GUI is 
ready to use. This is accomplished by executing their callbacks. Note that 
because you are calling these functions directly, MATLAB does not implicitly 
pass the first two arguments, as it would if these functions were executed as 
callbacks in response to an event. You therefore must explicitly pass all 
arguments in these function calls.

% Initialize list box and make sure
% the hold toggle is set correctly
listBoxCallback(listBox,[])
holdToggleCallback(holdToggle,[])

The Callback Functions
TheGUI components that have callbacks are the list box, toggle button, and 
plot push button. In addition, the figure’s three uipanels define resize functions 
that MATLAB executes whenever users resize the figure. 

See “Programming the Resize Functions” on page 8-79 for information on 
writing callback functions for the figure and uipanel ResizeFcn properties.

List Box Callback. The list box callback generates a list of the current variables in 
the base workspace using the evalin and who functions. It then assigns this list 
to the list box String property so that it displays these variable names. 

Note how the function takes advantage of the fact that the first argument 
passed to the callback is the handle of the callback object (i.e., the source of the 
callback event, which is the list box). Therefore, whenever you click in the list 
box, MATLAB updates the list to display the current workspace variables.

%% Callback for list box
function listBoxCallback(src,evt)

% Load workspace vars into list box
vars = evalin('base','who');
set(src,'String',vars)

end % listBoxCallback
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Plot Button Callback. The plot button callback performs three tasks:

• Gets the names of the variables selected by the user in the list box

• Gets the type of plot selected by the user in the pop-up menu

• Constructs and evaluates the plotting command in the base workspace

%% Callback for plot button
function plotButtonCallback(src,evt)

% Get workspace variables
vars = get(listBox,'String');
var_index = get(listBox,'Value');
if length(var_index) ~= 2

errordlg('You must select two variables',...
'Incorrect Selection','modal')
return

end
% Get data from base workspace
x = evalin('base',vars{var_index(1)});
y = evalin('base',vars{var_index(2)});
% Get plotting command
selected_cmd = get(popUp,'Value');
% Make the GUI axes current and create plot
axes(a)
switch selected_cmd
case 1 % user selected plot

plot(x,y)
case 2 % user selected bar

bar(x,y)
case 3 % user selected stem

stem(x,y)
end

end % plotButtonCallback

Hold State Toggle Button Callback. The toggle button callback requires the handles 
of the GUI figure and axes. Because these callbacks are written as nested 
functions, the figure handle (f) and the axes handle (a) are in scope within the 
callback.
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You want the GUI to toggle the hold state, but the GUI figure handle is hidden. 
It is necessary, therefore, to use the axes handle as the first argument to the 
hold function. 

%% Callback for hold state toggle button
function holdToggleCallback(src,evt)

button_state = get(src,'Value');
if button_state == get(src,'Max')

% toggle button is depressed
hold(a,'on')
set(src,'String','Hold On')

elseif button_state == get(src,'Min')
% toggle button is not depressed
hold(a,'off')
set(src,'String','Hold Off')

end
end % holdToggleCallback
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Optimizing Graphics Performance
This section discusses techniques that can help increase the speed with which 
MATLAB creates graphs. These techniques generally apply to cases where you 
are creating many graphs of similar data and can therefore improve rendering 
speed by preventing MATLAB from performing unnecessary operation. 

Whether a given technique improves performance depends on the particular 
application. The profile function can help you determine where your code is 
consuming the most time.

General Performance Guidelines
The following list provides some general guidelines for optimizing 
performance:

• Set automatic-mode properties to manual whenever possible to prevent 
MATLAB from performing unnecessary operations. 

• Modify existing objects instead of creating new ones. 

• Use low-level core objects when creating objects repeatedly.

• Do not recreate legends or other annotations in a program loop; add these 
after you finish modifying the graph. 

• Set the text Interpreter property to none if you are not using TeX 
characters.

• Try various renderers and erase modes. MATLAB might not have 
auto-selected the fastest renderer for your application.

The remainder of this section provides more details on these and other 
techniques.

“Disable Automatic Modes” on page 8-96 — information on optimizing the use 
of axes objects.

“Changing Graph Data Rapidly” on page 8-98 — an example of techniques for 
interactive plotting.

“Performance of Bit-Mapped Images” on page 8-101 — information on 
optimizing the use of image objects.

“Performance of Patch Objects” on page 8-101 — information on optimizing the 
use of patch objects.



8 Handle Graphics Objects

8-96

“Performance of Surface Objects” on page 8-102 — information on optimizing 
the use of surface objects.

Disable Automatic Modes
Graphics objects have properties that control many aspects of their behavior 
and appearance. The axes object in particular has many mode properties that 
enables it to respond to changes in the data represented in a graph.

For example, when you plot data, the axes determines appropriate axis limits, 
tick-mark placement, and labeling. Any changes you make to the plotted data 
(adding another line graph, for example) causes the axes to recompute the axis 
limits and to determine what values to use for the tick marks. 

Fixing Axis Limits
The process of recalculating axis limits and the locations of the tick marks 
along each axis contributes to the time it takes to create a graph. If you are 
plotting data into the same axes repeatedly, you can improve performance by 
manually setting some or all of the axis limits, which, in turn, disables axis 
scaling and tick picking. 

For example, suppose you are plotting time series graphs in which you always 
view a 200 second time interval along the x-axis and your data ranges from -1 
to 1. The following statement creates an axes with these limits and, in the 
process, sets the limit-picking mode to manual. Thereafter, MATLAB does not 
change the limits or recalculate tick mark locations (as long as you do not call 
a high-level plotting function like plot):

axes('XLim',[0 200],'YLim',[-1 1])

Set All Modes to Manual
To maximize the efficiency with which MATLAB can update your graphs, you 
should disable all automatic operation so that MATLAB does not need to spend 
time determining if it is even necessary to recalculate a property value. The 
following steps illustrate this technique:

1 Create a figure and select the renderer you want to use. Line graphs should 
use painters to take advantage of its line thinning algorithm.
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figure('Renderer','painters')

Setting a property automatically sets its associated mode property to 
manual.

2 Create an axes explicitly and set all properties (such as the axis limits) for 
which you can predetermine the appropriate value.

3 Set all other mode property values to manual (see table below).

4 If you are creating line graphs using the painters renderer, set the axes 
DrawMode property to fast.

5 If you cannot determine the appropriate value for all mode properties, create 
your first graph and then use the set command to set mode properties to 
manual. See “Changing Graph Data Rapidly” on page 8-98 for an example.

The following table lists the axes mode properties and provides an explanation 
of what the mode controls.

Mode Property What It Controls

ALimMode Transparency limits mode

CameraPositionMode Positioning of the viewpoint

CameraTargetMode Positioning of the camera target in the axes

CameraUpVectorMode The direction of “up” in 2-D and 3-D views

CameraViewAngleMode The size of the projected scene and 
stretch-to-fit behavior

CLimMode Mapping of data values to colors

DataAspectRatioMode Relative scaling of data units along x-, y-, and 
z-axes and stretch-to-fit behavior

DrawMode Controls the way MATLAB renders graphics 
objects (use with line graphs)
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Changing Graph Data Rapidly 
MATLAB plotting functions perform a wide variety of operations in the process 
of creating a graph to make plotting easier. For example, the plot function 
clears the current axes before drawing new lines, selects a line color or a 
marker type, searches for user-defined default values, and so on.

Low-Level Functions for Speed
The features that make plotting functions easy to use also consume computer 
resources. If you want to maximize graphing performance, you should use 
low-level functions and disable certain automatic features. 

Low-level graphics functions (e.g., line vs. plot, surface vs. surf) perform 
fewer operation and therefore can be faster when you are creating many 
graphics objects. See “High-Level Versus Low-Level” on page 8-14 for more 
information on how these functions differ. 

Avoid Creating Graphics Objects
Each graphics object requires a certain amount of the computer’s resources to 
create and store information, such as the value of all the object’s properties. It 
is therefore more efficient to use fewer graphics objects if possible. 

PlotBoxAspectRatioMode Relative scaling of plot box along x-, y-, and 
z-axes and stretch-to-fit behavior

TickDirMode Direction of axis tick marks (in for 2-D, out 
for 3-D)

XLimMode
YLimMode
ZLimMode

Limits of the respective x, y, and z axes

XTickMode
YTickMode
ZTickMode

Tick mark spacing along the respective x-, y-, 
and z-axes

XTickLabelMode
YTickLabelMode
ZTickLabelMode

Tick mark labels along the respective x-, y-, 
and z-axes

Mode Property What It Controls
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For example, you can add NaNs to vertex data (which causes that vertex to not 
be rendered) to create line segments that look like separate lines. You must 
place the NaNs at identical locations in each vector of data:

x = [rand(5,1);nan;rand(4,1);nan;rand(6,1)];
y = [rand(5,1);nan;rand(4,1);nan;rand(6,1)];
line(x,y);

Update the Object’s Data
If you want to view different data on what is basically the same graph, it is 
more efficient to update the data of the existing objects (lines, text, etc.) rather 
than recreating the entire graph.

For example, suppose you want to visualize the effect on your data of varying 
certain parameters. Follow these steps:

1 Set the limits of any axis that can be determined in advance (you can use max 
and min to determine the range of your data). 

2 Recalculate the data using the new parameters.
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3 Use the new data to update the data properties of the lines, text, etc. objects 
used in the graph.

4 Call drawnow to flush the event queue and update the figure (and all child 
objects in the figure).

The following example illustrates the use of these techniques in a GUI that 
uses sliders to vary two parameters in a mathematical expression, which is 
then plotted.

Note  If you are using the MATLAB Help browser, you can run this example 
or open it in the MATLAB editor.
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Performance of Bit-Mapped Images
Images can be defined with lower precision (than double) values to reduce the 
total amount of data required. MATLAB performs many operations on 
nondouble data types you can use smaller image data without converting the 
data to type double. See “Working with 8-Bit and 16-Bit Images” on page 6-11 
for more information.

Direct Color Mapping
Where possible, use indexed images because this type of image can apply direct 
mapping of pixel values to colormap values (CDataMapping set to direct). With 
direct mapping, MATLAB does not need to scale the data and then map it to 
values in the colormap. 

See the CDataMapping image property for more information. 

Use Truecolor for Smaller Images
The use of truecolor (red, green, and blue values) eliminates the need for color 
mapping. However, with very large images, the data can be quite large and 
thereby slow performance.

Direct Mapping of Transparency Values
If you are using an alphamap of transparency values, prescale the alpha data 
so you can use the most efficient alpha data mapping (AlphaDataMapping set to 
none)

See the AlphaDataMapping image property for more information.

Performance of Patch Objects
You can improve the speed with which MATLAB renders patch objects using 
the following techniques.

Define Patch Faces as Triangles
If you are using patch objects that have many vertices per patch face, you 
should modify your data so that each face has only three vertices, but still looks 
like your original object. This eliminates the tessellation step from the 
rendering process.
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Use Data Thinning
It is sometimes possible (or even desirable) to reduce the number of vertices in 
a patch and still produce the desired results. 

See the reducepatch and reducevolume functions for more information.

Direct Color Mapping
Where possible, use direct color mapping for coloring patches. (CDataMapping 
set to direct). With direct mapping, MATLAB does not need to scale the data 
and then map it to values in the colormap. 

See the CDataMapping patch property for more information. 

Use Truecolor for Smaller Patches
The use of truecolor (red, green, and blue values) eliminates the need for color 
mapping. However, with very large patches, the data can be quite large and 
thereby slow performance.

Direct Mapping of Transparency Values
If you are using an alphamap of transparency values, prescale the alpha data 
so you can use the most efficient alpha data mapping (AlphaDataMapping set to 
none)

See the AlphaDataMapping patch property for more information.

Performance of Surface Objects
You can improve the speed with which MATLAB renders surface objects using 
the following techniques.

Direct Color Mapping
Where possible, use direct color mapping for coloring surfaces. (CDataMapping 
set to direct). With direct mapping, MATLAB does not need to scale the data 
and then map it to values in the colormap. 

See the CDataMapping surface property for more information. 



Optimizing Graphics Performance

8-103

Use Truecolor for Smaller Surfaces
The use of truecolor (red, green, and blue values) eliminates the need for color 
mapping. However, with very large surfaces, the data can be quite large and 
thereby slow performance.

Mapping of Transparency Values
If you are using an alphamap of transparency values, prescale the alpha data 
so you can use the most efficient alpha data mapping (AlphaDataMapping set to 
none)

See the AlphaDataMapping surface property for more information.

Use Texture-Mapped Face Color
If you are using surface objects in an animation or want to be able to pan and 
rotate them quickly, you can achieve better rendering performance with large 
surfaces by setting EdgeColor to none and FaceColor to texture. 

This technique is particularly useful if you want a high resolution surface 
without creating an objects whose data is large and therefore, very slow to 
transform. For example,

h1 = surf(peaks(1000));
shading interp
cd1 = get(h1,'CData');
surf(peaks(24),'FaceColor','Texture','EdgeColor','none',...

'CData',cd1)
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Figure Objects
Figure graphics objects are the windows in which MATLAB displays graphics. 
Figure properties enable you to control many aspects of these windows, such as 
their size and position on the screen, the coloring of graphics objects displayed 
within them, and the scaling of printed pictures.

This section discusses some of the features that are implemented through 
figure properties and provides examples of how to use these features. 

See Figure Properties for a description of each property

Related Information About Figures
For more information about figures, see the following links:

“Graphics Windows — the Figure” on page 8-5 

“Preparing Figures and Axes for Graphics” on page 8-62

“Protecting Figures and Axes” on page 8-68

“The Figure Close Request Function” on page 8-70

“Using Panel Containers in Figures — Uipanels” on page 8-76

“Programming the Resize Functions” on page 8-79

“Figure Callbacks” on page 8-85

“Example — Simulating Multiple Colormaps in a Figure” on page 10-31

“Displaying Multiple Plots per Figure” on page 5-27
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Docking Figures in the Desktop
You can dock figures in the MATLAB desktop by clicking the dock button, , 
which appears on the right end of the menu bar. Once docked, figures are 
placed in a figure group container, which you can also dock and undock. 

You can select from a variety of arrangements of the figures in the container. 
The following picture shows how to select various figure arrangements. Once 
docked, the figure container displays the toolbar and menubar of the figure 
with focus.

Tile, Left/Right Split, Top/Bottom Split

Float, MaximizeUndock button
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Figure Properties That Affect Docking
There are two figure properties that are related to figure docking — 
DockControls and WindowStyle.

DockControls
The DockControls property controls the display of the controls used to dock 
figures. Setting DockControls to off removes the dock button from the 
menubar and disables docking from the figure Desktop menu.

WindowStyle
When you set the WindowStyle property to docked, MATLAB docks the figure 
in the desktop within a figure group container. 

If WindowStyle is set to docked, 

• MATLAB automatically sets DockControls to on.

• You cannot set the DockControls property to off. 

• You cannot set the figure Position property.

Docking Figures Automatically
If you want MATLAB to always dock figures, set the default value of the 
WindowStyle property to docked. The following statement,

set(0,'DefaultFigureWindowStyle','docked') 

creates a default value for the WindowStyle property on the root level. Issuing 
this statement on the command line sets the WindowStyle of all figures for the 
duration of your MATLAB session (unless you change the value). 

Place this statement in your startup.m file to make MATLAB always dock 
figures. See startup for more information on startup.m.

Creating a Nondockable Figure
In cases where you do not want users to be able to dock figures (e.g., figures 
used for GUIs), you should set figure properties as follows:

• DockControls to off

• WindowStyle to normal or modal

• HandleVisibility to off or callback
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Positioning Figures
The figure Position property controls the size and location of the figure 
window on the root screen. At startup, MATLAB determines the size of your 
computer screen and defines a default value for Position. This default creates 
figures about one-quarter of the screen’s size and places them centered left to 
right and in the top half of the screen. 

The Position Vector
MATLAB defines the figure Position property as a vector.

[left bottom width height]

left and bottom define the position of the first addressable pixel in the lower 
left corner of the window, specified with respect to the lower left corner of the 
screen. width and height define the size of the interior of the window (i.e., 
exclusive of the window border).

width

height

left

bottom

Figure No. 1
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MATLAB does not measure the window border when placing the figure; the 
Position property defines only the internal active area of the figure window. 

Because figures are windows under the control of your computer’s windowing 
system, you can move and resize figures as you would any other windows. 
MATLAB automatically updates the Position property to the new values. 

Units
The figure’s Units property determines the units of the values used to specify 
the position on the screen. Possible values for the Units property are

set(gcf,'Units')
[ inches | centimeters | normalized | points | {pixels} | 
characters]

with pixels being the default. These choices allow you to specify the figure size 
and location in absolute units (such as inches) if you want the window always 
to be a certain size, or in units relative to the screen size (such as pixels). 

Characters are units that enable you to define the location and size of the figure 
in units that are based on the size of the default system font. See “Example — 
Using Figure Panels” on page 8-77 for an example that uses character units.

Determining Screen Size
Whatever units you use, it is important to know the extent of the screen in 
those units. You can obtain this information from the root ScreenSize 
property. For example,

get(0,'ScreenSize')
ans =

1 1 1152 900

In this case, the screen is 1152 by 900 pixels. MATLAB returns the ScreenSize 
in the units determined by the root Units property. For example,

set(0,'Units','normalized')

normalizes the values returned by ScreenSize.

get(0,'ScreenSize')
ans =

0 0 1 1
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Defining the figure Position in terms of the ScreenSize in normalized units 
makes the specification independent of variations in screen size. This is useful 
if you are writing an M-file that is to be used on different computer systems.

Example — Specifying Figure Position
Suppose you want to define two figure windows that occupy the upper third of 
the computer screen (e.g., one for uicontrols and the other to display data). To 
position the windows precisely, you must consider the window borders when 
calculating the size and offsets to specify for the Position properties. 

1 The figure Position property does not include the window borders, so this 
example uses a width of 5 pixels on the sides and bottom and 30 pixels on 
the top.

bdwidth = 5;
topbdwidth = 30;

2 Ensure root units are pixels and get the size of the screen:

set(0,'Units','pixels') 
scnsize = get(0,'ScreenSize');

3 Define the size and location of the figures:

pos1  = [bdwidth,... 
2/3*scnsize(4) + bdwidth,...
scnsize(3)/2 − 2*bdwidth,...
scnsize(4)/3 − (topbdwidth + bdwidth)];

pos2 = [pos1(1) + scnsize(3)/2,...
pos1(2),...
pos1(3),...
pos1(4)];

4 Create the figures:

figure('Position',pos1) 
figure('Position',pos2)

The two figures now occupy the top third of the screen.
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Figure Colormaps — The Colormap Property
MATLAB defines a colormap as a three-column array. Each row of the array 
defines a particular color by giving three values in the range [0...1]. These 
values specify the RGB values; the intensity of the red, green, and blue video 
components. 

Colormaps enable you to control how MATLAB maps data values to colors in 
surfaces, patches, images, and plotting functions that are based on these 
objects. See the following sections for more information.

Coloring Mesh and Surface Plots in 3-D Visualization

Specifying Patch Coloring in 3-D Visualization

“The Image Object and Its Properties” on page 6-26

Specifying the Figure Colormap
The figure Colormap property contains the colormap array. You can specify the 
figure colormap by setting this property to an m-by-3 array, where m is the 
number of colors in the colormap. 

For example, the following statement creates a figure with a colormap having 
128 random colors.

figure('Colormap',rand(128,3));

The colormap function is an easy way to specify the colormap. MATLAB also 
provides a number of functions that generate colormaps. For example, 

colormap(hsv(96))

sets the colormap of the current figure to a 96 element version of the hsv 
colormap. See the colormap reference page for a list of predefined colormaps. 
Note that the default colormap is jet(64).
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Selecting Drawing Methods
MATLAB enables you to select different techniques for drawing graphics. The 
combination of settings you select depends on the type of graphics you are 
producing. 

There are four figure properties that affect how MATLAB draws graphics:

• BackingStore — Allows faster redrawing when obscured figure windows are 
exposed

• DoubleBuffer — Produces flash-free rendering for simple animations

• Renderer and RendererMode — Specifies different rendering methods or 
allows MATLAB to make the selection

Backing Store

Overview
Set BackingStore to on to produce fast redraws of previously obscured 
windows. Disable BackingStore to use less system memory.

More Details
The term “backing store” refers to an offscreen pixel buffer used to store a copy 
of the figure window’s contents.  When you move or delete windows on your 
display, previously obscured windows can become exposed (even partially), 
requiring the computer system to redraw these windows. With backing store 
enabled, MATLAB simply copies an exposed figure window’s contents from the 
buffer to the screen. 

The BackingStore property is on by default because this provides the most 
desirable behavior. However, the offscreen pixel buffers required for each 
figure window do consume system memory. If memory is limited on your 
system, set BackingStore to off to release the memory used by these buffers.

Double Buffering

Overview
Set DoubleBuffer to on when you are animating lines rendered in painters 
with EraseMode set to normal. 
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More Details
Double buffering is the process of drawing into an offscreen pixel buffer and 
then blitting the buffer contents to the screen once the drawing is complete 
(instead of drawing directly to the screen, where the process of drawing is 
visible as it progresses). Double buffering generally produces flash-free 
rendering for simple animations (such as those involving lines, as opposed to 
objects containing large numbers of polygons).

The figure DoubleBuffer property accepts the values on and off, with off 
being the default. You can select double buffering only when the figure 
Renderer property is set to painters. Zbuffer always uses double buffering 
and ignores this property. OpenGL does not use double buffering.

Use double buffering with the animated object’s EraseMode property set to 
normal. 

Selecting a Renderer

Overview
MATLAB automatically selects the best renderer based on the complexity of 
the graphics objects and the options available on your system. 

More Details
A renderer is the software that processes graphics data (such as vertex 
coordinates) into a form that MATLAB can use to draw into the figure. 
MATLAB supports three renderers:

• Painters 

• Z-buffer

• OpenGL

Painters
Painters method is faster when the figure contains only simple or small 
graphics. It cannot be used with lighting. 

Z-Buffer
Z-buffering is the process of determining how to render each pixel by drawing 
only the front-most object, as opposed to drawing all objects back to front, 
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redrawing objects that obscure those behind. The pixel data is buffered and 
then blitted to the screen all at once.

Z-buffering is generally faster for more complex graphics, but can be slower for 
very simple graphics. You can set the Renderer property to whatever produces 
the fastest drawing (either zbuffer or painters), or let MATLAB decide which 
method to use by setting the RendererMode property to auto (the default). 

Printing from Z-Buffer. You can select the resolution of the PostScript file 
produced by the print command using the −r option. By default, MATLAB 
prints Z-buffered figures at a medium resolution of 150 dpi (the default with 
Renderer set to painters is 864 dpi). 

The size of the file generated from a Z-buffer figure does not depend on its 
contents, just the size of the figure. To decrease the file size, make the 
PaperPosition property smaller before printing (or set PaperPositionMode to 
auto and resize the figure window). 

OpenGL
OpenGL is available on many computer systems. It is generally faster than 
either painters or Z-buffer and in some cases enables MATLAB to use the 
system’s graphics hardware (which results in significant speed increase). See 
the figure Renderer property for more information.

Limitations of OpenGL. OpenGL has two limitations when compared to painters 
and Z-buffer:

• OpenGL does not interpolate colors within the figure colormap; all color 
interpolation is performed through the RGB color cube, which can produce 
unexpected results. 

• OpenGL does not support Phong lighting.
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Specifying the Figure Pointer
MATLAB indicates the position of the pointer (cursor) within the figure 
window using a graphical symbol. You can select a pointer from 15 predefined 
symbols (see table below) or you can define your own symbol. By convention, 
each of the predefined symbols has a purpose associated with it (although 
MATLAB enforces no rules for the use of any symbols).

You specify the pointer symbol by setting the value of the figure Pointer 
property. For example, this statement sets the pointer in the current figure 
(gcf) to an arrow.

set(gcf,'Pointer','arrow')

The following table shows the predefined symbols, the associated specifier, and 
describes typical use.

Purpose Specifier Typical Symbol

Use for editing text ibeam

Locate a point on a graphics 
object

crosshair

Select a point anywhere in the 
figure

arrow

Indicate the system is busy watch

Resize an object from the top-left 
corner

topl

Resize an object from the 
top-right corner

topr

Resize an object from the 
bottom-left corner

botl

Resize an object from the 
bottom-right corner

botr

View the actual hot spot circle
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Defining Custom Pointers
When you set the Pointer property to custom, MATLAB displays the pointer 
you define using the PointerShapeCData and the PointerShapeHotSpot 
properties. Custom pointers are 16-by-16 pixels, where each pixel can be either 
black, white, or transparent. 

Specify the pointer by creating a 16-by-16 matrix containing elements that are

• 1’s where you want the pixel black

• 2’s where you want the pixel white

• NaNs where you want the pixel transparent

Assign the matrix to the figure PointerShapeCData property. MATLAB 
displays the defined pointer whenever the pointer is in the figure window.

The PointerShapeHotSpot property specifies the pixel that indicates the 
pointer location. MATLAB then stores this location in the root 
PointerLocation property. Set the PointerShapeHotSpot property to a 
two-element vector specifying the row and column indices in the 
PointerShapeCData matrix that correspond to the pixel specifying the location. 

Locate a point cross

Use as popular symbol fleur

Resize an object from the left side left

Resize an object from the right 
side

right

Resize an object from the top top

Resize an object from the bottom bottom

Align a point with other objects 
on the display

fullcross

See the next section for 
information on defining your own 
pointer shape

custom

Purpose Specifier Typical Symbol



Specifying the Figure Pointer

9-15

The default value for this property is [1 1], which corresponds to the upper left 
corner of the pointer.

Example — Two Custom Pointers
One way to create a custom pointer is to assign values to a 16-by-16 matrix by 
hand, as illustrated in the following example. 

First, initialize the matrix, setting all values to 2. Create a black border 1 pixel 
wide. Add alignment marks.

P = ones(16)+1;
P(1,:) = 1; P(16,:) = 1;
P(:,1) = 1; P(:,16) = 1;
P(1:4,8:9) = 1; P(13:16,8:9) = 1;
P(8:9,1:4) = 1; P(8:9,13:16) = 1;
P(5:12,5:12) = NaN; % Create a transparent region in the center
set(gcf,'Pointer','custom','PointerShapeCData',P,...

'PointerShapeHotSpot',[9 9])

The last statement sets the Pointer property to custom, assigns the matrix to 
the PointerShapeCData property, and selects element (9,9) as the “hot spot.”

MATLAB now uses the custom pointer within the figure window.

Creating Pointers from Functions. You can use a mathematical function to define 
the PointerShapeCData matrix. For example, evaluating the function
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g = 0:.2:20;
[X,Y] = meshgrid(g);
Z = 2*sin(sqrt(X.^2 + Y.^2));
mesh(Z);

produces an interesting surface.

Use the values of Z to create a pointer sampling fewer points so that Z is a 
16-by-16 matrix.

g = linspace(0,20,16);
[X,Y] = meshgrid(g);
Z = 2*sin(sqrt(X.^2 + Y.^2));
set(gcf,'Pointer','custom',...

'PointerShapeCData',flipud((Z>0) + 1))

The statement flipud((Z>0) + 1) sets all values in Z that are greater than 0 
to 2 (in MATLAB, true + 1 = 2), less than 0 to 1 (false + 1 = 1) and then flips the 
data around so that element (1,1) is the upper left corner. 
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Axes Objects — Defining Coordinate Systems for Graphs
MATLAB uses graphics objects to create visual representations of data. For 
example, a two-dimensional array of numbers can be represented as lines 
connecting the data points defined by each column, as a surface constructed 
from a grid of rectangles whose vertices are defined by each element of the 
array, as a contour graph where equal values in the array are connected by 
lines, and so on.

In all these cases, there must be a frame of reference that defines where to 
place each data point on the graph. This frame of reference is the coordinate 
system defined by the axes. Axes orient and scale graphs to produce the view 
of the data that you see on screen.

MATLAB creates axes to define the coordinate system of each graph. Axes are 
always contained within a figure object and themselves contain the graphics 
objects that make up the graph.

Axes properties control many aspects of how MATLAB displays graphical 
information. This section discusses some of the features that are implemented 
through axes properties and provides examples of how to uses these features. 

The axes property descriptions list all axes properties and provide an overview 
of the characteristics that are affected by each property. 
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Labeling and Appearance Properties
MATLAB provides a number of properties for labeling and controlling the 
appearance of axes. For example, this surface plot shows some of the labeling 
possibilities and indicates the controlling property. 

Creating Axes with Specific Characteristics
To create this axes, specify values for the indicated properties.

h = axes('Color',[.9 .9 .9],...
'GridLineStyle','--',...
'ZTickLabels','-1|Z = 0 Plane|+1',...
'FontName','times',...
'FontAngle','italic',...
'FontSize',14,...
'XColor',[0 0 .7],...
'YColor',[0 0 .7],...
'ZColor',[0 0 .7]);
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Axis Labels
The individual axis labels are text objects whose handles are normally hidden 
from the command line (their HandleVisibility property is set to callback). 
You can use the xlabel, ylabel, zlabel, and title functions to create axis 
labels. However, these functions affect only the current axes. If you are labeling 
axes other than the current axes by referencing the axes handle, then you must 
obtain the text object handle from the corresponding axes property. For 
example,

get(axes_handle,'XLabel')

returns the handle of the text object used as the x-axis label. Obtaining the text 
handle from the axes is useful in M-files and MATLAB-based applications 
where you cannot be sure the intended target is the current axes.

The following statements define the x- and y-axis labels and title for the axes 
above.

set(get(axes_handle,'XLabel'),'String','Values of X')
set(get(axes_handle,'YLabel'),'String','Values of Y')
set(get(axes_handle,'Title'),'String','\fontname{times}\itZ = 
f(x,y)') 

Because the labels are text, you must specify a value for the String property, 
which is initially set to the empty string (i.e., there are no labels). 

MATLAB overrides many of the other text properties to control positioning and 
orientation of these labels. However, you can set the Color, FontAngle, 
FontName, FontSize, FontWeight, and String properties.

Note that both axes objects and text objects have font specification properties. 
The call to the axes function on the previous page set values for the FontName, 
FontAngle, and FontSize properties. If you want to use the same font for the 
labels and title, specify these same property values when defining their String 
property. For example, the x-axis label statement would be

set(get(h,'XLabel'),'String','Values of X',...
'FontName','times',...
'FontAngle','italic',...
'FontSize',14)
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Positioning Axes
The axes Position property controls the size and location of an axes within a 
figure. The default axes has the same aspect ratio (ratio of width to height) as 
the default figure and fills most of the figure, leaving a border around the 
edges. However, you can define the axes position as any rectangle and place it 
wherever you want within a figure. 

The Position Vector
MATLAB defines the axes Position property as a vector.

[left bottom width height]

left and bottom define a point in the figure that locates the lower left corner 
of the axes rectangle. width and height specify the dimensions of the axes 
rectangle. Viewing the axes in 2-D (azimuth = 0°, elevation = 90°) orients the 
x-axis horizontally and the y-axis vertically. From this angle, the plot box (the 
area used for plotting, exclusive of the axis labels) coincides with the axes 
rectangle.
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By default, MATLAB draws the plot box to fill the axes rectangle, regardless of 
its shape. However, axes properties enable control over the shape and scaling 
of the plot box.

Position Units
The axes Units property determines the units of measurement for the 
Position property. Possible values for this property are

set(gca,'Units')
[ inches | centimeters | {normalized} | points | pixels ]

with normalized being the default. Normalized units map the lower left corner 
of the figure to the point (0,0) and the upper right corner to (1.0,1.0), regardless 
of the size of the figure. Normalized units cause axes to resize automatically 
whenever you resize the figure. All other units are absolute measurements that 
remained fixed as you resize the figure.
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Automatic Axes Resize
When you create a graph, MATLAB automatically creates an axes to display 
the graph. The axes is sized to fit in the figure and automatically resizes as you 
resize the figure. Note, however, that MATLAB applies the automatic resize 
behavior only when the axes Units property is set to normalized (the default).

You can control the resize behavior of the axes using the following axes 
properties. 

• OuterPosition — The boundary of the axes including the axis labels, title, 
and a margin. For figures with only one axes, this is the interior of the figure.

• Position — The boundary of the axes, excluding the tick marks and labels, 
title, and axis labels.

• ActivePositionProperty — Specifies whether to use the OuterPosition or 
the Position property as the size to preserve when resizing the figure 
containing the axes.

• TightInset — The margins added to the width and height of the Position 
property to include text labels, title, and axis labels.

• Units — Keep this property set to normalized to enable automatic axes 
resizing.

The following graph shows the areas defined by the OuterPosition, 
TightInset + Position, and Position properties. 
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When you add axis labels and a title, the TightInset changes to accommodate 
the additional text, as shown in the following graph.

OuterPosition

TightInset+Position

Position
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Now the size of the rectangle defined by the TightInset + Position properties 
includes all graph text. The Position and OuterPosition properties remain 
unchanged.

Using OuterPosition as the ActivePositionProperty
As you resize the figure, MATLAB maintains the area defined by the 
TightInset + Position so the test is not cut off. Compare the next two graphs, 
which have both been resized to the same figure size.

OuterPosition

TightInset+Position

Position
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ActivePositionProperty = OuterPosition

ActivePositionProperty = Position

The following picture shows how these properties apply to 3-D graphs.
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Axes Resizing in Subplots
Using the OuterPosition property as the ActivePositionProperty is an 
effective way to prevent titles and labels from being overwritten when there 
are multiple axes in a figure. 

The following picture illustrates how MATLAB resizes the axes to 
accommodate the multiline titles on the lower two axes.

OuterPosition

Position

TightInset+Position
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The default 3-D view is azimuth = -37.5°, elevation = 30°.
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Multiple Axes per Figure
The subplot function creates multiple axes in one figure by computing values 
for Position that produce the specified number of axes. 

The subplot function is useful for laying out a number of graphs equally 
spaced in the figure. However, overlapping axes can create some other useful 
effects. The following two sections provide examples:

• “Placing Text Outside the Axes” on page 10-13

• “Multiple Axes for Different Scaling” on page 10-14

Placing Text Outside the Axes
MATLAB always displays text objects within an axes. If you want to create a 
graph and provide a description of the information alongside the graph, you 
must create another axes to position the text. If you create an axes that is the 
same size as the figure and then create a smaller axes to draw the graph, you 
can then display text anywhere independently of the graph.

For example, define two axes.

h = axes('Position',[0 0 1 1],'Visible','off');
axes('Position',[.25 .1 .7 .8])

Because the axes units are normalized to the figure, specifying the Position as 
[0 0 1 1] creates an axes that encompasses the entire window. 

Now plot some data in the current axes. The last axes created is the current 
axes, so MATLAB directs graphics output there.

t = 0:900;
plot(t,0.25*exp(-0.005*t))

Define the text and display it in the full-window axes.

str(1) = {'Plot of the function:'};
str(2) = {' y = A{\ite}^{-\alpha{\itt}}'};
str(3) = {'With the values:'};
str(3) = {' A = 0.25'};
str(4) = {' \alpha = .005'};
str(5) = {' t = 0:900'};
set(gcf,'CurrentAxes',h)
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text(.025,.6,str,'FontSize',12)

Multiple Axes for Different Scaling
You can create multiple axes to display graphics objects with different scaling 
without changing the data that defines these objects (which would be required 
to display them in a single axes).

h(1) = axes('Position',[0 0 1 1]);
sphere
h(2) = axes('Position',[0 0 .4 .6]);
sphere
h(3) = axes('Position',[0 .5 .5 .5]);
sphere
h(4) = axes('Position',[.5 0 .4 .4]);
sphere
h(5) = axes('Position',[.5 .5 .5 .3]);

Plot of the function:
  y = Ae−αt

With the values:
  A = 0.25
  α = .005
  t = 0:900
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sphere
set(h,'Visible','off')

Each sphere is defined by the same data. However, because the parent axes 
occupy regions of different size and location, the spheres appear to be different 
sizes and shapes.
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Individual Axis Control 
MATLAB automatically determines axis limits, tick mark placement, and tick 
mark labels whenever you create a graph. However, you can specify these 
values manually by setting the appropriate property. 

When you specify a value for a property controlled by a mode (e.g., the XLim 
property has an associated XLimMode property), MATLAB sets the mode to 
manual, enabling you to override automatic specification. Because the default 
values for these mode properties are automatic, calling high-level functions 
such as plot or surf resets these modes to auto. 

This section discusses the following properties.

Property Purpose

XLim,YLim,ZLim Sets the axis range

XLimMode, 
YLimMode, 
ZLimMode

Specifies whether axis limits are determined 
automatically by MATLAB or specified 
manually by the user

XTick, 
YTick,
ZTick

Sets the location of the tick marks along the 
axis

XTickMode, 
YTickMode, 
ZTickMode

Specifies whether tick mark locations are 
determined automatically by MATLAB or 
specified manually by the user

XTickLabel,
YTickLabel,
ZTickLabel

Specifies the labels for the axis tick marks

XTickLabelMode, 
YTickLabelMode, 
ZTickLabelMode

Specifies whether tick mark labels are 
determined automatically by MATLAB or 
specified manually by the user

XDir,YDir,ZDir Sets the direction of increasing axis values
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Setting Axis Limits
MATLAB determines the limits automatically for each axis based on the range 
of the data. You can override the selected limits by specifying the XLim, YLim, 
or ZLim property. For example, consider a plot of the function  evaluated 
with A = 0.25, α = 0.05, and t = 0 to 900.

t = 0:900;
plot(t,0.25*exp(−0.05*t))

The plot on the left shows the results. MATLAB selects axis limits that 
encompass the range of data in both x and y. However, because the plot 
contains little information beyond t = 100, changing the x-axis limits improves 
the usefulness of the plot. If the handle of the axes is axes_handle, then the 
following statement,

set(axes_handle,'XLim',[0 100])

creates the plot on the right.

You can use the axis command to set limits on the current axes only.
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Semiautomatic Limits
You can specify either the minimum or maximum value for an axis limit and 
allow the other limit to autorange. Do this by setting an explicit value for the 
manual limit and Inf for the automatic limit. For example, the statement

set(axes_handle,'XLim',[0 Inf])

sets the XLimMode property to auto and allows MATLAB to determine the 
maximum value for XLim. Similarly, the statement

set(axes_handle,'XLim',[−Inf 800])

sets the XLimMode property to auto and allows MATLAB to determine the 
minimum value for XLim. 

Setting Tick Mark Locations
MATLAB selects the tick mark location based on the data range to produce 
equally spaced ticks (for linear graphs). You can specify alternative locations 
for the tick marks by setting the XTick, YTick, and ZTick properties. 

For example, if the value 0.075 is of interest for the amplitude of the function 
, specify tick marks to include that value.

set(gca,'YTick',[0 0.05 0.075 0.1 0.15 0.2 0.25])
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You can change tick labeling from numbers to strings using the XTickLabel, 
YTickLabel, and ZTickLabel properties. 

For example, to label the y-axis value of 0.075 with the string Cutoff, you can 
specify all y-axis labels as a string, separating each label with the “|” 
character.

set(gca,'YTickLabel','0|0.05|Cutoff|0.1|0.15|0.2|0.25')

Changing Axis Direction
The XDir, YDir, and ZDir properties control the direction of increasing values 
on the respective axis. In the default 2-D view, the x-axis values increase from 
left to right and the y-axis values increase from bottom to top. The z-axis points 
out of the screen.

You can change the direction of increasing values by setting the associated 
property to reverse. For example, setting XDir to reverse,

set(gca,'XDir','reverse')

produces a plot whose x-axis decreases from left to right.
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In the 3-D view, the y-axis increases from front to back and the z-axis increases 
from bottom to top.

Setting the x-, y-, and z-directions to reverse,

set(gca,'XDir','rev','YDir','rev','ZDir','rev')

yields
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Using Multiple X- and Y-Axes
The XAxisLocation and YAxisLocation properties specify on which side of the 
graph to place the x- and y-axes. You can create graphs with two different 
x-axes and y-axes by superimposing two axes objects and using XAxisLocation 
and YAxisLocation to position each axis on a different side of the graph. This 
technique is useful to plot different sets of data with different scaling in the 
same graph.

Example — Double Axis Graphs
This example creates a graph to display two separate sets of data using the 
bottom and left sides as the x- and y-axis for one, and the top and right sides as 
the x- and y-axis for the other.

Suppose you have two sets of data having different x- and y-ranges:

x1 = [0:.1:40];
y1 = 4.*cos(x1)./(x1+2);
x2 = [1:.2:20];
y2 = x2.^2./x2.^3;

Using low-level line and axes routines allows you to superimpose objects 
easily. Plot the first data, making the color of the line and the corresponding x- 
and y-axis the same to more easily associate them.

hl1 = line(x1,y1,'Color','r');
ax1 = gca;
set(ax1,'XColor','r','YColor','r')

Next, create another axes at the same location as the first, placing the x-axis 
on top and the y-axis on the right. Set the axes Color to none to allow the first 
axes to be visible and color code the x- and y-axis to match the data.

ax2 = axes('Position',get(ax1,'Position'),...
'XAxisLocation','top',...
'YAxisLocation','right',...
'Color','none',...
'XColor','k','YColor','k');

Draw the second set of data in the same color as the x- and y-axis.

hl2 = line(x2,y2,'Color','k','Parent',ax2);
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Creating Coincident Grids
Since the two axes are completely independent, MATLAB determines tick 
mark locations according to the data plotted in each. It is unlikely the gridlines 
will coincide. This produces a somewhat confusing looking graph, even though 
the two grids are drawn in different colors. However, if you manually specify 
tick mark locations, you can make the grids coincide.

The key is to specify the same number of tick marks along corresponding axis 
lines (it is also necessary for both axes to be the same size). The following graph 
of the same data uses six tick marks per axis, equally spaced within the 
original limits. To calculate the tick mark locations, obtain the limits of each 
axis and calculate an increment.

xlimits = get(ax1,'XLim');
ylimits = get(ax1,'YLim');
xinc = (xlimits(2)−xlimits(1))/5;
yinc = (ylimits(2)−ylimits(1))/5;

Now set the tick mark locations.

set(ax1,'XTick',[xlimits(1):xinc:xlimits(2)],...
'YTick',[ylimits(1):yinc:ylimits(2)])
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Perform this calculation and set the axis limits for both axes. The resulting 
graph is visually simpler, even though the y-axis on the left has rather odd tick 
mark values.
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Automatic-Mode Properties
While object creation routines that create axes children do not explicitly change 
axes properties, some axes properties are under automatic control when their 
associated mode property is set to auto (which is the default). The following 
table lists the automatic-mode properties.

For example, if all property values are set to their defaults and you enter these 
statements,

Mode Property What It Controls

CameraPositionMode Positioning of the viewpoint

CameraTargetMode Positioning of the camera target in the axes

CameraUpVectorMode The direction of “up” in 2-D and 3-D views

CameraViewAngleMode The size of the projected scene and 
stretch-to-fit behavior

CLimMode Mapping of data values to colors

DataAspectRatioMode Relative scaling of data units along x-, y-, and 
z-axes and stretch-to-fit behavior

PlotBoxAspectRatioMode Relative scaling of plot box along x-, y-, and 
z-axes and stretch-to-fit behavior

TickDirMode Direction of axis tick marks (in for 2-D, out 
for 3-D)

XLimMode
YLimMode
ZLimMode

Limits of the respective x, y, and z axes

XTickMode
YTickMode
ZTickMode

Tick mark spacing along the respective x-, y-, 
and z-axes

XTickLabelMode
YTickLabelMode
ZTickLabelMode

Tick mark labels along the respective x-, y-, 
and z-axes
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line(1:10,1:10)
line(1:10,[1:10].^2)

the second line statement causes the YLim property to change from [0 10] to 
[0 100]. 

This is because YLimMode is auto, which always causes MATLAB to recompute 
the axis limits. 

If you set the value controlled by an automatic-mode property, MATLAB sets 
the mode to manual and does not automatically recompute the value. 

For example, in the statements

line(1:10,1:10)
set(gca,'XLim',[1 10],'YLim',[1 20])
line(1:10,[1:10].^2)

the set statement sets the x- and y-axis limits and changes the XLimMode and 
YLimMode properties to manual. The second line statement now draws a line 
that is clipped to the axis limits [1 12] instead of causing the axes to 
recompute its limits.
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Colors Controlled by Axes
Axes properties specify the color of the axis lines, tick marks, labels, and the 
background. Properties also control the colors of the lines drawn by plotting 
routines and how image, patch, and surface objects obtain colors from the 
figure colormap.

The axes properties discussed in this section are listed in the following table.

Specifying Axes Colors
The default axes background color is set up by the colordef command, which 
is called in your startup file. However, you can easily define your own color 
scheme. 

Changing the Color Scheme
Suppose you want an axes to use a “black-on-white” color scheme. First, change 
the background to white and the axis lines, grid, tick marks, and tick mark 
labels to black.

set(gca,'Color','w',...

Property Characteristic it Controls

Color Axes background color

XColor, YColor, ZColor Color of the axis lines, tick marks, gridlines, 
and labels

Title Title text object handles

XLabel, YLabel, Zlabel Axis label text object handles

CLim Controls mapping of graphic object CData to 
the figure colormap

CLimMode Automatic or manual control of CLim property

ColorOrder Line color autocycle order

LineStyleOrder Line styles autocycle order (not a color, but 
related to ColorOrder)



Colors Controlled by Axes

10-29

'XColor','k',...
'YColor','k',...
'ZColor','k')

Next, change the color of the text objects used for the title and axis labels.

set(get(gca,'Title'),'Color','k')
set(get(gca,'XLabel'),'Color','k')
set(get(gca,'YLabel'),'Color','k')
set(get(gca,'ZLabel'),'Color','k')

Changing the figure background color to white completes the new color scheme.

set(gcf,'Color','w')

When you are done, a figure containing a mesh plot looks like the following 
figure.

You can define default values for the appropriate properties and put these 
definitions in your startup.m file. Titles and axis labels are text objects, so you 
must set a default color for all text objects, which is a good idea anyway because 
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the default text color of white is not visible on the white background. Lines 
created with the low-level line function (but not the plotting routines) also 
have a default color of white, so you should change the default line color as well.

To set default values on the root level, use

set(0,'DefaultFigureColor','w'
'DefaultAxesColor','w',...
'DefaultAxesXColor','k',...
 'DefaultAxesYColor','k',...
 'DefaultAxesZColor','k',...
 'DefaultTextColor','k',...
 'DefaultLineColor','k')

MATLAB colors other axes children (i.e., image, patch, and surface objects) 
according to the values of their CData properties and the figure colormap. 

Axes Color Limits — the CLim Property
Many of the 3-D graphics functions produce graphs that use color as another 
data dimension. For example, surface plots map surface height to color. The 
color limits control the limits of the color dimension in a way analogous to 
setting axis limits.

The axes CLim property controls the mapping of image, patch, and surface 
CData to the figure colormap. CLim is a two-element vector [cmin cmax] 
specifying the CData value to map to the first color in the colormap (cmin) and 
the CData value to map to the last color in the colormap (cmax). Data values in 
between are linearly transformed from the second to the next to last color, 
using the expression

colormap_index = fix((CData−cmin)/(cmax−cmin)*cm_length)+1

cm_length is the length of the colormap. When CLimMode is auto, MATLAB sets 
CLim to the range of the CData of all graphics objects within the axes. However, 
you can set CLim to span any range of values. This allows individual axes within 
a single figure to use different portions of the figure’s colormap. You can create 
colormaps with different regions, each used by a different axes. 

See the caxis command for more information on color limits.

See “Example — Simulating Multiple Colormaps in a Figure” on page 10-31 for 
an example that calculates color limits.
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Example — Simulating Multiple Colormaps in a 
Figure
Suppose you want to display two different surfaces in the same figure and color 
each surface with a different colormap. You can produce the effect of two 
different colormaps by concatenating two colormaps and then setting the CLim 
property of each axes to map into a different portion of the colormap. 

This example creates two surfaces from the same topographic data. One uses 
the color scheme of a typical atlas — shades of blue for the ocean and greens 
for the land. The other surface is illuminated with a light source to create the 
illusion of a three-dimensional picture. Such illumination requires a colormap 
that changes monotonically from dark to light. 
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Calculating Color Limits
The key to this example is calculating values for CLim that cause each surface 
to use the section of the colormap containing the appropriate colors. 

To calculate the new values for CLim, you need to know

• The total length of the colormap (CmLength)

• The beginning colormap slot to use for each axes (BeginSlot)

• The ending colormap slot to use for each axes (EndSlot)
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• The minimum and maximum CData values of the graphic objects contained 
in the axes. That is, the values of the axes CLim property determined by 
MATLAB when CLimMode is auto (CDmin and CDmax).

First, define subplot regions and plot the surfaces.

ax1 = subplot(2,1,1);
view([0 80])
surf(topodata)
shading interp
ax2 = subplot(2,1,2),;
view([0 80]);
surfl(topodata,[60 0])
shading interp

Concatenate two colormaps and install the new colormap.

colormap([Lightingmap;Atlasmap]);

Obtain the data you need to calculate new values for CLim.

CmLength = size(get(gcf,'Colormap'),1);% Colormap length
BeginSlot1 = 1; % Beginning slot
EndSlot1  = size(Lightingmap,1); % Ending slot
BeginSlot2 = EndSlot1+1; 
EndSlot2  = CmLength;
CLim1  = get(ax1,'CLim');% CLim values for each axis
CLim2  = get(ax2,'CLim');

Defining a Function to Calculate CLim Values
Computing new values for CLim involves determining the portion of the 
colormap you want each axes to use relative to the total colormap size and 
scaling its Clim range accordingly. You can define a MATLAB function to do 
this.

function CLim = newclim(BeginSlot,EndSlot,CDmin,CDmax,CmLength)
% Convert slot number and range
% to percent of colormap
PBeginSlot = (BeginSlot − 1) / (CmLength − 1);
PEndSlot  = (EndSlot − 1) / (CmLength − 1);
PCmRange = PEndSlot − PBeginSlot;
% Determine range and min and max 



10 Axes Properties

10-34

% of new CLim values
DataRange  = CDmax − CDmin;
ClimRange  = DataRange / PCmRange;
NewCmin = CDmin − (PBeginSlot * ClimRange);
NewCmax = CDmax + (1 − PEndSlot) * ClimRange;
CLim = [NewCmin,NewCmax];

The input arguments are identified in the bulleted list above. The M-file first 
computes the percentage of the total colormap you want to use for a particular 
axes (PCmRange) and then computes the CLim range required to use that portion 
of the colormap given the CData range in the axes. Finally, it determines the 
minimum and maximum values required for the calculated CLim range and 
returns these values. These values are the color limits for the given axes.

Using the Function
Use the newclim M-file to set the CLim values of each axes. The statement

set(ax1,'CLim',newclim(65,120,clim1(1),clim1(2)))

sets the CLim values for the first axes so the surface uses color slots 65 to 120. 
The lit surface uses the lower 64 slots. You need to reset its CLim values as well.

set(ax2,'CLim',newclim(1,64,clim1(1),clim1(2)))

How the Function Works
MATLAB enables you to specify any values for the axes CLim property, even if 
these values do not correspond to the CData of the graphics objects displayed in 
the axes. MATLAB always maps the minimum CLim value to the first color in 
the colormap and the maximum CLim value to the last color in the colormap, 
whether or not there are really any CData values corresponding to these colors. 
Therefore, if you specify values for CLim that extend beyond the object’s actual 
CData minimum and maximum, MATLAB colors the object with only a subset 
of the colormap.

The newclim M-file computes values for CLim that map the graphics object’s 
actual CData values to the beginning and ending colormap slots you specify. It 
does this by defining a “virtual” graphics object having the computed CLim 
values. The following picture illustrates this concept. It shows a side view of 
two surfaces to make it easier to visualize the mapping of color to surface 
topography. The virtual surface is on the left and the actual surface on the 
right. In the center is the figure’s colormap. 
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The real surface has CLim values of [0.4 −0.4]. To color this surface with slots 
65 to 120, newclim computed new CLim values of [0.4 −1.4269]. The virtual 
surface on the left represents these values.

Defining the Color of Lines for Plotting
The axes ColorOrder property determines the color of the individual lines 
drawn by the plot and plot3 functions. For multiline graphs, these functions 
cycle through the colors defined by ColorOrder, repeating the cycle when they 
reach the end of the list. 

The colordef command defines various color order schemes for different 
background colors. colordef is typically called in the matlabrc file, which is 
executed during MATLAB startup.

Virtual surface 
mapped to entire
120 slot colormap

Figure Colormap Real surface using
only color slots 65
to 120
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Defining Your Own ColorOrder
You can redefine ColorOrder to be any m-by-3 matrix of RGB values, where m 
is the number of colors. However, high-level functions like plot and plot3 
reset most axes properties (including ColorOrder) to the defaults each time you 
call them. To use your own ColorOrder definition you must do one of the 
following three things:

• Define a default ColorOrder on the figure or root level

• Change the axes NextPlot property to add or replacechildren

• Use the informal form of the line function, which obeys the ColorOrder but 
does not clear the axes or reset properties

Changing the Default ColorOrder. You can define a new ColorOrder that MATLAB 
uses within a particular figure, for all axes within any figures created during 
the MATLAB session, or as a user-defined default that MATLAB always uses. 

To change the ColorOrder for all plots in the current figure, set a default in 
that figure. For example, to set ColorOrder to the colors red, green, and blue, 
use the statement

set(gcf,'DefaultAxesColorOrder',[1 0 0;0 1 0;0 0 1])

To define a new ColorOrder that MATLAB uses for all plotting during your 
entire MATLAB session, set a default on the root level so axes created in any 
figure use your defaults.

set(0,'DefaultAxesColorOrder',[1 0 0;0 1 0;0 0 1])

To define a new ColorOrder that MATLAB always uses, place the previous 
statement in your startup.m file.

Setting the NextPlot Property. The axes NextPlot property determines how 
high-level graphics functions draw into an existing axes. You can use this 
property to prevent plot and plot3 from resetting the ColorOrder property 
each time you call them, but still clear the axes of any existing plots. 

By default, NextPlot is set to replace, which is equivalent to a cla reset 
command (i.e., delete all axes children and reset all properties, except 
Position, to their defaults). If you set NextPlot to replacechildren,

set(gca,'NextPlot','replacechildren')
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MATLAB deletes the axes children, but does not reset axes properties. This is 
equivalent to a cla command without the reset.

After setting NextPlot to replacechildren, you can redefine the ColorOrder 
property and call plot and plot3 without affecting the ColorOrder.

Setting NextPlot to add is the equivalent of issuing the hold on command. This 
setting prevents MATLAB from resetting the ColorOrder property, but it does 
not clear the axes children with each call to a plotting function. 

Using the line Function. The behavior of the line function depends on its calling 
syntax. When you use the informal form (which does not include any explicit 
property definitions),

line(x,y,z)

line obeys the ColorOrder property, but does not clear the axes with each 
invocation or change the view to 3-D (as plot3 does). However, line can be 
useful for creating your own plotting functions where you do not want the 
automatic behavior of plot or plot3, but you do want multiline graphs to use 
a particular ColorOrder.

Line Styles Used for Plotting — LineStyleOrder
The axes LineStyleOrder property is analogous to the ColorOrder property. It 
specifies the line styles to use for multiline plots created with the plot and 
plot3 functions. MATLAB increments the line style only after using all of the 
colors in the ColorOrder property. It then uses all the colors again with the 
second line style, and so on. 

For example, define a default ColorOrder of red, green, and blue and a default 
LineStyleOrder of solid, dashed, and dotted lines.

set(0,'DefaultAxesColorOrder',[1 0 0;0 1 0;0 0 1],...
'DefaultAxesLineStyleOrder','-|--|:')

Then plot some multiline data.

t = 0:pi/20:2*pi;
a = ones(length(t),9);
for i = 1:9

a(:,i) = sin(t-i/5)';
end
plot(t,a)



10 Axes Properties

10-38

MATLAB cycles through all colors for each line style.
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A
ActivePositionProperty property 10-7
adding data to axes 1-13
animation 5-62

erase modes for 5-64
movies 5-62

annotating graphs 3-1
adding a title 3-29
adding labels 3-32
adding text 3-38
how to 3-2

area 5-2, 5-17, 5-18
area graphs 5-2, 5-17
arrays, storing images 6-4
arrows

adding to a graph 3-52
aspect ratio of figures 7-41, 7-43

See also printing
axes

adding labels 3-32
adding text 3-39
aspect ratio

2-D 4-24
automatic modes 10-25
axis control 10-16
axis direction 10-19
CLim property 10-30
color limits 10-30
ColorOrder property 10-36
colors 10-28
cutting and copying 1-40
individual axis control 10-16
labeling 3-35
labels

font properties 10-4
using TeX characters 3-45

locking position 1-44

making grids coincident 10-23
multiaxis 10-22
multiple 4-27, 10-13
NextPlot property 8-62
overlapping 10-13
pasting 1-40
positioning 10-5–10-15
preparing to accept graphics 8-62
properties

for labeling 10-3
protecting from output 8-68
scaling

independent 10-14
setting

limits 10-17
line styles used for plotting 10-37

setting limits 4-20
standard plotting behavior 8-66
target for graphics 4-29
tick marks 4-22

locating 10-18
units 10-6
unlocking position 1-44
with two x- and y-axes 10-22

axis 6-2
equal 4-25
illustrated examples, 2-D 4-25
image 6-23
square 4-25
tight 4-26

axis labels, rotating 3-34
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B
background color, of text 3-49
backing store 9-10
bar 5-2, 5-3
bar graphs 5-2–5-17

3-D 5-3
coloring 2-D bars by height 5-5
coloring 3-D bars by height 5-8
grouped

2-D 5-2
3-D 5-4

horizontal 5-11
labeling 5-4, 5-12
overlaid with bar graphs 5-14
overlaid with plots 5-15
stacked 5-10

bar3 5-2, 5-3
bar3h 5-2
barh 5-2
binary images 6-8
bins, specifying for histogram 5-27
BMP 6-2
buttons on toolbar 3-52

C
callbacks

function handles used for 8-87
using function handles for 8-87

CData property
images 6-26

CDataMapping property
images 6-26

cla 8-63
clabel 5-44, 5-46
clf 8-63
close 8-70

close request function
default 8-70

closereq.m 8-70
CloseRequestFcn property 8-70

default value 8-70
errors in 8-71
overriding 8-71

closing figures 8-70
closing MATLAB, errors occurring when 8-71
color limits, calculating 10-32
colorbars

adding to graphs 3-13
labeling ticks 3-14
positioning 3-14

colordef 4-30
colormaps

selection of 3-17
shifting interactively 3-17
simulating multiple 10-31

ColorOrder 10-35
colors

changing color scheme 10-28
controlled by axes 10-28
mapping to data 10-30
specifying figure colors 4-29
used for plotting 10-35

compass 5-38
compass plots 5-38
complex numbers, plotting 4-16

with feather 5-40
containers for graphics objects 8-76
contour 5-44
contour plots 5-44

algorithm 5-51
data preparation 5-57
filled 5-47
filtering noisy data for 5-58
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in polar coordinates 5-54
indexing contours 5-49
labeling 5-46
specifying contour levels 5-48, 5-53

contour3 5-44
contourc 5-44, 5-51
contourf 5-44, 5-47
converting the data class of an indexed image 

6-11
copying

figures 1-47
options 1-47

copying graphics objects 8-56
current

axes 8-50
figure 8-50
object 8-50

current figure 8-6
cursors

See pointers

D
data cursor 2-3
data tips 2-7

See also data cursor
data types

8-bit integers 6-4
double-precision 6-4

DataAspectRatio property
images 6-24

default
aspect ratio

of figure windows 7-41
CloseRequestFcn 8-70
factory 8-42
figure color scheme 4-29

property values 8-43–8-49
removing 8-45
search path, diagram 8-43
setting to factory defaults 8-46

default line styles, setting and removing 4-12
deleting graphics objects 8-58
deselecting objects 1-40
discrete data graphs 5-29–5-37

stairstep plots 5-36
stem plots 5-29

double

converting image data to double 6-35
converting to uint16 6-12
converting to uint8 6-12
converting to uint8 or uint16 6-11

double buffering 9-10

E
editing plots 1-37

interactively 1-38
efficient programming 8-72, 8-73
ending plot edit mode 1-39
erase modes 5-64

and printing 5-66
background 5-66
images 6-29
none 5-64
xor 5-67

errors closing MATLAB 8-71
examples

animation 5-64
area graphs 5-17
bar graphs 5-3
contour plots 5-44
copying graphics objects 8-57
custom pointers 9-15
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direction and velocity graphs 5-38
discrete data graphs 5-29
double axis graphs 10-22
finding object handles 8-52
histograms 5-24
hold 8-68
line 8-65
movies 5-63
multiline text 3-48
newplot 8-65
object creation functions 8-12
overlapping axes 10-13
pie charts 5-21
plot 4-3

complex data 4-16
plotting line styles 10-37
ScreenSize property 9-7
setting default property values 8-46
simulating multiple colormaps 10-31
specifying figure position 9-7
subplot 4-27
text 3-39

exporting
Enhanced Metafiles 7-71
using getframe 7-24

exporting figures 1-47
Adobe Illustrator 7-73
EPS files 7-71
formats

choosing a format 7-64
MATLAB and GhostScript 7-66
vector or bitmap 7-66

JPEG files 7-73
LaTeX

importing example 7-26
lighting 7-69
publication quality 7-72

TIFF files 7-73
transparency 7-69

extent of computer screen 9-6

F
factory defaults 8-42
feather 5-38, 5-39
feather plots 5-39
figure

colormap 9-9
palette 1-7
toolbar 1-2

figure files 1-46, 1-47
figures

CloseRequestFcn 8-70
closing 8-70
copying 1-47
defining custom pointers 9-14
defining pointers 9-13
defining the color of 4-29
exporting 1-47
for plotting 4-27
introduction to 9-2
NextPlot property 8-62
opening 1-47
positioning 9-5
positioning example 9-7
preparing to accept graphics 8-62
printing

default figure size for printing 7-41
protecting from output 8-68
rendering properties 9-10
saving 1-46
saving to other formats 1-47
specifying pointers 9-13
standard plotting behavior 8-66
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units 9-6
visible property 8-70
with multiple axes 4-27

files
exporting 1-47
figure .fig 1-46
formats for figures 1-47
opening 1-47
printing 1-48
saving 1-46

fill, properties changed by 8-73
fill3, properties changed by 8-73
findobj 8-52
fonts

axis labels 10-4
formats for figures 1-47
function handles

Handle Graphics callbacks 8-87
functions

convenience forms 8-15
high-level vs. low-level 8-14

G
gca 8-51

handle visibility 8-69
gcf 8-51

handle visibility 8-69
gco 8-51
get 8-38
getframe 5-62
GIF graphic file format 7-73
ginput 5-60
gradient 5-42
graphical input 5-60
graphics

improving performance of 8-95

graphics file formats
list of formats supported by MATLAB 6-2

graphics images
16-bit

intensity 6-12
8-bit

intensity 6-12
RGB 6-12

converting from one format to another 6-35
converting to RGB 6-35
reading from file 6-17
writing to file 6-18
See also BMP, HDF, JPG, PCX, PNG, TIFF, 

XWD
graphics M-files

structure of 8-66
graphics objects

accessing handles 8-50
accessing hidden handles 8-69
axes 8-11
controlling where they draw 8-60
copying 8-56
deleting 8-58
function handle callbacks 8-87
functions that create

convenience forms 8-15
handle validity versus visibility 8-71
HandleVisibility property 8-68
images 8-11
invisible handles 8-68
lights 8-11
line 8-11
patches 8-12
properties 8-35

changed by functions 8-73
changed when created 8-13
common to all objects 8-36
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factory defined 8-42
getting current values 8-40
listing possible values 8-39
querying in groups 8-42
search path for default values 8-43
searching for 8-52
setting values 8-38

property names 8-15
rectangle 8-12
setting parent of 8-14
surface 8-12
text 8-12

graphs
annotating 3-2
area 5-17–5-19
bar 5-2–5-17

horizontal 5-11
compass plots 5-38
contour plots 5-44–5-56
direction and velocity 5-38–5-43
discrete data 5-29–5-37
feather plots 5-39
generating M-code for 1-48
histograms 5-24–5-28
labeling 3-1
pie charts 5-21–5-23
quiver plots 5-41
stairstep plots 5-36
with double axes 10-22

grayscale 6-20
See also intensity images

Greek characters
using to annotate 3-36
See also text function

grids, coincident 10-23

H
handles to graphics objects 8-50

finding 8-52
handles, saving in M-files 8-72
HandleVisibility property 8-68
HDF 6-2
high-level functions 8-14
hist 5-24
histograms 5-24

in polar coordinates 5-26
labeling the bins 5-27
rose plot 5-26
specifying number of bins 5-27

hold 4-8
and NextPlot 8-63
testing state of 8-67

hold state, testing for 8-67
HorizontalAlignment property 3-42

I
image 6-2, 6-22

properties changed by 8-74
image types

binary 6-8
images

16-bit 6-11
indexed 6-11

8-bit 6-11
indexed 6-11

data types 6-4
erase modes 6-29
indexed 6-6
information about files 6-19
intensity 6-7
numeric classes 6-2
printing 6-34
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properties 6-26
CData 6-26
CDataMapping 6-26
XData and YData 6-27

RGB 6-9
size and aspect ratio 6-22
storing in MATLAB 6-4
truecolor 6-9
types 6-6
See also graphics images

imagesc 6-2, 6-8
imfinfo 6-3, 6-19
imread 6-2, 6-17
imwrite 6-3, 6-18
ind2rgb 6-35
indexed images

converting the data class of 6-11
indirgb 6-3
intensity images

converting the data class of 6-12
interpreter property 3-47
ishold 8-67

J
JPEG 6-2

L
labeling

axes 3-32
labeling graphs 3-1, 3-32
LaTeX

See TeX
legend 5-32
limits

axes 4-20, 10-17

line styles
used for plotting 4-6

redefining 10-37
lines

adding as annotations 3-52
adding to existing graph 4-8
marker types 4-6
styles 4-6

LineStyleOrder property 10-37
locking axes position 1-44
loglog, properties changed by 8-74
low-level functions 8-14

M
mapping data to color 10-30
markers used for plotting 4-6
MATLAB 4 color scheme 4-30
MATLAB, quitting 8-70
matrix

displaying contours 5-45
plotting 4-14
representing as

area graph 5-17
bar graph 5-3
histogram 5-25

storing images 6-4
M-code, saving a graph as 1-48
meshc 5-53
M-files

basic structure of graphics 8-66
closereq 8-70
to set color mapping 10-34
using newplot 8-63
writing efficient 8-72

movie 5-62, 5-63
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movies 5-62
example 5-63

moving
objects 1-44

multiaxis axes 10-22
multiline text 3-48

N
newplot 8-63

example using 8-65
NextPlot property 8-62

add 8-62
new 8-62
replace 8-63
replacechildren 8-63, 8-67
setting plotting color order 10-36

O
open 1-47
OpenGL 9-11, 9-12

printing 7-50
opening figures 1-47
options for copying 1-47
organization of Handle Graphics 8-3
orient

example 7-48
OuterPosition property 10-7

P
page setup 1-48
painters algorithm 9-11
panels

contained in figures 8-76
panning 2-14

paper type
setting from the command line 7-46

paper type for printing
setting from the command line 7-46

PaperPosition property
example 7-44

PaperType property
example 7-46

parent, of graphics object 8-14
PCX 6-2
pie charts 5-21

labeling 5-22
offsetting a slice 5-21
removing a piece 5-23

plot 4-3, 4-4
properties changed by 8-74

plot browser 1-11
Plot Catalog 1-9
plot edit mode

overview 1-38
selecting objects 1-39
starting and ending 1-39

plot edit toolbar 3-2
plot objects

cutting and copying 1-40
pasting 1-40

plot3

properties changed by 8-75
plotedit 1-39
plots

editing 1-37
plotting

adding to existing graph 4-8
annotating graphs 3-1
area graphs 5-17
bar graphs 5-2
compass plots 5-38
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complex data 4-16
contour plots 5-44
contours, labeling 5-46
creating a plot 4-3
data-point markers 4-6
elementary functions for 4-2
feather plots 5-39
interactive 5-60
line colors 10-35
line styles 4-6
matrices 4-14
multiple bar graphs 5-14
multiple graphs 4-4
overlaying bar graphs 5-15
quiver plots 5-41
specifying line styles 4-5, 10-37
stairstep plots 5-36
stem plots 5-29
to subaxis 4-27
vector data 4-2
windows for 4-27

plotting tools 1-4
PNG 6-2

writing as 16-bit using imwrite 6-18
Pointer property 9-14
pointers

custom 9-14
example defining 9-15

specifying 9-13
PointerShapeCData property 9-14
PointerShapeHotSpot property 9-14
polar 5-56
polar coordinates

contour plots 5-54
rose plot 5-26

position of figure 9-5
Position property

axes 10-5
figure 9-5

Position property 10-7
positioning axes 1-44
positioning of axes 10-5
positioning text on a graph 3-39
preferences 1-47
printing

aspect ratio 7-41
default 7-41

background color 7-56
figure size

setting from the command line 7-40, 7-44, 
7-84

fonts
supported for HPGL 7-78
supported for PostScript and GhostScript 

7-78
supported for Windows drivers 7-78

images 6-34
MATLAB printer driver

definition 7-75
OpenGL 7-50
paper type

setting from the command line 7-46
PaperType property

example 7-46
PostScript

fonts supported for 7-78
quick start 7-30
renderer

methods 7-49
resolution

with painters renderer 9-12
with Z-buffer renderer 9-12

troubleshooting 7-85
Z-buffer 9-12
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printing figures 1-48
properties

automatic axes 10-25
changed by built-in functions 8-73
changed by object creation functions 8-13
defining in startup.m 8-49
for labeling axes 10-3
naming convention 8-15
specifying default values 8-45
See also graphics objects

Property Editor 1-15
property values

defaults 8-43
defined by MATLAB 8-42
getting 8-38
resetting to default 8-45
setting 8-38
specifying defaults 8-45
user defined 8-43

Q
quiver 5-38, 5-41
quiver plots 5-41

2-D 5-41
3-D 5-42
combined with contour plot 5-42
displaying velocity vectors 5-43

quiver3 5-38

R
Renderer property

and printing 9-12
rendering

options 9-10
Z-buffer 9-11

reset 8-63
resizing objects 1-44
RGB

converting to 6-35
images 6-9

converting the data class of 6-12
rose 5-24, 5-26
rotating 3-D views 2-15
rotating axis labels 3-34

S
saveas 1-46
saving figures 1-46
saving graphs 1-46
screen extent, determining 9-6
ScreenSize property 9-6

example 9-7
selecting multiple objects 1-39
selection

of plot objects 1-39
selection button 1-39
semilogx, properties changed by 8-75
semilogy, properties changed by 8-75
set 8-38
ShowHiddenHandles property 8-69
size of computer screen 9-6
spline 5-60
stairs 5-29, 5-36
stairstep plot 5-36
starting plot edit mode 1-39
stem 5-29
stem plots 5-29

3-D 5-33
overlaid with line plot 5-32

stem3 5-29, 5-33
string variable, in text 3-47
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subplot 4-27
surfc 5-53
symbols, TeX characters 3-45

T
Tag property use 8-52
TeX

available characters 3-45
creating mathematical symbols 3-45
symbols in text 3-36, 3-46

text
adding to axes 3-39, 3-45
for labeling plots 3-39
horizontal and vertical alignment 3-42
multiline 3-48
placing dynamically, example 3-43
placing outside of axes 10-13
positioning 3-41
TeX characters 3-46
using variables in 3-47

text annotations 3-7
tick marks, on axes 4-22, 10-18
TIFF 6-2
TightInset property 10-7
title

adding to a graph 3-29
toolbar

buttons 3-52

U
uint16 arrays

converting to double 6-11, 6-12
operations supported on 6-13
storing images 6-5

uint8 arrays

converting to double 6-11, 6-12
operations supported on 6-13

uint8 arrays
storing images 6-5

uipanels 8-76
undo/redo 1-45, 2-17
units

axes 10-6
used by figures 9-6

Units property 10-7
unlocking axes position 1-44
unselecting objects 1-40

V
vectors

displaying velocity 5-43
velocity vectors displayed with quiver 5-43
VerticalAlignment property 3-42
visibility of graphics objects 1-12, 8-71

X
XWD 6-2

Z
Z-buffer 9-11

printing 9-12
zoom 2-11
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